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OpenKM 6.3 - CE

i OpenKM Community version is licensed under terms of GINU General Public Licence.

TTTTTTTY

OpenKM is an Electronic Document and Record Management System (EDRMS). There's a lot of literature about document

management terms like: DMS, EDRMS or CMS usually more influenced by marketing rules rather than objective reasons.

The differences between DMS, CMS, and EDRMS in most cases are subjective or not relevant from the Document Management
point of view. Lately, it seems the term CMS has gotten some marketing success and actually is one of the most common used.
However, we prefer the term EDRMS, perhaps with lesser success on the marketing world but from our point of view more

strict and representative.

OpenKM helps you to:

» Day-to-day data capture.
e Storage.
¢ Modify and share physical and/or digital documents within the organization.

o Apply retention periods to stored items.

Identify the owner of each record series and documents.
e Set a chain of custody and proper audit trail.

¢ When needed apply legal records holds.

¢ Managing records disposition.

¢ Preserving records through their life cycle.

Some of the OpenKM goals are:

¢ Increase efficiency. Faster documents approval, reduced manual data entry, automated recurring tasks among others.

¢ Set compliance levels. The system helps the organization to avoid penalties when regulators, auditors and other
government authorities summons them for inspections.

e Preserve historical content. Follow the status of the document (determined by the different phases of the lifecycle).

¢ Consolidate the company knowledge on a single access point.

V The OpenKM technical staff maximum is "Try finding out the easy solution for each problem. If you cannot
find it, try again."

Although we've tried to give our powerful application what it needs to solve problems with a minimalist solution,
sometimes its not possible. OpenKM can solve day-to-day complex scenarios. It is not a closed application and
has a lot of features that can be used and configured on several ways.

Please take your time to read the documentation, it is time well spent. If you have some doubt contact with us.
Usually a problem have several ways to be resolved.
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Your suggestions are always welcomed, we try creating a better application to solve real life problems in a
more efficient way. Your suggestions help us growing the knowledge of EDRMS solutions and how it can

be applied to real case scenarios.
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Hardware and software requirements

This section presents information about the environment needed to run an OpenKM server, listing the required and optional

software and providing some facts about their configuration.

This sections aims at helping you to validate or define the production environment. However, the check-list is not

TTTTT T T

exhaustive and needs to be completed with the user's experience.

Requirements

OpenKM can be installed on any operating system (Linux, Windows, Mac OS X,) since it is a multi-platform application.

.
1
i V A Linux host is a good choice because this OS handles heavy I/O applications, it works with OpenKM quite well,
1
1
|

and it is conveniently priced.

The only requirement to run the OpenKM is to have Java 8 (also called Java 1.8) installed.

A Make sure you're installing OpenJDK 1.8 if you install JRE the application will not run correctly.

rTTTT T TN

Checking the Java version

1. Open a terminal:
¢ On Linux or Mac OS X: open a terminal.
¢ On Windows: press "windows" key + r, type cmd (or command) in the Run window and press "OK" or open
the "Prompt command" from "Start > Programs > Accessories" menu.
2. Type java -version and press Enter.

If Java is correctly installed on your computer, the name and version of the Java virtual machine is displayed:

-

i
i Java version "1.8.0_31"

|

i Java(TM) SE Runtime Environment (build 1.8.0_31-b13)
|

|

|

Java HotSpot(TM) 64-Bit Server VM (build 25.31-b07, mixed mode)

E—

If Java is not installed on your computer, it will fail to display the Java version. Then, you will need to install Java (see below).

If Java is installed but not included in the PATH, it will fail to find the Java command. Then, you will need to add

$JAVA_HOME/bin/ in your PATH (see: How do I set or change the PATH system variable?).
Installing Java
For Windows users

If the required version of Java is not installed on your computer:
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1. Download it from the Oracle website (Java 8) and choose the appropriate platform for your hardware and Windows

version.

2. Run the downloaded .exe file and follow the instructions displayed.

For Linux users

You can download Java 8 from Oracle website (choose the right architecture). You can find RPM and TGZ packages to install.

If you use Ubuntu the following is a better method:

-~

$ sudo add-apt-repository ppa:webupd8team/java

i

|

|

I $ sudo apt-get update

[}

[}

i $ sudo apt-get install oracle-java8-installer

R———

This way your OpenJDK will be upgraded every time a new release is available.

In case you have another OpenJDK installed (like GCJ), you can select the right one this way:

$ sudo update-alternatives --config java

ST

e ——

For Mac OS X Users

Java packages and instructions for installation are available from the Oracle website:

e Download

e Instructions

Recommendations

Hardware configuration

V OpenKM runs quite well on any computer with a common hardware configuration. For a better performance we
recommend at least 4 GB RAM (have at least >=2GB of plenty RAM) and a fast hard disk like SATA or better.

A dual-core Intel based CPU with 3.20 GHz should be fine for a reduced number of users (30-50 concurrent
users).

Be sure to have enough disk space for the document repository and its versions.

A Linux host is a good choice because this OS handles heavy I/O applications like this quite well, and it is not

expensive.

It is highly recommended 64 bits architecture.

A We suggest having a modern server with good performance.

Although OpenKM can be installed on a server with other applications, the best scenario is a dedicated server.

Keep in mind that on a shared scenario other applications can have a negative effect on OpenKM.
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7

For more information about hardware requirements consult with your sales & marketing representatives as they should provide

you a hardware requirements estimation.

Try giving them as much detailed information as possible for a more accurate estimation:

« Estimated number of concurrent users.

» Type of users (% of reader and % of writers).
« Estimated first year number of files.

« Estimated number of files growing per year.
» Estimated document size average.

e Most common document types (MS Office, OpenOffice, PDF, etc.).

i You can use your older history of documents and folders to get some of these values.

TTTTTTTY

Browser support

OpenKM user interface is based on GWT framework, than means the supported browsers are determinated by GWT browser

support.

Actual browsers supported:

o Firefox

o Internet Explorer 8, 9, 10, 11

e Safari 5, 6

e Chromium and Goggle Chrome

e Opera latest version

More information at GWT Browsers and Servers.

V We encourage your browser to be updated to the latest version.

We recommend Firefox and Chrome rather than IE, for several reasons; best performance, less security holes,
follow the standards.

—_————— e —
E—

Operating systems

Linux (Known working configurations):

e Ubuntu
e Debian

e CentOS
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¢ Red Hat Linux

A Red Hat Linux is a more difficult scenario, because some packages aren't by default in the Red Hat official
repositories.

V Ubuntu is the preferred Linux choise. We run the tests against Linux distribution and we build the packages for it.
However, any recent Linux distribution should be usable as long as:

e OpenJDK 8 is available.

¢ You can adapt the provided Linux scripts.

o Thirdparty software requirements

Windows (Known working configurations):

e For development: Windows 7, Windows 8

e For deployment: Windows Server 2003, Windows Server 2008, Windows Server 2012

Databases

Known working configurations:

« MySQL

e PostgreSQL

¢ Oracle
e SQL server
(
i The application internally uses Hibernate, in fact you should get it running from any of the supported Hibernate
i dialects, for more information read Hibernate: SQL. Dialects.
JVM

Although OpenKM can run with other JDK we recommend the use of OpenJDK 8 (64 bits architecture is highly recommended).

LDAP

e Open LDAP

e Microsoft Active Directory
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Third-party software requirements

OpenKM takes advantage of using third-party software for some features. Some of this software needs to be installed on the

server, others are optional.

Software Usage Additional information Required
Openoffice o Converts Yes
or documents to pdf.
Libreoffice o Needed for

preview feature.

Imagemagick e Transforms Usually comes by default installed in Linux OS. Yes

images. . . . . .
& In Windows in most cases it is not necessary to install it,

Generates

because it comes embedded by default with OpenKM

thumbnails. bundle installation.

e Needed for

preview feature.

On most cases it is not necessary to install it, because it Yes
SWETools

Converts pdf

comes embedded by default with OpenKM bundle
document to swf.

installation.
e Needed for

preview feature.

GhostScript Interpreter for the Usually comes by default installed on Linux OS. Optional

PostScript
language and for

PDF.

Needed by

Imagemagick.

Pdftohtml Converts pdf Optional

document to html.
e Needed for

preview feature.
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Tesseract or « OCR engine. Required when application must processes images to Optional

cuneiform e Used for the text extract text (OCR).

extraction feature.

Ffmpeg o Converts and Optional
streams audio and

video

Clamav or e Antivirus Required when antivirus feature is enabled. Optional

equivalent
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Installation

OpenKM can be installed on several Operating Systems and can be configured to use different databases. Because it's
implemented in Java, the only software requirement is having a Java Virtual Machine compiled for your platform. But OpenKM
also depends on third-party applications to be fully configured. For example, it needs a working OpenOffice or LibreOffice
installation to be able of preview documents. Or you may want to extract text from your scanned images, and for this an OCR

engine is needed.

Before installing you need to prepare the server. Depending on the Operating System you should follow some tips. When you
install the Operating System, keep on mind that OpenKM does not need a graphical user desktop. So, in Linux systems, you can
avoid installing these packages and save some memory. Another important advice is to do a minimal Operating System
installation. We only need the minimum to access the server. In case of Linux server, we prefer to access by SSH because is fast

and secure. Please, don't install Java or Tomcat or any other software unless you have already asked us.

This is a checklist of information we should know before installing:

+ How many document do you want to store?
* How many user will access OpenKM?

o How many concurrent users?

* How much memory does the server have?

* How many CPUs does the server have?

o How much free disk is avaible in the server?
o Which Operating System is installed?

o Is the installed Operating System the 64 bits version?
In case of Linux server there are some aditional questions:

o Which distro (name and version)?
» Does the server have a GUI (X-Windows) installed?
e It is a clean and minimal installation (only SSH) or have you installed another software?

o Is this server used for other applications?

Is the database already installed?

In this section you will learn how to install OpenKM in your server and how to match most common third-party applications

requirements.

OpenKM has been successfully installed on:

oS Description
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Linux Ubuntu Server

Linux Mint

Debian

CentOS

Red Hat

SuSE

Windows Windows Server 2012 R2

Windows Server 2008 R2

Windows Server 2003 R2

Windows 8

Windows 7
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Installing on Ubuntu and Debian

Preliminaries

Check disk size

$ df -h

ST

Create user named openkm

e ——

$ sudo adduser openkm

i You can easily generate random passwords at:
o https://www.random.org/passwords.
o https://www.safetydetectives.com/password-meter/

Check if partners channels are enabled

$ cat /etc/apt/sources.list

ST

e ——

In case they are not enabled, enable them.

$ sudo vim /etc/apt/sources.list

$ sudo apt-get update

f
I
I
I
I
I
I
I
1

Check server configuration

-~

$ wget -Nc smxi.org/inxi

|
|
i $ sudo chmod +x inxi
|
|
' $ sudo /inxi -F

R———

Increase ulimit

{
' $ sudo vim /etc/pam.d/su
\,

e ——

uncomment the following line

#session required

to

session required

pam limits.so

pam limits.so
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$ sudo vim /etc/security/limits.conf

ST

e ——

and add the following lines to the end of the file (before the line # End of file)

us soft nofile 6084

& hard nofile 6084

A Now reboot the server, execute ulimit -n and check if the open files limits are now updated.

rTTTT T TN

Checking Java version

$ java -version

ST

e ——

If Java is correctly installed on your computer, the name and version of the Java virtual machine is displayed:

-~

openjdk version "1.8.0_212"
OpenJDK Runtime Environment (build 1.8.0_212-8u212-b03-0Oubuntu1.18.04.1-b03)

OpenJDK 64-Bit Server VM (build 25.212-b03, mixed mode)

The Java version may be different depending on your installed one, but we always recommend the latest 1.8
release.

Install Java

i Perform these steps only if Java 8 is not already installed on your server.

TTTTTTTY

In case of Ubuntu

$ sudo apt-get update

$ sudo apt-get install openjdk-8-jdk

f
I
I
I
I
I
I
I
1

In case of Debian

$su -
$ apt-get update
$ apt-get install openjdk-8-jdk

$ exit

Set OpenJDK 1.8 as your default Java version

i Perform this only if Java 8 is not your default Java version.

TTTTTTTY

———
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$ sudo update-alternatives --config java

T

~———

Installing database

Install MySQL if you do not have it already installed:

$ sudo apt-get install mysql-server

T

~———

When you install MySQL, the installer will ask you for a password for the root user. Keep this password handy.

Also you can install MariaDB, which replaces MySQL in latest versions:

{
i $ sudo apt-get install mariadb-server
\,

~———

Change MySQL root password

Do it only if it's necessary to change MySQL root password.

Method 1

T

$ /usr/bin/mysgladmin -u root -h localhost password 'password'

~———

Method 2

-~

$ sudo /etc/init.d/mysql stop
$ sudo mysqld --skip-grant-tables &

$ mysql -u root mysgl

> FLUSH PRIVILEGES;

> exit;

> UPDATE user SET Password=PASSWORD('YOURNEWPASSWORD') WHERE User="root';

as a service.

A MySQL in this case has not been started at service. The process must be killed to stop MySQL and start it again

Method 3

$ mysgl

i
|
|
|
|
|
|
|
|
i > flush privileges;

> UPDATE mysql.user SET Password=PASSWORD('MyNewPass') WHERE User="root';

R———

Method 4

g
i $ sudo /etc/init.d/mysql stop
|
I

$ mysqld_safe --skip-grant-tables &

4
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$ mysql -u root mysgl
> UPDATE user SET Password=PASSWORD('YOURNEWPASSWORD') WHERE User="root';
> FLUSH PRIVILEGES;

> exit;

A MySQL in this case has not been started at service. The process must be killed to stop MySQL and start it again

as a service

More information at MySQL : Reseting permissions.

Check InnoDB is default MySQL engine

$ mysql -h localhost -u root -p

> show engines;

V It should looks something like this:

| InnoDB | DEFAULT | Supports transactions, row-level locking, and foreign keys | YES | YES | YES |

If it not default, modify /etc/mysql/my.cnf

$ vim /etc/mysgl/my.cnf

ST

and under [mysqld] add

default-storage-engine = innodb

A After changing default MySQL engine the MySQL service must be restarted to take effect.

TTTTT TN

Create database

-~

CREATE DATABASE okmdb DEFAULT CHARACTER SET utf8 DEFAULT COLLATE utf8 bin;

|

|

i CREATE USER openkm@localhost IDENTIFIED BY 'password';

|

|

i GRANT ALL ON okmdb.* TO openkm@localhost WITH GRANT OPTION;

R———

Installing OpenKM and Tomcat bundle

$ cd /home/openkm

$ unzip openkm-6.3.2-community-tomcat-bundle.zip

A The tomcat version numeration name can be altered in order to upgrade to a major version.
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case "S$1" in
start)
start
stop)
stop
restart)
stop
sleep 30
start

rr

SECHO "Usage: tomcat {start|stop|restart}"
exit 1
esac
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Configuring Tomcat as a service
A For security reasons you shouldn't run Tomcat as root. It is better to use the user named openkm.

Create a file with the script:

$ sudo vim /etc/init.d/tomcat
e 1
' #!/bin/sh 5
\ ### BEGIN INIT INFO i
i # Provides: tomcat
' # Required-Start: Sremote fs S$Ssyslog '
! # Required-Stop: Sremote fs $syslog J
\ # Default-Start: 2 345
' # Default-Stop: 016 :
' # Short-Description: Start and stop Apache Tomcat J
\ # Description: Enable Apache Tomcat service provided by daemon. i
. 444 END INIT INFO
E ECHO=/bin/echo E
i TEST=/usr/bin/test 1
i TOMCAT_USER=openkm
' TOMCAT_ HOME=/home/openkm/tomcat '
| TOMCAT_START_SCRIPT=$TOMCAT_HOME/bin/Startup.sh i
: TOMCAT_STOP_SCRIPT=$TOMCAT_HOME/bin/shutdown.sh i
! STEST -x $TOMCAT START SCRIPT || exit 0
\ STEST -x $TOMCAT_STOP_SCRIPT || exit O i
E start () { E
! SECHO -n "Starting Tomcat" i
: g = $TOMCAT_USER -C "$TOMCAT_START_SCRIPT &" i
5 $ECHO "." ;
Vol 1
| stop() |
' SECHO -n "Stopping Tomcat" J
: su - STOMCAT USER -c "$TOMCAT STOP SCRIPT 60 -force &" :
i while [ "$(ps -fu $TOMCAT USER | grep java | grep tomcat | wc -1)" -gt "O0" ]; do
E sleep 5; $ECHO -n "."
! done J
| SECHO "." i
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exit 0O

The script must be changed if you use other user to start the service or your $TOMCAT_HOME is not
/home/openkm/tomcat

Make it executable:

$ sudo chmod 755 /etc/init.d/tomcat

ST
(R

Update the run-levels:

{
i $ sudo update-rc.d tomcat defaults
\,

~———

Check the service

Start the service:

$ sudo service tomcat start

ST
(R

Stop the service:

$ sudo service tomcat stop

ST
(R

Installing third-party software

Software Required Command

R

$ apt-get install libreoffice

LibreOffice or Yes

OpenOffice

Tesseract No $ apt-get install tesseract-ocr tesseract-ocr-eng
Depending on your locale you would like to install other
language file.

Clamav No $ apt-get install clamav

Imagemagick Yes $ apt-get install imagemagick

Ghostscript Yes $ apt-get install ghostscript
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Start application

Check OpenKM.cfg parameters

$ vim /home/openkm/tomcat/OpenKM.cfg

ST

~———

Your configuration should be something like this:

# OpenKM Hibernate configuration values

hibernate.dialect=org.hibernate.dialect.MySQL5InnoDBDialect

hibernate.hbm2ddl=create

A Ensure hibernate.dialect=org.hibernate.dialect. MySQL5Dialect is enabled if your database is MySQL.

First time application start:

$ service tomcat start

To see the startup process can execute the command:

$ tail -f /home/openkm/tomcat/log/catalina.log

ST

~———

When application is started you'll see in log file the lines:

2015-07-04 18:28:10,680 [main] INFO org.apache.coyote.httpll.HttpllProtocol - Startii:

' 2015-07-04 18:28:10,688 [main] INFO
, 2015-07-04 18:28:10,692 [main] INFO

org.apache.coyote.ajp.AjpProtocol - Starting Pro
org.apache.catalina.startup.Catalina - Server st.

The application will be accessible at http://YOUR_IP:8080/0OpenKM by user:okmAdmin with password:admin. ( Do not

forget to change it !). For more information about Manage users and roles.

Configure default extensions:

Go to Administration > Database query and execute:

Other common additional configurations setup

INSERT INTO OKM EXTENSION (EXT UUID, EXT NAME)
INSERT INTO OKM EXTENSION (EXT UUID, EXT NAME)
INSERT INTO OKM PROFILE MSC EXTENSION (PEX ID,
INSERT INTO OKM PROFILE MSC EXTENSION (PEX ID,

VALUES ('808e7a42-2e73-470c-ba23-e4c9d
VALUES ('58392af6-2131-413b-b188-1851a.
PEX EXTENSION) VALUES (1, '808e7a42-2e
PEX EXTENSION) VALUES (1, '58392af6-251

OpenKM comes with a lot of configuration parameters. Please make sure to review: Recommended configuration parameters.

o Configuring Apache HTTP Reverse-Proxy
o Configuring mail
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e Configuring Tomcat memory utilization
¢ Configuring Tomcat port

¢ Configuring Tomcat SSL/TLS

« Configuring Tomcat timezone

Restart installation from scratch

The OpenKM first startup does some background configurations like filesystem folder creation, changes in the OpenKM.cfg

what only happens during the first startup.

Sometimes maybe some mistake in OpenKM configuration, for example, wrong database connection or similar issues during

the first startup what raise and application failure. To restart the installation from scratch we suggest following the next steps.

1. Ensure OpenKM is stopped.

2. Edit the OpenKM.cfg and set the parameter hibernate.hbm2ddl=create

3. In case issue with database connection, we suggest checking the connection from the OpenKM server. Remember some
databases require enabling the user to gain connection from a server ( specific IP, range of IP, any server ).

4. Delete the folder named "repository"

5. Start OpenKM.
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Installing on RedHat and CentOS

ﬁ If you decide installing Redhat, take in consideration you should have a licensed Redhat version, otherwise the

repositories for installing software are locked.

Does not have much sense installing Redhat without a license subscription in the same direction does not have
much sense enable CentOS repos in a Redhat, if this is your way better intalling CentOS at the begining.

e e

— e/

Preliminaries

Check disk size

$ df -h

ST

Create a user named openkm

~———

$ sudo adduser openkm

ST

~———

- g
1 You can easily generate random passwords at https:/www.random.org/passwords.

TTTTTTTY

———

Check server configuration

-~

$ wget -Nc smxi.org/inxi
$ sudo chmod +x inxi

$ sudo ./inxi -F

A If it doesn't work, try installing this package:

Increase ulimit

$ sudo vim /etc/security/limits.conf

ST

add the following lines to the end of the file (before the line # End of file)

&3 soft nofile 6084

€5 hard nofile 6084

~———

A Execute ulimit -n and see the open files limits are now updated.

TTTTT TN
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Checking Java version

$ java -version

ST

~———

If Java is correctly installed on your computer, the name and version of the Java virtual machine is displayed:

-~

openjdk version "1.8.0_212"
OpenJDK Runtime Environment (build 1.8.0_212-b04)

OpenJDK 64-Bit Server VM (build 25.212-b04, mixed mode)

A The Java version numeration name can be altered in order to be upgraded to major version.

Install Java

~

i Perform these steps only if Java 8 is not already installed on your server.

$ sudo yum install java-1.8.0-openjdk-devel

The Java version may be different depending on your installed one, but we always recommend the latest 1.8

release.

Set OpenJDK 1.8 as your default Java version

i Perform this only if Java 8 is not your default Java version.

TTTTTTTY

———

{
i $ alternatives --config java
\,

~———

Installing database

Install MySQL if you do not have it already installed:

$ sudo yum install mysql-server mysql

ST

Configure it as service:

$ sudo chkconfig --levels 235 mysgld on

i On latest Centos the MySQL package has been replaced in the repositories by MariaDB.

Install MariaDB:

{
| $ sudo yum install mariadb-server
\,
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Configure as service:

{
| $ sudo systemctl enable mariadb
1

Edit the /etc/selinux/config file:

i If you get some trouble on the first database startup because it can not create files into tmp folder do:

$ sudo vim /etc/selinux/config

And apply this change to:

To take effect inmediatelly, execute from command line:

$ sudo setenforce 0

Change MySQL root password

Do it only If it's necessary to change the MySQL root password.

Method 1

$ /usr/bin/mysgladmin -u root -h localhost password 'password'

T

~———

Method 2

-~

$ sudo /etc/init.d/mysql stop
$ sudo mysqld --skip-grant-tables &

$ mysql -u root mysgl

> FLUSH PRIVILEGES;

> exit;

> UPDATE user SET Password=PASSWORD('YOURNEWPASSWORD') WHERE User="root';

as service.

A In this case MySQL has not been started as a service. The process must be killed to stop MySQL and start it again

Method 3

-~

$ mysgl

> flush privileges;

|
|
i > UPDATE mysql.user SET Password=PASSWORD('MyNewPass') WHERE User="root';
|
|
{

R———

Method 4
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-~

$ sudo /etc/init.d/mysql stop

$ mysqld_safe --skip-grant-tables &

$ mysql -u root mysgl

> UPDATE user SET Password=PASSWORD('YOURNEWPASSWORD') WHERE User="root';
> FLUSH PRIVILEGES;

> exit;

A In this case MySQL has not been started as service. The process must be killed to stop MySQL and start it again

as service.

More information at MySQL : Reseting permissions.

Check InnoDB is default MySQL engine

$ mysql -h localhost -u root -p

> show engines;

V It should show something like this:

| InnoDB | DEFAULT | Supports transactions, row-level locking, and foreign keys | YES | YES | YES |

If it not default, modify /etc/mysql/my.cnf

$ vim /etc/mysgl/my.cnf

and under [mysqld] add

default-storage-engine = innodb

A After changing the default MySQL engine the MySQL service must be restarted to take effect.

TTTTT TN

Create database

-~

CREATE DATABASE okmdb DEFAULT CHARACTER SET utf8 DEFAULT COLLATE utf8 bin;

|

|

i CREATE USER openkm@localhost IDENTIFIED BY 'password';

|

|

i GRANT ALL ON okmdb.* TO openkm@localhost WITH GRANT OPTION;

R———

Installing OpenKM and Tomcat bundle

$ cd /home/openkm

$ unzip openkm-6.3.2-community-tomcat-bundle.zip

~
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A The tomcat version numeration name can be altered in order to be upgraded to major version.

Configuring Tomcat as a service

TTTTT TN

A For security reasons you shouldn't run Tomcat as roet. It is better to use the user named openkm.

Create a file with the script:

ST

$ sudo vim /etc/init.d/tomcat

#!/bin/sh

### BEGIN INIT INFO
# Provides: tomcat

# Required-Start: Sremote fs S$syslog

# Required-Stop: Sremote fs $syslog

# Default-Start: 2 345

# Default-Stop: 016

# Short-Description: Start and stop Apache Tomcat
#
#

## END INIT INFO

ECHO=/bin/echo

TEST=/usr/bin/test

TOMCAT USER=openkm

TOMCAT HOME=/home/openkm/tomcat
TOMCAT_START_SCRIPT=$TOMCAT_HOME/bin/Startup.Sh
TOMCAT_STOP_SCRIPT=$TOMCAT_HOME/bin/shutdown.sh

STEST -x $TOMCAT START SCRIPT || exit 0
STEST -x $STOMCAT STOP SCRIPT || exit 0

start () |
SECHO -n "Starting Tomcat"
su - $TOMCAT_USER =@ "$TOMCAT_START_SCRIPT &"
SECHO "."

}

stop () {
SECHO -n "Stopping Tomcat"
su - S$TOMCAT USER -c "$TOMCAT STOP SCRIPT 60 -force &"

Description: Enable Apache Tomcat service provided by daemon.

while [ "$(ps -fu $TOMCAT USER | grep java | grep tomcat | wc -1)" -gt "O0" ];

sleep 5; SECHO -n "."
done
SECHO "."

case "$1" in
start)
start
stop)
stop
restart)
stop
sleep 30
start

rr
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*)

exit 1

SECHO "Usage: tomcat {start|stop|restart}"

/home/openkm/tomcat

The script must be changed if you use other user to start the service or your STOMCAT_HOME is not

Make it executable:

$ sudo chmod 755 /etc/init.d/tomcat

Update the run-levels:

ST

$ sudo chkconfig tomcat --level 2345 on

~———

Check the service

Start the service:

$ sudo service tomcat start

ST

Stop the service:

ST

$ sudo service tomcat stop

Installing thirdparty software

Software Required
OpenOffice or Yes
LibreOffice

Description

Check these packages are present:

» openoffice.org-ure-3.1.1-19.5.el5_5.6
» openoffice.org-headless-3.1.1-19.5.el5_5.6

o openoffice.org-pyuno-3.1.1-19.5.el5_5.6

Execute this command line to check the installed packages:

P

$ rpm -qga | grep openoffice

A Take the names of the packages as an orientation.

If headless package is not installed OpenKM will not be able to

start soffice service.
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Tesseract

ClamAV

Imagemagick

GhostScript

Htop

Start application

No

No

Yes

Yes

no

Check OpenKM.cfg parameters

Some useful links:

o https://code.google.com/p/tesseract-ocr/wiki/Compiling
e https://code.google.com/p/python-
tesseract/wiki/HowToCompileForCentos

e http://www.vicchiam.com/blog/?p=168

Some useful links:

o http://www.clamav.net/doc/install.html#rhel

$ yum install ImageMagick

$ yum install ghostscript

Download from http://pkgs.repoforge.org/htop/

P

[}
. $ rpm -ivH htop-1.0.3-1.el6.rf.x86_64.rpm
\

ST

$ vim /home/openkm/tomcat/OpenKM.cfg

~———

Your configuration should be something like this:

# OpenKM Hibernate configuration values

hibernate.dialect=org.hibernate.dialect.MySQL5InnoDBDialect

hibernate.hbm2ddl=create

TTTTT TN

A Ensure hibernate.dialect=org.hibernate.dialect. MySQL.5Dialect is enabled if your database is MySQL

First time application start:

{
i $ service tomcat start
\,

~———

To check if the startup process can execute the command:

s
|
|
|
|
\

$ tail -f /home/openkm/tomcat/log/catalina.log

~———
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When the application is started you'll see in log file the lines:

2015-07-04 18:28:10,680 [main] INFO org.apache.coyote.httpll.HttpllProtocol - Startii:
' 2015-07-04 18:28:10,688 [main] INFO org.apache.coyote.ajp.AjpProtocol - Starting Pro
1 2015-07-04 18:28:10,692 [main] INFO org.apache.catalina.startup.Catalina - Server sit.

The application will be accessible at http://YOUR_IP:8080/0OpenKM by user:okmAdmin with password:admin. ( Do not

forget to change it !). For more information please check: Manage users and roles.
Configure the default extensions:

Go to Administration > Database query and execute:

INSERT INTO OKM EXTENSION (EXT UUID, EXT NAME) VALUES ('808e7a42—2e73—470c—ba23—e4c9id
INSERT INTO OKM EXTENSION (EXT UUID, EXT NAME) VALUES ('58392af6-2131-413b-b188-1851a.
INSERT INTO OKM PROFILE MSC EXTENSION (PEX ID, PEX EXTENSION) VALUES (1, '808e7a42-2e
INSERT INTO OKM PROFILE MSC EXTENSION (PEX ID, PEX EXTENSION) VALUES (1, '58392af6—2il

Linux Oracle 7.X Throubleshooting

The libreoffice and tesseract tools are not into the default repositories, you cal follow the steps described in the URL below for

installing them:

Install libreoffice from RPM

,

i You should download the last RPM file version, what might be found at
https://www. libreoffice.or wnloa nl ?type=rpm-x rsion=

The process description below has been described at https://www.tecmint.com/install-libreoffice-on-rhel-centos-
fedora-debian-ubuntu-linux-mint/

Libreoffice at the end will be installed into the folder /opt/libreoffice6.0

$ yum remove openoffice* libreoffice*

$ cd /opt

$ wget https://www.libreoffice.org/donate/dl/rpm-x86_64/6.0.4/es/LibreOffice_6.0.4_Linux_x86-64_rpm.tar.gz
$ tar -xvf LibreOffice_6.0.4_Linux_x86-64_rpm.tar.gz

$ cd LibreOffice_6.0.4_Linux_x86-64_rpm/RPMS

$ yum localinstall *.rpm

Install Tesseract

The script below has been found from https://gith m/EisenVault/install- ract-redhat-centos/ we suggest

———————— e

|
|
|
take a look at the last version of the script in the github project for updates. i
|
|
|

Before executing the script, review it, consider to apply changes about downloading the dictionaries you need, for
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example for spanish dictionary should be download https://github.com/tesseract-
ocr/tessdata/raw/3.04.00/spa.traineddata what is not present in the script by default.

#!/bin/sh
cd /opt

yum -y update
yum -y install libstdc++ autoconf automake libtool autoconf-archive pkg-config gcc g

#Install AutoConf-Archive
wget ftp://mirror.switch.ch/pool/4/mirror/epel/7/ppc64/a/autoconf-archive-2016.09.16
rpm —-i autoconf-archive-2016.09.16-1.el7.noarch.rpm

#Install Leptonica from Source E
wget http://www.leptonica.com/source/leptonica-1.75.3.tar.gz ]
tar -zxvf leptonica-1.75.3.tar.gz ]
cd leptonica-1.75.3 E
./autobuild :
./configure i
make ]
make install E
cd '

#!/bin/sh

. #Install Tesseract from Source
| wget https://github.com/tesseract-ocr/tesseract/archive/3.05.01.tar.gz
' tar -zxvf 3.05.0l.tar.gz
' cd tesseract-3.05.01
i ./autogen.sh 1
. PKG _CONFIG PATH=/usr/local/lib/pkgconfig LIBLEPT HEADERSDIR=/usr/local/include ./conf
' LDFLAGS="-L/usr/local/lib" CFLAGS="-I/usr/local/include" make :
' make install
i ldconfig
rcd

#Download and install tesseract language files

wget https://github.com/tesseract-ocr/tessdata/raw/3.04.00/ben.traineddata
wget https://github.com/tesseract-ocr/tessdata/raw/3.04.00/eng.traineddata
wget https://github.com/tesseract-ocr/tessdata/raw/3.04.00/hin.traineddata
wget https://github.com/tesseract-ocr/tessdata/raw/3.04.00/tha.traineddata
wget https://github.com/tesseract-ocr/tessdata/raw/3.04.00/0sd.traineddata
mv *.traineddata /usr/local/share/tessdata

#Download Hindi Cube data

wget https://github.com/tesseract-ocr/tessdata/raw/3.04.00/hin.cube.bigrams

wget https://github.com/tesseract-ocr/tessdata/raw/3.04.00/hin.cube.fold

wget https://github.com/tesseract-ocr/tessdata/raw/3.04.00/hin.cube.lm

wget https://github.com/tesseract-ocr/tessdata/raw/3.04.00/hin.cube.nn

wget https://github.com/tesseract-ocr/tessdata/raw/3.04.00/hin.cube.params

wget https://github.com/tesseract-ocr/tessdata/raw/3.04.00/hin.cube.word-freq
wget https://github.com/tesseract-ocr/tessdata/raw/3.04.00/hin.tesseract cube.nn
mv hin.* /usr/local/share/tessdata

In -s /opt/tesseract-3.05.01 /opt/tesseract-latest

Other common additional setup configurations

OpenKM comes with a lot of configuration parameters we suggest taking a look at: Recommended configuration parameters.

» Configuring Apache HTTP Reverse-Proxy
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o Configuring mail

o Configuring Tomcat memory utilization
o Configuring Tomcat port

o Configuring Tomcat SSL/TLS

o Configuring Tomcat timezone

Restart installation from scratch

The OpenKM first startup does some background configurations like filesystem folder creation, changes in the OpenKM.cfg

what only happens during the first startup.

Sometimes maybe some mistake in OpenKM configuration, for example, wrong database connection or similar issues during

the first startup what raise and application failure. To restart the installation from scratch we suggest following the next steps.

1. Ensure OpenKM is stopped.

2. Edit the OpenKM.cfg and set the parameter hibernate.hbm2ddl=create

3. In case issue with database connection, we suggest checking the connection from the OpenKM server. Remember some
databases require enabling the user to gain connection from a server ( specific IP, range of IP, any server ).

4. Delete the folder named "repository"

5. Start OpenKM.
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Installing on Windows

Preliminaries
Check that you have enought disk size.
We recommend installing these tools:

» Geany ( text editor ).

e mTail ( Windows Program that works like the Unix command "tail" ).

Checking Java version
C:\> java -version

If Java is correctly installed on your computer, the name and version of the Java virtual machine is displayed:

java version "1.8.0_101"
Java(TM) SE Runtime Environment (build 1.8.0_101-b13)

Java HotSpot(TM) 64-Bit Server VM (build 25.101-b13, mixed mode)

The Java version may be different depending on your installed one, but we always recommend the latest 1.8

release.

TTTTT T T

We recommend also setting the JAVA_HOME variable:

setx JAVA_HOME "C:\Program Files\Java\jdk1.8.0_101" /M

Install Java

i Do these steps only if java 8 is not installed on your server.

TTTTTTTY

If the required version of Java is not installed on your computer:

1. Download it from the Oracle website (Java 8) and choose the appropriate platform for your hardware and Windows

version.

2. Run the downloaded .exe file and follow the instructions displayed.

Installing database
Install MySQL if you do not have it already installed:

Download MySQL MSI Installer from MySQL Community Server and follow the installation wizard steps.

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


http://www.geany.org/Download/Releases
http://ophilipp.free.fr/op_tail.htm
http://www.oracle.com/technetwork/java/javase/downloads/index.html
http://dev.mysql.com/downloads/mysql/
https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE Page 63 of 1191

i If you do not have a MySQL client software it is also good idea to install MySQL Workbench.

TTTTTTTY

Check InnoDB is default MySQL engine

show engines;

V It should show something like this:

| InnoDB | DEFAULT | Supports transactions, row-level locking, and foreign keys | YES | YES | YES |

If it not default, modify c:\ProgramData\MySQL\MySQL Server 5.6\my.ini

and under [mysqld] add

default-storage-engine = innodb

A After changing default MySQL engine the MySQL service must be restarted to take effect.

TTTTT TN

Create database

-

CREATE DATABASE okmdb DEFAULT CHARACTER SET utf8 DEFAULT COLLATE utf8 bin;

|

|

i CREATE USER openkm@localhost IDENTIFIED BY 'password’;

|

|

i GRANT ALL ON okmdb.* TO openkm@localhost WITH GRANT OPTION;

R———

Installing OpenKM and Tomcat bundle

Unzip openkm-6.3.2-community-tomcat-bundle.zip to c:\

A The Tomcat version numeration name can be altered in order to be upgraded to major version.

TTTTT TN

Copy files from C:\temcat\bin\x86 or C:\tomcat\bin\x64 to C:\tomcat\bin based on the server architecture.

Configuring Tomcat as a service

Register the service:

A Open a windows terminal as administrator.

TTTTT TN
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W |
Open

_— o
J Motepad @Ru'l &8 administrator
e
~ Fin to Taskbar .
@ InternetEx  Pin to Start Menu SR
Remove from this list Documents
i50 | Geany
A Properties
- Computer
MySQL Workbench 5.2 CE
= Metwork
;& Computer Management
Control Panel

Devices and Printers

Administrative Tools r

Help and Support

Run...

k All Programs

Search programs and files @J Log off Pl

cd c:\tomcat\bin

service.bat install

Set the JVM parameters for the Tomcat service:

P

A The parameters below are deprecated when you are running OpenJDK 1.8. do not execute these ones:

~

openkm //US//OpenKM ++JvmOptions="-XX:PermSize=256m"
openkm //US//OpenKM ++JvmOptions="-XX:MaxPermSize=512m"

,______

cd c:\tomcat-7.0.61\bin

openkm //US//OpenKM ++JvmOptions="XX:+UseG1GC"

openkm //US//OpenKM ++JvmOptions="-Djava.awt.headless=true"
openkm //US//OpenKM ++JvmOptions="-Djava.net.preferlPv4Stack=true"
openkm //US//OpenKM ++JvmOptions="-Dfile.encoding=utf-8"

openkm //US//OpenKM ++JvmOptions="-Dsun.jnu.encoding=UTF-8"

openkm //US//OpenKM ++JvmOptions="-Dmail.mime.ignoreunknownencoding=true"

Execute the tomcat7w.exe as administrator:
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% tomcat? 12/04/2013 16:43 .

’ o tomcatiw 12/04/2013 16:43

o 11T
13| torncat-juli 6/05/20129:35 I
— ! @l&nmahﬂah" I 051
|| tomcat-native, | W 2/04/2013 15:43 |
tool-wrapper Troubleshoot compatibility 2/04/2013 16:43 !
Fin to Taskb i
|| tool-wrapper.st S ey 2/04/2013 16:43 !

Fin to Start Menu

i . 1
Versian Restore previous versions 2/04/2013 16:43
wersion.sh 2/04/2013 16:43 !
- Send to C
nodified: 12/04,/2013 . 52013 16:58
L
Size: 101KE
Copy

Create shartout
Delete
Rename

Properties

Check the configuration parameters:

i Also you can change "Startup type" to Automatic.

TTTTTTTY

| # Apache Tomcat 7 Properties 5[ | # Apache Tomcat 7 Properties

General ILog on I Logging I Java | Startup | Shutdnwnl -Generall Log On  Legging IJava I 5
Service Mame: tomcat?
i Level:
Lisplay name: vache Tomcat 7 sl
Log path:

Description: I Apache Tomcat 7.00 27 Server - http:/ftomcat. apache. I C: \tomeat-7.0.27\ogs

Path to executable: Log prefix: I commons-daeman
IC: \openkmhinitomcat?. exe [R5/ Tomcat? pid fle: I—

Startup type: Manuzl |
Redirect Stdout:
I auto
Service Status:  Stopped Redirect Stderror:
I auto
Start | Stop | Fause | Festark |

oK I Cancel | Apply | Ql
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A # Apache Tomcat 7 Properties

General I Log On I Logging Java |513r1L||:| I Shutdown |

[ Use default
Java Virtual Machine:

I C:\Program Files (x36)Javaijdk1.6.0_37re'bintserverijvm. dil

Java Classpath:

B3Il = Apache Tomcat 7 Properties

General I Log On I Logging I Java S

Class:

I org.apache. catalina.startup. Bootstr

_| Image:
|

Java Options:

I Ci\tomcat-7.0. 27binbootstrap. jar ;C: \tomeat-7.0. 27bin tomecat-juli. jar; Working Path:

I c:\tomcat-7.0.27]

-XX:MaxPermSize=256m
-KX:PermSize=128m
Tjava.awt. headless=true
Dfile.encoding=utf-&

Initial memory pool: | 128 ME
Maximum memory pool: | 1024 ME
Thread stack size: | KB

;I Method: I

I | Arguments: start

=
Timeout: I

Mode: jvm

oK I Cancel | Apply | QO

in - ice-h html

TTTTTTTTY

" & Apache Tomcat 7 Properties x|
.General I Log On I Logaging I Java I Startup Shutdown |
Class:
prg.apache. cataling. startup. Bootstrap
Image:
Working Path:
Method:
Arguments: stop :I
[~
Timeout: | i) 5EC.
Mode: Ij-.,.-m j
oK I Cancel | Apply |
More information about how to configure Tomcat service on Windows at: http:/tomcat.apache.org/tomcat-7.0-
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Check the service

From terminal

Start the service:

ST

$ net start tomcat7

~———

Stop the service:

ST

$ net stop tomcat7

~———

From Windows service panel

{3}, Services

Fle Acbon View Help

L ElEREE I

G IS

Apache Tomcat 7
Start the service

Description:

Apache Tomcat 7.0.27 Server -

hittp: /ftomcat.apache.org/

*;, ASP.NET State Service

., Background Inteligent ...

"4, Bass Fitering Engine
. Certificate Propagation
" CNG Key Isolation

"4 COM 4+ Event System

4 COM+ System Applicat...

‘s Computer Brawser
‘i Credential Manager
“: Cryptographic Services

.':,-: DCOM Server Process ...
i Deskotop Window Mana.,..

—,
E e Rl:'y:.-'."l'-'::

B Restark
Provides supr Al Tasks
Transfers file:

The Base Filts Reiresh
Copies user ¢ Properties
The CHG key

Supports Sys__1oP
Manages the conf

Maintains an upd.

Provides seqre ...

Provides four ma. Started
The DOOMLALIMG...  Started

Provides Desktop ... Started

3

e

R wi s e e T e i e i L e Bty

\ Extended 4 Standard /

From tomcat7w tool

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE

Page 68 of 1191

A # Apache Tomcat 7 Properties

General | Log On | Logaing | Java | Startup | Shutdown |

Service Mame: tomcat?

Display name: Apache Tomcat 7

Description: I Apache Tomcat 7.00 27 Server - http:/ftomcat. apache.

Path to executable:

I C:\openkmbin\tomcat?.exe [RS/Tomcat?

Startup type: IManuaI j

x|

Configuring environment variables

Add to environment path variable the sigar folder, the bin folder:

{
i setx PATH "%PATH%,;C:\tomcat\lib\sigar" /M
i
|
|

setx PATH "%PATH%;C:\tomcat\bin" /M

These operations also can be done from Windows environment variables:

TTTTTTTY

A Depending on your Windows OS version the next screens could be quite different.
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Command Prompt
-;a Motepad

@ Internet Explorer

Tiyt | Geany

i

MySOL Workbench 5.2 CE
v w0
E‘# Computer Management

Administrator

Documents

v ——

Network ¢ Manage

Map network drive, .,
Contral F Disconnect network drive...

Show on Desktop
Rename

Devices

Administr

_inix]

|@ Lu;l - System an... = System

- mj I Search Control Panel

Contral Panel Home

'@' Device Manager

Remote settings

@ Advanced system settings

See also
Action Center
Windows Update

View basic information about your computer

Windows edition

Windows Server 2003
R.2 Enterprise

Copyright © 2009
Microsoft
Corporation. All
rights reserved.

Service Pack 1

System

Processor: Intel(R) Core(TM)
i7-2600 CPU @
3.40GHz 3.38 GHz

Installed memary (RAM): 4,00 GBE

=
(R T A b i o e
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System Properties 5'

Computer Namel Hardware Advanced |Hﬂmut&|

fou must be logged on as an Administrator to make most of these changes.

— Performance
Visual effects, processor scheduling, memany usage, and virtual memony

— User Profiles
Deskiop settings related to your logon

Settings... |

— Startup and Recovery
System startup. system failure, and debugging information

Settings... |

[ ]

ok | cancd | sppl |

Add sigar folder path - c:\tomcat\lib\sigar\ - to your environment path variable:
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Environment Variables x|

~User variables for Administrator

Variable | Value
TEMP %%l ISERPROFILES:\AppData\Local Temp |
™R %ol ISERPROFILES:\AppDataLocal \Temp
Edit System Variable x|
I
Variable name: I Path

| Variable value: I i?ﬁ,birtc:\_tommt—?.U.ﬂ‘lﬂ:‘lﬁigar;ciﬂmgral

PRI PR L) ) % ) T L ) ) ) i
PROCESSCOR_A... AMDg4 ;I
New... Edit... | Delete |
oK | Cancel |
Installing OpenKM

With Tomcat stopped copy the OpenKM.war file into /home/openkm/tomcat/webapps

$ copy OpenKM.war c:\tomcat-7.0.61\webapps

s
|
|
|
|
\

~———

Install third party software:

Software Required Description

We recommend using OpenOffice rather than Libreoffice, because we've found problems

OpenOffice Yes

in some servers to setup as service by OpenKM.

Download from https://code.google.com/p/tesseract-ocr/ and follow the installation
Tesseract No

wizard.
Clamav No Download from http://www.clamav.net/download.html and follow the installation wizard.
Imagemagick No Tomcat bundle comes with embedded convert tool.
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In case you decide for install it, go to

latest binary release and follow the installation wizard.
Take in consideration 16 bits needs more hardware resources than 8 bits.

We suggest ImageMagick-6.9.1-7-Q8-x64-dll.exe rather than
ImageMagick-6.9.1-7-Q16-x64-dll.exe ( note the version numeration can

be distinct due ImageMagick version upgrade ).

imagemagick.org/script/binary-rel hp and download the

GhostScript No Tomcat bundle comes with embedded Ghostscript tool.

If you decide installing it, go to

http://ghostscript.com/download/gsdnld.html and follow the installation

wizard.

Y

There is also an available Extras.zip file that contains all these software as a Portable edition.

Start application

Check OpenKM.cfg parameters

C:\> geany c:\openkm\OpenKM.cfg

ST

~———

Your configuration should be something like this:

# OpenKM Hibernate configuration values
hibernate.dialect=org.hibernate.dialect.MySQL5InnoDBDialect

hibernate.hbm2ddl=create

# Initial configuration - Windows

system.openoffice.path=C:/Program Files (x86)/OpenOffice 4

A Ensure hibernate.dialect=org.hibernate.dialect. MySQL5Dialect is enabled if your database is MySQL.

TTTTT TN

First time application start:

$ net start tomcat7

ST

~———

i Use mTail Program - or equivalent - to watch the c:\tomcat-7.0.61\log\catalina.log file

TTTTTTTY

When application is started you'll see it in the log file the lines:
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2015-07-04 18:28:10,680 [main] INFO org.apache.coyote.httpll.HttpllProtocol - Startii
' 2015-07-04 18:28:10,688 [main] INFO org.apache.coyote.ajp.AjpProtocol - Starting Pro
1 2015-07-04 18:28:10,692 [main] INFO org.apache.catalina.startup.Catalina - Server sit.

The application will be accessible at http://YOUR_IP:8080/0OpenKM by user:okmAdmin with password:admin. ( Do not

forget to change it !). For more information: Manage users and roles.
Configure default extensions:

Go to Administration > Database query and execute:

INSERT INTO OKM EXTENSION (EXT UUID, EXT NAME) VALUES ('808e7a42—2e73—470c—ba23—e4c9id
INSERT INTO OKM EXTENSION (EXT UUID, EXT NAME) VALUES ('58392af6-2131-413b-bl188-1851a
INSERT INTO OKM PROFILE MSC EXTENSION (PEX ID, PEX EXTENSION) VALUES (1, '808e7a42-2Ze
INSERT INTO OKM PROFILE MSC EXTENSION (PEX ID, PEX EXTENSION) VALUES (1, '58392af6—251

Other common additional setup configurations

OpenKM comes with a lot of configuration parameters please take a look at: Recommended configuration parameters.

o Configuring Apache HTTP Reverse-Proxy
¢ Configuring mail

e Configuring Tomcat memory utilization

¢ Configuring Tomcat port

¢ Configuring Tomcat SSL/TLS

¢ Configuring Tomcat timezone
Restart installation from scratch

The OpenKM first startup does some background configurations like filesystem folder creation, changes in the OpenKM.cfg

what only happens during the first startup.

Sometimes maybe some mistake in OpenKM configuration, for example, wrong database connection or similar issues during

the first startup what raise and application failure. To restart the installation from scratch we suggest following the next steps.

1. Ensure OpenKM is stopped.

2. Edit the OpenKM.cfg and set the parameter hibernate.hbm2ddl=create

3. In case issue with database connection, we suggest checking the connection from the OpenKM server. Remember some
databases require enabling the user to gain connection from a server ( specific IP, range of IP, any server ).

4. Delete the folder named "repository"

5. Start OpenKM.
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Using the installer

Another way of installing OpenKM is using the installer tool. This is a Java application which eases the installation process and

works on Ubuntu, Debian, RedHat, CentOS and Windows platforms. Keep in mind that you need a working Java installation
prior to use this tool. We recommend OpenJDK 8. Please check these pages for more information about installing Java on your

server; look for Checking Java version section:

o Installing on RedHat and CentOS
o Installing on Ubuntu and Debian
o Installing on Windows

i The installer downloads several packages from SourceForge like Tomcat and OpenKM, so it should have

connection access.

TTTTTTTTY

Once Java 8 is installed you can download the installer from

https://sourceforge.net/projects/openkm/files/common/OKMInstaller.jar. In Linux you can download it from the command line:

$ wget https://sourceforge.net/projects/openkm/files/common/OKMInstaller.jar

i The installer will make the installation in the folder which it runs in, so before running move the
OKMInstaller.jar to the location where OpenKM should be installed. In case of running on Linux it also changes

the files permissions to a user called "openkm" so, if you haven't created such user, please create it now:

i $ sudo adduser openkm
\,

This command should work in most common Linux distributions.

It's a text-based installer, so you need to execute it from console as root if you are on Linux or as Administrator if you are on

Windows. This is because it needs to install package dependencies and configure OpenKM as a service:

$ java -jar OKMInstaller.jar

ST

~———

And this is the output:
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FBumming in Livnux: 0.2.3 (build: Z5467)
Linux distro: ubuntu (Ubuntu - 14.04)
Java version: 1.8.0_77

Current directory: -homesopenkmn

Databaze [mariadhl:

Databaze root password [wmgosliol)¥]:
Database name [okmdbl:

Databaze uszer [openkml:

Databaze password [FIpgDMoktk]:

Database: mariadh

Install database: true

Database root password: wmgosliol)Y
Database name: okndb

Database user: openkm

Database password: FIpgDMbkik
Install versiom: 6.4.27

Start install process? [ysNIl:

Values in brackets are the default one. If you hit Enter, this is the chosen value. If you want a different one, just write the string.
At the end, the installed will show the entered information and you would be able to verify it and proceed or enter again these

values.

Once the info is validated, the installation process will start. This process may take several minutes depending on your Internet
connection and server performance. In case of Linux based systems, it will install all required dependencies like ImageMagick

and LibreOffice.

i If you access the Internet using a proxy, just configure it when executing the application:

FTTTTTTTT Y

$ java -Dhttp.proxyHost=192.168.0.1 -Dhttp.proxyPort=3128 -jar OKMInstaller.jar

SR——

You may also need https.proxyHost and https.proxyPort or even http.proxyUser, http.proxyPassword, https.proxyUser

and https.proxyPassword parameters.

Supported databases
The installer supports these databases:

e MariaDB (mariadb)

» MySQL (mysql)

o PostgreSQL (posgresqgl)
e SQL Server (sqlserver)

o Oracle (oracle)

« HSQLDB (hsqldb)
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o H2 (h2)

Other options
The installer will also check if the port 8080 is already being used, which is the default port used by Tomcat and should be free.

If you want to disable this check, use the -p or --port parameters.

$ java -jar OKMInstaller.jar -p
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Using Docker

Docker is a software platform that allows you to build, test, and deploy applications quickly. Docker packages software into
standardized units called containers that have everything the software needs to run including libraries, system tools, code, and

runtime. Using Docker, you can quickly deploy and scale applications into any environment and know your code will run.

There is a public Docker image available at https://hub.docker.com/repository/docker/openkm/openkm-ce and it is the easiest

way yo get OpenKM running on your server.
Please, refer to Docker documentation for installation instructions and to learn more about Docker.
Once Docker has been installed, just execute this command to get your OpenKM CE instance:

$ docker run --name openkm-ce -p 8080:8080 openkm/openkm-ce

And after that, point your browser at http://localhost:8080/. The default user and password is "okmAdmin" / "admin".
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Database

OpenKM stores most of its data in a SQL database. Several databases are supported, but they must be configured in order to

work correctly.
Configure database

e Configuring MySQL and MariaDB.
¢ Configuring Oracle.

¢ Configuring PostgreSQL.

e Configuring SQL Server.

« Configuring other databases.
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Configuring MySQL and MariaDB

MariaDB is a community-developed split of the MySQSL intended to remain free under the GNU GPL. Being a
split of a leading Open Source software system, it is notable for being led by the original developers of MySQL,

who separated it due to concerns over its acquisition by Oracle.

———————————\

Preliminaries

A Perform all changes with the application stopped.

TTTTT TN

Check if your MySQL installation has InnoDB engine enabled:

$ mysql -h localhost -u root -p

> show engines;

V It should show something like this:

| InnoDB | DEFAULT | Supports transactions, row-level locking, and foreign keys | YES | YES | YES |

In case of another default engine, there are two options:

1. Use the org.hibernate.dialect. MySQL5InnoDBDialect dialect and avoid changing the default MySQL Storage
Engine.

2. Change default engine

Change default engine

Modify the MySQL configuration file named my.cnf

and under [mysqld] add

default-storage-engine = innodb

A After changing the default to MySQL the service must be restarted to take effect.

TTTTT TN

Change default charset

In Ubuntu 16.04 the default charset configured in MariaDB and MySQL is utf8mb4 but we recommend switching to utf8. In

order to get the recommended charset you have to modify these files:

/etc/mysql/mariadb.conf.d/50-server.cnf

character-set-server = utf8

-
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collation-server = utf8_general _ci

.

|
|
|
\

/etc/mysql/mariadb.conf.d/50-client.cnf

default-character-set = utf8

ST
(R

/etc/mysql/mariadb.conf.d/50-mysql-clients.cnf

i
i default-character-set = utf8
\,

~———

Once modified, a database server restart is needed.

Database creation

Create a database and user

DROP DATABASE IF EXISTS okmdb;

CREATE DATABASE okmdb DEFAULT CHARACTER SET utf8 DEFAULT COLLATE utf8 bin;
CREATE USER openkm@localhost IDENTIFIED BY '*secret*';

GRANT ALL ON okmdb.* TO openkm@localhost WITH GRANT OPTION;

You can check the database engine with:

$ mysqlshow -h localhost -u root -p --status okmdb;

ST
(R

More information at MySQL.: Case Sensitivity in String Searches

Configure your OpenKM.cfg

P

A This configuration property should be set before the database creation. Once the database has been initialized
don't modify it because can damage your installation.

If your OpenKM installation has been already configured with another database you can't switch to

another database by simply changing this property.

Edit the file STOMCAT_HOME/OpenKM.cfg

hibernate.dialect=org.hibernate.dialect.MySQL5Dialect
hibernate.hbm2ddl=create

hibernate.dialect=org.hibernate.dialect.MySQL5InnoDBDialect
hibernate.hbm2ddl=create

MySQL timezone

If you want to set your timezone in your jdbc connection according to your timezone configured in your system, first you can
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see the mappings both for MySQL and for MariaDB in this way:

(
| SELECT * FROM mysql.time_zone_name
\,

~———

So, for example, you could configure your jdbc connection like this if your system timezone is for example UTC+1:

spring.datasource.url=jdbc:mysql://localhost:3306/0kmdb?

{
:
|
|
|
|
|
|

autoReconnect=true&useUnicode=true&characterEncoding=UTF8&serverTimezone=Europe/Madrid

Where Europe/Madrid is a valid value taken from the table time_zone_name.
Configure Tomcat datasources

Edit the file STOMCAT_HOME/conf/server.xml and enable the resource named jdbc/OpenKMDS

<Resource name="7jdbc/OpenKMDS" auth="Container" type="javax.sql.DataSource"
maxActive="100" maxIdle="30" maxWait="10000" validationQuery="select 1" J
username="openkm" password="*secret*" driverClassName="com.mysqgl.jdbc.Drive
url="jdbc:mysqgl://localhost:3306/okmdb?autoReconnect=true&amp; useUnicode=tEr'

<Resource name="7jdbc/OpenKMDS" auth="Container" type="javax.sql.DataSource"
maxActive="100" maxIdle="30" maxWait="10000" validationQuery="select 1" J
username="openkm" password="*secret*" driverClassName="org.mariadb.jdbc.Dri-
url="jdbc:mariadb://localhost:3306/okmdb?useSSL=false&amp;autoReconnect=tr§u'

MariaDB can use these driverClassName values:

o com.mysql.jdbc.Driver

o org.mariadb.jdbc.Driver

In recent MySQL versions, it seems you need to add useSSL=false to the connection URL.

A Configures the attributes values named:

e userName.
e password.

e url ( change to your hosts and port ).

It can only use a resource named jdbc/OpenKMDS.

Configure application login

Edity the file $TOMCAT_HOME/OpenKM.xml
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E <security:authentication-manager alias="authenticationManager">
! <security:authentication-provider>

i <security:password-encoder hash="md5"/>

E <security:jdbc-user-service

P data-source-ref="dataSource"

i users-by-username-query="select usr id, usr password, 1 from OKM USER where ju
: authorities-by-username-query="select ur user, ur role from OKM USER ROLE whe
E </security:authentication-provider> i
' </security:authentication-manager>

Check for JDBC Driver

Go to STOMCAT_HOME/lib and check for JDBC mysql-connector-java-5.1.12-bin.jar Driver.

If it is not present, download MySQL JDBC driver from MySQL Home Page and move it.

p-

A The driver numeration version could be distinct due some version upgrade.

i MariaDB can use its own JDBC mariadb-java-client-1.1.7.jar Driver.

If is not present, download mariaDB JDBC driver from MariaDB Connector/] and move it.

Run application

As a process into OpenKM startup, the application will create automatically and empty database structure.

i Once the tables are created, OpenKM will automatically change the hibernate.hbm2ddl property from create to

none.

TTTTTTTTY

Additional information

e InnoDB Performance Tuning Tips
e InnoDB - High disk write I/O on ibdatal file and ib_logfileQ

Remove and create MySQL service in Windows

P

A Ensure your mysql/bin folder is in your PATH at environment variables.

.4

For example in MySQL 5.7 the bin folder location is at C:\Program Files\MySQL\MySQL Server 5.7\bin

If you have MySQL Window service you can remove with one of these command line:

c:\> mysqld --remove MySQL57

ST

or

c:\> sc delete MySQL57

ST
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Create the service:

c:\> "C:\Program Files\MySQL\MySQL Server 5.7\bin\mysqld.exe" --install MYSQL57 --defaults-

file="C:\ProgramData\MySQL\MySQL Server 5.7\my.ini"

i More information at http://dev.mysql.com/doc/refman/5.7/en/windows-start-service.html

Migrate from Windows to Linux

A By default table names in Windows are lowercase and in Linux in uppercase.

TTTTT TN

When you migrate from Windows to Linux you must convert lowercase table name to uppercase. The next script will helps on it:
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MySQL tuning

Take this documentation as is, not as a definitive guide to tuning MySQL. There is a lot of information and knowledge that
should be read before changing MySQL configuration. The documentation has been created based on experience shared by

OpenKM server administrator users.

Useful links should read:

e MySQL: InnoDB Performance Tuning Tips
o MySQL: The MySQL Query Cache
e InnoDB - High disk write I/O on ibdatal file and ib_logfileQ

Sample one
Server information

o Virtualized Windows Server 2008

e CPU: Intel Xeon X3470 @2,93GHz

* RAM: 7GB

e JVM settings for Tomcat: -Xms 3072 -Xmx 3072 -XX:PermSize=256m -XX:MaxPermSize=512m

* Repository is 1GB
MySQL my.cnf changes

e innodb_buffer_pool_size=1792M
¢ innodb_additional_mem_pool_size=16M
e innodb_log_file_size=256M

e innodb_log_buffer_size=8M

Using MySQL server InnoDB engine with the default configuration parameters in my.cnf file can cause a serious performance
bottleneck in applications with high database read write activity. MySQL should have enough RAM to be able to cache the

repository and avoid the high Disk I/O activity.

The most important parameters are:

e innodb_buffer_pool_size
¢ innodb_additional_mem_pool_size
e innodb_log_file_size

e innodb_log_buffer_size
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p

V According to some database experts, innodb_buffer_pool_size should occupy the 70 percent of RAM of a
dedicated database server.

A Before changing these values, please read MySQL documentation carefully. Before making any changes you
should make sure that MySQL server has been stopped correctly (check server log), otherwise the innodb will
become corrupted and MySQL server won't restart.

Considerations Repository is 1GB so 1792M is enough RAM for innodb_buffer_pool_size. The larger the repository the more
memory you need to allocate to innodb_buffer_pool_size. If you are using x86 MySQL server you cannot allocate RAM larger

than 2GB.

Information collected from OpenKM forum post.
Sample two

Server information

e CPU: Intel Xeon E5606 @2.13GHz

e RAM: 4GB

o System: Windows server 2008, 64bit

o JAVA_OPTS=-Xms256m -Xmx1024m -XX:PermSize=256m -XX:MaxPermSize=512m -Djava.awt.headless=true -
Dfile.encoding=utf-8

e Database size:2.5G

¢ Repository size:40GB

« 100,000 nodes(folders + documents)
MySQL my.cnf changes

e query_cache_size=0
e table_open_cache=2000

o tmp_table_size=16M

thread_cache_size=9
e myisam_max_sort_file_size=100G
e myisam_sort_buffer_size=32M

o key_buffer_size=8M

read_buffer_size=64K

read_rnd_buffer_size=256K
e sort_buffer_size=256K
e innodb_additional_mem_pool_size=16M

e innodb_log_buffer_size=8M
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e innodb_buffer_pool_size=1042M

Results

Before optimization the login time was about 45-55 seconds with a lot of hard-disk I/O usage. After the MySQL optimization

login takes about 10 seconds.

i With more RAM it will be possible to get a higher MySQL buffer and probably better perfomance.

TTTTTTTY

Information collected OpenKM Forum post.
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Change MySQL data directory

Ubuntu

Stop the service:

ST

$ service mysql stop

~———

Create a new folder destination:

$ mkdir /new_path/mysql_data

$ ¢p -R -p /var/lib/mysql /new_path/mysql_data

A MySQL user should have enough credentials granted to the new folder /new_path/mysql_data.

Optionally modify the path of older mysql data store folder location:

$ mv /var/lib/mysql /var/lib/mysql_old

s
|
|
|
|
\

Edit the datadir property into the /etc/mysql/my.cnf configuration file:

$ vim /etc/mysql/my.cnf

ST

Change the older data store folder path with the newer:

datadir = /var/lib/mysql

to

datadir = /new path/mysql data

Enable appamor. Edit the file /etc/apparmor.d/usr.sbin.mysqld:

$ vim /etc/apparmor.d/usr.sbin.mysqld

ST

~———

Change the older data store folder path with the newer:

/usr/lib/mysql/plugin/ r,

/usr/lib/mysql/plugin/*.so* mr,

/var/lib/mysql/ r,

/var/lib/mysql/** rwk,

to
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/new path/mysql data/plugin/ r,

/new path/mysql data/plugin/*.so* mr,

/new path/mysql data/ r,

/new path/mysql data/** rwk,

Start MySQL service:

$ service mysql start

ST

~———

i More information at h

TTTTTTTY

———

CentOS and RHEL

Stop the service:

$ service mysqld stop

Create a new folder destination:

$ mkdir /new_path/mysql_data

$ ¢p -R -p /var/lib/mysql /new_path/mysql_data

A The mysql user must have enough credentials granted to the new folder /new_path/mysql_data.

Optionally modify the path of older mysql data store folder location:

$ mv /var/lib/mysql /var/lib/mysql_old

ST

Edit the datadir property into the /etc/mysql/my.cnf configuration file:

$ vim /etc/mysql/my.cnf

ST

Change the older data store folder path with the newer:

datadir = /var/lib/mysql

to

datadir = /new path/mysql data

Enable appamor.

$ yum install policycoreutils-python

T
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i $ getenforce

[}

i $ semanage fcontext -a -t mysqld_db_t "/new_path/mysql_data(/.*)?"
|

l

$ restorecon -Rv /new_path/mysql_data

Start MySQL service:

$ service mysqld start

ST

~———

More information at h

TTTTTTTY

Windows

Stop the service:

C:\> net stop mysql56

ST

~———

Create a new folder destination:

C:\> robocopy "C:\ProgramData\MySQL\MySQL Server 5.6\data" c:\new_path\mysql_data

ST

~———

Optionally modify the path of older mysql data store folder location:

C:\> ren "C:\ProgramData\MySQL\MySQL Server 5.6\data" "C:\ProgramData\MySQL\MySQL Server 5.6\data_old"

ST

~———

Edit the datadir property into the C:\ProgramData\MySQL\MySQL Server 5.6\my.ini configuration file:

Change the older data store folder path with the newer:

datadir = C:\ProgramData\MySQL\MySQL Server 5.6\data

to

datadir = c:\new path\mysqgl data

Start MySQL service:

C:\> net start mysql56

ST

~———
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MySQL 8 throubleshooting

Could not create connection to database server

Might be several reason why the application is not able to stablish the connection to the database, take a look into the log file

what might give to you the clues about what is happening.

Strong Password Encryption for Authentication

The latest MySQL installation wizard suggest you to use " Strong Password Encryption for Authentication" as can be shown in

the next screenshot:

MySQL. Installer
MySQL Server 8.0.11

Authentication Method

B rMysqL Installer

Authentication Method

% Use Strong Password Encryption for Authentication (RECOMMENDEL

My3S0L 8 supports a new authentication based on improved stronger SH
methods, It is recommended that all new MySQL Server installations use
forward.

Attention: This new authentication plugin on the server side reg
A of connectors and clients which add support for this new 8.0 de
(caching_sha_password authentication).

Currently MyS0L 8.0 Connectors and community drivers which use libm
this new method. If clients and applications cannot be updated to suppo
authentication method, the MySQL 8.0 Server can be configured to uset
Authentication Method below,

" Use Legacy Authentication Method (Retain MySQL 5.x Compatibility)

Using the old MyS0L 5.x legacy authentication method should only be ©
following cases:

- If applications cannot be updated to use MySQL 8 enabled Connectors
- For cases where re-compilation of an existing application is not feasible
- An updated, language specific connector or driver is not yet available,

Security Guidance: When possible, we highly recommend taking needed

upgrading your applications, libraries, and database servers to the new s
This new method will significantly improve your security.

< Back M

When the option "Strong Password Encryption for Authentication" is enabled rather than "Legacy Authentication Method"
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you are enabling SSL connection by default. Than means you might read some literature and apply some changes in your

connection setting into your server.xml server to connect with the database. Usually in this scenario you will get some error like

what is shown belown:

java.sql.SQLException: Cannot create PoolableConnectionFactory (Could not create conh
apache. tomcat.dbcp.dbcp2.BasicDataSource.createPoolableConnectionFactory (Basi
apache. tomcat.dbcp.dbcp2.BasicDataSource.createDataSource (BasicDataSource. jav
apache.tomcat.dbcp.dbcpZ.BasicDataSource.getConnection(BasicDataSource.javaﬁl
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exceptions.ExceptionFactory.createException (ExceptionFactory.java:10
exceptions.ExceptionFactory.createException(ExceptionFactory.java:ﬁ4
exceptions.ExceptionFactory.createCommunicationsException (ExceptionF.

E Caused by: java.sqgl.SQLNonTransientConnectionException: Could not create connection it

.protocol.a.NativeAuthenticationProvider.negotiateSSLConnection (Nativ
.protocol.a.NativeAuthenticationProvider.proceedHandshakeWithPluggabl
.protocol.a.NativeAuthenticationProvider.connect (NativeAuthentication
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at
at
at

com.
com.
.mysql.cj.

com
35

mysqgl.cj.
mysqgl.cj.

protocol.a.NativeProtocol.connect (NativeProtocol. java:1411) ~ [mysqli—
NativeSession.connect (NativeSession.java:165) ~[mysgl-connector-java
jdbc.ConnectionImpl.connectWithRetries (ConnectionImpl. java:876) ~[nly

common frames omitted '

Caused by: javax.

at
. at
roat
vat
i at
. at
1 at
! at
. at
i at
at
| at
. at
1 at
! at
i at

at
at
at
at

sun.
sun.
sun.
sun.
.security.

sun

sun.
sun.
sun.
sun.
.security.
sun.
.security.
com.
com.
com.
com.

sun

sun

41

security.
security.
security.
security.

security.
security.
security.
security.

security.

mysqgl.cj.
mysqgl.cj.
mysqgl.cj.
mysqgl.cj.

net.ssl.SSLHandshakeException: java.security.cert.CertificateExcepﬁi
ssl.Alerts.getSSLException (Alerts.java:192) ~[na:1.8.0 171] J
ssl.SSLSocketImpl. fatal (SSLSocketImpl.java:1964) ~[na:1.8.0 171]
ssl.Handshaker.fatalSE (Handshaker.java:328) ~[na:1.8.0 171]
ssl.Handshaker.fatalSE (Handshaker.java:322) ~[na:1.8.0 171]
ssl.ClientHandshaker.serverCertificate (ClientHandshaker.java:1614)
ssl.ClientHandshaker.processMessage (ClientHandshaker.java:216) ~[na:
ssl.Handshaker.processLoop (Handshaker. java:1052) ~[na:1.8.0 171]
ssl.Handshaker.process record(Handshaker.java:987) ~[na:1.8.0 171]
ssl.SSLSocketImpl.readRecord (SSLSocketImpl.java:1072) ~[na:1.8.0 17,
ssl.SSLSocketImpl.performInitialHandshake (SSLSocketImpl.java:1385)
ssl.SSLSocketImpl.startHandshake (SSLSocketImpl.java:1413) ~[na:1.8.:0
ssl.SSLSocketImpl.startHandshake (SSLSocketImpl.java:1397) ~[na:1.8.,0
protocol.ExportControlled.performTlsHandshake (ExportControlled. java:
protocol.StandardSocketFactory.performTlsHandshake(StandardSocketFéc
protocol.a.NativeSocketConnection.performTlsHandshake (NativeSocketCo
protocol.a.NativeProtocol.negotiateSSLConnection (NativeProtocol. javia

et

[y

- 3-

common frames omitted ,

Caused by: java.security.cert.CertificateException: java.security.cert. CertPathValidla
at com.mysqgl.cj.protocol.ExportControlledSX509TrustManagerWrapper.checkServerTrusted
at sun.security.ssl.AbstractTrustManagerWrapper.checkServerTrusted (SSLContextImpl. ja

at sun.security.ssl.ClientHandshaker.serverCertificate (ClientHandshaker.java:1596) ~

52 common frames omitted J

Caused by: java.security.cert.CertPathValidatorException: Path does not chain with an
sun.security.provider.certpath.PKIXCertPathValidator.validate (PKIXCertPathValidat
sun.security.provider.certpath.PKIXCertPathValidator.enginevalidate(PKIXCertPatﬁV
java.security.cert.CertPathValidator.validate (CertPathValidator. java:292) ~[na:]I.
com.mysql.cj.protocol.ExportControlledSX509TrustManagerWrapper.checkServerTrusted

54 common frames omitted

You have two options:

« Configure SSL for the MySQL connection.

« Switch from "Strong Password Encryption for Authentication" to "Legacy Authentication Method .

i Some url what might be useful for you is you decide going ahead with SSL configuration:
o https://dev.mysql.com/doc/connector-j/8.0/en/connector-j-reference-using-ssl.html
o https://dev.mysql.com/doc/refman/8.0/en/creating-ssl-rsa-files-using-mysql.html

In Windows is quite easy to enable "Legacy Authentication Method":
o Execute the installer.
e Click on reconfigure beside MySQL Server.
o Follow the wizard screens and choose "Legacy Authentication Method".
Old JDBC driver

If in your log file is shown the error below:
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Caused by: java.lang.NullPointerException: null '
at com.mysqgl. jdbc.ConnectionImpl.getServerCharset (ConnectionImpl. java:3005) ~[mysql-
at com.mysqgl.jdbc.MysqlIO.sendConnectionAttributes (MysqlIO. java:1916) ~[mysgl-connec
at com.mysql.jdbc.MysqlIO.proceedHandshakeWithPluggableAuthentication (MysqlIO. java :l
at com.mysqgl.jdbc.MysqlIO.doHandshake (MysqlIO. java:1215) ~[mysql—connector—java—5.ﬁ.
at com.mysqgl.jdbc.ConnectionImpl.coreConnect (ConnectionImpl. java:2255) ~[mysqgl-conne
at com.mysql. jdbc.ConnectionImpl.connectWithRetries (ConnectionImpl. java:2106) ~[mysqg

41 common frames omitted

You are using a wrong driver version for connecting to the MySQL Server 8, you should make the next changes:

* Replace the mysql-connector-java-5.1.38-bin.jar into your STOMCAT_HOME/libs by the latest JDBC driver for
MySQL Server 8. You can get the latest driver from https://dev.mysql.com/downloads/connector/j/.

o Change the MySQL connection settings set into your $TOMCAT_HOME/conf/server.xml, should be something like:

In the latest version of MySQL JDBC driver, the name of the class com.mysql.jdbc.Driver has been changed to
com.mysql.cj.jdbc.Driver.

<Resource name="jdbc/OpenKMDS" auth="Container" type="javax.sqgl.DataSource"
maxTotal="100" maxIdle="30" maxWaitMillis="10000" validationQuery="select
username="openkm" password="openkm" driverClassName="com.mysql.cj.jdbc.Dr
url="jdbc:mysql ://localhost:3306/okmdb?autoReconnect:true&amp;useUnicodeE:

The server time zone value is unrecognized

If in your log file is shown the error below or similar:

E Caused by: com.mysqgl.cj.exceptions.InvalidConnectionAttributeException: The server ﬁL
1 at sun.reflect.NativeConstructorAccessorImpl.newInstance( (Native Method) ~[na:1.8.0
i at sun.reflect.NativeConstructorAccessorImpl.newInstance (NativeConstructorAccessorIm
: at sun.reflect.DelegatingConstructorAccessorImpl.newInstance (DelegatingConstructorAc
E at java.lang.reflect.Constructor.newInstance (Constructor. java:423) ~[na:l.8.07l7l]5

! at com.mysqgl.cj.exceptions.ExceptionFactory.createException (ExceptionFactory.java:59
i at com.mysqgl.cj.exceptions.ExceptionFactory.createException (ExceptionFactory.java:83
E at com.mysqgl.cj.util.TimeUtil.getCanonicalTimezone (TimeUtil. java:128) ~[mysql—connéc
P at com.mysqgl.cj.protocol.a.NativeProtocol.configureTimezone (NativeProtocol. java:2201
i at com.mysqgl.cj.protocol.a.NativeProtocol.initServerSession (NativeProtocol.java:2225
. at com.mysqgl.cj.jdbc.ConnectionImpl.initializePropsFromServer (ConnectionImpl.java:13
E at com.mysqgl.cj.jdbc.ConnectionImpl.connectWithRetries (ConnectionImpl. java:895) ~[@y
! 45 common frames omitted ]

It seems the latest MySQL JDBC driver have some issue with your OS time zone configuration, a quick workaround is to

indicate the server time zone, for example serverTimezone=UTC:

<Resource name="jdbc/OpenKMDS" auth="Container" type="javax.sql.DataSource" '
maxTotal="100" maxIdle="30" maxWaitMillis="10000" validationQuery="select
username="openkm" password="openkm" driverClassName="com.mysql.cj.jdbc.Dr
url="jdbc:mysql://localhost:3306/0kmdb test ?autoReconnect:true&amp;useUnEi

Problem connecting to your database
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If you get an error like this:

<Resource name="jdbc/OpenKMDS" auth="Container" type="javax.sql.DataSource" '
maxTotal="100" maxIdle="30" maxWaitMillis="10000" validationQuery="select
username="openkm" password="openkm" driverClassName="com.mysql.cj.jdbc.Dr
url="jdbc:mysql://localhost:3306/okmdb test ?allowPublicKeyRetrieval=true§&‘
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Configuring Oracle

Database creation

Create tablespace

create user OPENKM identified by *secret* default tablespace OPENKMDATA quota unlimiit
' grant all privileges to OPENKM; ]
| grant create any context, create cluster, create dimension, create indextype, create

A This configuration property should be set before the database creation. Once the database has been initialized
don't modify it because can damage your installation.

If your OpenKM installation has been already configured with another database you can't switch to another
database simply changing this property.

hibernate.dialect=org.hibernate.dialect.OraclellgDialect
hibernate.hbm2ddl=create

Configure Tomcat datasources

Edit the file STOMCAT_HOME/conf/server.xml and enable the resource named jdbc/OpenKMDS

<Resource name="jdbc/OpenKMDS" auth="Container" type='"javax.sqgl.DataSource"
maxActive="100" maxIdle="30" maxWait="10000" validationQuery="select 1 from dual" !
username="OPENKM" password="*secret*" driverClassName="oracle.jdbc.driver.OracleDnri
url="jdbc:oracle:thin:@localhost:1521:XE"/> ‘

A Configure the attributes values named:

e userName.
e password.

e url ( change to your hosts and port ).

Can be only one resource named jdbc/OpenKMDS.

Sample using service name instead of SID:
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o

The main difference between SID connection is the ":" is replaced by "/".

<Resource name="jdbc/OpenKMDS" auth="Container" type="javax.sql.DataSource"
maxActive="100" maxIdle="30" maxWait="10000" validationQuery="select 1 from dual" !
username="0OPENKM" password="*secret*" driverClassName="oracle.jdbc.driver.OracleDri
url="jdbc:oracle:thin:@localhost:1521/ServiceName" /> ‘

Configure application login

Edity the file STOMCAT_HOME/OpenKM.xml

E <security:authentication-manager alias="authenticationManager">
! <security:authentication-provider>

i <security:password-encoder hash="md5"/>

: <security:jdbc-user-service

E data-source-ref="dataSource" i
! users-by-username-query="select usr id, usr password, 1 from OKM USER where yu
: authorities-by-username-query="select ur user, ur role from OKM USER ROLE whe
E </security:authentication-provider> i
' </security:authentication-manager>

Check for JDBC Driver

Go to STOMCAT_HOME/lib and check for JDBC ojdbc6-11.2.0.3.jar Driver.

If it is not present, download Oracle JDBC driver from QOracle IDBC Driver page and move it.

A The driver numeration version could be distinct due some version upgrade.

TTTTT TN

Run application

As a process into OpenKM startup, the application will create automatically and empty database structure.

i Once the tables are created, OpenKM will automatically change the hibernate.hbm2ddl property from create to

none.

TTTTTTTTY
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Configuring PostgreSQL

Database creation

Create a database and user

E DROP DATABASE IF EXISTS okmdb; E
' CREATE USER openkm WITH PASSWORD '*secret*'; ]
. CREATE DATABASE okmdb WITH OWNER openkm ENCODING 'UTFS8'; ‘

or from the command line

$ createuser --pwprompt openkm

$ createdb --owner=openkm --encoding=UTF8 okmdb

More info at:

e PostgreSQL 9.1 Documentation

e Guia Ubuntu: PostgreSQL

Configure your OpenKM.cfg

A This configuration property should be set before the database creation. Once the database has been initialized
don't modify it because can damage your installation.

If your OpenKM installation has been already configured with another database you can't switch to another

database simply changing this property.

hibernate.dialect=org.hibernate.dialect.PostgreSQLDialect
hibernate.hbm2ddl=create

Configure Tomcat datasources

Edit the file STOMCAT_HOME/conf/server.xml and enable the resource named jdbc/OpenKMDS

<Resource name="jdbc/OpenKMDS" auth="Container" type='"javax.sqgl.DataSource"
maxActive="100" maxIdle="30" maxWait="10000" validationQuery="select 1" J

A Configure the attributes values named:

e userName.

e password.

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


http://www.postgresql.org/docs/9.1/static/index.html
http://www.guia-ubuntu.com/index.php?title=PostgreSQL
https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE Page 98 of 1191

e url ( change to your hosts and port ).

Can be only one resource named jdbc/OpenKMDS.

Configure application login

Edity the file STOMCAT_HOME/OpenKM.xml

E <security:authentication-manager alias="authenticationManager'"> E
! <security:authentication-provider> i
i <security:password-encoder hash="md5"/> i
: <security:jdbc-user-service ‘
E data-source-ref="dataSource" E
! users-by-username-query="select usr id, usr password, 1 from OKM USER where ,
i authorities-by-username-query="select ur user, ur role from OKM USER ROLE whi
E </security:authentication-provider> E
' </security:authentication-manager>

Check for JDBC Driver
Go to STOMCAT_HOME/Ilib and check for JDBC postgresql-9.1-902.jdbc4.jar Driver.

If is not present, download PostgreSQL JDBC driver from PostgreSQL Driver Page and move it.

,
i
|
! 0 The driver numeration version could be distinct due some version upgrade.
|
|
|

Run application

As a process into OpenKM startup, the application will create automatically and empty database structure.

i Once the tables are created, OpenKM will automatically change the hibernate.hbm2ddl property from create to

none.

TTTTTTTTY

Additional information

If you want to obtain the maximun performance from PostgreSQL, pgFouine will help in your task.

PostgreSQL 9.6 and upper

From PostgreSQL version 9.6 and upper, has been changed some tables and columns of the schema. Check that you are using

the right JDBC driver.

You can find the current JDBC driver in $STOMCAT_HOME/libs

.
I
i A Read this related issue for more information PostgreSQL - ERROR o.h.tool.hbm2ddl.SchemaUpdate - could not
i complete schema update
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Configuring SQL Server

Database creation

Create a database and user

Start SQL Server Management Studio Express and create a database called okmdb.

§ Nueva base de datos

A General
4 Dpeiores
4% Grupos de archivos

OME X0

Servidor;
DARKMANITIZ

Conewan:

3

B Ver piopiedades de
[=lal= ]

Listo

5 Generar zecuencia de comando: = n Ayuda

Mombre de la base de datos: :ukmdl_::

Propigtario: |=4

Archivoz de la basze de datos:

| Momiwe logico  Tipo de archive  Grupode archivas  Tamafio inicial (MB)  Crecimiento aut
ockmdb Datos PRIMARY ' 3 i En 1 ME, crecim
ockmdb _log  Registio Mo aphcable 1 Enun 10%, crec

! <

,Qgrag,ar Liunkas

[ Aceplar ][ Cancelar

Select your appropriate database collate.
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E' Hueva base de datos

‘; E Generar secuencia de comandos - Lﬁ Bpuda

General

A Dpriones

2 Grupos de archivas Intercalacidn: r-.-1n:u:IEern_Ei|:|ar'|i:szh_EI_.-'l'-.I_Fi.Ei
kodelo de recuperacion: | Simple
Mivel de compatibilidad: | SOL Server 2005 [30)

Obraz opciones:

|£!Al

oiijzy | S

EH Automatico
Actualizar eztadizticaz automatica p asincranic Falze

Actualizar estadisticas automaticamente True
Cerrar automaticamente Falze
Crear estadisticas automaticamente True
Reducir automaticamente Falze
B Cursor
Cierre de curzor al confirmar habilitado Falze
Curzor predeterminado GLOBAL
B Estado
Baze de datos de wdlo lectura Falze
S epyvidar Restringir accesa MULTI_USER
DARERMAMSTIZ E Recuperacion
Corgsicn Werficacion de paginas CHECESLIM
23 B Varios
i ] Advertenciaz AMS| habilitadaz Falze
2 ww Anulacion aritmética habilitada Falze
Ao Anulacion exacta numérnica Falze

— f 1 IR 1 IR [ |

Actuahzar estadizticas automatica y asincronicamente

Lizto
Aceptar l [ e
3
i We checked with Modern_Spanish_CI_AI_KS, where CI indicate case-insensitive collation and AS indicate i
accent-sensitive collation. i
|
|
If you're not sure about your collation could also try with SQL_Latin1_General_CP1_CI_AS. i
- J

Configure your OpenKM.cfq

P

A This configuration property should be set before the database creation. Once the database has been initialized
don't modify it because can damage your installation.

If your OpenKM installation has been already configured with another database you can't switch to another
database simply changing this property.
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Edit the file STOMCAT_HOME/OpenKM.cfg

hibernate.dialect=org.hibernate.dialect.SQLServerDialect
hibernate.hbm2ddl=create ]

Configure Tomcat data sources

Edit the file STOMCAT_HOME/conf/server.xml and enable the resource named jdbc/OpenKMDS

<Resource name="jdbc/OpenKMDS" auth="Container" type='"javax.sqgl.DataSource"
maxActive="100" maxIdle="30" maxWait="10000" validationQuery="select 1"

A Configure the attributes values named:

o userName.
e password.

e URL ( change to your hosts and port ).

Can be only one resource named jdbc/OpenKMDS.

Configure application login

Edit the file sSTOMCAT_HOME/OpenKM.xml

<security:authentication-manager alias="authenticationManager">
! <security:authentication-provider>

i <security:password-encoder hash="md5"/>
<security:jdbc-user-service

P data-source-ref="dataSource" ]
i users-by-username-query="select usr id, usr password, 1 from OKM USER where u
: authorities-by-username-query="select ur user, ur role from OKM USER ROLE whe
</security:authentication-provider> i
' </security:authentication-manager>

Check for JDBC Driver
Go to STOMCAT_HOME/Ilib and check for JDBC sqljdbc4.jar Driver.

If it is not present, download SQL Server JDBC driver from Microsoft SQL Server Driver Page and move it.

p-

A The driver numeration version could be distinct due to some version upgrade.

Other JDBC driver for MS SQL Server we've tested is jdts.
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Run application

As a process into the OpenKM startup, the application will create automatically an empty database structure.

[ |
I

i i Once the tables are created, OpenKM will automatically change the hibernate.hbm2ddl property from create to i
| none. |
[ )
Troubleshooting

You can not connect to MS SQL Server

Ensure you've got TCP protocol enabled ( by default is disabled )

¥ SOL Server Configuration Manager

Archivo  Accion Ver  Ayoda

e 5B 8

‘E Adrninistrador de configuracidn de SQL Server (Loc|| mombre de protocolo Estado
Servicios de SCL Server 2005 %™ Memoria compartida Hahilitadao
= 4 Configuracidn de red de SQL Server 2005

W Canalizaciones con nombre Deshabilitado
g TCPITP Hahilitadia

Protocolos de SCOLEXPRESS
Protocaolos de MSSOLSERYER
= .. Configuracidn de S0L Mative Client
Protocolos de cliente

VI Dieshabilitado

Bl Alias

Connection lost after some time

We have observed in some SQL Server editions what seems a new behaviour what passed some hours the connection is closed (
might be some extra configuration parameter in the latest SQL server editions what comes enabled by default or similar ).

There's a new configuration attribute name autoReconnect what solves it.

<Resource name="jdbc/OpenKMDS" auth="Container" type='"javax.sqgl.DataSource"
maxActive="100" maxIdle="30" maxWait="10000" validationQuery="select 1" J
username="sa" password="***" driverClassName="com.microsoft.sqlserver. jdbd.
url="jdbc:sqlserver://localhost\SQL;databaseName=okmdb;autoReconnect:true":/

Not able to login into OpenKM

When first-time OpenKM login it fails with right username and password ( okmAdmin / admin ), you should check database

configuration.

Check if the database is configured to be case-sensitive, might be one of the reasons why you are not able to login.
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If you have this troubleshooting, you should to drop the database and create again selecting the collation as

case-insensitive.

TTTTT T T

Additional information

e How to enable remote connections in SQL Server 2008
e How do I configure SQL Server 2005/2008 to accept SQL Authentication
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Configuring other databases

OpenKM uses Hibernate that means can be installed on major DBMS. For more information take a look at Hibernate: SQL

Dialects.

By default application has been tested in:

e MySQL or MariaDB.
e PostgreSQL.
e MS SQL Server.

e Oracle.

i If you want to check other database, ask us at our public forum.

TTTTTTTY
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Backup and restore

One of the most important things to have is an updated backup of your OpenKM.

If you have followed the installation instructions then you have configured OpenKM to use a production-safe database and

optionally you have set a path the OpenKM repository data store.

~

i OpenKM has several configurations, but for optimal performance we recommend:

e Use the default data store that saves binary information directly to the server disk (in a non human
comprehensible format).

o All the other information, folders and documents structure, metadata, etc., is stored in the database.

A OpenKM allows the use of other datastores, for example to save binary data into a database.

TTTTTTTN

SM———

In this case:

1. First backup your database (make a SQL dump)

2. Then backup your data on filesystem

i By default, all documents are stored in STOMCAT_HOME/repository. This default folder can be changed using
the property repository.home in the file $STOMCAT_HOME/OpenKM.cfq file.

Although OpenKM supports hot backups of your data, it is recommended to stop Tomcat before starting the
backup. Apply this good practice when possible.

Backup steps:

» Stop Tomcat (optional).
» Backup the database (mandatory).
 Backup the repository folder (mandatory).

e Start Tomcat (optional).

i Performing the backup in that order (the database first, then the filesystem) will ensure backup consistency.

TTTTTTTY

There is an alternative to traditional backup methods: you can export the whole repository from OpenKM Administration >
Utilities > Repository export and choose metadata and history options. But we do not suggest this way of doing backups. For

medium to large repositories we suggest some incremental backup solution.
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Detailed steps

In case you have OpenKM configured with MySQL or MariaDB you can follow these steps to backup and restore. For other

databases check its corresponding command.

Backup

$ /etc/init.d/tomcat stop
$ mysqldump -h localhost -u root -p okmdb > /path/to/openkm/okmdb.sql
$ zip -r /path/to/backup/okm-backup.zip /path/to/openkm

$ /etc/init.d/tomcat start

After that, you will have a ZIP archive with the whole OpenKM installation and the exported database. Please, check before

destroying the installation. We always recommend to restore the backup to ensure you have all the required files.
Restore
Please, note that you have to create the database if wasn't created previously. In case of MySQL or MariaDB install it:

$ sudo apt install mariadb-server

And execute the following sentences:

CREATE USER 'openkm'@'localhost' IDENTIFIED BY 's3cr3t0';
. CREATE DATABASE okmdb DEFAULT CHARACTER SET utf8 DEFAULT COLLATE utf8 bin;
\ GRANT ALL ON okmdb.* TO 'openkm'@'localhost' WITH GRANT OPTION,

Keep on mind that the user and database name may be different in you case. Please, take a look at the installation report or

check it at sSTOMCAT_HOME;/conf/server.xml
Once created restore the database and files:

$ unzip /path/to/backup/okm-backup.zip -d /path/to/restore

$ mysql -h localhost -u root -p okmdb < /path/to/restore/okmdb.sql

Set the permissions according to the user who start OpenKM:

$ sudo chown openkm:openkm /path/to/openkm -R

Install the required dependencies:

$ sudo apt install gawk imagemagick libreoffice tesseract-ocr

Once restored, verify file permissions, start OpenKM and make a repository check. See Repository checker.
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Backup scripts

o Linux backup and restore with rdiff-backup tool Linux backup and restore with rdiff-backup tool
e Linux backup and restore with rsync
o Linux backup and restore with Duplicity

o Linux backup with LETP
Additional information

o Rdiff-backup home page

o Easy Automated Snapshot-Style Backups with Linux and Rsync
e Duplicity Backup Howto

o DAR differential backup mini-howto.

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


../../view/okm-6.4/linux-backup-and-restore-with-rsync.html
http://rdiff-backup.nongnu.org/
http://www.mikerubel.org/computers/rsync_snapshots/
https://help.ubuntu.com/community/DuplicityBackupHowto
http://dar.linux.free.fr/doc/mini-howto/dar-differential-backup-mini-howto.es.html
https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE Page 108 of 1191

Linux backup and restore with BorgBackup

Borg is a deduplicating backup program which also supports compression and authenticated encryption. It provides an efficient

and secure way to backup data. The data deduplication technique used makes Borg suitable for daily backups since only

changes are stored. The authenticated encryption technique makes it suitable for backups to not fully trusted targets.

A more detailed description of BorgBackup can be found at https://borgbackup.readthedocs.io/en/stable/index.html.

Installation

Borg is included in many Linux distributions repositories but sometimes the packaged version is quite old, and it is better to

install manually. This installation is as simple as:

https://gith I ki rg/rel

i
1
| i In the official borg releases website section you will find the latest version:
|
|
|
[

.4

S wget https://github.com/borgbackup/borg/releases/download/1.1.5/borg-1linux64
$ chmod +x borg-linux64
S mv borg-linux64 /usr/local/bin/borg

Sample script

Backup to remote computer with SSH

#!/bin/bash

#

## BEGIN CONFIG ##

HOST=$ (uname -n)

OPENKM DB="okmdb"

OPENKM HOME="/home/openkm"

TOMCAT HOME= "$OPENKM7HOME/tomcat "
DATABASE EXP= "SOPENKMiHOME/db "
BACKUP HOST="backup@bk-server.com"
BACKUP DIR="/mnt/backup/SHOST"
BACKUP REPO= S] {BACKUP_HOST} : S {BACKUP _DIR}"
## END CONFIG ##

# Check root user
if [ $(id -u) != 0 ]; then echo "You should run this script as root"; exit; fi

echo "Backup destination ${BACKUP REFO}"

if (ssh ${BACKUP HOST} "[ ! -d ${BACKUP DIR} ]"); then
echo "Initialize backup repository: ${BACKUP DIR}"
ssh ${BACKUP HOST} "mkdir -p ${BACKUP DIR}"
borg init -e none ${BACKUP REPO}

fi

# Database

echo "Backup MySQL databases"
mkdir -p ${DATABASE EXP}

echo "- Backuping $OPENKM DB..."
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borg create -v --stats ${BACKUP REPO}::'{now:%Y-%m-%d $H:8M}' ${OPENKM HOME}
borg prune -v ${BACKUP REPO} --list --keep-daily=7 --keep-weekly=4 --keep-monthly=6

#!/bin/bash

# Configuration

DATABASE EXP= "/home/openkm/db"

BACKUP HOST="backup@bk-server.com"

BACKUP DIR="/mnt/backup/SHOST"

BACKUP REPO= S {BACKUP_HOST} : 8 {BACKUP _DIR}"

echo "### BEGIN: §$(date +"$x 8X") ###"
echo "Backup destination ${BACKUP REFPO}"
TBEGIN=$ (date +'"%s")

# Check if the repository is already initialized
borg list ${BACKUP REPO} > /dev/null
RESULT=$8?; if [[ S{RESULT} != 0 ]]; then
echo "Initializing backup repository..."
borg init -e none ${BACKUP REPO}
fi

E # Database

\ echo "Backup MySQL databases"

i mkdir -p ${DATABASE EXP}

E MYSQL DBS=$ (mysglshow | awk '(NR > 2) && (/[a-zA-Z0-9]+[ ]J+[|]/) { print $2 }');

v for DB in $MYSQL DBS; do

: if [[ $DB != "mysql" && $DB != "test" && $DB != "information schema" && $DB != "per

echo "- Backuping $DB..." E
mysqgldump --single-transaction --add-drop-table --quick ${DB} > ${DATABASE EXP}/m
fi ]
done

borg create -v --stats ${BACKUP REPO}::'{now:%Y-8m-%d $H:8M}' /opt /var /etc /root /h
RESULT=$?; if [[ S{RESULT} != 0 ]]; then

echo LR b b b b b b b g b b b b b b b b b b b b e b b b b 2 b g b b b b b S b b g b b b b b b b e b e b

echo " Backup error => exit code: S{RESULT}"

echo MMA kA A A A A A A hA A AAAA A A A A A AR A A AR A A A A A AN

fi

# Prune old backups

echo "Prune old backups"

borg prune -v --list --keep-within=30d ${BACKUP REFPO}
RESULT=$8?; if [[ S{RESULT} != 0 ]]; then

echo LU b e b b b b b b b b b b b b b b b b b b b b e b b b g b b g b b b b b S b 2 g b b b g b b b b e b

echo " Backup error => exit code: S{RESULT}"

echo LU b gt b e b b b b b b b b b b b b b b b b b S e b b S g 2 g g b b b b b b b b b b b b g b b b b e b

£i E
TEND=S (date +"%s") E
TDIFF=$ ( (STEND-STBEGIN) ) E
echo "### END: S(date +"%x %X") - S((STDIFF / 60)) mins and S ((STDIFF % 60)) secs ###

E #!/bin/bash E
Vo |
\ ## BEGIN CONFIG ## '
E HOST=$ (uname -n) E
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OPENKM DB="okmdb"

OPENKM HOME="/home/openkm"

TOMCAT HOME="SOPENKM HOME/tomcat"
DATABASE EXP="$OPENKM HOME/db'"
BACKUP DIR="/mnt/backup"

BACKUP REPO="${BACKUP DIR}/${HOST}"
## END CONFIG ##

# Check root user
if [ $(id -u) != 0 ]; then echo "You should run this script as root"; exit; fi

# Mount disk

if mount | grep "$BACKUP DIR type" > /dev/null; then
echo "$BACKUP DIR already mounted";

else
mount "$BACKUP DIR";

if mount | grep "$BACKUP DIR type" > /dev/null; then E
echo "$BACKUP DIR mounted"; i

else
echo "$BACKUP DIR error mounting";
exit -1;

fi

fi

# Initialize repository

echo "Backup destination ${BACKUP REFPO}"

if ! 1s -1 ${BACKUP DIR} | grep '"d' | grep "${HOST}" > /dev/null; then
echo "Initialize backup repository: ${BACKUP REPO}"
mkdir $ {BACKUP_REPO}
borg init -e none ${BACKUP REPO}

fi

# Database

echo "Backup MySQL databases"

mkdir -p ${DATABASE EXP}

echo "- Backuping $OPENKM DB..."

mysqgldump --single-transaction --add-drop-table --quick ${OPENKM DB} > ${DATABASE EXP

# Data backup

echo "File system backup: ${BACKUP REPO}"

borg create -v --stats ${BACKUP REPO}::'{now:%Y-%m—-%d $H:8M}' ${OPENKM HOME }

borg prune -v ${BACKUP REPO} --list --keep-daily=7 --keep-weekly=4 --keep-monthly=6

# Umount disk

sync

umount "SBACKUP DIR"

echo "$BACKUP DIR umounted";

Configure crontab

To install the cron job, run:

$ sudo mkdir /root/logs

$ sudo crontab -e

And add these lines according to your personal configuration:

' MAILTO=nomail@openkm.com E
' PATH=/usr/sbin:/usr/bin:/sbin:/bin:/usr/local/bin '
\ @daily /root/backup.sh 2>&1 | tee /root/logs/backup.$ (date +\%Y.\8m.\8d \%H.\8M.\8S).
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.4

B
|

i i More information at Crontab quick reference

|

i If you want to be notified by mail you should install " postfix" service in your server.
Recovery

In order to list all stored backup use the list action parameter:

-~

$ borg list backup@bk-server.com:/mnt/backup/name

2018-02-07 Thu, 2018-02-07 10:12:31 [c878b314107c76b2d86ba75a9e5b2a216bf1f0d6b824313396c51ccda02a72e6]

2018-02-08 Thu, 2018-02-08 10:15:45 [2cf11f13bc7a2c9c0f1a0c243da52ac4b7657e7c6429cca0bf06a80467837f1e]

R———

If you want to list all files in a given backup:

ST

$ borg list backup@bk-server.com:/mnt/backup/name::2018-02-07_09:27

~———

In case you need to access the contents of a backup you can mount as a local filesystem:

$ mkdir /tmp/backup

$ borg mount backup@bk-server.com:/mnt/backup/name::2018-02-07_09:27 /tmp/backup

i If you do not specify an specific backup then will be mounted all the backup. The command line should be:

>

$ mkdir /tmp/backup

I
I
I
i\ $ borg mount backup@bk-server.com:/mnt/backup /tmp/backup

At the end you might be interested in umount the folder

borg umount /tmp/backup

ST

~———
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Linux backup and restore with rdiff-backup tool

Rdiff-backup backs up one directory to another, possibly over a network. The target directory ends up a copy of the source
directory, but extra reverse diffs are stored in a special subdirectory of that target directory, so you can still recover files lost

some time ago.

The idea is to combine the best features of a mirror and an incremental backup. rdiff-backup also preserves subdirectories,

hard links, dev files, permissions, uid/gid ownership, modification times, extended attributes, acls, and resource forks.

Also, rdiff-backup can operate in a bandwidth efficient manner over a pipe, like rsync. Thus you can use rdiff-backup and ssh to

securely back a hard drive up to a remote location, and only the differences will be transmitted.

i If you need to backup to CIFS (SMB, Samba) or Mac's HFS, please take a look at rdiff-backup FAQ.

TTTTTTTY

Debian & Ubuntu

This utility is included in the software repository, so to install just run as root:

$ apt-get install rdiff-backup

[ |
I

i - Rdiff-backup from Debian issues a warning message due to a deprecated method [0s.popen2 is deprecated], i
i which can be hidden following the steps at How to shut up Python deprecation warnings. i
g J
CentOS & RedHat

In this case, the application is not included in the default software repository so you need to make use of the EPEL repository:

$ rpm -Uvh http://dl.fedoraproject.org/pub/epel/7/x86_64/e/epel-release-7-5.noarch.rpm
$ yum update

$ yum install rdiff-backup

Preliminaries
In these scripts are assumed these default values:

e STOMCAT_HOME value is "/home/openkm/tomcat”
e OpenKM database is named "okmdb".
e OpenKM database password value is "*secret*".

* OpenKM start & stop service script location is "/etc/init.d/tomcat”

Sample script
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P

A As a good practice the backup should be done by root user.

i The script below does a backup to USB and the application database is MySQL.

USB disk mount point can be defined in /etc/fstab as:

These are the global script sections:

« Global var configuration under ## BEGIN CONFIG ## section.

o Checking user root under # Check root user section.

» Deleting older database backup # Delete older local database backup section.

* Mount disk ( optional section ) under # Mount disk section.

 Stop application ( optional section ) under # Stop tomcat section.

o Clean logs ( optional section ) under # Clean logs section.

o Backup the database to the filesystem under #Backup database section.

» Backup repository and database dump to backup destination under #Backup and purge old backups section.

« Start application ( optional section ) # Start tomcat section.

» Show statistics ( optional section ) # Status section.

» Umount disk ( optional section ) under # Umount disk section.

Configuration parameters explanation:

Parameter

HOST

DATABASE_PASS

OPENKM_DB

Description
The server host name.
The database password.
(
i i The datase user to do backup is always root user.
|
|

.

The application database name.

P

i Usually will be named "okmdb".

.
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OPENKM_HOME The openkm home folder.

TOMCAT_HOME The tomcat home folder.

Usually into OPENKM_HOME folder.

.

DATABASE_EXP The database dump folder.

Usually into the same server.

.

BACKUP_DIR Backup destination. In case of a remote server, the form is user@server::/path/to/backup

Create a backup script /root/backup.sh

$ sudo su

$ vim /root/backup.sh

#!/bin/bash

#

## BEGIN CONFIG ##

HOST=$ (uname -n)

DATABASE PASS="*secret*"
OPENKM DB="okmdb"

OPENKM HOME="/home/openkm"
TOMCAT HOME="$OPENKM HOME/tomcat"
DATABASE EXP="$OPENKM HOME/db"
BACKUP DIR="/mnt/backup"

## END CONFIG ##

# Check root user

if [ $(id -u) != 0 ]; then echo "You should run this script as root";

# Delete older local database backup

echo -e "### BEGIN: S$(date +"$%x $X") ###\n"
rm -rf SDATABASEiEXP

mkdir -p SDATABASEiEXP

# Mount disk

if mount | grep "S$BACKUP DIR type" > /dev/null; then
echo "$BACKUP DIR already mounted";

else
mount "SBACKUPiDIR We

if mount | grep "$BACKUP DIR type" > /dev/null; then

echo "$BACKUP DIR mounted";

else
echo "$BACKUP DIR error mounting";
exit -1;

fi

fi

exit;

fi
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# Stop Tomcat
/etc/init.d/tomcat stop

# Clean logs

#echo "Clean Tomcat temporal files."

#rm -rf $TOMCAT7HOME/lOgS/*

#rm -rf $TOMCAT7HOME/temp/*

#rm -rf $TOMCAT HOME/work/Catalina/localhost

# Backup database

if [ -n "SDATABASE;PASS" ]; then
echo "* Backuping MySQL data from $OPENKM DB..." i
mysgldump -h localhost -u root -p$DATABASE PASS SOPENKM DB > $DATABASE7EXP/mysqli$EO
echo M e o o o e e ",- 1

fi

# Backup and purge old backups
rdiff-backup --remove-older-than 30B $BACKUP DIR/$HOST
rdiff-backup -v 3 --print-statistics --include $OPENKM HOME --exclude '**' / $BACKU.

# Start Tomcat
/etc/init.d/tomcat start
echo -e "\n### END: S(date +"%x $%X") ###"

# Status

echo " We
rdiff-backup --list-increment-sizes SBACKUP DIR/SHOST
echo "*********************************"; -

df -h | grep "SBACKUP DIR"

echo " = Uy

# Umount disk
sync
umount "$BACKUP7DIR"

___________________________________.1'3;1__________

Increase the backup period

Modify the # Backup and purge old backups section increasing the parameter value:

The "30B" value indicate that will be able to restore a full backup of any of the last 30 days, increasing to " 90B"
will indicate any of the last 90 days, etc...

Do remote backup

Modify the # Backup and purge old backups section.

i
- . . |
1 The backup@server indicate remote "server" accessed by user "backup". |
|
|
J

' # Backup and purge old backups
' rdiff-backup --remove-older-than 30B backup@server::$BACKUP DIR/SHOST ]
\ rdiff-backup -v 3 --print-statistics --include SFILES --exclude '**' / backup@server:
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A Also could be only modified the ## Config section, for example:

## BEGIN CONFIG ##
BACKUP DIR="user@server::/path/to/backup"

# Backup and purge old backups
rdiff-backup --remove-older-than 30B $BACKUP DIR/SHOST

Do remote backup to SMB or CIFS

Modify the # Mount disk section.

# Mount disk
if mount | grep "SBACKUP DIR type" > /dev/null; then '
echo "$BACKUP DIR already mounted"; i
else i
echo "Mounting S$BACKUP DIR ...";

if mount | grep "$BACKUP DIR type" > /dev/null; then E
echo "$BACKUP DIR mounted"; '
else '
echo "Error mounting $BACKUP DIR."; i
exit -1; E

fi i
=4 i

Do PostgreSQL backup

Modify the # Backup database section

# Backup de PostgreSQL
echo "* Backuping PostgreSQL data from $OPENKM DB..."
su postgres -c "pg dump SOPENKM DB" > SDATABASE EXP/pg $OPENKM DB.sql

# Databases optimizations

su postgres -c "vacuumdb -a -z" > /dev/null
su postgres —-c "reindexdb -a -q" 2> /dev/null

Configure crontab

To install the cron job, run:

$ sudo mkdir /root/logs

$ sudo crontab -e

And add these lines according to your personal configuration:
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MAILTO=nomail@openkm.com

@daily /root/backup.sh | tee /root/logs/backup.$ (date +\8Y.\8m.\8d \8%H.\8$M.\38S).log

.4

B
1

i i More information at Crontab quick reference

|

i If you want to be notified by mail you should install " postfix" service in your server.
Restoring backup

You can list the available backups:

~

$ rdiff-backup --list-increment-sizes /path/to/backup

Sun Sep 11 05:00:19 2012 4.25 GB 4.25 GB (current mirror)
Sun Sep 4 00:00:18 2012 13.3 MB 4.26 GB

Sun Aug 28 00:00:13 2012 674 MB 4.92 GB

Sun Aug 21 00:00:14 2012 5.50 MB 4.93 GB

Sun Aug 14 00:00:16 2012 1.75 MB 4.93 GB

Sun Aug 7 00:00:12 2012 288 KB 4.93 GB

Sun Jul 31 00:00:13 2012 43.0 KB 4.93 GB

FriJul 29 10:36:39 2012 5.56 KB 4.93 GB

Then decide to restore some of the backups, for example the one made on Sun Aug 28 00:00:13 2012:

$ rdiff-backup --restore-as-of 2012-08-28 /path/to/backup /path/to/destination

ST

~———

Or restore the last backup

$ rdiff-backup --restore-as-of now /path/to/backup /path/to/destination

i The --restore-as-of parameter accepts several formats. See rdiff-backup documentation for more info.

Sample for restoring single folder ( the /home/openkm/tomcat/ must exists )

rdiff-backup --restore-as-of now /mnt/backup/ms1/home/openkm/tomcat/ /home/openkm/tomcat/

e db: The backup of the database.

e tomcat-7.0.61: The backup of the Tomcat installation and OpenKM repository into.

i Inside of /path/to/destination you should see a directory /home/openkm, and inside it a couple of directories:

Additional information

o rdiff-backup home page
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o rdiff-backup wiki

o Automated backups with rdiff-backup

e Using rdiff-backup for remote backups

e Suppress socket warnings when using rdiff-backup
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Linux Sample Backup with Duplicity

Duplicity backs directories by producing encrypted tar-format volumes and uploading them to a remote or local file server.
Because duplicity uses librsync, the incremental archives are space efficient and only record the parts of files that have changed
since the last backup. Because duplicity uses GnuPG to encrypt and/or sign these archives, they will be safe from spying and/or

modification by the server.

Installation

Duplicity can be installed in Debian / Ubuntu as simple as:

$ sudo apt-get install duplicity ncftp python-boto python-paramiko

To avoid the Import of duplicity.backends.giobackend Failed: No module named gio warning, you need to
install the python-gobject-2 package:

|

$ apt-get install python-gobject-2

But it not in the CentOS / RedHat default repositories, so you need to install from another source. This script will help in this

installation process:
#!/bin/bash

wget http://dl.fedoraproject.org/pub/epel/6/x86 64/duplicity-0.6.18-1.el16.x86 64.rpnl
wget http://dl.fedoraproject.org/pub/epel/6/x86 64/ncftp-3.2.4-1.e16.x86 64.rpm ‘

wget http://dl.fedoraproject.orqg/pub/epel/6/x86 64/librsync-0.9.7-15.el6.x86 64.rpm !

wget http://dl.fedoraproject.org/pub/epel/6/x86 64/python-GnuPGInterface-0.3.2-6.el6..
wget http://dl.fedoraproject.org/pub/epel/6/x86 64/python-boto-2.5.2-1.el6.noarch.rpm

rpm -Uvh duplicity-0.6.18-1.el6.x86 64.rpm ncftp-3.2.4-1.el16.x86 64.rpm librsync—0.9:.

Command line basics
To make a backup you can do:
$ duplicity --no-encryption /home/openkm file:///path/to/backup
To verify it:
$ duplicity --no-encryption verify file:///path/to/backup /home/openkm

To list backed files:

$ duplicity --no-encryption list-current-files file:///path/to/backup

To restore a single file:
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$ duplicity --no-encryption --file-to-restore tomcat/OpenKM.cfq file:///path/to/backup RestoredBackup

i The path to the file that is to be restored is related to the directory on which the backup set is based. So in the
command above, tomcat/OpenKM.cfg plus the directory on which we based our backup (/home/openkm) equals
/home/openkm/tomcat/OpenKM.cfg

———————————\

Preliminaries
In these scripts are assumed these default values:

e STOMCAT_HOME value is "/home/openkm/tomcat”
e OpenKM database is named "okmdb".
e OpenKM database password value is "*secret*".

e OpenKM start & stop service script location is "/etc/init.d/tomcat”

Sample script

P

A As a good practice the backup should be done by root user.

i The script below does a backup to USB and the application database is MySQL.

USB disk mount point can be defined in /etc/fstab as:

These are the global script sections:

¢ Global var configuration under ## BEGIN CONFIG ## section.

o Checking user root under # Check root user section.

» Deleting older database backup # Delete older local database backup section.

e Mount disk ( optional section ) under # Mount disk section.

 Stop application ( optional section ) under # Stop tomcat section.

o Clean logs ( optional section ) under # Clean logs section.

o Backup the database to the file system under #Backup database section.

» Backup repository and database dump to backup destination under #Backup and purge old backups section.
« Start application ( optional section ) # Start tomcat section.

» Show statistics ( optional section ) # Status section.

» Un mount disk ( optional section ) under # Umount disk section.
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Configuration parameters explanation:

Parameter Description

HOST The server host name.

DATABASE_PASS The database password.

{
|
i i The data base user to do the backup is always root user.
|
|

.

OPENKM_DB The application database name.

i Usually will be named "okmdb".

.

OPENKM_HOME The openkm home folder.

TOMCAT_HOME The tomcat home folder.

i Usually into OPENKM_HOME folder.

.

DATABASE_EXP The database dump folder.

i Usually into the same server.

.

BACKUP_DIR Backup destination.

Create a backup script /root/backup.sh

$ sudo su

$ vim /root/backup.sh

#!/bin/bash
D :
\ ## BEGIN CONFIG ## '
HOST=$ (uname -n)
' DATABASE PASS='"*secret*" 1
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OPENKM DB="okmdb"
OPENKM HOME="/home/openkm"
TOMCATiHOME="$OPENKM7HOME/tomcat"
DATABASEiEXP="SOPENKMiHOME/db"
BACKUP DIR="file:///mnt/backup"”
## END CONFIG ##
# Check root user
if [ $(id -u) != 0 ]; then echo "You should run this script as root"; exit; fi

# Delete older local database backup

echo -e "### BEGIN: S$(date +"$%x $X") ###\n"
rm -rf SDATABASEiEXP

mkdir -p SDATABASEiEXP

# Mount disk

if mount | grep "S$BACKUP DIR type" > /dev/null; then
echo "$BACKUP DIR already mounted";

else
mount "$BACKUP DIR";

if mount | grep "$BACKUP DIR type" > /dev/null; then
echo "$BACKUP DIR mounted";

else
echo "$BACKUP DIR error mounting";
exit -1;

fi

fi

# Stop Tomcat
/etc/init.d/tomcat stop

# Clean logs

#echo '"Clean Tomcat temporal files."

#rm -rf $TOMCAT7HOME/lOgS/*

#rm -rf $TOMCAT7HOME/temp/*

#rm -rf $TOMCAT HOME/work/Catalina/localhost

# Backup database
if [ -n "SDATABASEiPASS" ], then
echo "* Backuping MySQL data from $OPENKM DB..."

mysgldump -h localhost -u root -pSDATABASE PASS S$OPENKM DB > $DATABASE EXP/mysqgl
"

CEne Yo———coem—coooooooorossrrer e oo e oo oo ;
fi

# Backup and purge old backups
duplicity remove-older-than 1M --force $BACKUP DIR/$HOST

if [ $(date +%u) -eq 7 ], then
echo "*** Full Backup ***"

duplicity full --no-encryption $OPENKM HOME $BACKUP DIR/$HOST

RETVAL=S5?
else
echo "*** Incremental Backup ***"
duplicity --no-encryption SOPENKM HOME $BACKUP DIR/$HOST
RETVAL=S57?
fi

[ $RETVAL -eq 0 ] && echo "*** SUCCESS ***"
[ $RETVAL -ne 0 ] && echo "*** FAILURE ***"

# Start Tomcat
/etc/init.d/tomcat start
echo -e "\n### END: S(date +"%x $%X'") ###"

# Status
echo " Uy

3
Q
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duplicity collection-status SBACKUP DIR/SHOST
echo "*****************************;***";

df -h | grep "SBACKUP DIR"

echo " = Wg

# Umount disk
sync
umount "$BACKUP7DIR"

Increase the backup period

Modify the # Backup and purge old backups section increasing the parameter value:

[ |
|

| The "1M" value indicate will be removed backups older one month. Changing to "3M" or "1Y" indicate older 3 i
| ]
i Month or 1 Year, etc.. |
\ )
1 ——remove-older-than 3M

Perform the remote backup

Modify the ## Config section section.

BACKUP DIR="ftp://user@ftp.domain.es/backup"
export FTP PASSWORD="WhateverPasswordYouSetUp"

# Backup and purge old backups
duplicity remove-older-than 1M --force $BACKUP DIR/$HOST

. 1if [ $(date +%u) -eq 7 ], then i
E echo "*** Full Backup ***" E
! duplicity full --no-encryption SOPENKM HOME $BACKUP DIR/$HOST J
: RETVAL=S57? '
1 else E
! echo "*** Incremental Backup ***"

i duplicity --no-encryption SOPENKM HOME $BACKUP DIR/$HOST ]
: RETVAL=S7? '
| £ |

[ $SRETVAL -eq 0 ] && echo "*** SUCCESS ***"
[ $RETVAL -ne 0 ] && echo "*** FAILURE ***"

duplicity collection-status $BACKUP DIR/$HOST
unset FTP PASSWORD

Perform the remote backup to SMB or CIFS

Modify the # Mount disk section.
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# Mount disk

if mount | grep "S$BACKUP DIR type" > /dev/null; then

echo "$BACKUP DIR already mounted";

else

echo "Mounting $BACKUP DIR ...";

if mount

grep "$BACKUP DIR type" > /dev/null; then

echo "$BACKUP DIR mounted";

else

echo "Error mounting $BACKUP DIR.";

exit -1;
fi

Do the PostgreSQL backup

Modify the # Backup database section

# Backup de

echo "* Backuping PostgreSQL data from $OPENKM DB..."
-c "pg dump SOPENKM DB" > $DATABASE EXP/pg S$SOPENKM DB.sql

su postgres

# Databases
su postgres
su postgres

PostgreSQL

optimizations

-c "vacuumdb

-c "reindexdb -a -gq" 2> /dev/null

-a -z" > /dev/null

Do the remote backup to Amazon s3

Modify the ## Config section section.

BACKUP DIR="s3+http://somebucket/somedirectory"

export AWS ACCESS KEY ID=""
export AWS _SECRET ACCESS KEY=""
export PASSPHRASE=""

# Backup and purge old backups

if [ S(date
echo T % % %
duplicity
RETVAL=S5?

else
echo T % % %
duplicity
RETVAL=S57?

fi

+%u) -eq 7 ]
Full Backup

; then

x A AN

full --no-encryption --s3-use-new-style $OPENKM HOME $BACKUP DIR/$HOST

Incremental Backup ***"
--no-encryption --s3-use-new-style $OPENKM HOME $BACKUP DIR/$HOST

[ $RETVAL -eq 0 ] && echo "*** SUCCESS ***"

# Status
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duplicity collection-status --s3-use-new-style $BACKUP DIR/SHOST

' unset AWS_ACCESS_KEY_ID
' unset AWS SECRET ACCESS KEY
! unset PASSPHRASE

Configure crontab

To install the cron job, run:

$ sudo mkdir /root/logs

$ sudo crontab -e

Add these lines according to your personal configuration:

MAILTO=nomail@openkm.com

@daily /root/backup.sh | tee /root/logs/backup.$(date +\8Y.\8m.\8%d \8H.\8M.\$%S).log

If you want to be notified by mail you should install " postfix" service in your server.

i
|
- . . .
! l More information at Crontab quick reference
|
|
I
I
I
[\

.4

Troubleshooting deleting old backups

You have configured Duplicity to make a full backup every 7 days, and deleting backups older than 14 days to save space. What

happen if you see a message like this?

! Tue May 1 00:00:00 2012
' Wed May 2 00:00:00 2012

Which can't be deleted because newer sets depend on them

Duplicity uses rsync, which contains incremental changes. Those files won't be deleted because, even though the backup maybe

older than 7 days, there are backups which are incremental and younger than 7 days.

So, dfter 2 weeks have passed, those files will be deleted, since the full backup and the incremental backups are now 14 days

old, and there exists a full backup newer than the full and incremental backups.

Restoring backup

You can list the available backups:

$ duplicity collection-status /path/to/backup

Sun Sep 11 05:00:19 2012 4.25 GB 4.25 GB (current mirror)
Sun Sep 4 00:00:18 2012 13.3 MB 4.26 GB

Sun Aug 28 00:00:13 2012 674 MB 4.92 GB

Sun Aug 21 00:00:14 2012 5.50 MB 4.93 GB
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Sun Aug 14 00:00:16 2012 1.75 MB 4.93 GB
Sun Aug 7 00:00:12 2012 288 KB 4.93 GB
Sun Jul 31 00:00:13 2012 43.0 KB 4.93 GB
FriJul 29 10:36:39 2012 5.56 KB 4.93 GB

Then decide to restore some of the backups, for example the one made on Sun Aug 28 00:00:13 2012:

$ duplicity restore --restore-time 2012-08-28 /path/to/backup /path/to/destination

The --restore-time parameter accepts several formats. See duplicity documentation and Duplicity Backup Howto

for more info.

i Inside of /path/to/destination you should see a directory /home/openkm, and inside it a couple of directories:

e db: The backup of the database.

e tomcat: The backup of the Tomcat installation and OpenKM repository into.

Additional information

e Using Duplicity to Backup Your Data

o Ubuntu/Debian - Encrypted Incremental Backups With Duplicity on Amazon S3
o Duplicity Backup Howto

e Duplicity URL Format

o Installation and configuration of duplicity for encrypted SETP remote backup

e Playing with Duplicity backup and restore tool and Amazon S3

e Bash wrapper script for automated backups with duplicity
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Linux backup and restore with rsync

Rsync is a software application and network protocol for Unix, Linux and Windows systems which synchronizes files and
directories from one location to another while minimizing data transfer using delta encoding when appropriate. An important
feature of rsync not found in similar programs/protocols is that the mirroring takes place with only one transmission in each

direction. rsync can copy or display directory contents and copy files, optionally using compression and recursion.

Preliminaries
In these scripts are assumed these default values:

e STOMCAT_HOME value is "/home/openkm/tomcat”
e OpenKM database is named "okmdb".
e OpenKM database password value is "*secret*".

"

e OpenKM start & stop service script location is "/etc/init.d/tomcat

Sample script

P

A As a good practice the backup should be done by root user.

i The script below does a backup to USB and the application database is MySQL.

USB disk mount point can be defined in /etc/fstab as:

These are the global script sections:

¢ Global var configuration under ## BEGIN CONFIG ## section.

o Checking user root under # Check root user section.

» Deleting older database dump # Delete older local database backup section.

* Mount disk ( optional section ) under # Mount disk section.

» Stop application ( optional section ) under # Stop tomcat section.

o Clean logs ( optional section ) under # Clean logs section.

o Backup the database to the filesystem under #Backup database section.

» Backup repository and database dump to backup destination under # Create backup section.
« Start application ( optional section ) # Start tomcat section.

» Umount disk ( optional section ) under # Umount disk section.
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Configuration parameters explanation:

Parameter

HOST

DATABASE_PASS

OPENKM_DB

OPENKM_HOME

TOMCAT_HOME

DATABASE_EXP

BACKUP_DIR

RSYNC_OPTS

Description
The server host name.
The database password.
(
i i The database user to do backup is always root user.
|
|

S—

The application database name.

P

i Usually will be named "okmdb".

S—

The openkm home folder.

The tomcat home folder.

P

i Usually into OPENKM_HOME folder.

S—

The database dump folder.

P

i Usually into the same server.

S—

Backup destination.

Rsync parameters.

Create a backup script /root/backup.sh

$ sudo su

$ vim /root/backup.sh

E #!/bin/bash
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#

## BEGIN CONFIG ##

HOST=$ (uname -n)

DATABASE PASS="*secret*"

OPENKM DB="okmdb"

OPENKM HOME="/home/openkm"

TOMCAT HOME="$OPENKM HOME/tomcat"
DATABASE EXP="$OPENKM HOME/db"
BACKUP DIR="/mnt/backup"

RSYNC OPTS="-apzhR --stats --delete --exclude=*~ --delete-excluded"
## END CONFIG ##

# Check root user
if [ $(id -u) != 0 ]; then echo "You should run this script as root"; exit;

# Delete older local database backup

echo -e "### BEGIN: S$(date +"$%x $X") ###\n"
rm -rf $DATABASE7EXP

mkdir -p SDATABASEiEXP

# Mount disk

if mount | grep "S$BACKUP DIR type" > /dev/null; then
echo "$BACKUP DIR already mounted";

else
mount "SBACKUPiDIR We

if mount | grep "$BACKUP DIR type" > /dev/null; then
echo "$BACKUP DIR mounted";

else
echo "$BACKUP DIR error mounting";
exit -1;

fi

fi

# Stop Tomcat
/etc/init.d/tomcat stop

# Clean logs

#echo '"Clean Tomcat temporal files."

#rm -rf $TOMCAT7HOME/lOgS/*

#rm -rf $TOMCAT7HOME/temp/*

#rm -rf $TOMCAT HOME/work/Catalina/localhost

# Backup database
if [ -n "SDATABASE;PASS" ], then
echo "* Backuping MySQL data from $OPENKM DB..."

mysgldump -h localhost -u root -pSDATABASE PASS S$OPENKM DB > $DATABASE EXP/mysqgl

CEREe Yommoocoooooooooooooooooooosoooososees Wg
fi

# Create backup
rsync $RSYNC70PTS $OPENKM7HOME $BACKUP7DIR/$HOST

# Start Tomcat
/etc/init.d/tomcat start
echo -e "\n### END: S(date +"%x $%X") ###"

# Umount disk
sync
umount "$BACKUP7DIR "

Do backup with rotation

Modify the # Create backup section.

fi
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# Create backup

# Calculate snapshot

LASTisNAPSHOT=\lS -1tr $BACKUP7DIR | tail -1 | awk {'print $8'} | cut -d . -f 2°
NEWisNAPSHOT=$ ( (LAST SNAPSHOT+1))

# Create backup
! "cd $BACKUP DIR/S$HOST; rm -rf backup.3; mv backup.2 backup.3; mv backup.l pac
, rsync $RSYNC70PTS ——link—dest:"$BACKUP7DIR/$HOST/backup.l" "OPENKM_HOME" "SBA

Do remote backup

Modify the ## BEGIN CONFIG ## section.

# Create backup
# Create missing backup folder ( optional )
ssh SBACKUPi.SRV "mkdir -p $BACKUP7DIR”

NEW SNAPSHOT=$% (date "+8Y-8%m-8dT%H:3%M:%S")
LAST SNAPSHOT=$ (ssh $BACKUP SRV 1ls -tr $BACKUP DIR/$HOST | tail -1)

# Calculate snapshot
if [ $LAST SNAPSHOT ]; then
echo "Incremental backup $NEW _SNAPSHOT based on $LAST SNAPSHOT... " ]
else E
echo "Initial full backup $NEW SNAPSHOT..." ]
rsync $RSYNC OPTS "$OPENKM HOME" "SBACKUP SRV:$BACKUP DIR/$HOST/$NEW SNAPSHOT" ‘
fi i

Do incremental backup with backup-dir

Modify the ## BEGIN CONFIG ## section.

Modify the # Create backup section.
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' # Create backup
' NEW SNAPSHOT='date +%Y-%m-%d° i
i echo -e "\n### RSYNC - BEGIN : S(date +"%x 3%X") ###\n" 1
1 echo "* New Snapshot: $NEW_SNAPSHOT" 5

Do incremental backup with link-dest

Modify the ## BEGIN CONFIG ## section.

# Create backup

' # Calculate snapshot

\ LAST SNAPSHOT='ssh $BACKUP SRV "cd $BACKUP DIR && stat --format='%n' * | tail -1""
: NEW SNAPSHOT='date +3%Y-%m-%d"

' echo -e "\n### RSYNC - BEGIN : $(date +"$x $X") ###\n"

1 echo "* Last Snapshot: $LAST SNAPSHOT"

i echo "* New Snapshot: $NEW SNAPSHOT"

if [ ! SLASTisNAPSHOT ]; then
rsync $RSYNC70PTS $OPENKMiHOME/ "SBACKUPiDIR/SHOST/SNEwiSNAPSHOT"
else

Do remote backup to SMB or CIFS

Modify the # Mount disk section.

E # Mount disk E
' 1f mount | grep "SBACKUP DIR type" > /dev/null; then i
i echo "$BACKUP DIR already mounted";

. else 1
' echo "Mounting S$BACKUP DIR ...";

i mount -t cifs //REMOTE SERVER/REMOTE DIR $BACKUP DIR -o username=REMOTE USER,passwo
i if mount | grep "$BACKUP DIR type" > /dev/null; then

5 echo "$BACKUP DIR mounted";

! else

i echo "Error mounting $BACKUP DIR.";

: exit -1;

v fi

Do PostgreSQL backup

Modify the # Backup database section

# Backup de PostgreSQL
! echo "* Backuping PostgreSQL data from $OPENKM DB..." J
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# Databases optimizations
su postgres -c "vacuumdb -a -z" > /dev/null
su postgres —-c "reindexdb -a -q" 2> /dev/null

su postgres -c "pg dump SOPENKM DB" > SDATABASE EXP/pg $OPENKM DB.sql

Configure crontab

To install the cron job, run:

$ sudo mkdir /root/logs

$ sudo crontab -e

And add these lines according to your personal configuration:

MAILTO=nomail@openkm.com

@daily /root/backup.sh | tee /root/logs/backup.$ (date +\8Y.\8m.\8d \%H.\8$M.\38S).log

|

B
|

i i More information at Crontab quick reference

|

|

! If you want to be notified by mail you should install " postfix" service in your server.
Rsync and FTP

Rsync need SSH access to work, but you can also use it with an FTP server if you mount it locally with curlftpfs:

A Backup performance may degrade using this method.

TTTTT TN

Install curlftpfs and rsync:

$ sudo apt-get install curlftpfs rsync

Create mountpoin:

$ mkdir /path/to/mount

Mount remote director:

$ curlftpfs ftp.example.com /path/to/mount

T

~———

Create local directory:

$ mkdir /local/path

T

~———

Rsync mounted directory to local director:

$ rsync -r -t -v --progress --bwlimit=500 /path/to/mount/ /local/path/

T

~———
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Restoring backup

You can list the available backups:

$ Is -1d /path/to/backup/*

drwxr-xr-x 4 root root 4096 sep 11 05:00:19 2012 2012-09-11T05:00:19
drwxr-xr-x 4 root root 4096 sep 4 00:00:18 2012 2012-09-04T00:00:18

drwxr-xr-x 4 root root 4096 aug 28 00:00:13 2012 2012-08-28T00:00:13
drwxr-xr-x 4 root root 4096 aug 21 00:00:14 2012 2012-08-21T00:00:14
drwxr-xr-x 4 root root 4096 aug 14 00:00:16 2012 2012-08-14T00:00:16
drwxr-xr-x 4 root root 4096 aug 7 00:00:12 2012 2012-08-07T00:00:12

drwxr-xr-x 4 root root 4096 jul 31 00:00:13 2012 2012-07-31T00:00:13

drwxr-xr-x 4 root root 4096 jul 29 10:36:39 2012 2012-07-29T10:36:39

Then decide to restore some of the backups, for example the one made on Sun Aug 28 00:00:13 2012:

$ ¢p /path/to/backup/2012-08-28T00:00:13 /path/to/destination

See rsync documentation for more info.

Inside of /path/to/destination you should see a directory /home/openkm, and inside it a couple of directories:

e db: The backup of the database.

¢ tomcat: The backup of the Tomcat installation and OpenKM repository into.

Additional information

o Easy Automated Snapshot-Style Backups with Linux and Rsync
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Linux backup with LFTP

LFTP is a sophisticated FTP client, and a file transfer program supporting a number of network protocols.

A This configuration does not provide incremental backups.

TTTTT TN

Preliminaries

In these scripts are assumed these default values:

$TOMCAT_HOME value is "/home/openkm/tomcat”
¢ OpenKM database is named "okmdb".
¢ OpenKM database password value is "*secret*".

e OpenKM start & stop service script location is "/etc/init.d/tomcat”

Sample script

P

A As a good practice the backup should be done by root user.

i The script below does a backup to USB and the application database is MySQL.

USB disk mount point can be defined in /etc/fstab as:

These are the global script sections:

Global var configuration under ## BEGIN CONFIG ## section.

o Checking user root under # Check root user section.

e Deleting older database backup # Delete older local database backup section.

e Stop application ( optional section ) under # Stop tomcat section.

¢ Clean logs ( optional section ) under # Clean logs section.

¢ Backup the database to the filesystem under #Backup database section.

¢ Backup repository and database dump to backup destination under #Backup and purge old backups section.

e Start application ( optional section ) # Start tomcat section.

Configuration parameters explanation:

Parameter Description
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HOST

NOW

DATABASE_PASS

OPENKM_DB

OPENKM_HOME

TOMCAT_HOME

DATABASE_EXP

BACKUP_DIR

The server host name.

Actual date in format 'dd-MM-yyyy'.

The database password.

i The data base user to do backup is always root user.

TTTTTTTY

——

The application database name.

i Usually will be named "okmdb".

TTTTTTTY

——

The openkm home folder.

The tomcat home folder.

i Usually into OPENKM_HOME folder.

TTTTTTTY

——

The database dump folder.

i Usually into the same server.

TTTTTTTY

——

FTP Backup destination.

Create a backup script /root/backup.sh

sudo su

vim /root/backup.sh

#!/bin/bash
#

## BEGIN CONFIG ##
HOST=$ (uname -n)
NOW=$ (date +"%d-m-%Y")
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1

DATABASE PASS="*secret*"

OPENKM DB="okmdb"

OPENKM HOME="/home/openkm"

TOMCAT HOME= "$OPENKM7HOME/tomca t"

DATABASE EXP= "SOPENKMiHOME/db "

BACKUP DIR="ftp://user:password@ftp.server/backup"
## END CONFIG ##

# Check root user
if [ $(id -u) != 0 ]; then echo "You should run this script as root"; exit,; fi

# Delete older local database backup

echo -e "### BEGIN: S$(date +"$%x $X") ###\n"
rm -rf SDATABASEiEXP

mkdir -p SDATABASEiEXP

# Stop Tomcat
/etc/init.d/tomcat stop

#echo '"Clean Tomcat temporal files."

#rm -rf $TOMCAT7HOME/logS/*

#rm -rf $TOMCAT7HOME/temp/*

#rm -rf $TOMCAT HOME/work/Catalina/localhost

# Backup database
if [ -n "SDATABASE;PASS" ]; then
echo "* Backuping MySQL data from $OPENKM DB..."
mysgldump -h localhost -u root -p$DATABASE PASS $OPENKM DB > SDATABASE EXP/mysql

# Backup and purge old backups
1ftp $BACKUP DIR -e "mkdir $NOW; mirror --reverse $OPENKM HOME $SNOW; exit!"

# Start Tomcat
/etc/init.d/tomcat start

i # Clean logs
1 echo -e "\n### END: $(date +"%x $X") ###"

Configure crontab

To install the cron job, run:

$ sudo mkdir /root/logs

$ sudo crontab -e

Add these lines according to your personal configuration:

MAILTO=nomail@openkm.com
@daily /root/backup.sh | tee /root/logs/backup.$(date +\8Y.\8m.\%d \8H.\8M.\$%S).log

- . . .
1 More information at Crontab quick reference

If you want to be notified by mail you should install " postfix" service in your server.

.4
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Instance replication

To enhance OpenKM availability you can have two instances of the application running on different servers. If the principal

server gets down due to a hardware failure you can switch to the mirrored server and keep working.

REPLICATION > ‘

Mirror Server

d

Main Server

Client

In this scheme, we assume:

» Each node has its own document repository and database.
o The backup instance is supposed to be a clone of the main instance.

« In case the main instance is down, you should send the client request to the backup instance.

- An option is to use a DNS which you can modify in case of server failure, or an HAProxy instance which properly

configured can detect a problem in the main server and forward the request to the working one.

A Keep in mind that in this configuration only one server should accept client petitions.

When the main server is down, the backup one becomes the new main server so the old main server is now the backup one (well,

when it is available again).
This is the configuration of each server:
Main server

e OpenKM is configured normally.
 The database is configured to send modifications to the backup instance.

 Rsync is configured to send datastore modifications every few minutes to the backup server.

Mirror server
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¢ OpenKM is configured in read-only mode.
¢ The database is configured to accept modification from the main instance.

e Datastore files are periodically updated by Rsync tool from the main server.

Different implementations
The provided solution is not the only one, but the simplest.

An improvement over this first approach is using an external file server (connected by NFS) so Rsync is not needed. Using a
NAS solution which improves the data backup and availability. It is highly recommended if the stored information is critical for

your business.

Another improvement is related to the database. Some database can be configured in master / slave mode, which the required
mode for this server configuration. But you can also deploy the database in a dedicated server (which should be also replied)

but some providers like Oracle offer specific database cluster solutions which should be taken in consideration.

Sample Linux implementation

V The replication is done only in one direction, from main server to mirror server.

The mirror server must be configured to be in read-only mode so users can't add or modify documents.

.4

The follow script will propagate the repository changes from main server to mirror server:

i On the sample the main server 192.168.1.101.
Both OpenKM are installed at the OpenKM user home (/home/openkm) for simplicity.

This script should be executed - by user root - from the main server, and can be scheduled to be executed every
day using Linux cron utility, for example.

The script uses rsync to minimize network load and only modified or added documents will be transferred. The
whole process can take a few minutes, depending on your repository activity.

#!/bin/bash
echo -e "### BEGIN: $(date +"$%x %X") ###\n"

# Stop local Tomcat
/etc/inid.d/tomcat stop

. # Stop remote Tomcat
ssh root@192.168.1.101 '/etc/inid.d/tomcat stop'

# Sync OpenKM repositories
rsync -rahe 'ssh -p 22022' --stats --delete --exclude tomcat/server/default/log --exc

# Start local Tomcat
/etc/init.d/tomcat start

# Start remote Tomcat
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ssh root@192.168.1.101 '/etc/init.d/tomcat start'

update OKM CONFIG set 'true' where CFG KEY='system.readonly';

i |
1 |
| A After the first synchronization, stop remote Tomcat, update the start.sql script there and start the Tomcat again. |
1 |
1 |
{ ]
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Setup

.
|
i V This section provides information for configuring and tuning OpenKM.
|
|

The application contains a lot of Configuration parameters and probably you will not need to know all of them. However, we
encourage you to take a look at the Recommended configuration parameters section where you will find the minimum

configuration required to use OpenKM.

Also you could be interested on:

e Preview parameters
e User interface configuration parameters

OpenKM works with third-party applications Wordpress, Joomla or Google Drive among others that need specific setup to get

it running.

i If you have some issue see Troubleshooting section.

TTTTTTTY
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Antivirus configuration

OpenKM can be integrated with an anti virus software which is be able to execute anti virus check from command line.

The example below is based on ClamAV, an Open Source anti virus engine which detects trojans, viruses, malware & other

malicious programs.

Linux

Debian / Ubuntu

Install antivirus:

Go to Administration > Configuration parameters:

Field / Property Type Description
system.antivir String  jysr/bin/clamscan
Red Hat / CentOS

ClamAV is not present by default in default repositories, so you must install it from a non default one.

Repository valid for Centos 5.2 ( for other versions it may be different ):

[dag]

gpgcheck=1

enabled=1

Update the virus database:

name=Dag RPM Repository for Red Hat Enterprise Linux
baseurl=http://apt.sw.be/redhat/elSreleasever/en/S$Sbasearch/dag/

gpgkey=http://dag.wieers.com/packages/RPM-GPG-KEY.dag. txt
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Windows

To Install and configure ClamAV on Windows:

Note: GREEN Text like this denotes commands run in a command console/terminal

BLACK Text like this denotes code changes

« Download the latest version from: https://www.clamav.net/downloads

e Unpack the ZIP archive and move it to: C:\ so that it appears in your path as: C:\ClamAV

« Copy the example conf files from C:\ClamAV\conf_examples to C:\ClamAV

e Open up a command terminal: Start->Run cmd

o Change to the ClamAV directory: c¢d C:\ClamAV

e Run clamconf. exe, it should inform that you need to edit the example config file. (I included this just so you can

check that the files are in the right location)

For DEFAULT MINIMAL configuration (Probably not suitable and you should configure the parameters for your situation)
Edit freshclam.conf, clamav-milter.conf and comment Example. In addition to commenting Example in clamd.conf; to

enable the local server you will need to change line 80 to: LocalSocket C:\CLAMAV\clamd.socket

¢ Run clamconf. exe again, you will get an output of all your configurations.

At the beginning you will get a message about being unable to open database, this is because it has not yet been

created.

TTTTT T T

e Run mkdir database. If you run clamconf again you will see that the database error is gone and that you have 0

signatures

e Run freshclam. exe, this will start the initial signature download for ClamAV and may take a few minutes.

At this point you can run clamd. exe to check that the server can run manually. (If you decide to test run at this point, you will

have to kill the process for the next section)

In case you need to create a freshclam.conf file use this as base:

# URL of server where database updates are to be downloaded from
# If this option is given multiple times, each will be tried 1in
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# the order given until an update 1is successfully downloaded
#MAKE SYU

DatabaseDirectory "C:\Program Files\ClamAV-x64\db\"
DatabaseMirror database.clamav.net

# Number of times to try each mirror before moving to the next one
MaxAttempts 3

#LogFile C:\Program Files\ClamAV-x64\log\freshclam.log
#NotifyClamd C:\Program Files\ClamAV-x64\clamd.conf
LogFileMaxSize 20480000

LogTime true

UpdateLogFile C:\Program Files\ClamAV-x64\log\freshclam.log

Clamd Service Setup

Now to setup it up so it starts automatically:

Details for the screen capture are below:

e, O WINDOWS' system32h cmd.exe

C:~ClamAl>zc create ClamD hinPath= “"C:“Program Files“Windows Resource Kitz“Too

~Epvany.exe'’
[SC] CreateService SUCCESS

C:~ClamAl>regedit

C:xClamAl *services .msc

e Run sc create ClamD binPath= C:\Program Files\Windows Resource
Kits\Tools\srvany.exe (yes the space is required in this command and you may have your resource tools in a

different location)

It should tell you: [SC] CreateService SUCCESS

® Run Regedit. Find: HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\ClamD
¢ Right click on ClamD and create a new Key
e Name the key Parameters
e Click on the new Parameters Key, in the right pane create a new String Value
e Name the String Value Application
e Right click and Modify Application to: C:\ClamAV\clamd.exe -c C:\ClamAV\clamd.conf

¢ Close Regedit

e Run services.msc
e Find ClamD in the list
e Right click -> Properties
e Change Startup type to: Automatic
e Select the recovery tab and change all three failures to: Restart the Service

o Select the General tab and Apply
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Freshclam Virus Signature Auto Update

Almost done!

¢ Navigate to: Start->All Programs->Accessories->System Tools->Scheduled Tasks
o Add Scheduled Task

¢ Next->Browse to C:\ClamAV\freshclam.exe

e Select to Perform this task daily

e Next

e Select a good time to update

e Next

o Enter the user credentials to run as

e Next

e Select open Advance options

e Next

o Alter Run to be: C\ClamAV\freshclam.exe -c C:\ClamAV\freshclam.conf
o Select the Settings Tab

e Change the Stop Task to 30 minutes

* Apply

¢ Ok

Right click and run the freshclam task to make sure you do not have any errors.

Go to Administration > Configuration parameters:

Field / Property Type Description

system.antivir String C:\ClamAV\clamscan.exe

If everything was configured correctly, OpenKM will scan every uploaded document in order to check if it's safe.
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Cleaning older activity log data

There's a table named OKM_ACTIVITY where openkm saves a log will the actions done by the users on all the nodes. In this
table can be easily several milions of rows what can affect the perfomance of the database. Really you should be interested on
most actual activity log data - for example last year - and keep the other data outside the database. For it is a good practice to

perfom some cleaning process, exporting oldest activity log data and then deleting it from database.

-

V Taking control of OKM_ACTIVITY log table size you can improve your database perfomance and reduce the
total amount of your database backup size and time for doing it.

Doing backups of OKM_ACTIVITY by range and deleting from database you keep your activity log information
safe without affecting database performance.

You always can restore the OKM_ACTIVITY logs in other database for doing forensic analytics.

MySQL
Linux

Create a file named clean_okm_activity.sh at /root/ folder:

#!/bin/sh

## BEGIN CONFIG ##

DATABASE PASS="*secret*"

BACKUP DIR="/mnt/backup/okm activity"
## END CONFIG ##

mysqldump -h localhost -u root —pSDATABASE_PASS -w"ACT DATE < (NOW() - INTERVAL 365
mysql -h localhost -u root -p$SDATABASE PASS okmdb < /root/delete.sql

Make clean_okm_activity.sh as executable file:

$chmod +x clean_okm_activity.sh

ST

Create a file named delete.sql at /root/ folder:

E DELETE FROM OKM ACTIVITY WHERE ACT DATE < (NOW() - INTERVAL 365 DAY);
1 ANALYZE TABLE ORKM ACTIVITY;

Configure crontab

To install the cron job, run:

$ sudo mkdir /root/logs

$ sudo crontab -e

And add these lines according to your personal configuration:

~———
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MAILTO=nomail@openkm.com
@daily /root/clean okm activity.sh | tee /root/logs/okm activity.$ (date +\8Y.\8m.\8d

i More information at Crontab quick reference

If you want to be notified by mail you should install " postfix" service in your server.

.4

Windows

Create a file named clean_okm_activity.bat at c:\backup folder:

' set SQLFILE DATE=$DATE:~6,4%.3%DATE:~3,2%.3DATE:~0,2%
! set SQLFILE TIME=$TIME:~0,2%.S$TIME:~3,2% !
| set SQOLFILE=c:\backup\okm activity-$SQLFILE DATE$-$SQLFILE TIME$%.sql :
1 set DATABASE PASS=*secret* 5

mysqgldump —-h localhost -u root -p3DATABASE PASS% -w"ACT DATE < (NOW() - INTERVAL 365
mysql —-h localhost -u root -p3DATABASE PASS% okmdb < delete.sql '

DELETE FROM OKM ACTIVITY WHERE ACT DATE < (NOW() - INTERVAL 365 DAY);
ANALYZE TABLE OKM ACTIVITY;

Database replication with federated tables

The procedure for using FEDERATED tables is very simple. Normally, you have two servers running, either both on the same
host or on different hosts. (It is possible for a FEDERATED table to use another table that is managed by the same server,

although there is little point in doing so.)

i You should have two database servers. Production MySQL server (A) and backup MySQL server (B).

TTTTTTTY

First of all must enable federated tables on production server. Stop MySQL production service service and edit the MySQL

configuration file ( my.cnf or my.ini depending on your OS ). Go to [mysqld] section and set below:

[mysqld]
# To enable federated feature

federated

Start your production MySQL service and execute from your preferred MySQL client tool the command:

show create table okm_activity:
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You will get something like:

' CREATE TABLE ‘okm activity' (
! "ACT ID' bigint (20) NOT NULL AUTO INCREMENT, !
: "ACT ACTION' varchar(127) COLLATE utf8 bin DEFAULT NULL, :
; "ACT DATE' datetime DEFAULT NULL, :
E ‘ACT ITEM' varchar(64) COLLATE utf8 bin DEFAULT NULL, E
: "ACT PARAMS' varchar (4000) COLLATE utf8 bin DEFAULT NULL, :
: "ACT PATH' longtext COLLATE utf8 bin, :
‘ACT TENANT' bigint (20) DEFAULT NULL,
! "ACT USER' varchar (64) COLLATE utf8 bin DEFAULT NULL, ;
: PRIMARY KEY ('ACT ID'), :
| KEY 'IDX ACTIVITY TENANT' ('ACT TENANT'), :
KEY ‘IDX ACTIVITY DATE' ('ACT DATE),
! KEY 'IDX ACTIVITY TNTUSRACT' ('ACT TENANT', ACT USER', ACT ACTION'), !
. KEY 'IDX ACTIVITY TNTDATACT' ('ACT TENANT', ACT DATE', ACT ACTION) :
| ) ENGINE=innodb DEFAULT CHARSET=utf8 COLLATE=utf8 bin |

Create the table "okm_activity" in your backup MySQL server.

Create the federated table in your production MySQL server ( take a look we have changed the table name, the

ENGINE=innodb for ENGINE=federated and we have added the connection link ):

CREATE TABLE "okm activity remote  (
\ACTiID\ bigint (20) NOT NULL AUTO INCREMENT,
\ACTiACTION\ varchar (127) COLLATE utf8 bin DEFAULT NULL,
\ACTiDATE‘ datetime DEFAULT NULL,
\ACTiITEM‘ varchar (64) COLLATE utf8 bin DEFAULT NULL,
\ACTiPARAMS\ varchar (4000) COLLATE utf8 bin DEFAULT NULL,
\ACTiPATH‘ longtext COLLATE utf8 bin,
\ACTiTENANT\ bigint (20) DEFAULT NULL,
\ACTiUSER‘ varchar (64) COLLATE utf8 bin DEFAULT NULL,
PRIMARY KEY (‘ACTiID\),
KEY ‘IDXiACTIVITYiTENANT\ (‘ACTiTENANT‘) o
KEY ‘IDXiACTIVITYiDATE‘ (\ACTiDATE\) 7
KEY ‘IDXiACTIVITYiTNTUSRACT\ (\ACTiTENANT\ 7 ‘ACTiUSER\ 7 \ACTiAC’TION\) 7
KEY ‘IDXiACTIVITYiTNTDATACT\ (\ACTiTENANT\ p ‘ACTiDATE\ 7 \ACTiACTION\)
) ENGINE=FEDERATED DEFAULT CHARSET=utf8 COLLATE=utf8 bin
CONNECTION='mysql://user:poassword@server b:3306/okmdb/okm activity';

select (NOW() - INTERVAL 1 DAY) into (@dump date;

insert into okm activity remote select * from okm activity where act date < (@dump da
delete from okm activity where act date < @dump date;

analyze table okm activity;
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Configuring Apache HTTP Reverse-Proxy

Exposing OpenKM directly from Tomcat can be risky, if you need the application to be accessed from the Internet (for example

https://issues.jboss.org/browse/JBAS-3861). It could be infected by PerlBot. 8080 may be blocked by a firewall, for this reason
is a recommendable to expose your OpenKM installation through the standard web port 80. In the following steps we explain

how to configure Apache to handle these requests and forward to Tomcat application server using the AJP13 protocol.

From the Apache documentation: The AJP13 protocol is packet-oriented. A binary format was presumably chosen over the
more readable plain text for performance reasons. The web server communicates with the servlet container over TCP
connections. To cut down on the expensive process of socket creation, the web server will attempt to maintain persistent TCP

connections to the servlet container, and to reuse a connection for multiple request/response cycles.

Internal IP vs external IP

Your OpenKM can be accessed from two different zones: Internet and LAN. This means that to access this server you need to

use two IPs: external IP (Internet) and internal IP (LAN).

The internal IP address (also known as "local IP address") is the address that is assigned by your local network router that
often begins with 192.168.x.x. These IP addresses can only be seen by other computers in your local network (LAN) and not by

any computers connected in an external network such the Internet.

To reach the Internet or a computer in another network your computer is often assigned an external IP address, which can then

be used to refer to the computer in your local network.
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In the above picture, there are three computers in the local network that have each been assigned their own internal IP address
by the router. The ISP is connected to the router and gives the router an external IP address that allows it to communicate with
the Internet. On the Internet everyone sees your external IP address, but any information coming from the router is "converted"

from the external IP address to the internal IP address.

So if you want your OpenKM installation accessible from both LAN and Internet, the trick here is to configure the client
computers to resolve your internal IP (192.168.0.50) if they are inside the LAN or the external IP if they are on Internet. To
resolve the Internet IP (67.166.214.148) your computer uses the public DNS. So, you need to configure a sort of DNS server

inside the LAN or modify every client host file to resolve to the internal IP.

Debian and Ubuntu

The first thing is to install the required Apache software. From Debian / Ubuntu you can install Apache with a single command:

$ sudo apt-get install apache2

ST

Edit the file named /etc/apache2/apache2.conf and configure a ServerName to prevent warnings in the Apache startup process:

ServerRoot "/etc/apache2"
ServerName "your-domain.com"
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- Edit apache2.conf is optional.

Enable the proxy module:

$ sudo a2enmod proxy_ajp

s
|
|
|
|
\

~———

Create the configuration file /etc/apache2/sites-available/openkm.conf with this content:

$ vim /etc/apache2/sites-available/openkm.conf

ST

<VirtualHost *:80>
ServerName openkm.your-domain.com
RedirectMatch */$ /OpenKM

ProxyPass /OpenKM ajp://127.0.0.1:8009/0penKM keepalive=0n
ProxyPassReverse /OpenKM http://openkm.your-domain.com/OpenKM

ErrorLog /var/log/apache2/openkm-error.log
CustomLog /var/log/apache’?/openkm-access.log combined
</VirtualHost>

The VirtualHost ServerName must be other than ServerName in the main Apache configuration. Enable this site configuration:

$ cd /etc/apache2/sites-available/

$ sudo aZensite openkm.conf

Check the configuration

Restart Apache:

$ sudo /etc/init.d/apache?2 restart

s
|
|
|
|
\

~———

Check the access your OpenKM installation from http://openkm.your-domain.com/.

p

V Another advantage of using Apache is that you can log OpenKM access and generate web statistics.

i To check the configuration files can execute the command:

{
| /usr/sbin/apache?2 -t
1

Red Hat and CentOS

Use the yum application manager to install Apache:
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$ sudo yum install httpd

s
|
|
|
|
\

~———

Enable it at boot:

{
- $ sudo chkconfig httpd —-level 2345 on
\,

~———

Now create the file /etc/httpd/conf.d/openkm.conf with this content:

$ vim /etc/httpd/conf.d/openkm.conf

ST

<VirtualHost *:80>
ServerName openkm.your-domain.com
RedirectMatch */$ /OpenKM

ProxyPass /OpenKM ajp://127.0.0.1:8009/0penKM keepalive=0n
ProxyPassReverse /OpenKM http://openkm.your-domain.com/OpenKM

ErrorLog /var/log/httpd/openkm-error.log
CustomLog /var/log/httpd/openkm-access.log combined
</VirtualHost>

Check the configuration

Restart Apache:

ST

$ sudo /etc/init.d/httpd restart

~———

Check the access your OpenKM installation from http://openkm.your-domain.conv.

V Another advantage of using Apache is that you can log OpenKM access and generate web statistics.

rTTTTT T

Windows

Install de apache webserver from http://httpd.apache.org/download.cgi ( windows binary no mod_ssl )

Edit the C:Program files\Apache Software Foundation\Apache2.2\conf\httpd.conf

# Enable proxy modules
LoadModule proxy module modules/mod proxy.so
LoadModule proxy ajp module modules/mod proxy ajp.so

#Add in bottom

NameVirtualHost *:80

<VirtualHost *:80>
ServerName openkm.your-domain.com
RedirectMatch */$ /OpenKM
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ProxyRequests Off
ProxyVia On

<Proxy *>
AddDefaultCharset off
Order deny,allow
Allow from all
Deny from All
</Proxy>

ProxyPass /OpenKM ajp://127.0.0.1:8009/0penKM keepalive=0n
ProxyPassReverse /OpenKM http://openkm.your-domain.com/OpenKM

ErrorLog logs/openkm-error log
CustomLog logs/openkm-access log common
</VirtualHost>

Max OS X

Edit the file called /etc/apache2/apache2.conf and configure a ServerName, enable proxy modules and mod_proxy:

ServerRoot "/usr"
ServerName "openkm.your-domain.com"

LoadModule proxy module libexec/apache2/mod proxy.so
LoadModule proxy ajp module libexec/apache2/mod proxy ajp.so

<IfModule mod proxy.c>
ProxyRequests Off
<Proxy "*">
AddDefaultCharset off
Allow from all
Deny from all
Order Deny,Allow
</Proxy>
ProxyVia On
</IfModule>

<VirtualHost *:80>
ServerName openkm.your-domain.com
RedirectMatch */$ /OpenKM

ProxyPass /OpenKM ajp://127.0.0.1:8009/0penKM keepalive=0n
ProxyPassReverse /OpenKM http://openkm.your-domain.com/OpenKM

ErrorLog /var/log/apache2/openkm-error.log
CustomLog /var/log/apacheZ2/openkm-access.log combined
</VirtualHost>

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE Page 153 of 1191

Check the configuration

Restart Apache:

Check the access to your OpenKM installation from http://openkm.your-domain.com/.

Another advantage of using Apache is that you can log OpenKM access and generate web statistics.

rTTTTT T

Troubleshooting

If you see an error message like:

Invalid command 'RewriteEngine', perhaps misspelled or defined by a module not included in the server

configuration

(TTTTTTTTY

——

You need to enable this Apache module:

-

$ sudo a2enmod rewrite
$ sudo a2enmod proxy_http

$ sudo a2enmod headers

R———

Additional information

o Apache Module mod_proxy

o Apache Module mod_proxy_ajp

o Apache Module mod_rewrite

e mod_rewrite, a beginner’s guide

e Using Apache Virtual Hosts and ProxyPass Together
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Configuring Apache HTTP for changing context URL

First of all you must have one of these configurations running on your server:

e Configuring Apache HTTP Reverse-Proxy

Configuring Apache HTTPS Reverse-Proxy

On the sample below the http://openkm.your-domain.co enKM/frontend has been rewrited to

http://openkm.yourdomain.com/frontend

TTTTTTTTY

Enable the headers module:

$ sudo a2enmod headers

To change /OpenKM application context try this as your VirtualHost configuration:

<VirtualHost *:80>
ServerName openkm.your-domain.com

ProxyPass / ajp://localhost:8009/0penKM/

ProxyPassReverse / http://openkm.your—-domain.com/OpenKM/

.*)S S1/0OpenKM/frontend/S2
ProxyPassReverseCookiePath /OpenKM /

ErrorLog /var/log/apache2/openkm-error.log

CustomLog /var/log/apacheZ2/openkm-access.log combined
</VirtualHost>

: RequestHeader edit X-GWT-Module-Base * (http://openkm.your-domain.com)/frontend/(

You need also set the configuration parameter system.apache.request.header.fix to on (true).
Additional information

e Apache configuration for GWT applications
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Configuring Apache HTTPS Reverse-Proxy

Exposing OpenKM directly from Tomcat can be dangerous if you need the application to be accessed from Internet (for example

https://issues.jboss.org/browse/IBAS-3861). As result you can be infected by PerlBot. Also this 8080 may be blocked by a
firewall. For these reasons, it is a good practice to expose your OpenKM installation through the standard web port 80. In the
following steps we explain how to configure Apache to handle these request and forward to Tomcat application server using the

AJP13 protocol.

From the Apache documentation: The AJP13 protocol is packet-oriented. A binary format was presumably chosen over the
more readable plain text for performance reasons. The web server communicates with the servlet container over TCP
connections. To cut down on the expensive process of socket creation, the web server will attempt to maintain persistent TCP

connections to the servlet container, and to reuse a connection for multiple request/response cycles.

Internal IP vs external IP

Your OpenKM can be accessed from two different zones: Internet and LAN. This means that to access this server you need to

use two IPs: external IP (Internet) and internal IP (LAN).

The internal IP address (also known as "local IP address") is the address that is assigned by your local network router that
often begins with 192.168.x.x. These IP addresses can only be seen by other computers in your local network (LAN) and not by

any computer connected in an external network such the Internet.

To reach the Internet or a computer in another network your computer is often assigned an external IP address, which can then

be used to refer to the computer in your local network.
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In the above picture, there are three computers in the local network that have each been assigned their own internal IP address
by the router. The ISP is connected to the router and gives the router an external IP address that allows it to communicate with
the Internet. On the Internet everyone sees your external IP address, but any information coming from the router is "converted"

from the external IP address to the internal IP address.

So if you want your OpenKM installation to be accessible from both LAN and Internet, the trick here is to configure the client
computers to resolve your internal IP (192.168.0.50) if they are inside the LAN or the external IP if they are on Internet. To
resolve the Internet IP (67.166.214.148) your computer uses the public DNS. So, you need to configure a sort of DNS server

inside the LAN or modify every client host file to resolve to the internal IP.

Debian and Ubuntu

The first thing in to install the required Apache software. From Debian / Ubuntu you can install Apache with a single command:

$ sudo apt-get install apache2

ST

Edit the file named /etc/apache2/apache2.conf and configure a ServerName to prevent warnings in the Apache startup process:

ServerRoot "/etc/apache2"
ServerName "your-domain.com"
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- Edit apache2.conf is optional.

Enable the proxy module:

$ sudo a2enmod proxy_ajp

s
|
|
|
|
\

~———

Create the Certificates

-~

$ sudo mkdir /etc/apache2/ssl
$ sudo /usr/sbin/make-ssl-cert /usr/share/ssl-cert/ssleay.cnf /etc/apache2/ssl/apache.pem

$ sudo a2enmod ssl

i If you need to convert .pem file to crt use the command:

{
| $ openssl x509 -in cacert.pem -out cacert.crt
\

V Also you could be interested on Configuring OpenSSL.

Ensure ports 443 is listen in /etc/apache2/ports.conf:

$ cat /etc/apache2/ports.conf | grep Listen

s
|
|
|
|
\

Create the configuration file /etc/apache2/sites-available/openkm.conf with this content:

<VirtualHost *:443>
ServerName openkm.your-domain.com
RedirectMatch */$ /OpenKM

ProxyPass /OpenKM ajp://127.0.0.1:8009/0penKM
ProxyPassReverse /OpenKM https://openkm.your-domain.com/OpenKM

ErrorLog /var/log/apache2/openkm.your-domain.com-error.log
CustomLog /var/log/apachel2/openkm.your-domain.com-access.log combined

SSLEngine on
SSLCertificateFile /etc/apache2/ssl/apache.pem
</VirtualHost>

The VirtualHost ServerName must be other than ServerName in the main Apache configuration. Enable this site configuration:

$ cd /etc/apache2/sites-available/

$ sudo aZensite openkm.conf
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Redirect all HTTP connections to HTTPS

i This step is optional.

TTTTTTTY

Edit the configuration file /etc/apache2/sites-available/openkm.conf and add these content

$ vim /etc/apache2/sites-available/openkm.conf

s
|
|
|
|
\

<VirtualHost *:80>

ServerName openkm.your-domain.com

Redirect permanent / https://openkm.your-domain.com/
</VirtualHost>

Check the configuration

Restart Apache:

$ sudo /etc/init.d/apache?2 restart

s
|
|
|
|
\

~———

Check the access your OpenKM installation from https://openkm.your-domain.com/.

P

V Another advantage of using Apache is that you can log OpenKM access and generate web statistics.

i To check the configuration files can execute the command:

{
| $ /usr/sbin/apache?2 -t
1

Red Hat and CentOS

Use the yum application manager to install Apache:

$ sudo yum install httpd

Enable it at boot:

$ sudo chkconfig httpd --level 2345 on

Create the Certificate

$ sudo yum install mod_ssl openssl crypto-utils

ST

Generate private keys ( for more information visit Apache HTTP Secure Server Configuration)

$ genkey your-domain.com

ST

TTTTTTY

i Usually you want to generate self-certificate and not sending it to Certify Authority. Is good practice to set a

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


http://openkm.your-domain.com/
http://www.linuxtopia.org/online_books/rhel5/rhel5_administration/rhel5_s1-httpd-secure-server.html
https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE

Page 159 of 1191

password on private key, but in this case each time you restart Apache service it'll be demanded.

T

V Also you could be interested on Configuring OpenSSL.

rTTTTT T

During the process will be generated two files at:

ReplaceSSLCertificateFile /etc/pki/tls/certs/your-domain.com.cert

SSLCertificateKeyFile /etc/pki/tls/private/your-domain.com.key

Now create the file /etc/httpd/conf.d/openkm.conf with this content:

$ vim /etc/httpd/conf.d/openkm.conf

Ve
i
|

|
\

' <VirtualHost *:443>
! ServerName openkm.your-domain.com

i ProxyPass / ajp://localhost:8009/0penkKM/
ProxyPassReverse / http://your-domain.com/OpenKM/

' ErrorLog /var/log/your-domain.com-error.log

! CustomLog /var/log/your-domain.com-access.log combined

SSLEngine on

SSLCertificateFile /etc/pki/tls/certs/your-domain.com.cert

SSLCertificateKeyFile /etc/pki/tls/private/your-domain.com.key
</VirtualHost>

SSLCertificateFile /etc/pki/tls/certs/your-domain.com.cert
SSLCertificateKeyFile /etc/pki/tls/private/your-domain.com.key

Check the configuration

Restart Apache:

$ sudo /etc/init.d/httpd restart

ST

~———

Check the access your OpenKM installation from https://openkm.your-domain.com/.

rTTTTT T

V Another advantage of using Apache is that you can log OpenKM access and generate web statistics.

Troubleshooting
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If you see an error like:

Invalid command 'RewriteEngine', perhaps misspelled or defined by a module not included in the server
configuration

(TTTTTTTTY

You need to enable this Apache module:

$ sudo a2enmod rewrite
$ sudo a2enmod proxy_http

$ sudo a2enmod headers

Additional information

¢ Apache Module mod_proxy

e Apache Module mod_proxy_ajp
o Apache Module mod_rewrite

e mod_rewrite, a beginner’s guide

e Using Apache Virtual Hosts and ProxyPass Together
e Rewrite HI'TP To HTTPS

e Redirect to SSL

e Configuracién SSL de Tomcat
e How To Create a SSL Certificate on Apache for CentOS 6
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Configuring Nginx HTTP Reverse-Proxy

Exposing OpenKM directly from Tomcat can be dangerous if you need the application to be accessed from the Internet (for

example https://issues.jboss.org/browse/JBAS-3861). As result it can be infected by PerlBot. Also this 8080 may be blocked by a
firewall. For these reasons, is a good idea to expose your OpenKM installation through the standard web port 80. In the
following steps we explain how to configure Apache to handle these requests and forward them to Tomcat application server

using the AJP13 protocol.

From the Apache documentation: The AJP13 protocol is packet-oriented. A binary format was presumably chosen over the
more readable plain text for reasons of performance. The web server communicates with the servlet container over TCP
connections. To cut down on the expensive process of socket creation, the web server will attempt to maintain persistent TCP

connections to the servlet container, and to reuse a connection for multiple request/response cycles.

Internal IP vs external IP

Your OpenKM can be accessed from two different zones: Internet and LAN. This means that to access this server you need to

use two IPs: external IP (Internet) and internal IP (LAN).

The internal IP address (also known as "local IP address") is the address that is assigned by your local network router that
often begins with 192.168.x.x. These IP addresses can only be seen by other computers in your local network (LAN) and not by

any computers connected in an external network such the Internet.

To reach the Internet or a computer in another network your computer is often assigned an external IP address, which can then

be used to refer to the computer in your local network.
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In the above picture, there are three computers in the local network that have each been assigned their own internal IP address
by the router. The ISP is connected to the router and gives the router an external IP address that allows it to communicate with
the Internet. On the Internet everyone sees your external IP address, but any information coming from the router is "converted"

from the external IP address to the internal IP address.

So if you want your OpenKM installation accessible from both LAN and Internet, the trick here is configure the client computers
to resolve your internal IP (192.168.0.50) if they are inside the LAN or the external IP if they are on the Internet. To resolve
the Internet IP (67.166.214.148) your computer uses the public DNS. So, you need to configure a sort of DNS server inside the

LAN or modify every client host file to resolve to the internal IP.

Debian and Ubuntu

The first thing in to install the required Apache software. From Debian / Ubuntu you can install Apache with a single command:

$ sudo apt-get install nginx

ST

Now create the configuration file /etc/nginx/sites-available/openkm with this content:

1 server {
i listen 80; ‘
i server name openkm.your-domain.com; i
# Avoid checking files size #
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client max body size 0;
rewrite /S /OpenKM/ permanent;

location /OpenKM/ {
proxy set header X-Forwarded-Host $host;
proxy set header X-Forwarded-Server $host;
proxy set header X-Forwarded-For $proxy add x forwarded for;
proxy pass http://localhost:8080/0penKM/ ;

Enable this site configuration:

$ In -s /etc/nginx/sites-available/openkm /etc/nginx/sites-enabled/

ST
(R

Check the configuration

Restart Nginx:

{
i $ sudo /etc/init.d/nginx restart
\,

~———

Check the access your OpenKM installation from http://openkm.your-domain.com/.

Another advantage of using Nginx is that you can log OpenKM access and generate web statistics.

rTTTTT T

Red Hat and CentOS

Use the yum application manager to install Nginx:

{
i $ sudo yum install nginx
\,

Enable it at boot:

$ sudo chkconfig nginx --level 2345 on

s
|
|
|
|
\

Depending on your CentOS version this Nginx version may be too old so it's better to install it from their repositories. To do

this, create a file called /etc/yum.repos.d/nginx.repo and include one on these configurations:

[nginx]
! name=nginx repo ‘
| baseurl=http://nginx.org/packages/centos/Sreleasever/Sbasearch/ ]
gpgcheck=0
' enabled=1 :
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RedHat

[nginx]
! name=nginx repo ‘
| baseurl=http://nginx.org/packages/rhel/Sreleasever/Shbasearch/ ]
gpgcheck=0
' enabled=1 :

{ )
i $ vim /etc/nginx/conf.d/openkm.conf i
\, J
Fr T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T TS T T T T T T 1
server {
P listen 80; '
i server name openkm.your-domain.com; i
# Avoid checking files size #
i client max body size 0; J
‘ rewrite */$ /OpenKM permanent; ‘
location /OpenKM {
i proxy set header X-Forwarded-Host $host; 1
proxy set header X-Forwarded-Server $host;
i proxy set header X-Forwarded-For $proxy add x forwarded for; i
! proxy pass http://localhost:8080/0OpenKM; i
E } |
D/ :
( |
i 1 Change openkm.your-domain.com with your server IP or your domain value. |

]
| ]
[ )

Check the configuration

Restart Nginx:

{
i $ sudo /etc/init.d/nginx restart
\,

~———

Check the access your OpenKM installation from http://openkm.your-domain.com/.

If you can't access server port from other machines, please take a look at your firewall configuration. For more info read How

To Set Up a Basic Iptables Firewall on Centos 6.

V Another advantage of using Nginx is that you can log OpenKM access and generate web statistics.

A In case you see this kind of errors in the Nginx log:

Execute this command and try again:
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s ]
i $ setsebool httpd_can_network_connect true | !
J

1
i
| i
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Configuring Lucene Analyzer

Depending on the language used in the documents and properties, you have obtain better search results configuring a proper

Lucene Analyzer.

By default, OpenKM use the org.apache.lucene.analysis.standard.StandardAnalyzer which works fine with English and most

languages, but you can get better search results configuring more specific analyzer for you language.

~

L]
1 Some analyzers:

org.apache.lucene.analysis.en.EnglishAnalyzer

org.apache.lucene.analysis.es.SpanishAnalyzer

org.apache.lucene.analysis.fr.FrenchAnalyzer

org.apache.lucene.analysis.it.ItalianAnalyzer

org.apache.lucene.analysis.de.GermanAnalyzer

org.apache.lucene.analysis.el.GreekAnalyzer

org.apache.lucene.analysis.hi.HindiAnalyzer

More information at:

e Analyzer
e ReusableAnalyzerBase
e StopwordAnalyzerBase

If you are working with oriental languages like Chinese or Japanese you have several analyzers to use. Read

Lucene documentation. You can also try ik-analyzer

A If you want only a white space tokenized analyzer can try with this one WhitespaceAnalyzer.

If you have not configured the search analyzer before the first time you start OpenKM, then Lucene indexed will be created

using this default analyzer.

A If you want to change this configuration property after the OpenKM repository has been created you need to

Rebuild Lucene Indexes.
Once the operation has been completed, the Lucene indexes will be using the new analyzer.

For more information take a look at Rebuild indexes.

Configure an Analyzer
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Edit the STOMCAT_HOME/OpenKM.cfg file and add the line:
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Configuring OCR engine

OpenKM can work with several OCR engines, for example Tesseract 2.x, Tesseract 3.x, Cuneiform or Abby among others.

V OpenKM can be integrated with any OCR engine that can be executed from command line.

rTTTTT T

Tesseract

Tesseract is an Open Source OCR engine adopted by Goggle. It works really well. The OCR natively can read TIFF documents

and has hight ratio of recognition with images 300 dpi of resolution and converted to lineart (1 bit color).
The supported image formats are:

e TIFF
e PNG
o JPG

e GIF

Installation

(0 Description

Ubuntu and Debian $ apt-get install tesseract-ocr tesseract-ocr-eng

A Depending on your locale you would like to install other language file.

More information at:

o https://github.com/tesseract-ocr

o https://code.google.com/p/tesseract-ocr/

Red Hat and CentOS  More information at:

e https://code.google.com/p/tesseract-ocr/wiki/Compiling
e https://code.google.com/p/python-tesseract/wiki/HowToCompileForCentos
o http://www.vicchiam.com/blog/?p=168

Windows Download from https://code.google.com/p/tesseract-ocr/ and follow the installation wizard.
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Check installation

From command line execute ( where image.jpg should be an existing image file ):

$ tesseract image.jpg text

i The file image.jpg is an image file.

If all goes right a file named text.txt what contains the extracted text will be created.

Configuration

Go to Administration > Configuration parameters and edit the parameter named system.ocr:

(0}
. /usr/bin/tesseract ${fileIn} ${fileOut}
Linux
or
/usr/bin/tesseract S{fileIn} S{fileOut} -1 esp
i The parameter -1 esp indicate must be used the Spanish language support while executing
OCR.
To see all tesseract options execute:
i Y
I $ tesseract i
\,
. c:\Tesseract-ocr-3.0.2\tesseract.exe ${fileIn} ${fileOut}
Windows

or

c:\Tesseract-ocr-3.0.2\tesseract.exe S{fileIn} S{fileOut} -1 spa
The parameter -1 esp indicate must be used the Spanish language support while executing OCR.

To see all tesseract options execute:

c:\Tesseract-ocr-3.0.2> tesseract.exe

P
|
|
|
|
\

~———

Parameter ${fileIn} will be replaced internally by image document to be processed.
Parameter ${fileOut} will be replaced internally by temporal text file.

Can set other additional parameters like -1 spa parameter in example.

{

1

i A Each parameter is separated by a single "white space".
1

[
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S

Additional information

e http://code.google.com/p/tesseract-ocr/
e Tesseract - Summary & first experiences.

o Tesseract OCR Google Groups

e First Interactions with Tesseract OCR on Ubuntu Linux

e http://code.google.com/p/tesseract-ocr/wiki/ReadMe
e http://code.google.com/p/tesseract-ocr/wiki/FAQ

Cuneiform

(

| i We recommend the use of Tesseract rather than cuneiform.
I

I

|

The supported image formats are:

e TIFF
e PNG
o JPG

e GIF

Installation

(00

Ubuntu and Debian

Red Hat and Centos

Windows

Description

~

$ apt-get install cuneiform

More information at:

e http://cognitiveforms.com/products_and_services/cuneiform

More information at:

e http://cognitiveforms.com/products_and_services/cuneiform

A Not available to be executed from command line.

More information at:
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e http://cognitiveforms.com/products_and_services/cuneiform

Check installation

From command line execute ( where image.jpg should be an existing image file ):

$ cuneiform image.jpg -o text.txt

i The file image.jpg is an image file.

If all goes right a file named text.txt what contains the extracted text will be created.

Configuration
Go to Administration > Configuration parameters and edit the parameter named system.ocr:
(0}

. /usr/bin/cuneiform S${fileIn} -o S{fileOut}
Linux

or

/usr/bin/cuneiform S${fileIn} -o S{fileOut} -1 esp

i The parameter -1 esp indicate must be used the Spanish language support while executing
OCR.

To see all cuneiform options execute:

$ cuneiform

Windows Not available.

Parameter ${fileIn} will be replaced internally by image document to be processed.

Parameter ${fileOut} will be replaced internally by temporal text file.

Can set other additional parameters like -1 spa parameter in example.

A Before the ${fileOut} must be set -o parameter.

Each parameter is separated by a single "white space".

S m——
S—

Abby OCR for linux
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OCR4 Linux is a commercial OCR engine. It is the slowest of all tested tools, but keep in mind that it also reads nearly any

image format, while you probably need to convert your images for the other tools first.
Installation

oS Description

Ubuntu, Debian, Red Hat and Centos More information at:

o http://www.ocr4linux.com/

Windows Not available.

Check installation
From command line execute ( where image.jpg should be an existing image file ):

$ /usr/local/bin/abbyyocr9 abbyyocr11 -ii -fm -if image.jpg -tet UTF8 -of text.txt

i The file image.jpg is an image file.

If all goes right will be created a file named text.txt what contains the extracted text.

|

Configuration
Go to Administration > Configuration parameters and edit the parameter named system.ocr:
(0}

Li /usr/local/bin/abbyyocrll -ii -fm -if ${fileIn} -tet UTF8 -of
inux

s${fileOut}

There're a lot of parameters, to see all ocr4linux options execute:

$ abbyyocri1 -?

F—— TN
| S

Windows Not available.

Parameter ${fileIn} will be replaced internally by image document to be processed.
Parameter ${fileOut} will be replaced internally by temporal text file.

Can set other additional parameters like -1 spa parameter in example.
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{
1
i A Each parameter is separated by a single "white space".
1
1

Dictionary

You can also use an OpenOffice.org dictionary to enhance the OCR process. Can find these language specific dictionaries at

OpenOffice.org Dictionary Repository.
Configuration

Go to Administration > Configuration parameters and edit the parameter named system.openoffice.dictionary:

oS
. /home/openkm/dictionary/en-GB.zip
Linux
. c:\tomcat-7.0.61\dictionary\en-GB.zip
Windows

\
|
|
|
|
|
|
J

p
|
1
| A Dictionaries comes in .zip or oxt format. Can use both.
1
1
|

OCR rotate configuration

There's a configuration parameter that force document ocr on rotated document.

rTTTTT T

V The feature is useful for example in upside down scanned pages, where standard OCR direction will fails.

Configuration
Go to Administration > Configuration parameters and edit the parameter named system.ocr.rotate:

Property Description

mon

system.ocr.rotate The parameter is a collection of degrees separated by character ";

0,90;,180;270;

Additional information:

e Linux OCR Software Comparison
e Tesseract OCR

e Cuneiform
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e Ocropy

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://github.com/tmbdev/ocropy
http://jocr.sourceforge.net/
http://www.gnu.org/software/ocrad/
https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE Page 175 of 1191

Configuring OpenSSL

Create OpenSSL configuration file

This sample has been done with Ubuntu and Debian server, for Red Hat and CentOS the path of Apache files is
not the same.

On Ubuntu and Debian the Apache path /etc/apache?2 is /etc/httpd on Red Hat and CentOS.

—_————— e —
——

Edit file /etc/ssl/openssl.cnf

$ vim /etc/ssl/openssl.cnf

RANDFILE = $ENV::SSLDIR/.rnd
[ ca]
default ca = CA default

[ CA default ]

dir = /opt/ca

certs = Sdir/certs

new certs dir = §dir/newcerts

crl dir = $dir/crl

database = Sdir/index.txt
private key = Sdir/private/ca.key
certificate = Sdir/ca.crt

serial = Sdir/serial

crl = Sdir/crl.pem
RANDFILE = Sdir/private/.rand
default days = 365
default crl days = 30

default md = shal

preserve = no

policy = policy anything
name opt = ca default

cert opt = ca default

[ policy anything ]

countryName = optional
stateOrProvinceName = optional
localityName = optional
organizationName = optional
organizationalUnitName = optional
commonName = supplied
emailAddress = optional

[ req ]

default bits = 2048
default md = shal
default keyfile = privkey.pem
distinguished name = req distinguished name
x509 extensions = v3 ca
string mask = nombstr

[ req distinguished name ]

countryName = Country Name (2 letter code)
countryName min = Z

countryName max = Z

stateOrProvinceName = State or Province Name (full name)
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nsComment
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‘ localityName = Locality Name (eg, city) ‘
E 0.organizationName = Organization Name (eg, company) E
! organizationalUnitName = Organizational Unit Name (eg, section) J
i commonName = Common Name (eg, YOUR name) ]
i commonName max = 64 1
E emailAddress = Email Address E
i emailAddress max = 64 I
E [ usr cert ] E
! basicConstraints = CA:FALSE i
| # nsCaRevocationUrl = https://url-to-exposed-clr-list/crl.pem t
E [ ssl server ] E
! basicConstraints = CA:FALSE J
i nsCertType = server

E keyUsage = digitalSignature, keyEncipherment E
P extendedKeyUsage = serverAuth, nsSGC, msSGC ]
! nsComment = "OpenSSL Certificate for SSL Web Server" ]
E [ ssl client ] E
! basicConstraints = CA:FALSE ]
] nsCertType = client '
: keyUsage = digitalSignature, keyEncipherment 1
E extendedKeyUsage = clientAuth E
! nsComment = "OpenSSL Certificate for SSL Client" d
E [ v3 req ] E
! basicConstraints = CA:FALSE i
i keyUsage = nonRepudiation, digitalSignature, keyEncipherment ]
E [ v3 ca ] E
! basicConstraints = critical, CA:true, pathlen:0 J
: nsCertType = ss1CA '
E keyUsage = CRLSign, keyCertSign E
P extendedKeyUsage = serverAuth, clientAuth i
! nsComment = "OpenSSL CA Certificate" ]

Create Certification Authority (CA)

Create folder structure to hold certificates:

$ mkdir /opt/met-ca

$ mkdir /opt/met-ca/certs

$ mkdir /opt/met-ca/crl

$ mkdir /opt/met-ca/newcerts

$ mkdir /opt/met-ca/private

$ mkdir /opt/met-ca/requests

$ touch /opt/met-ca/index.txt

$ echo “01” > /opt/ca/serial

$ echo “01” > /opt/ca/crinumber

$ chmod 700 /opt/ca
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Create public and private auto signed keys of our own Certification Authority ( in the example is valid for 10 years ). We will

need to specify certificate data, password to crypt and the process will generate two files:

3 openssl req -config /etc/ssl/openssl.cnf -new -x509 -days 3650 -shal -newkey rsa:2048 -keyout /opt/ca/private/ca.key -out

/opt/ca/ca.crt

Change key grants:

$ chmod 600 /opt/met-ca/private/ca.key

Create Apache Certification

Create a pair of keys. We will need to specify password and certification data. Will be created the file key ( server.key ) and

certification request (server.pem).

$ openssl req -new -shal -newkey rsa:2048 -nodes -keyout server.key -out server.pem

CA should sign the certification request. Copy server.pem to certification request and sign.

$ openssl ca -config /etc/ssl/openssl.cnf -policy policy_anything -extensions ssl_server -out requests/server-signed.pem -

infiles requests/server.pem

Apache will be waiting a PEM format, is mandatory convert to this format:

$ openssl x509 -in requests/server-signed.pem -out requests/server.crt

Apache configuration

Copy server.crt and server.key into /etc/apache2/ssl (if SSL folder not exists, create it ). Change files grants ( server.key should

only be read by root user, server.crt should have read grant to everybody ):

$ chmod 400 server.key

$ chmod 444 server.crt

If Apache is not listening SSL port, enable it configuring /etc/apache2/ports.conf:

Listen 80
Listen 443

Enable Apache SSL support:

$ apt-get install libapache-mod-ssl

Indicate Apache to load SSL modules:
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$ a2enmod ssl

FTTTTY
|

Configure website:

Link default-ssl file to enable SSL:

$ In -s /etc/apache2/sites-available/default-ssl /etc/apache2/sites-enabled/default-ssl

ST
(R

Edit /etc/apache2/sites-availables/default-ssl ( enable SSL engine and set SSLCertificateFile and SSLCertificateKeyFile )

SSLEngine on
' SSLCertificateFile /etc/apache2/ssl/server.crt i
| SSLCertificateKeyFile /etc/apache2/ssl/server.key 1

Create user certificate:

To create certificates and sign with CA, first create the pair of keys. We will need to specify password and certification data.

Will be created a eky (user.key) and certification request ( user.pem ):

$ openssl req -new -shal -newkey rsa:2048 -nodes -keyout user.key -out user.pem

ST
(R

With CA is needed sign certificates:

-

$ cp /tmp/usuario.pem /opt/ca/requests

$ openssl ca -config /etc/ssl/openssl.cnf -policy policy_anything -extensions [b]ssl_client[/b] -out requests/user-signed.pem -

R———

infiles requests/user.pem

Convert certificate to PKCS12 to be recognized by browser

{
i $ openssl pkcs12 -export -clcerts -in user-signed.pem -inkey usuario.key -out user.p12
\,

~———

The files user-signed.pem, user.pem and user.key can be deleted

$ wipe user-signed.pem user.key user.pem

ST
(R

A The user.p12 should be installed to allow user browser.

TTTTT TN

Certification revocation

If the server has been compromised the CA should be revocated. To revocate a certificate should see serial number at

/opt/ca/index.txt.

$ openssl ca -config /etc/ssl/openssl.cnf -revoke newcerts/<serial-number>.pem

ST
(R

Creat a list of revocated certificates ( CRL )
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$ openssl ca -config /etc/ssl/openssl.cnf -gencrl -crlexts crl_ext -md shal -out crl.pem

ST
(R

To send to the browser list should be converted to DER format:

$ openssl crl -in crl.pem -out ca.crl -outform DER

ST
(R

Now can be sent to browser.

Add CRL to Apache

Copy CRL file to Apache SSL folder:

$ cp /tmp/crl.pem /etc/apache2/ssl/ca.crl

s
|
|
|
|
\

~———

Modify /etc/apache2/sites-available/default-ssl file, add SSLCARevocationFile:

Restart Apache service.
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Configuring SWFTools

By default the application comes with tomcat bundle with pre-configured SWFTools into.

P

A In most cases it is not necessary installi SWFTools in your server. Only in case it presents some problem with

pre-configured SWFTools into tomcat bundle.

i Application take advantage of SWFTools to convert PDF document to SWF to be shown into UI preview tab.
See FlexPaper: Converting Documents for more info.
Ubuntu

sudo add-apt-repository ppa:guilhem-fr/swftools
sudo apt-get update

sudo apt-get install swftools

Improving performance

For better performance, use this configuration.

Property Description

system.swftools.pdf2swf  Pdf2swf tool used to convert PDF documents to SWF.

/usr/bin/pdf2swf -T 9 -f -t -G -s storeallcharacters

S{fileIn} -o S{fileOut}

The parameters specifies that:

¢ -f: Fonts should be embedded, improves searchability in the document

-t : Inserts a stop between each frame, improves stability

¢ -G : Makes the document smaller and faster to render

-s storeallcharacters : Stores all character information about the texts in the document, improves searchability

Red Hat and Centos

Better if you compile version 0.9.x

yum install zlib-devel libjpeg-devel giflib-devel freetype-devel gcc gcc-c++
wget http://www.swftools.org/swftools-0.9.1.tar.gz

tar xzf swftools-0.9.1.tar.gz
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cd swftools-0.9.1
/configure --prefix=/usr/local
make

make install

Improving performance

For better performance, use this configuration.

Property Description

system.swftools.pdf2swf  Pdf2swf tool used to convert PDF documents to SWF.

/usr/bin/pdf2swf -T 9 -f -t -G -s storeallcharacters

S{fileIn} -o S{fileOut}

The parameters specifies that:

¢ -f: Fonts should be embedded, improves searchability in the document
e -t : Inserts a stop between each frame, improves stability
¢ -G : Makes the document smaller and faster to render

e -s storeallcharacters : Stores all character information about the texts in the document, improves searchability

i Take a look at pdf2swf wiki for complete parameters reference.

TTTTTTTY

Debian

This package is not include in the Debian repositories, so you need to compile from source:

aptitude install build-essential libgif-dev xpdf libfreetype6 libfreetype6-dev libjpeg62 libjpeg8 libjpeg8-dev
wget http://www.swftools.org/swftools-0.9.1.tar.gz

tar xzf swftools-0.9.1.tar.gz

cd swftools-0.9.1

./configure --prefix=/usr/local

make

make install

i Or you can try to install the Ubuntu package.

TTTTTTTY

Take a look at pdf2swf wiki for complete parameters reference.

Y
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Improving performance
For better performance, use this configuration.

Property Description

system.swftools.pdf2swf  Pdf2swf tool used to convert PDF documents to SWF.

/usr/bin/pdf2swf -T 9 -f -t -G -s storeallcharacters

S{fileIn} -o S{fileOut}

The parameters specifies that:

e -f : Fonts should be embedded, improves searchability in the document

-t : Inserts a stop between each frame, improves stability
e -G : Makes the document smaller and faster to render

-s storeallcharacters : Stores all character information about the texts in the document, improves searchability

Windows
Download last Swftools http://www.swftools.org/download.html and install it ( for example at c:\tomcat-7.0.61\tools\swftools ).
Improving performance

For better performance, use this configuration.

Property Description

system.swftools.pdf2swf  Pdf2swf tool used to convert PDF documents to swf.

c:\tomcat-7.0.61\tools\swftools\pdf2swf.exe -T 9 -f -t -G -s

storeallcharacters S{fileIn} -o S{fileOut}

The parameters specifies that:

e -f: Fonts should be embedded, improves searchability in the document

-t : Inserts a stop between each frame, improves stability
e -G : Makes the document smaller and faster to render

-s storeallcharacters : Stores all character information about the texts in the document, improves searchability

Take a look at pdf2swf wiki for complete parameters reference.

TTTTTTTY
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Troubleshooting

Conversion problems with big files

If the document is large (has many pages) or is complex, the conversion may fail with this error:

P

n ERROR ID Table overflow

S~

ERROR This file is too complex to render- SWF only supports 65536 shapes at once

You can workaround this error adding the -s poly2bitmap parameter which convert graphics to bitmaps:
Property Description

/usr/bin/pdf2swf -T 9 -f -t -G -s poly2bitmap -s
system.swftools.pdf2swf
storeallcharacters ${fileIn} -o S{fileOut}

Segmentation fault ( core dumpled )
This is a log of segmentation fault error:

/home/openkm/tomcat-7.0.61/bin/pdf2swf -f -T 9 -t -s storeallcharacters input.pdf -o output.swf
NOTICE processing PDF page 1 (878x1105:0:0) (move:0:0)

NOTICE File contains forms

NOTICE File contains pbm pictures

NOTICE File contains soft masks

WARNING multiply blended transparency groups not yet supported!

NOTICE File contains transparency groups

Segmentation fault (core dumped)

You can try the -s poly2bitmap or -s bitmap arguments. In our experience it seems the bitmap option is more reliable for fixing
display issues, but of course you decimate any text, and in some cases increase file size and processing time. You can also add
the -s multiply=4 the bitmap argument to get a really crisp bitmap output further increasing size and processing time, but gets

you pretty close to the original PDF.

/home/openkm/tomcat-7.0.61/bin/pdf2swf -f -T 9 -t -s bitmap -s storeallcharacters input.pdf -o output.swf
NOTICE processing PDF page 1 (878x1105:0:0) (move:0:0)

NOTICE Writing SWF file output.swf

Error with PDF with copy protected

Perhaps the PDF is copy protected. Hence, you're not allowed to convert it.
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ﬁ FATAL PDF disallows copying

TTTTTTTY

If you created this PDF using Acrobat Distiller, try switching the copy protection checkbox off. If you can't disable the

protection you can modify the 'pdf2swf source code to disable this check (see http://www.foolabs.com/xpdf/cracking.html).

The pre-configured pdf2swf tool into tomcat bundle comes with this hacking.

TTTTTTTY
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Configuring mail

The application sometimes sends emails to users, for example when the users have been subscribed to a document or folder.

p-

A By default tomcat mail is configured assuming your server has a mail service binding in your localhost.
This is the default value in the STOMCAT_HOME/conf/server.xml file.

<Resource auth="Container" name="mail/OpenKM" type="javax.mail.Session"
mail.from="testing@openkm.com" mail.smtp.host="localhost" />

Change mail configuration
Get your mail account data ( same than you will use to configure standard mail client, like Outlook or Thunderbird ).

Edit the file $STOMCAT_HOME/conf/server.xml:

ST

vim /home/openkm/tomcat/conf/server.xml

~———

After editing the server.xml should looks something like this:

<Resource name="mail/OpenKM" type="javax.mail.Session"
mail.transport.protocol="smtp"
mail.smtp.auth="true"
mail.smtp.host="your smtp server"
mail.smtp.user="<username>"
password="<password>"
mail.port="25"
mail.debug="true"/>

<Resource name="mail/OpenKM" auth="Container" type="javax.mail.Session"
mail.transport.protocol="smtp"
mail.smtp.auth="true"
mail.smtp.host="smtp.gmail.com"
mail.smtp.port="465"
mail.smtp.user="<username>"
password="<password>"
mail.from="<sender email>"
mail.smtp.quitwait="false"
mail.smtp.starttls.enable="true"
mail.smtp.socketFactory.class="javax.net.ssl.SSLSocketFactory"
mail.debug="true"/>

<Resource name="mail/OpenKM" auth="Container" type="javax.mail.Session"
! mail.transport.protocol="smtp"
i mail.smtp.starttls.enable="true"
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mail.smtp.auth="true"
mail.smtp.host="smtp.office365.com"
mail.smtp.port="587"
mail.smtp.user="<username>"
mail.from="<username>"
password="<password>"
mail.debug="true" />

Additional information

p

V Optionally, you can use these attributes :

e mail.user="<username>"

If you get problems during tomcat startup, can try using the attribute mail.smtp.quitwait="false".

i A complete list of all available parameters can be found at sun.mail.smtp package Javadoc and javax.mail
package Javadoc.
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Configuring Tomcat memory utilization

It's also a good idea to configure the Tomcat memory utilization.

Edit the file $STOMCAT_HOME/bin/setenv.sh and edit the parameter JAVA_OPTS where you can increase the system memory

managed by the JVM (Java Virtual Machine).

OpenJDK 1.8

This is the default configuration file values. Tomcat will you 2048MB ( Xmx parameter ) and a heap is dinamically reserved by
the JVM. For this configuration your server needs at least >=3.5GB of RAM ( Is a good practice always getting 1GB of free

RAM for OS).

JAVA OPTS="$JAVA OPTS -Xms256m -Xmx2048m -XX:+UseConcMarkSweepGC"

! JAVA OPTS="$JAVA OPTS -Djava.awt.headless=true -Dlog4j.configuration=file://$CATALINA
| JAVA OPTS="$JAVA OPTS -Dfile.encoding=UTF-8 -Dsun.jnu.encoding=UTF-8 -Dmail.mime.igno
‘ CATALINAiPID=$CATALINAiHOME/catalina.pid

export LD LIBRARY PATH=$LD LIBRARY PATH: $CATALINA7HOME/_Z ib/sigar

OpenJDK 1.7

This is the default configuration file values. Tomcat will you 2048MB ( Xmx parameter ) and a maximum heap of 512MB ( -
XX:MaxPermSize parameter ). For this configuration your server needs at least >=3.5GB of RAM ( Is a good practice always

getting 1GB of free RAM for OS).

JAVA OPTS="$JAVA OPTS -Xms256m -Xmx2048m -XX:PermSize=256m -XX:MaxPermSize=512m -XX: :+
! JAVA OPTS="$JAVA OPTS -Djava.awt.headless=true -Dlog4j.configuration=rfile: //SCATALIMA
i JAVAﬁOPTS—"$JAVAﬁOPTS -Dfile.encoding=UTF-8 -Dsun.jnu.encoding=UTF-8 -Dmail.mime.igno
‘ CATALINAiPID=$CATALINA7HOME/ca talina.pid

E export LDﬁLIBRARYiPATH=$LD7LIBRARYiPATH:$CATALINA7HOME/lib/sigar
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Configuring Tomcat port

By default the tomcat binding ports are 8005, 8080 and 8009.

If you have other tomcat running on same server or other application like JBoss Application Server, probably

these ports are already used. In this case you should change default ports.

TTTTT T T

Change tomcat ports

A The port change must be done with the tomcat application stopped.

TTTTT TN

Edit STOMCAT_HOME/confg/server.xml and look for all Tomcat port properties.

Service Default port Example of new port
Shut-down 8005 8105
Port
Change

<Server port="8005" shutdown="SHUTDOWN'">

to

<Server port="8105" shutdown="SHUTDOWN'">

Tomcat 8080 8180
Connector
Port Change

<Connector address="0.0.0.0" connectionTimeout="20000" port="8080"
protocol="HTTP/1.1" redirectPort="8443"/>
to

<Connector address="0.0.0.0" connectionTimeout="20000" port="8180"

protocol="HTTP/1.1" redirectPort="8443"/>

AJP 8009 8109
Connector
Port Change
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<Connector address="127.0.0.1" port="8009" protocol="AJP/1.3"
redirectPort="8443"/>
to

<Connector address="127.0.0.1" port="8109" protocol="AJP/1.3"

redirectPort="8443"/>

i To shut-down the different instances execute the shutdown.sh script from each $TOMCAT_HOME/bin.

TTTTTTTY
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Configuring Tomcat session time-out

By default the session time-out is set to 30 minutes.

To change the Tomcat session time-out, edit the STOMCAT_HOME/conf/web.xml and change the values into the session

section:

Fr T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T T TS T T T T T T 1
<!-- You can set the default session timeout (in minutes) for all newly ==
<!-- created sessions by modifying the value below. -=>

<session-timeout>30</session-timeout>

\ <session-config> :
' </session-config> :
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Configuring Tomcat SSL/TLS

Secure Sockets Layer (SSL) and the new Transport Layer Security (TLS), are cryptographic protocols designed to provide a
secure communication between two computers. They use certificates and cryptography to authenticate the counterpart with
whom they are communicating and to negotiate a session key. This session key is used to encrypt data between the endpoints. A
consequence of using certificates, is that Certificate Authorities (CA) and a public key infrastructure are necessary to verify the
relation between a certificate and its owner, as well as to generate, sign, and administer the validity of certificates. Due to this

reason you have two options to configure SSL:

o Self-signed Certificate: it's free because you create your own certificate.

¢ CA Certificate: It cost money because you need to pay for it to a certification authority.

Tomcat currently operates only on JKS, PKCS11 or PKCS12 format keystores. The JKS format is Java's standard "Java
KeyStore" format, and is the format created by the key tool command-line utility. This tool is included in the OpenJDK. The
PKCS12 format is an Internet standard, and can be manipulated via (among other things) OpenSSL and Microsoft's Key-

Manager.

Each entry in a key store is identified by an alias string. Whilst many key store implementations treat aliases in a case non
sensitive manner, case sensitive implementations are available. The PKCS11 specification, for example, requires that aliases
are case sensitive. To avoid issues related to the case sensitivity of aliases, it is not recommended to use aliases that differ only

in case.

Self-signed Certificate

Create the Certificate Key store

$ keytool -genkey -alias tomcat -keyalg RSA -keystore self-signed.jks

Enter keystore password: ***¥*x%

Re-enter new password: ****x**

What is your first and last name? [Unknown]: Self-Signed Certificate

What is the name of your organizational unit? [Unknown]: System Management
What is the name of your organization? [Unknown]: OpenKM

What is the name of your City or Locality? [Unknown]: Palma de Mallorca
What is the name of your State or Province? [Unknown]: Islas Baleares

What is the two-letter country code for this unit? [Unknown]: ES

Is CN=Self-Signed Certificate, OU=System Management, O=OpenKM, L=Palma de Mallorca, ST=Islas Baleares, C=ES
correct?

[no]: yes
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Enter key password for <tomcat>

(RETURN if same as keystore password):

i The password changeit is the default password set into STOMCAT_HOME/conf/server.xml file

TTTTTTTY

Edit the Tomcat Configuration file

Enable the SSL connector:

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"
maxThreads="150" scheme="https" secure="true" ]
clientAuth="false" sslProtocol="TLS" '
keystoreFile="S{catalina.home}/sef-signed.jks" keystorePass="changeit" key.

Check configuration

Restart Tomcat service and check your OpenKM URL with https://YOUR_SERVER_IP:8443/OpenKM.

CA Certificate

Prepare the Certificate Key store

$ keytool -genkey -alias tomcat -keyalg RSA -keystore ca-signed.jks

Enter keystore password: ****¥*x%

Re-enter new password: ****x**

What is your first and last name? [Unknown]: CA-Signed Certificate

What is the name of your organizational unit? [Unknown]: System Management
What is the name of your organization? [Unknown]: OpenKM

What is the name of your City or Locality? [Unknown]: Palma de Mallorca
What is the name of your State or Province? [Unknown]: Islas Baleares

What is the two-letter country code for this unit? [Unknown]: ES

Is CN=Self-Signed Certificate, OU=System Management, O=OpenKM, L=Palma de Mallorca, ST=Islas Baleares, C=ES
correct?

[no]: yes

Enter key password for <tomcat>

(RETURN if same as keystore password):

i The password changeit is the default password set into STOMCAT_HOME/conf/server.xml file

TTTTTTTY

Create the Certificate Signing Request
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This step is different from the self-signed certificate because you need to send this information to the Certification Authority
(CA) which need to validate and sign. Your chosen CA will send you back some files with the Root Certificate the Intermediate

Certificates and the Primary Certificate (which is the certificate created for you,).

$ keytool -certreq -keyalg RSA -alias tomcat -file ca-signed.csr -keystore ca-signed.jks

Install the Root Certificate

Every time you install a certificate to the key store you must enter the key store password that you chose when you generated it.

Enter the following command to install the Root Certificate file:

$ keytool -import -trustcacerts -alias root -file RootCertFileName.crt -keystore ca-signed.jks

If you receive a message that says "Certificate already exists in system-wide CA keystore under alias <...> Do you still want to

add it to your own keystore? [no]:", select Yes. If successful, you will see "Certificate was added to keystore".
Install the Intermediate Certificate

If your certificate authority provided an intermediate certificate file, you will need to install it here by typing the following

command:

$ keytool -import -trustcacerts -alias intermediate -file IntermediateCertFileName.crt -keystore ca-signed.jks
If successful, you will see "Certificate was added to keystore".
Install the Primary Certificate

Type the following command to install the Primary certificate file (for your domain name):

3$ keytool -import -trustcacerts -alias tomcat -file PrimaryCertFileName.crt -keystore ca-signed.jks

i The command $ keytool -list -keystore ca-signed.jks -v shows all certificates imported.

TTTTTTTY

Edit the Tomcat Configuration file

Enable the SSL connector:

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"
maxThreads="150" scheme="https" secure="true"
clientAuth="false" sslProtocol="TLS"

Check configuration

Restart Tomcat service and check your OpenKM URL with https://YOUR_SERVER_IP:8443/OpenKM.
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CA Certificate without preparing keystore

Sometimes the person who installs the certificate is not the same that made the request to obtain the certificate. In this case

every step is similar to the previous one with the exception of the installation of the Primary Certificate.

In this case, when the primary certificate is installed, it is necesary to install the private RSA key too. To do it, apart from the

primary certificate, the private RSA key must be given.

Obtain p12 certficate

Obtain p12 certificate from private key and primary certificate. This is the way that both keys are installed.
$ openssl pkes12 -export -in PrimaryCertFileName.crt -inkey privateRSA.key > PrimaryCertFileName.p12

If successful, PrimaryCertFileName.p12 certificate will be created.

Install p12 Certificate

Type the following command to install the .p12 certificate file (for your domain name):

$ keytool -v -importkeystore -srckeystore PrimaryCertFileName.p12 -srcstoretype PKCS12 -destkeystore ca-signed.jks -

deststoretype JKS

If successful, you will see "Certificate was added to keystore".
Change alias to Primary Certificate
Type the following command to install the .p12 certificate file (for your domain name):

$ keytool -changealias -keystore ca-signed.jks -alias 1 -destalias tomcat

Let's Encrypt
Let's Encrypt uses a client application which automates the certificate generation and renovation.
Client installation

In Linux you can install the tool with these commands:

$ wget https://dl.eff.org/certbot-auto

$ chmod a+x certbot-auto

The first will install the required dependencies:

$ sudo ./certbot-auto

Certificate generation
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Now it's time to generate a certificate. This is a sample command line used to generate only the certificate. For more info about

usage and command line options, please visit https://certbot.eff.org/:

$ sudo ./certbot-auto certonly --standalone -m contact@mail-server.com -d sample-domain.com

This will create a directory structure where you can locate the certificate. This directory is protected so you need to switch to

root to go into:

$ sudo su -

$ cd /etc/letsencrypt/live/sample-domain.com

As you can see there are seveal PEM files. Let's create a PKCS12 certificate from these files which will be used in Tomcat:

$ openssl pkcs12 -export -in cert.pem -inkey privkey.pem -CAfile chain.pem -caname root -name tomcat -out mycert.p12

Keep the password safe because it will be used later.
Tomcat configuration

Copy the generated file to TOMCAT_HOME and edit the STOMCAT_HOME/conf/server.xml file to configure the new

certificate:

<Connector port="8443" protocol="HTTP/1.1" SSLEnabled="true"
maxThreads="150" scheme="https" secure="true" {
clientAuth="false" sslProtocol="TLS" '
keystoreFile="S{catalina.home}/mycert.pl2" keystorePass="changeit" keyAliEa

Once Tomcat is started, the 8443 port will accept SSL connections. But remember these connection should only be done using

the domain you used to generate the certificate, otherwise the browser will alert you about the site.

Other configuration

To redirect from non SSL port 8080 to SSL port 8443 edit the STOMCAT_HOME/web.xml and append at the end:

<security-constraint>
<web-resource-collection>
<web-resource-name>App nmae</web-resource-name>
<url-pattern>/*</url-pattern>
<http-method>GET</http-method>
<http-method>POST</http-method>
</web-resource-collection>

<user-data-constraint>
<transport-guarantee>CONFIDENTIAL</transport-guarantee>
</user-data-constraint>
</security-constraint>

And restart Tomcat.
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Known issues

Windows uses a different protocol

In Window systems the protocol used in the Connector must be changed so the final configuration is:

<Connector port="8443" protocol="org.apache.coyote.httpll.HttpliNioProtocol" SSLEnabl
maxThreads="150" scheme="https" secure="true" ]

clientAuth="false" sslProtocol="TLS" '
keystoreFile="S{catalina.home}\ca-signed. jks" keystorePass="changeit" keyEA

ca-bundles certificates

Sometimes the certificates provider gives serveral certifcates in one file with .ca-bundle extension. Sometimes, when this bundle
is imported as one file, only one of the certicates is imported. In is this case, the solution is to split the bundle in several files

(once for each certificate).

To do it, it is possible to edit the ca-bundle file, and each certificate is separated by:

Additional information

Are several ways to configure SSL in Tomcat for more information:

e Apache Tomcat - SSL / TLS Configuration HOW-TO
e A Simple, Step-By-Step Guide To Apache Tomcat SSL Configuration | MuleSoft
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Configuring Tomcat timezone

Tomcat works in GMT timezone if you want to change it you should add something like at $STOMCAT_HOME/bin/setenv.sh ( or

$TOMCAT_HOME/bin/setenv.bat if you're on Windows ):

More information about timezone list.
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Configuring Tomcat to work behing an Internet proxy

A We encourage to consider do not configure Internet connection in Servers behing an Internet proxy.
It have some disadvantages like:
» You will need to use your proxy data each time you will upgrade the application with OpenKM automatic
updater tools.

e It's need to configure JVM parameters with your Internet proxy data for the application be able to

connect to Internet.

Is not much clear what are the advantatges for this kind of configuration on Production Servers, what are not the

same scenario than end users. Take it as is, only a suggestion.

Linux

Configuration below is based on setting proxy configuration parameters in the JVM environment. There's

another option what is configuring proxy at OS level, here are several option one of them is:

Edit your "/etc/bash.bashrc” file as root and put these lines at the end of your " /etc/bash.bashrc” file:

export http proxy=http://username:password@proxyserver.net:port/
export ftp proxy=http://username:password@proxyserver.net:port/

e Stop OpenKM.

o Edit the STOMCAT_HOME/bin/setenv.sh file and add the lines:

A The http://proxy.url.com value must be your own url host of the proxy.

The "user" value must be the user for getting connection to the proxy. If your proxy does not require
authentication you can remove the entire line where are set these parameters.

The "password" values must be the password of the user for getting connection to the proxy. If your proxy does

not require authentication you can remove the entire line where are set these parameters.

set JAVA OPTS=%$JAVA OPTS$% -Dhttp.proxyHost=http://proxy.url.com -Dhttps. proxyHost—ht-t
| set JAVA OPTS=%JAVA OPTS% -Dhttp.proxyUser=user -Dhttps.proxyUser=user J
\ set JAVA OPTS=%JAVA OPTS% -Dhttp.proxyPassword=password -Dhttps.proxyPassword=passwor

JAVA OPTS="$JAVA OPTS -Xms256m -Xmx2048m -XX:+UseConcMarkSweepGC —Djava.awt.headlessiz
JAVA OPTS="$JAVA OPTS -Dfile.encoding=UTF-8 -Dsun.jnu.encoding=UTF-8 -Dmail.mime.igno
set JAVA OPTS=%JAVA OPTS$% -Dhttp.proxyHost=http://proxy.url.com -Dhttps. proxyHost—ht't
set JAVA OPTS—/JAVA OPTS% -Dhttp.proxyUser=user -Dhttps.proxyUser=user I
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set JAVA OPTS=%JAVA OPTS% -Dhttp.proxyPassword=password —-Dhttps.proxyPa ssword=passwofr
CATALINA_PID=$CATALINA_HOME/catalina.pid '
export LD_LIBRARY_PATH=$LD_LIBRAR Y PATH: $CATALINA_HOME/_Z ib/sigar

set JAVA OPTS=%JAVA OPTS% -Dsun.net.spi.nameservice.nameservers=8.8.8.8
set JAVA OPTS=%JAVA OPTS% -Dsun.net.spi.nameservice.provider.l=dns,sun

o Start OpenKM.

¢ Go to Administration > Tools > Scripting and execute the script below ( should be shown google html code ).

import java.net.URL;
import java.net.HttpURLConnection;
import java.io.BufferedReader,

URL url = new URL ("http://www.google.com") ;

HttpURLConnection urlConn = (HttpURLConnection) url.openConnection()
urlConn.setDoInput (true) ;

urlConn.setDoOutput (true) ;

urlConn.setUseCaches (false) ;

urlConn.setRequestMethod ("GET") ;

BufferedReader input = new BufferedReader (new InputStreamReader (urlConn.getInputStrea.
String line; E
StringBuilder sb = new StringBuilder(); ]
while ((line = input.readLine()) != null) { i
sb.append (line) ; E
} 1
input.close () ; :

print(sb.toString().replaceAll ("\n",6 "<br/>")); E

Configuration below is based on setting proxy configuration parameters in the JVM environment. There's
another option what is configuring proxy at OS level, consider looking for this information at Microsoft technet
website.

———————————\

Step one

Check starting and stopping OpenKM from the command line.

e First stop OpenKM service.

¢ Edit STOMCAT_HOME/bin/seten.bat file and add the lines:

A The http://proxy.url.com value must be your own url host of the proxy.

The "user" value must be the user for getting connection to the proxy. If your proxy does not require
authentication you can remove the entire line where are set these parameters.

The "password" values must be the password of the user for getting connection to the proxy. If your proxy does
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not require authentication you can remove the entire line where are set these parameters. |

f___

e ettt 1
]

set JAVA OPTS=%$JAVA OPTS% -Dhttp.proxyHost=http://proxy.url.com -Dhttps. proxyHost—ht-tj
| set JAVA OPTS=3%JAVA OPTS% -Dhttp.proxyUser=user -Dhttps.proxyUser=user d
\ set JAVA OPTS=3%JAVA OPTS% -Dhttp.proxyPassword=password -Dhttps.proxyPassword=passwor

JAVA OPTS="$JAVA OPTS -Xms256m -Xmx2048m -XX:+UseConcMarkSweepGC -Djava.awt. headless:—
1 JAVA OPTS="$JAVA OPTS -Dfile.encoding=UTF-8 -Dsun.jnu.encoding=UTF-8 -Dmail.mime. _1gn'
| set JAVA OPTS=%JAVA OPTS$ -Dhttp.proxyHost=http://proxy.url.com -Dhttps. proxyHost—ht.tj
set JAVA OPTS=%JAVA OPTS% -Dhttp.proxyUser=user -Dhttps.proxyUser=user I
' set JAVA OPTS=%JAVA OPTS% -Dhttp.proxyPassword=password -Dhttps. proxyPassword=passwqr
\ CATALINA PID= $CATALINA HOME/catalina.pid ]
E export LDﬁLIBRARYiPATH—SLDiLIBRARYiPATH $CATALINA7HOME/lib/sigar E

set JAVA OPTS=%JAVA OPTS% -Dsun.net.spi.nameservice.nameservers=8.8.8.8
set JAVA OPTS=%JAVA OPTS% -Dsun.net.spi.nameservice.provider.l=dns,sun

e Start OpenKM from the command line.

c:\tomcat-8.5.24\bin\> catalina.bat run

ST
N

¢ Go to Administration > Tools > Scripting and execute the script below ( should be shown google html code ).

import java.net.URL;
import java.net.HttpURLConnection;
import java.io.BufferedReader,

URL url = new URL ("http://www.google.com") ;

HttpURLConnection urlConn = (HttpURLConnection) url.openConnection();
urlConn.setDoInput (true) ;

urlConn.setDoOutput (true) ;

urlConn.setUseCaches (false) ;

urlConn.setRequestMethod ("GET") ;

BufferedReader input = new BufferedReader (new InputStreamReader (urlConn.getInputStrea.
String line; E
StringBuilder sb = new StringBuilder(); ]
while ((line = input.readLine()) != null) { i
sb.append (line) ; E
} 1
input.close(); ]

print(sb.toString().replaceAll ("\n",6 "<br/>")); E

If all has gone right in step one, now you can configure parameters into the OpenKM service.

e Stop OpenKM.
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e Go to STOMCAT_HOME/bin and execute the next command line:

.
1
i A The command lines below does not registering the parameters for DNS resolving. If you need it, simply add them.
1
|

c:\tomcat-8.5.24\bin\> OpenKM //US//OpenKM + +JvmOptions="-Dhttp.proxyHost=http://proxy.url.com"
c:\tomcat-8.5.24\bin\> OpenKM //US//OpenKM + +JvmOptions="-Dhttps.proxyHost=http://proxy.url.com"
c:\tomcat-8.5.24\bin\> OpenKM //US//OpenKM + +JvmOptions="-Dhttp.proxyUser=user"
c:\tomcat-8.5.24\bin\> OpenKM //US//OpenKM ++JvmOptions="-Dhttps.proxyUser=user"
c:\tomcat-8.5.24\bin\> OpenKM //US//OpenKM ++JvmOptions="-Dhttp.proxyPassword=password"

c:\tomcat-8.5.24\bin\> OpenKM //US//OpenKM + +JvmOptions="-Dhttps.proxyPassword=password

e Start OpenKM from services.

¢ Go to Administration > Tools > Scripting and execute the script below ( should be shown google html code ).

import java.net.URL;
import java.net.HttpURLConnection;
import java.io.BufferedReader,

URL url = new URL("http://www.google.com") ;

HttpURLConnection urlConn = (HttpURLConnection) url.openConnection()
urlConn.setDoInput (true) ;

urlConn.setDoOutput (true) ;

urlConn.setUseCaches (false) ;

urlConn.setRequestMethod ("GET") ;

String line;

StringBuilder sb = new StringBuilder();

while ((line = input.readLine()) != null) {
sb.append (line) ;

}

input.close();

print(sb.toString().replaceAll ("\n",6 "<br/>"));

BufferedReader input = new BufferedReader (new InputStreamReader (urlConn.getInputStrea.
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Change repository home

By default the repository is located at "$TOMCAT_HOME/repository" but you can change to other location.

A This action must be done with application stopped.

TTTTT TN

Understanding the contents of repository folders

Into "$TOMCAT_HOME/repository" there are three folder "index", "cache" and "datastore".

Folder Backup Description
index No The folder which contains the Lucene search engine indexes. The content of that folder can be
rebuild.
{ 3
i i Although is not mandatory backup this folder, we recommend doing it. i
. |
| J

cache No The folder which contains the application cached files. For example, for previewing documents,
sometimes is needed to transform the original document to other format. The conversion
consumes a lot of hardware resources, for this reason the application stores these converted files

to be reused later. The content of that folder can be cleaned without major problems.

{
1
i i Although is not mandatory backup this folder, we recommend doing it.
|
|

R

datastore  Yes The folder which contains all binary data of the documents.

A Is mandatory mandatory backup this folder otherwise the binary data of the

documents could be lost on a server hardware fail.

Move entire repository location

o Stop the application
¢ Move the "$TOMCAT_HOME/repository" to other location.
e Edit the "$TOMCAT_HOME/OpenKM.cfg" file and add the property "repository.home".

o Start the application

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE

Page 203 of 1191

Sample

Windows

Move repository folders individually

Table of properties:

Folder Property

index hibernate.search.index.home
cache repository.cache.home
datastore repository.datastore.home

TTTTT TN

A These parameters can not be used in combination with the parameter " repository.home".

e Stop the application

e Move the "$TOMCAT_HOME/repository/{folder}" to other location.

o Edit the "$STOMCAT_HOME/OpenKM.cfg" file and add the some property.

o Start the application

Sample

Windows

hibernate.search.index.home=C:/okmrepo/index
' repository.datastore.home=D:/okm/datastore

repository.cache.home=D:/okm/cache

hibernate.search.index.home=/mnt/okmrepo/index
! repository.datastore.home=/mnt/okm/datastore

repository.cache.home=/mnt/okm/cache
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Troubleshooting

Windows mapped network disk is not working

We encourage do not use networking ( NAS or Samba ) for storing repository. Because network issues will affect

TTTTT T T

the repository we consider as a dangerous configuration.

Seems there're restrictions using network unit ( mapped with "net use" command line ) and application running from services.

To solve it is necessary to create a link between UNC and the file system.

MKLINK /D C:\okm-repository \\192.168.1.36\eDocuments\okm-repository

In most cases will be necessary to use a standard user for running OpenKM service either the standard
configured. Take a look at OpenKM windows service configuration to change the default "Local system user" to

your own.
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Change default role names

By default application comes with two connection roles named "ROLE_USER" and "ROLE_ADMIN". Any OpenKM user must

have assigned one of these roles to loggin.

Change the default roles

P

A Change roles usually is not an easy task, we recommend have a backup before start working on it.

Is a good practice, first test this kind of changes on a development environment before trying on your production.

.4

To change the default roles must be done three actions:

1. Change the roles name at administration.
2. Modify the contents of the file applicationContext.xml into the "$TOMCAT/webapp/OpenKM.war".

3. Update existing database roles name "ROLE_USER" and "ROLE_ADMIN" to new names.

A You can modify the file "applicationContext.xml" into the "$TOMCAT_HOME/webapps/OpenKM.war" or
modify the exploded war file at "$TOMCAT_HOME/webapp/OpenKM/WEB-INF/applicationContext.xml".

Take in mind each time the "OpenKM.war" file is modified the contents of
"$TOMCAT_HOME/webapp/OpenKM" folder will be completely cleaned.

Sections into the "appContext.xml" to be modified:

Mandatory:

<!-- Remove prefix to be able of use custom roles --> '
<beans:bean id="roleVoter" class="org.springframework.security.access.vote.Rc

<beans:property name="rolePrefix" value="ROLE "/> b
</beans:bean>

¢ Go to Administration > Configuration parameters.

¢ Change the values of parameters "default.admin.role" and "default.admin.role". Also can be done from Database
query, see the next SQL script.

¢ Go to Administration > Utilities > Database query and execute the role name update sql:

-—- Optionally the configuration parameters can be set from SQL
UPDATE OKM CONFIG SET CFG VALUE='NEW ROLE USER NAME' WHERE CFG KEY='default.user.role
UPDATE OKM CONFIG SET CFG VALUE='NEW ROLE ADMIN NAME' WHERE CFG KEY='default.admin.ro
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-—- Update security table

-— Insert new roles

INSERT INTO ORKM ROLE
INSERT INTO ORKM ROLE
-— Update user roles

-—- Remove older roles

DELETE FROM OKM ROLE WHERE ROL ID IN ('ROLE USER',

(ROL ID, ROL ACTIVE) VALUES ('NEW ROLE USER NAME',
(ROL ID, ROL ACTIVE) VALUES ('NEW ROLE ADMIN NAME', 'T');

UPDATE OKM USER ROLE SET UR ROLE='NEW ROLE USER NAME' WHERE UR ROLE='ROLE USER'; E

UPDATE OKM NODE ROLE PERMISSION SET NRP ROLE='NEW ROLE USER NAME' WHERE NRP ROLE= 'ROIrL.
UPDATE OKM NODE ROLE PERMISSION SET NRP ROLE='NEW ROLE ADMIN NAME' WHERE NRP ROLE='RO.

T ;

UPDATE OKM USER ROLE SET UR ROLE= 'NEWiROLE:ADMINiNAME " WHERE UR ROLE='ROLE ADMIN';

"ROLE _ADMIN') ;

e Stop the application.

¢ Modify the contents of the file "applicationContext.xml".

e Start the application.

Sample of appContext.xml file

P

V The "ROLE_USER" has been modified to "OPENKM_ROLE_USER".

The "ROLE_ADMIN" has been modified to "OPENKM_ROLE_ADMIN".

A The contents of the "applicationContext.xml" can be modified, take only as a reference.

€f==

<?xml version="1.0" encoding="UTF-8"?>

<beans:beans xmlns:beans="http://www.springframework.org/schema/beans"
xmlns:security="http://www.springframework.org/schema/security"
xmlns:context="http://www.springframework.orqg/schema/context"
xmlns:jee="http://www.springframework.org/schema/jee"
xmlns:jaxws="http://cxf.apache.org/jaxws"
xmlns:jaxrs="http://cxf.apache.org/jaxrs"
xmlns:xsi="http://www.w3.
xsi:schemaLocation="http

http:

http

http:
http:
http:
http:
http:
http:

http

http:

http

org/2001/XMLSchema-instance"
2/ www.
/S WwWw .
2/ www.
/S www .
J//wWwWw .
/S www .
/S WwWw .
/S www .
//cxf.
://cxf.
//cxf.
://cxf.

<context:component-scan base-package="com.

springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
apache.org/jaxws

apache.org/schemas/jaxws.xsd

apache.org/jaxrs

apache.org/schemas/jaxrs.xsd">

openkm" />

<!-- <task:annotation-driven/> -->
<!-- Tasks configuration moved to $CATALINA HOME/OpenKM.xml -->
<!-- Apache CXF Web Services -->

<beans:import resource='"classpath:META-INF/cxf/cxf.xml"/>
<beans:import resource="classpath:META-INF/cxf/cxf-servlet.xml"/>

org/schema/beans
org/schema/beans/spring-b
org/schema/security
org/schema/security/sprih
org/schema/context ]
org/schema/context/spring
org/schema/jee i

org/schema/jee/spring-je

<beans:bean class="org.springframework.beans.factory.config.MethodInvokingFactoryBe
<beans:property name="targetClass" Value=”org.springframework.security.core.cdn
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<beans:property name="targetMethod" value="setStrategyName" />
<beans:property name="arguments" value=" INHERITABLETHREADLOCAL" />

</bean
-—>

<beans:bean id="WSS4JInInterceptor" class="org.apache.cxf.ws.security.wss4j.WSS4JTI
<beans:constructor-arg>
<beans:map>
<beans:entry key="action" value="UsernameToken'"/>
<beans:entry key="passwordType" value="PasswordText"/>

</beans:map>
</beans:constructor-arg>

</bean

s:bean>

TS

<beans:entry key="passwordCallbackClass" value="com.openkm.spring.ClientPassw

s:bean>

<!-- SOAP -->

<jaxws:
<jaxws:
<jaxws:

<jaxws

<jaxws:

<jaxws

<jaxws:
<jaxws:
<jaxws:
<jaxws:

<jaxws

<jaxws:

<jaxws

<jaxws:

Lf==

-—>

</jaxws:endpoint>

endpoint
endpoint
endpoint
rendpoint
endpoint
sendpoint
endpoint
endpoint
endpoint
endpoint
sendpoint
endpoint
sendpoint
endpoint

<jaxws:inInterceptors>
<beans:ref bean="WSS4JInInterceptor"/>
</jaxws:inInterceptors>

id="authService" implementor=”com.openkm.ws.endpoint.AuthService"Ea
id="bookmarkService" implementor="com.openkm.ws.endpoint.BookmarkSe
id="documentService" implementorz"com.openkm.ws.endpoint.DocumentSe
id="folderService" implementor="com.openkm.ws.endpoint.FolderServic
id="mailService" implementor='"com.openkm.ws.endpoint.MailService" a
id="noteService" implementor="com.openkm.ws.endpoint.NoteService" a
id="notificationService" implementor:"com.openkm.ws.endpoint.Notiﬁi
id="propertyGroupService" implementor="com.openkm.ws.endpoint.Prope
id="propertyService" implementor="com.openkm.ws.endpoint.PropertySe
id="repositoryService" implementor="com.openkm.ws.endpoint.Reposito
id="searchService" implementor="com.openkm.ws.endpoint.SearchServﬁc
id="dashboardService" implementor="com.openkm.ws.endpoint.Dashboard
id="workflowService" implementor="com.openkm.ws.endpoint.WorkflowSe
id="testService" implementor="com.openkm.ws.endpoint.TestService" a

<!-- OpenCMIS -->

<jaxws:endpoint id="cmisNavigationService" implementor="org.apache.chemistry.opencm
<jaxws:endpoint id="cmisPolicyService" implementor="org.apache.chemistry.opencmis.s
<jaxws:endpoint id="cmisDiscoveryService" implementor:"org.apache.chemistry.openc@i
<jaxws:endpoint id="cmisMultiFilingService'" implementor="org.apache.chemistry.openc.
<jaxws:endpoint id="cmisRepositoryService" implementor="org.apache.chemistry.opencm
<jaxws:endpoint id="cmisRelationshipService" implementor="org.apache.chemistry.open
<jaxws:endpoint id="cmisVersioningService" implementorz”org.apache.chemistry.opendm
<jaxws:endpoint id="cmisObjectService" implementor="org.apache.chemistry.opencmis.,s
<jaxws:endpoint id="cmisAclService" implementorz"org.apache.chemistry.opencmis.seﬁv
<!-- REST -->

<jaxrs:server id="restAuth" address="/rest/auth">
<jaxrs:serviceBeans>
<beans:bean class="com.openkm.rest.endpoint.AuthService"/>
</jaxrs:serviceBeans>
<jaxrs:providers>
<bean class="org.apache.cxf.jaxrs.provider.json.JSONProvider">
<property name="dropRootElement" value="true"/>
<property name="supportUnwrapped" value="true"/>

</bean>

</jaxrs:providers>
</jaxrs:server>
<jaxrs:server id="restDocument" address='"/rest/document'">
<jaxrs:serviceBeans>
<beans:bean class="com.openkm.rest.endpoint.DocumentService"/>
</jaxrs:serviceBeans>
<jaxrs:providers>
<bean class="org.apache.cxf.jaxrs.provider.json.JSONProvider">
<property name="dropRootElement" value="true"/>
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<property name="supportUnwrapped" value="true"/>
</bean>
</jaxrs:providers>
</jaxrs:server>
<jaxrs:server id="restFolder" address="/rest/folder">
<jaxrs:serviceBeans>
<beans:bean class="com.openkm.rest.endpoint.FolderService"/>
</jaxrs:serviceBeans>
<jaxrs:providers>
<bean class="org.apache.cxf.jaxrs.provider.json.JSONProvider">
<property name="dropRootElement" value="true"/>
<property name="supportUnwrapped" value="true"/>
</bean>
</jaxrs:providers>
</jaxrs:server>
<jaxrs:server id="restMail" address="/rest/mail">
<jaxrs:serviceBeans>
<beans:bean class="com.openkm.rest.endpoint.MailService"/>
</jaxrs:serviceBeans>
<jaxrs:providers>
<bean class="org.apache.cxf.jaxrs.provider.json.JSONProvider">
<property name="dropRootElement" value="true"/>
<property name="supportUnwrapped" value="true"/>
</bean>
</jaxrs:providers>
</jaxrs:server>
<jaxrs:server id="restNote" address="/rest/note">
<jaxrs:serviceBeans>
<beans:bean class="com.openkm.rest.endpoint.NoteService"/>
</jaxrs:serviceBeans>
<jaxrs:providers>
<bean class="org.apache.cxf.jaxrs.provider.json.JSONProvider">
<property name="dropRootElement" value="true"/>
<property name="supportUnwrapped" value="true"/>
</bean>
</jaxrs:providers>
</jaxrs:server>
<jaxrs:server id="restPropertyGroup" address="/rest/propertyGroup">
<jaxrs:serviceBeans>
<beans:bean class="com.openkm.rest.endpoint.PropertyGroupService"/>
</jaxrs:serviceBeans>
<jaxrs:providers>
<bean class="org.apache.cxf.jaxrs.provider.json.JSONProvider">
<property name="dropRootElement" value="true"/>
<property name="supportUnwrapped" value="true"/>
</bean>
</jaxrs:providers>
</jaxrs:server>
<jaxrs:server id="restSearch'" address="/rest/search">
<jaxrs:serviceBeans>
<beans:bean class="com.openkm.rest.endpoint.SearchService"/>
</jaxrs:serviceBeans>
<jaxrs:providers>
<bean class="org.apache.cxf.jaxrs.provider.json.JSONProvider">
<property name="dropRootElement" value="true"/>
<property name="supportUnwrapped" value="true"/>
</bean>
</jaxrs:providers>
</jaxrs:server>
<jaxrs:server id="restRepository" address="/rest/repository'">
<jaxrs:serviceBeans>
<beans:bean class="com.openkm.rest.endpoint.RepositoryService"/>
</jaxrs:serviceBeans>
<jaxrs:providers>
<bean class="org.apache.cxf.jaxrs.provider.json.JSONProvider">
<property name="dropRootElement" value="true"/>
<property name="supportUnwrapped" value="true"/>
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</bean>
</jaxrs:providers>
</jaxrs:server>
<jaxrs:server id="restProperty" address='"/rest/property'">
<jaxrs:serviceBeans>
<beans:bean class="com.openkm.rest.endpoint.PropertyService"/>
</jaxrs:serviceBeans>
<jaxrs:providers>
<bean class="org.apache.cxf.jaxrs.provider.json.JSONProvider">
<property name="dropRootElement" value="true"/>
<property name="supportUnwrapped" value="true"/>
</bean>
</jaxrs:providers>
</jaxrs:server>
<jaxrs:server id="restTest" address="/rest/test">
<jaxrs:serviceBeans>
<beans:bean class="com.openkm.rest.endpoint.TestService"/>
</jaxrs:serviceBeans>
<jaxrs:providers>
<bean class="org.apache.cxf.jaxrs.provider.json.JSONProvider">
<property name="dropRootElement" value="true"/>
<property name="supportUnwrapped" value="true"/>
</bean>
</jaxrs:providers>
</jaxrs:server>

<security:global-method-security secured-annotations="enabled"/>

<!-- Remove prefix to be able of use custom roles —-->
<beans:bean id="roleVoter" class="org.springframework.security.access.vote.RoleVote

<beans:property name="rolePrefix" value="OPENKM ROLE "/> i
</beans:bean>

<!-- OpenCMIS -->

<beans:bean id="CmisLifecycleBean'" class="com.openkm.cmis.CmisLifecycleBean'">
<beans:property name="cmisServiceFactory" ref="CmisServiceFactory"/>

</beans:bean>

<beans:bean id="CmisServiceFactory" class="com.openkm.cmis.CmisServiceFactory"/>

<!-- Status -->

<security:http pattern="/Status" create-session="stateless'">
<security:intercept-url pattern="/**" access="IS AUTHENTICATED FULLY"/>
<security:http-basic/>

</security:http>

<!-- Download -->

<security:http pattern="/Download" create-session="stateless">
<security:intercept-url pattern="/**" access="IS AUTHENTICATED FULLY"/>
<security:http-basic/>

</security:http>

<!-- Workflow deploy -->

<security:http pattern="/workflow-register" create-session="stateless">
<security:intercept-url pattern="/**" access="IS AUTHENTICATED FULLY"/>
<security:http-basic/>

</security:http>

<!-- WebDAV using Basic authentication -->

<security:http pattern="/webdav/**" create-session="stateless'>
<security:intercept-url pattern="/**" access="IS AUTHENTICATED FULLY"/>
<security:http-basic/>

</security:http>

<!-- Syndication using Basic authentication -->

<security:http pattern="/feed/**" create-session="stateless'">
<security:intercept-url pattern="/**" access="IS AUTHENTICATED FULLY"/>
<security:http-basic/>
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</security:http>

<!-- OpenCMIS (Browser) using Basic authentication —-->

<security:http pattern="/cmis/browser/**" create-session="stateless">
<security:intercept-url pattern="/**" access="IS AUTHENTICATED FULLY"/>
<security:http-basic/>

</security:http>

<!-- OpenCMIS (AtomPub) using Basic authentication -->

<security:http pattern="/cmis/atom/**" create-session="stateless'">
<security:intercept-url pattern="/**" access="IS AUTHENTICATED FULLY"/>
<security:http-basic/>

</security:http>

<!-- OpenCMIS (AtomPub) using Basic authentication -->

<security:http pattern="/cmis/atomll/**" create-session="stateless">
<security:intercept-url pattern="/**" access="IS AUTHENTICATED FULLY"/>
<security:http-basic/>

</security:http>

<!-- REST -->

<security:http pattern="/services/rest/**" create-session="stateless'">
<security:intercept-url pattern="/**" access="IS AUTHENTICATED FULLY"/>
<security:http-basic/>

</security:http>

<!-- Additional filter chain for normal users, matching all other requests —-->
<!-- http://info.michael-simons.eu/2011/01/28/disable-jsessionid-path-parameter-in

<security:http access-decision-manager-ref="accessDecisionManager" access-denied-pa

<!-- GWT -->

<security:intercept-url pattern="/frontend/**" access="IS AUTHENTICATED FULLY"/>

<!-- JSPs -->

<security:intercept-url pattern="/login.jsp" access="IS AUTHENTICATED ANONYMOUSE

<security:intercept-url pattern="/admin/**" access="OPENKM ROLE ADMIN"/>

<security:intercept-url pattern="/mobile/**" access—"ISﬁAUTHENTICATEDﬁFULLY"/>

<!-- Servlets -->

<security:intercept-url pattern="/RepositoryStartup" access="IS AUTHENTICATED FUL

<security:intercept-url pattern="/TextToSpeech'" access='"IS AUTHENTICATED FULLY"/>
<security:intercept-url pattern="/HtmlPreview" access="ISﬁAUTHENTICATEDﬁFULLY"/>

<security:intercept-url pattern="/SyntaxHighlighter" access="IS AUTHENTICATED FUL.
<security:intercept-url pattern="/Test" access="IS AUTHENTICATED FULLY"/>

<!-- Extensions -->

<security:intercept-url pattern="/extension/ZohoFileUpload" access="IS AUTHENTICA
<security:intercept-url pattern="/extension/**" access:"ISfAUTHENTICATEDﬁFULLY"4>

<!-- Login page -->

<security:form-login login-page="/login.jsp" authentication-failure-url="/login.j

</security:http>

<!-- Needed for changing default role prefix -->

<beans:bean id="accessDecisionManager'" class="org.springframework.security. access'v

<beans:property name="decisionVoters">
<beans:1list>

<beans:bean class='"org. springframework.security.web.access.expression.WebExﬁr

<beans:ref bean="roleVoter"/>

<beans:bean class="org.springframework.security.access.vote. AuthentlcatedVot

</beans:1list>
</beans:property>
</beans :bean>

<!-- Security access logger -->
<beans:bean id="loggerListener" class="com.openkm.spring.LoggerListener"/>
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<jee:jndi-lookup id="dataSource'" jndi-name="jdbc/OpenKMDS" resource-ref="true'"/>

E <!-- Security configuration moved to $CATALINA HOME/OpenKM.xml --> E
! <!'-- WINFIX J
i <security:authentication-manager alias="authenticationManager'"> i
E <security:authentication-provider> E
! <security:password-encoder hash="md5"/> i
i <security:jdbc-user-service ]
: data-source-ref="dataSource"

E users-by-username-query="select usr id, usr password, 1 from OKMﬁUSERE
! authorities-by-username-query="select ur user, ur role from OKM USER RO.
i </security:authentication-provider> J
‘ </security:authentication-manager> i
WINFIX —-->
' </beans:beans> i

Download the changeRolesTools.zip.

It includes:

e change_roles.sh script to modify the applicationContext.xml file.

e path folder to patch "OpenKM.war" file.

To patch "OpenKM.war" file, copy the file into patch folder and then execute the patch.sh script ( or patch.bat
file on Windows ).

TTTTTTTTY
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Enable extensions

After the extensions have been registered in OpenKM will not be visible for the users until you enable them from

the Profile General tab.

TTTTT T T

By default OpenKM comes with the extensions disabled.

Types of extensions:

¢ Do not require additional software configuration.
¢ Need additional software configuration.

¢ Sample extensions for development.

Available extensions are registered in the OKM_EXTENSION table. To enable any of them, it's only necessary to insert it in this

table.

Extensions that do not require additional software configuration:

¢ Go to Administration > Database query. At bottom right select option JDBC, paste into the box the SQL inserts of the

extensions you want to enable. Finally click at bottom right the button execute.

A The Stapling extension is deprecated and has been superseded by Relation.

TTTTT TN

E INSERT INTO OKM EXTENSION (EXT UUID, EXT NAME) VALUES ('25af39c0—580f—43lC—8852—0b643
i INSERT INTO OKM EXTENSION (EXT UUID, EXT NAME) VALUES ('al925a00-ef41-11df-98cf-08002
. INSERT INTO OKM EXTENSION (EXT UUID, EXT NAME) VALUES ('88ca(0dl0-39e2-11e0-9207-08002
i\ INSERT INTO OKM EXTENSION (EXT UUID, EXT NAME) VALUES ('522e7720-5c54-11e0-80e3-08002
E INSERT INTO OKM EXTENSION (EXT UUID, EXT NAME) VALUES ('a7b5a3c0—4b2f—lleO—b8af—080d2
i INSERT INTO OKM EXTENSION (EXT UUID, EXT NAME) VALUES ('bb3feb20-570b-11e0-b8af-08002
i INSERT INTO OKM EXTENSION (EXT UUID, EXT NAME) VALUES ('fa7f4556-3249-4268-88e0-0dd78
E INSERT INTO OKM EXTENSION (EXT UUID, EXT NAME) VALUES ('c60082c2—7d4c—4750—901b—a8lﬁf
' INSERT INTO OKM EXTENSION (EXT UUID, EXT NAME) VALUES ('87f250d5-526d-4d8a-96ee-lebbe
i INSERT INTO OKM EXTENSION (EXT UUID, EXT NAME) VALUES ('c20c69a8-7d6b-4539-9e6b-6£f2c1
E INSERT INTO OKM EXTENSION (EXT UUID, EXT NAME) VALUES ('lOIfale6—4bf6—4e39—9124—88f44

Sample extensions for development:

There're some sample extension for development testing purpose.

¢ Go to Administration > Database query. At bottom right select option JDBC, paste into the box the SQL inserts of the

extensions you want to enable. Finally click at bottom right the button execute.
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INSERT INTO ORKM EXTENSION
INSERT INTO OKM EXTENSION
INSERT INTO ORKM EXTENSION
INSERT INTO ORKM EXTENSION

(EXT UUID,EXT NAME)
(EXT UUID,EXT NAME)
(EXT UUID,EXT NAME)
(EXT UUID,EXT NAME)

VALUES ( '9f84b330—d096—lldf—bd3b—08002050
VALUES ('44£94470-d097-11df-bd3b-0800200
VALUES ('d95e01a0-d097-11df-bd3b-080020,0
VALUES ( 'd9dab640—d098—lldf—bd3b—080020§0
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Enable WebDAV

Once WebDAYV is enabled, you can access the OpenKM repository with this URL:

Go to Administration > Configuration parameters:

Field / Property Type Description

Enable WebDAV service. By default it is disabled.
system.webdav.server = Boolean

true

mon

Character ":" may cause problems with some WebDAYV clients, Enabling this

parameter will replace in the URL the character ":" by "_". By default is disabled.

( \.
i A It's recommended enabling this parameter to prevent compatibility i
o |
system.webdav.fix Boolean | problems with some WebDAV clients. i
| |
| |
i A path like /okm:root/myfile.txt will be translated to !
i /okm_root/myfile.txt i
! J
true

g i
|

i V OpenKM WebDAYV is based on excellent Open Source Milton WebDAV API for Java. The Milton project i
i maintains a detailed WebDAV client compatibility list that describes a "Recipe for broad client compatibility." i
s )
Linux

From Linux you can use:

e http://dav.sourceforge.net/
e http://savannah.nongnu.org/projects/davfs2

For example, in Ubuntu or any Debian based Linux distro you can install this utility this way:
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And mount it:

And then in the user's home directory, look for ./davfs2/davfs2.conf. There you'll find a if_match_bug 1 line. Uncomment it.

See also:

e Ubuntu: Mounting remote filesystem using davfs2 (FUSE)

Windows

Install a WebDAV client for Windows.

n We don't recommend using the default Windows WebDAYV support because is buggy.

TTTTTTTY

Here you have several options:

e http://www.netdrive.net/ (Free for home use but does not handle document versioning properly)
o http://www.webdrive.com/ (The recommended option and will create a new document version when you save the
modifications)

e WebDAYV Clients on Windows XP

WebDrive

Probably this is the best choice if you are under Windows, because of its stability and ease of configuration. WebDrive 10
(Version 10.00, Build 2521) has been roughly tested with OpenKM to enhance compatibility effort. This is the supported

configuration to work with OpenKM WebDAYV connector:
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N Program Settings
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Windows Web Folders

Perform the following steps in Internet Explorer:

e Select File -> Open.
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e Fill in URL like http://your-domain.com:8080/OpenKM/webdav
o Check "Open as Web Folder".

e Click OK.

ﬁ There are some well-known issues. Please consult the following articles in case of any problem

e Be aware that there are multiple versions of WebDAV Microsoft libraries (and different type of bugs). To
avoid some frustration if these steps don't work for you in XP for Folders, more
information at Web Folder Client (MSDAIPP.DLL) Versions and Issues.

o Windows Vista and Windows 7 both restrict access to WebDAYV servers that use Basic HTTP
authentication on non-SSL connections. This restriction can be solved by changing a registry key. Read
more on. However, SSL connections do bring improved security. Thi rom Green is an

excellent resource to analyse & fix problems with your Windows WebDAYV client.

.

Windows XP's "My Network Places"

Windows XP supports 'Network Places' in the standard File dialog:

¢ Open networking.

e Connect as network resource.

o Write url http://your-domain.com:8080/OpenKM/webdav

e Set user and password.

¢ Open the Registry Editor utility (regedit.exe).

e Goto HKEY_LOCAL_MACHINE\SYSTEM\CurrentControlSet\Services\WebClient\Parameters, look for
TypeUseBasicAuth and replace the default value "1" by "2" allowing BasicAuth through NON SSL connections.

¢ Map your drive using this address: \\your-domain.com:8080/OpenKM/repository/default/okm_root/

More information at our OpenKM Forum.

Other tools

e Raiddrive

Mac

Install any WebDAV client for Mac, here you have some options:

o http://cyberduck.ch/

e http://www.webdrive.com/ (There is a version for Macintosh OS/X)

Mac OS X finder.
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e Select in the Finder "Go" and "Connect to Server...".
o Fill in the WebDAV URL http://your-domain:8080/OpenKM/webdav
o Enter a username and password.

» And the document repository is accessible!

Troubleshooting

Slow WedDAYV performance on Windows

If you have a slow webdav connection in windows 7 please follow the instructions in Fix Slow WebDAV Performance in

Windows 7. It turns out to be a windows issue, not OpenKM.

Furthermore in Windows 7/Vista you need to add your certificate (if its not issued by a verified CA) into windows if you plan to

use Webdav over SSL (and,like me, do not compensate with digest auth):

1. Get the certificate from the server administrator in CER format or download it from Firefox.
Start windows Certificate Manager: in command line type certmgr.msc

Select on the left Trusted Root Certification Authorities.

A LN

In the menu Actions > All Tasks select Import and then Next.
5. Browse for the location of certificate file you saved earlier on your computer and click Open.

6. You will get a few more warning messages. Just say to go through with it until the certificate is accepted.

Then map webdav content as a network drive without any other software. The folder should be: http://your-

domain:8080/OpenKM/webdav

To make sure that everything is ok with certificates, open the address using IE. If no warning pops up is shown, then is right.

A This allows you only to read/view files. If you need write access over a network drive you need to disable File

Locking (windows does not support webdav file lock).

For more information Web Lockers Webdav For MS Windows

A For Windows XP there is a fix (KB907306).

Turn off file locking
If you need to write access over a network drive you need to disable File Locking (windows does not support webdav file lock).

Execute registry editor tool, in command line type regedit. Modify or create this configuration parameter:

[HKEY LOCAL MACHINE\SYSTEM\CurrentControlSet\Services\WebClient\Parameters]
"SupportLocking"=dword: 00000000
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LDAP configuration

The LDAP integration is divided in two sections, login process and retrieving users and roles from LDAP server. It's usually
better starting with LDAP configuration parameters which are used by OpenKM to show users and roles into administration

and once this section is configured go to Spring Security configuration ( OpenKM.xml changes ).

Usually you only want to retrieve a subset of users and roles present in your LDAP, to be shown in the user interface or be able

to login into OpenKM. If this is your case, please take a look at LDAP best practices for filtering users and roles .
OpenLDAP

¢ OpenLDAP example with URL base at login
Active Directory

e Active Directory basic configuration

¢ Active Directory advanced configuration

¢ Active Directory example with referral enabled

e Active Directory example with login based on filtering users by roles ( suggested )

Uncategorised examples shared by users
e https://www.nosam.com/node/8, http://pastebin.com/iQa4LhyY ( more information OpenKM public forum )
Tools

e Microsoft Active Directoy Explorer.

o Apache Directory Studio.
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OpenLDAP example with URL base at login

LDAP Structure

dc=com
dc=some
ou=organization

cn=ROLE ADMIN
memberUid=okmAdmin
memberUid=userl
memberUid=user2

cn=ROLE USER
memberUid=user3
memberUid=user4

ou=organization

uid=userl
mail=user@mail.com
cn=User Name 1

uid=user?2
mail=user2@mail.com
cn=User Name 3

uid=user3
mail=user3@mail.com
cn=User Name 3

uid=user4
mail=user4@mail.com
cn=User Name 4

Valid roles:

e ¢cn=ROLE_X,ou=roles,dc=some,dc=com
e cn=ROLE_Y,ou=dept marketing,ou=roles,dc=some,dc=com

e cn=ROLE_Z,ou=dept sales,ou=roles,dc=some,dc=com
Invalid roles:

e cn=ROLE_INVALID,ou=dept,dc=some,dc=com ( any distinguished name not included in ou=roles,dc=some,dc=com )
Valid users:

¢ uid=USER_X,ou=organization,dc=some,dc=com
¢ uid=USER_Y,ou=dept id,ou=organization,dc=some,dc=com

¢ uid=USER_Z,ou=dept administrator,ou=organization,dc=some,dc=com
Invalid users:

e uid=USER_INVALID,ou=house,dc=some,dc=com ( any distinguished name not included in

ou=organization,dc=some,dc=com )

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE

Page 221 of 1191

OpenKM.xml

¢ Important login (Idap://192.168.0.13:389/dc=some,dc=com) sets default filter base queries at dc=some,dc=com with is

concatenated by default in all filter queries .

¢ Roles ( groups ) filter base is ou=roles ( real distinguised name is ou=roles,dc=some,dc=com ). Any valid roles should

have it as parent. ou=roles"/> really points to ou=roles,dc=some,dc=com"/>

e Users filter base is ou=organization ( real distinguised name is ou=organization,dc=some,dc=com ). Any valid user

should have it as parent. to

e User filter is uid={0}

e Finally take in consideration the value 1 at memberUid={1}"/>

<?xml version="1.0" encoding="UTF-8"?>

<beans:beans xmlns:beans="http://www.springframework.org/schema/beans"
xmlns:security="http://www.springframework.org/schema/security"
xmlns:task="http://www.springframework.org/schema/task"

org/2001/XMLSchema-instance"

xmlns:xsi="http://www.w3.
xsi:schemaLocation="http:
http:
http:
http:
http:
http:

<security:authentication-manager alias="authenticationManager'">
<security:authentication-provider ref="ldapAuthProvider" />

</security:authentication-manager>

<beans:bean id="contextSource" class="org.springframework.security.ldap.DefaultSp
<beans:constructor-arg value="ldap://192.168.0.13:389/dc=some,dc=com"/>
<beans:property name="userDn'" value="cn=Manager,dc=some,dc=com"/>

<beans:property name="password" value=

</beans :bean>

/S WwWw .
/S wwWw .
/S wWwWw .
J//wWwWw .
/S www .
/S WwWw .

springframework.
springframework.
springframework.
springframework.
springframework.
springframework.

n******n/>

org/schema/beans J
org/schema/beans/spring-b
org/schema/security i
org/schema/securlty/sprlp
org/schema/task

org/schema/task/spring- ba

1.

SR

<beans:bean id="ldapAuthProvider" class="org.springframework.security.ldap.authentic

<beans:constructor-arg>

<beans:bean class="org.springframework.security.ldap.authentication. BlndAuthentlca
<beans:constructor-arg ref="contextSource"/>
<beans:property name="userSearch" ref="userSearch'"></beans:property>

</beans:bean>
</beans:constructor-arg>
<beans:constructor-arg>

<beans:bean class="org.springframework.security.ldap.userdetails.DefaultLdapAuthor

<beans:constructor-arg ref="contextSource"/>
<beans:constructor-arg value="ou=roles"/>
<beans:property name="groupSearchFilter" value=

<beans:property name="groupRoleAttribute" value="cn"/>

<beans:property name="searchSubtree" value="true" />
<beans:property name="convertToUpperCase" value=

<beans:property name="rolePrefix" value="" />

</beans :bean>
</beans:constructor-arg>
</beans :bean>

"memberUid={1}"/>

<beans:bean id="userSearch" class="org.springframework.security.ldap.search.Filter
<beans:constructor-arg index="0" value="ou=organization" />

<beans:constructor-arg index="1" value="uid={0}" />

O
"true" /> E
e
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</beans :bean>

</beans:beans>

<beans:constructor-arg index="2" ref="contextSource" />
<beans:property name="searchSubtree" value="true" />

Configuration parameters

Go to Administration > Configuration parameters:

Field / Property

principal.adapter

system.login.lowercase

principal.ldap.server

principal.ldap.security.principal

principal.ldap.security.credentials

principal.ldap.referral

principal.ldap.users.from.roles

principal.ldap.user.attribute

principal.ldap.user.search.base

principal.ldap.user.search.filter

principal.ldap.username.attribute

principal.ldap.username.search.base

principal.ldap.username.search.filter

principal.ldap.mail.attribute

principal.ldap.mail.search.base

Type

String

String

String

String

String

String

Boolean

String

List

String

String

String

String

String

String

Description

com.openkm.principal.LdapPrincipalAdapter

false

ldap://192.168.xxx.xxx:389

cn=Manager ,dc=some ,dc=com

password

false

uid

ou=users,dc=some,dc=com

(objectClass=inetOrgPerson)

cn

ou=users,dc=some,dc=com

(uid={0})

mail

dc=some ,dc=com
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principal.ldap.mail.search.filter

principal.ldap.role.attribute

principal.ldap.role.search.base

principal.ldap.role.search.filter

principal.ldap.roles.by.user.attribute

principal.ldap.roles.by.user.search.base

principal.ldap.roles.by.user.search.filter

principal.ldap.users.by.role.attribute

principal.ldap.users.by.role.search.base

principal.ldap.users.by.role.search.filter

String

String

List

String

String

String

String

String

String

String

(uid={0})

cn

ou=roles,dc=some,dc=com

(objectClass=posixGroup)

cn

ou=roles,dc=some,dc=com

(memberUid={0})

memberUid

ou=roles,dc=some,dc=com

(& (objectClass=posixGroup) (cn={0}))
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OpenLDAP example retrieving attributes by name

LDAP Structure

dc=com
dc=some
ou=roles

cn=ROLE ADMIN
member=cn=okmAdmin,ou=users,dc=some,dc=com
member=cn=userl,ou=users,dc=some,dc=com
member=cn=user2,ou=users,dc=some,dc=com

cn=ROLE USER
member=cn=user3,ou=users,dc=some,dc=com

ou=users

uid=userl

mail=user@mail.com

cn=User Name 1

memberOf=cn=ROLE ADMIN,ou=roles,dc=some,dc=com
uid=user?2

mail=user2@mail.com

cn=User Name 3

memberOf=cn=ROLE ADMIN,ou=roles,dc=some,dc=com
uid=user3

mail=user3@mail.com

cn=User Name 3

memberOf=cn=ROLE USER,ou=roles,dc=some,dc=com
uid=Manager

mail=manager@mail.com

cn=Manager

Valid roles:

e ¢cn=ROLE_X,ou=roles,dc=some,dc=com
e cn=ROLE_Y,ou=dept marketing,ou=roles,dc=some,dc=com

e cn=ROLE_Z,ou=dept sales,ou=roles,dc=some,dc=com
Invalid roles:

e cn=ROLE_INVALID,ou=dept,dc=some,dc=com ( any distinguished name not included in ou=roles,dc=some,dc=com )
Valid users:

e uid=USER_X,ou=users,dc=some,dc=com
e uid=USER_Y,ou=dept id,ou=users,dc=some,dc=com

e uid=USER_Z,ou=dept administrator,ou=users,dc=some,dc=com
Invalid users:

e uid=USER_INVALID,ou=house,dc=some,dc=com ( any distinguished name not included in

ou=organization,dc=some,dc=com )
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OpenKM.xml

¢ Important login (Idap://192.168.0.13:389/dc=some,dc=com) sets default filter base queries at dc=some,dc=com with is

concatenated by default in all filter queries .

¢ Roles ( groups ) filter base is ou=roles ( real distinguised name is ou=roles,dc=some,dc=com ). Any valid roles should

have it as parent. ou=roles"/> really points to ou=roles,dc=some,dc=com"/>

e Users filter base is ou=users ( real distinguised name is ou=users,dc=some,dc=com ). Any valid user should have it as

parent. to

e User filter is uid={0}

¢ Finally take in consideration the value 1 at member={0}"/>

<?xml version="1.0" encoding="UTF-8"?>

<beans:beans xmlns:beans="http://www.springframework.org/schema/beans"
xmlns:security="http://www.springframework.org/schema/security"
xmlns:task="http://www.springframework.org/schema/task"

org/2001/XMLSchema-instance"

xmlns:xsi="http://www.w3.
xsi:schemaLocation="http:
http:
http:
http:
http:
http:

<security:authentication-manager alias="authenticationManager'">
<security:authentication-provider ref="ldapAuthProvider" />

</security:authentication-manager>

<beans:bean id="contextSource" class="org.springframework.security.ldap.DefaultSp
<beans:constructor-arg value="ldaps://192.168.0.13:389/dc=some,dc=com"/>
<beans:property name="userDn" value="cn=Manager,ou=users,dc=some,dc=com"/>

/S WwWw .
/S wwWw .
/S wWwWw .
J//wWwWw .
/S wWwWw .
/S WwWw .

springframework.
springframework.
springframework.
springframework.
springframework.
springframework.

<beans:property name="password" value="***"/>

</beans :bean>

<beans:bean id="ldapAuthProvider" class="org.springframework.security.ldap.auth

<beans:constructor-arg>

org/schema/beans J
org/schema/beans/spring-b
org/schema/security i
org/schema/securlty/sprlp
org/schema/task

org/schema/task/spring- ba

1.

___g____________h.___________

<beans:bean class="org.springframework.security.ldap.authentication.BindA

<beans:constructor-arg ref="contextSource"/>
<beans:property name="userSearch" ref="userSearch"></beans:property

</beans:bean>
</beans:constructor-arg>
<beans:constructor-arg>

S v

<beans:bean class="org.springframework.security.ldap.userdetails. DefaultL

<beans:constructor-arg ref="contextSource"/>

<beans:constructor-arg value="ou=roles"/>

<beans:property name="groupSearchFilter" value="member={0}"/>
<beans:property name="groupRoleAttribute" value="cn"/>
<beans:property name="searchSubtree" value="true" />
<beans:property name="convertToUpperCase" value=

<beans:property name="rolePrefix" value="" />

</beans :bean>
</beans:constructor-arg>
</beans :bean>

<beans:bean id="userSearch" class="org.springframework.security.ldap.search.Filt

<beans:constructor-arg index="0" value="ou=users" />
<beans:constructor-arg index="1" value="uid={0}" />

"true" />

N

S
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<beans:constructor-arg index="2" ref="contextSource" />
<beans:property name="searchSubtree" value="true" />
</beans:bean>

</beans:beans>

Configuration parameters

Go to Administration > Configuration parameters:

Field / Property Type Description
principal.adapter String com.openkm.principal.OpenLdapPrincipalAdapter
system.login.lowercase String false
principal.ldap.server String ldap://192.168.xxx.xxx:389
principal.ldap.security.principal String cn=Manager,ou=users,dc=some,dc=com
principal.ldap.security.credentials String password
principal.ldap.referral String
principal.ldap.users.from.roles Boolean false
principal.ldap.user.attribute String uid
principal.ldap.user.search.base List ou=users,dc=some,dc=com
principal.ldap.user.search.filter String (objectClass=inetOrgPerson)
principal.ldap.username.attribute String e
principal.ldap.username.search.base String ou=users,dc=some,dc=com
principal.ldap.username.search.filter String (uid={0})
principal.ldap.mail.attribute String mail
principal.ldap.mail.search.base String dc=some,dc=com
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principal.ldap.mail.search.filter

principal.ldap.role.attribute

principal.ldap.role.search.base

principal.ldap.role.search.filter

principal.ldap.roles.by.user.attribute

principal.ldap.roles.by.user.search.base

principal.ldap.roles.by.user.search.filter

principal.ldap.users.by.role.attribute

principal.ldap.users.by.role.search.base

principal.ldap.users.by.role.search.filter

String

String

List

String

String

String

String

String

String

String

(uid={0})

cn

ou=roles,dc=some,dc=com

(objectClass=groupOfNames)

memberOf

ou=users,dc=some,dc=com

(& (objectClass=inetOrgPerson) (uid={0}))

member

ou=roles,dc=some,dc=com

(& (objectClass=groupOfNames) (cn={0}))
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Active Directory example with referral enabled

This example covers the scenario where more than one Active Directory domains work together, and it's needed the following

parameter.

LDAP Structure

dc=com
dc=company
ou=0PENKM

cn=ROLE ADMIN
member=okmAdmin
member=userl
member=user?

cn=ROLE USER
member=user3
member=user4

cn=ROLE XXXX

cn=ROLE YYYY

ou=organizationl

SsAMAccountName=okmAdmin
memberOf=CN=ROLE ADMIN, OU=0OPENKM, DC=company , DC=com
mail=okmAdmin@mail.com
cn=0OpenKM Administrator

sAMAccountName=userl
memberOf=CN=ROLE ADMIN, OU=0OPENKM, DC=company , DC=com
mail=userl@mail.com
cn=User Name 1

sAMAccountName=user2
memberOf=CN=ROLE ADMIN, OU=0OPENKM, DC=company , DC=com
mail=user2@mail.com
cn=User Name 3

ou=organization2

sAMAccountName=user3
memberOf=CN=ROLE USER, OU=OPENKM, DC=company , DC=com
mail=user3@mail.com
cn=User Name 3

sAMAccountName=user4
memberOf=CN=ROLE USER, OU=OPENKM, DC=company , DC=com
mail=user4@mail.com
cn=User Name 4

Valid groups:

e cn=ROLE_ADMIN,ou=0OPENKM,dc=company,dc=com
e cn=ROLE_USER,0u=0OPENKM,dc=company,dc=com
e cn=ROLE_XXXX,ou=OPENKM,dc=company,dc=com

e cn=ROLE_YYYY,ou=OPENKM,dc=company,dc=com
Valid users:

e cn=userl,ou=organizationl,dc=company,dc=com
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® cn=user2,ou=organizationl,dc=company,dc=com
* cn=user3,ou=organization2,dc=company,dc=com

e cn=user4,ou=organization2,dc=company,dc=com

i Any distinguished name includes by default dc=company,dc=com

TTTTTTTY

OpenKM.xml

¢ Parameter follow indicates several domains servers working together (' balanced ).

e Users defined in any Active Directory node will be able to log in, because it has defined DC=company,DC=com as the
base filter.

¢ Any user authenticated in Active Directory can log in because it has not any filtering clause.

e Groups read by OpenKM can be defined in an Active Directory node, because it has defined DC=company,DC=com as

the base filter.

<security:authentication-manager alias="authenticationManager'>
<security:authentication-provider ref="ldapAuthProvider" />
</security:authentication-manager>

<beans:constructor-arg value="ldap://192.168.xxx.xxx:389"/>
<beans:property name="userDn" value="CN=Administrator,OU=0OPENKM,DC=company, DC=com
<beans:property name="password" value="****"/>
<beans:property name="baseEnvironmentProperties'>
<beans:map>
<beans:entry>
<beans:key>
<beans:value>java.naming.referral</beans:value>
</beans:key>
<beans:value>follow</beans:value>
</beans:entry>
</beans :map>
</beans:property>
</beans:bean>

<beans:bean id="contextSource'" class="org.springframework.security.ldap.DefaultSpri.

<beans:bean id="ldapAuthProvider" class="org.springframework.security.ldap.authenti
<beans:constructor-arg> E
<beans:bean class="org.springframework.security.ldap.authentication.BindAuthent
<beans:constructor-arg ref="contextSource"/> ]
<beans:property name="userSearch" ref="userSearch'"/>
</beans:bean>
</beans:constructor-arg>
<beans:constructor-arg>
<beans:bean class="org.springframework.security.ldap.userdetails.DefaultLdapAu
<beans:constructor-arg ref="contextSource"/>
<beans:constructor-arg value="DC=company,DC=com"/>
<beans:property name="groupSearchFilter" value="member={0}"/>
<beans:property name="groupRoleAttribute" value="cn"/>
<beans:property name="searchSubtree" value="true" />
<beans:property name="convertToUpperCase" value="false" />
<beans:property name="rolePrefix" value="" />
</beans:bean>
</beans:constructor-arg>
</beans:bean>

o
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<beans:bean id="userSearch" class="org.springframework.security.ldap.search.FilterB
<beans:constructor-arg index="0" value="DC=company,DC=com" /> i
<beans:constructor-arg index="1" value="sAMAccountName={0}" />
<beans:constructor-arg index="2" ref="contextSource'" /> d
<beans:property name="searchSubtree" value="true" /> '
</beans:bean>

Configuration parameters

Go to Administration > Configuration parameters:

Field / Property Type Description
principal.adapter String com.openkm.principal.LdapPrincipalAdapter
system.login.lowercase String true
principal.ldap.server String ldap://192.168.xxx.xxx:389
principal.ldap.security.principal String CN=Administrator, OU=OPENKM, DC=company, DC=com
principal.ldap.security.credentials String password
principal.ldap.referral String follow
principal.ldap.users.from.roles Boolean false
principal.ldap.user.attribute String sAMAccountName
principal.ldap.user.search.base List DC=company,DC=com
principal.ldap.user.search.filter String (objectclass=user)
principal.ldap.username.attribute String e
principal.ldap.username.search.base String DC=company,DC=com
principal.ldap.username.search.filter String (& (objectClass=person) (sAMAccountName={0}))
principal.ldap.mail.attribute String mail
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principal.ldap.mail.search.base

principal.ldap.mail.search.filter

principal.ldap.role.attribute

principal.ldap.role.search.base

principal.ldap.role.search.filter

principal.ldap.roles.by.user.attribute

principal.ldap.roles.by.user.search.base

principal.ldap.roles.by.user.search.filter

principal.ldap.users.by.role.attribute

principal.ldap.users.by.role.search.base

principal.ldap.users.by.role.search.filter

String

String

String

List

String

String

String

String

String

String

String

DC=company, DC=com

(& (objectClass=person) (sAMAccountName={0}))

cn

DC=company, DC=com

(objectclass=group)

memberOf

DC=company, DC=com

(& (objectClass=person) (sAMAccountName={0}))

member

DC=company, DC=com

(& (objectClass=group) (CN={0}))
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Active Directory example with login based on filtering users by roles

In this example, we'll see an Active Directory connection that allows connecting any Active Directory authenticated user

member of ROLE_USER or ROLE_ADMIN.

LDAP structure

dc=com
dc=company
ou=0PENKM

cn=ROLE ADMIN
member=okmAdmin
member=userl

cn=ROLE USER
member=user3

cn=ROLE XXXX
member=user?

cn=ROLE YYYY
member=user4

: ou=organizationl ]
sAMAccountName=okmAdmin
! memberOf=CN=ROLE ADMIN, OU=0OPENKM, DC=company , DC=com J
i userPrincipalName=okmAdmin@mail.com ]
‘ cn=0penKM Administrator '
sAMAccountName=userl
! memberOf=CN=ROLE ADMIN, OU=0OPENKM, DC=company , DC=com ]
i userPrincipalName=userl@mail.com ]
cn=User Name 1
P sAMAccountName=userZ2 '
i memberOf=CN=ROLE XXXX,OU=OPENKM,DC=company , DC=com i
‘ userPrincipalName=user2@mail.com ‘
cn=User Name 3
! ou=organization2 i
: SsAMAccountName=user3 ]
: memberOf=CN=ROLE USER, OU=OPENKM, DC=company , DC=com ‘
userPrincipalName=user3@mail.com
i cn=User Name 3 J
: sAMAccountName=user4 '
memberOf=CN=ROLE YYYY,OU=OPENKM, DC=company , DC=com
! userPrincipalName=user4@mail.com ]
i cn=User Name 4 J

Valid groups:

e cn=ROLE_ADMIN,ou=OPENKM,dc=company,dc=com
e cn=ROLE_USER,ou=OPENKM,dc=company,dc=com
e cn=ROLE_XXXX,ou=OPENKM,dc=company,dc=com

e cn=ROLE_YYYY,ou=OPENKM,dc=company,dc=com
Valid users:

e cn=userl,ou=organizationl,dc=company,dc=com
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* cn=user2,ou=organizationl,dc=company,dc=com

Invalid users:

» cn=user3,ou=organization2,dc=company,dc=com

* cn=user4,ou=organization2,dc=company,dc=com

i i
1

i i Any distinguished name includes by default dc=company,dc=com except users who are not a member of i
i ROLE_ADMIN or ROLE_USER i
A J
OpenKM.xml

e Users created in any Active Directory node members of ROLE_ADMIN or ROLE_USER will be able to log in because
it has defined DC=company,DC=com as the base filter, and as user account filter.
« Groups read by OpenKM can be created in an Active Directory node, because it has defined DC=company,DC=com as

the base filter.

<?xml version="1.0" encoding="UTF-8"?>
<beans:beans xmlns:beans="http://www.springframework.org/schema/beans" i
xmlns:security="http://www.springframework.org/schema/security" ]
xmlns:task="http://www.springframework.org/schema/task" i
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" E
xsi:schemaLocation="http://www.springframework.orqg/schema/beans ]
http://www.springframework.org/schema/beans/spring-b
http://www.springframework.org/schema/security i
http://www.springframework.org/schema/securlty/sprlm
http://www.springframework.orqg/schema/task
http://www.springframework.orqg/schema/task/spring- ta

<security:authentication-manager alias="authenticationManager'>
<security:authentication-provider ref="ldapAuthProvider" />
</security:authentication-manager>

<beans:bean id="contextSource" class="org.springframework.security.ldap.DefaultSprin
<beans:constructor-arg value="ldap://192.168.xxx.xxx"/>
<beans:property name="userDn'" value="CN=connect,OU=OpenKM,DC=company,DC=com" />
<beans:property name="password" value="****"/>
<beans:property name="baseEnvironmentProperties'>
<beans:map>
<beans:entry>
<beans:key>
<beans:value>java.naming.referral</beans:value>
</beans:key>
<beans:value>follow</beans:value>
</beans:entry>
</beans :map>
</beans:property>
</beans:bean>

<beans:bean id="ldapAuthProvider" class:"org.springframework.security.ldap.authentioa
<beans:constructor-arg>
<beans:bean class="org.springframework.security.ldap.authentication. BlndAuthentlc
<beans:constructor-arg ref="contextSource"/>
<beans:property name="userSearch" ref="userSearch"/>
</beans:bean>
</beans:constructor-arg>
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<beans:constructor-arg>
<beans:bean class="org.springframework.security.ldap.userdetails. DefaultLdapAuth
<beans:constructor-arg ref="contextSource"/>
<beans:constructor-arg value="DC=company,DC=com" />
<beans:property name="groupSearchFilter" value="member={0}"/>
<beans:property name="groupRoleAttribute" value="cn"/>
<beans:property name="searchSubtree" value="true" />
<beans:property name="convertToUpperCase'" value="false" />
<beans:property name="rolePrefix" value="" />
</beans:bean>
</beans:constructor-arg>
</beans:bean>

<beans:bean id="userSearch" class="org.springframework.security. ldap.search.FﬁlterBés
<beans:constructor-arg index="0" value="DC=company,DC=com" /> !
<beans:constructor-arg index="1" value="(&amp; (sAMAccountName={0}) (| (memberOf= CN—RO
<beans:constructor-arg index="2" ref="contextSource" /> '
<beans:property name="searchSubtree" value="true" /> E
</beans :bean> i

</beans:beans>

Configuration parameters

o User members of ROLE_ADMIN or ROLE_USER can be created in any active directory node, because it has defined
DC=company,DC=com as base filter, principal.ldap.user.search.base=DC=company,DC=com and user search filter
as principal.ldap.user.search.filter=(&(objectclass=user)(]
(memberOf=CN=ROLE_ADMIN,OU=0OpenKM,DC=company,DC=com).

e Groups can be created in any active directory node, because is has DC=company,DC=com as base filter,
principal.ldap.role.search.base=DC=company,DC=com.

o All Active Directory groups will be listed because it has not applied any filter restriction
principal.ldap.role.search.filter=(objectclass=group).

e Mail attribute used in this case is userPrincipalName ( the most common LDAP attribute to get mail is mail )

principal.ldap.mail.attribute=userPrincipal Name.

Go to Administration > Configuration parameters:

Field / Property Type Description
principal.adapter String com.openkm.principal.LdapPrincipalAdapter
system.login.lowercase String true
principal.ldap.server String ldap://192.168.xxx.xxx:389
principal.ldap.security.principal String CN=Administrator, OU=OPENKM, DC=company, DC=com
principal.ldap.security.credentials String password
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principal.ldap.referral

principal.ldap.users.from.roles

principal.ldap.user.attribute

principal.ldap.user.search.base

principal.ldap.user.search.filter

principal.ldap.username.attribute

principal.ldap.username.search.base

principal.ldap.username.search.filter

principal.ldap.mail.attribute

principal.ldap.mail.search.base

principal.ldap.mail.search.filter

principal.ldap.role.attribute

principal.ldap.role.search.base

principal.ldap.role.search.filter

principal.ldap.roles.by.user.attribute

principal.ldap.roles.by.user.search.base

principal.ldap.roles.by.user.search.filter

String

Boolean

String

List

String

String

String

String

String

String

String

String

List

String

String

String

String

follow

false

sAMAccountName

DC=company, DC=com

(& (objectclass=user) (|

(memberOf=CN=ROLE ADMIN,OU=OpenKM, DC=company,l

(memberOf=CN=ROLE USER, OU=OpenKM, DC=company , D(

cn

DC=company, DC=com

(& (objectClass=person) (sAMAccountName={0}))

userPrincipalName

DC=company, DC=com

(& (objectClass=person) (sAMAccountName={0}))

cn

DC=company, DC=com

(objectclass=group)

memberOf

DC=company , DC=com

(& (objectClass=person) (sAMAccountName={0}))

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE Page 236 of 1191

principal.ldap.users.by.role.attribute String member
principal.ldap.users.by.role.search.base ~ String OU=0OpenKM, DC=company , DC=com
principal.ldap.users.by.role.search.filter ~ String (& (objectClass=group) (cn={0}))

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE Page 237 of 1191

Active Directory basic configuration

This is the suggested configuration to be used when roles and users are both defined in the same node, otherwise, refer to

another example.

LDAP structure

dc=com
dc=company
cn=users

cn=ROLE ADMIN
member=okmAdmin
member=userl

cn=ROLE USER
member=user3

cn=ROLE XXXX
member=user?

cn=ROLE YYYY
member=user4

sAMAccountName=okmAdmin
memberOf=cn=ROLE ADMIN,cn=users,dc=company,dc=com
userPrincipalName=okmAdmin@mail.com
cn=0OpenKM Administrator

sAMAccountName=userl
memberOf=cn=ROLE ADMIN,cn=users,dc=company,dc=com
userPrincipalName=userl@mail.com
cn=User Name 1

sAMAccountName=user2
memberOf=cn=ROLE USER,cn=users,dc=company,dc=com
userPrincipalName=user2@mail.com
cn=User Name 3

<security:ldap-server id="ldapServer"
url="ldap://192.168.0.6:389/DC=1dap,dc=company,dc=local"
manager-dn="CN=Administrator,cn=users,dc=company,dc=local"
manager-password="password" />

<security:authentication-manager alias="authenticationManager'>
<security:ldap-authentication-provider
server-ref="ldapServer"
user-search-base="cn=Users"
user-search-filter=" (sAMAccountName={0})"
group-search-base="cn=Users"
group-search-filter=" (member={0})"
group-role-attribute="cn"
role-prefix="none">
</security:ldap-authentication-provider>
</security:authentication-manager>

Configuration parameters

e User members of ROLE_ADMIN or ROLE_USER are created into users node ( these should be the distinguished names
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CN=ROLE_ADMIN,cn=users,DC=company,DC=com and CN=ROLE_USER,cn=users,DC=company,DC=com).

« Groups can be created on any Active Directory node, because DC=company,DC=com is set as base filter,

principal.ldap.role.search.base=DC=company,DC=com.

o All Active Directory groups will be listed because it has not applied any filter restriction

principal.ldap.role.search.filter=(objectclass=group).

Go to Administration > Configuration parameters:

Field / Property

principal.adapter

system.login.lowercase

principal.ldap.server

principal.ldap.security.principal

principal.ldap.security.credentials

principal.ldap.referral

principal.ldap.users.from.roles

principal.ldap.user.attribute

principal.ldap.user.search.base

principal.ldap.user.search.filter

principal.ldap.username.attribute

principal.ldap.username.search.base

principal.ldap.username.search.filter

principal.ldap.mail.attribute

principal.ldap.mail.search.base

Type

String

String

String

String

String

String

Boolean

String

List

String

String

String

String

String

String

Description

com.openkm.principal.LdapPrincipalAdapter

true

ldap://192.168.0.6:389

CN=Administrator,cn=users,dc=company,dc=local

password

false

sAMAccountName

cn=users,dc=company,dc=local

(objectclass=person)

cn

cn=users,dc=company,dc=local

(& (objectClass=person) (sAMAccountName={0}))

mail

cn=users,dc=company,dc=local
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principal.ldap.mail.search.filter

principal.ldap.role.attribute

principal.ldap.role.search.base

principal.ldap.role.search.filter

principal.ldap.roles.by.user.attribute

principal.ldap.roles.by.user.search.base

principal.ldap.roles.by.user.search.filter

principal.ldap.users.by.role.attribute

principal.ldap.users.by.role.search.base

principal.ldap.users.by.role.search.filter

String

String

List

String

String

String

String

String

String

String

(& (objectClass=person) (sAMAccountName={0}))

cn

cn=users,dc=company,dc=local

(objectclass=group)

memberOf

DC=company , DC=com

(& (objectClass=person) (sAMAccountName={0}))

member

cn={0},cn=users,dc=company,dc=local

(objectclass=group)
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Active Directory advanced configuration

LDAP structure

dc=com
dc=company
cn=users

cn=ROLE ADMIN
member=okmAdmin
member=userl

cn=ROLE USER
member=user3

cn=ROLE XXXX
member=user?2

cn=ROLE YYYY
member=user4

sAMAccountName=okmAdmin
memberOf=cn=ROLE ADMIN,cn=users,dc=company ,dc=com
userPrincipalName=okmAdmin@mail.com
cn=0OpenKM Administrator

sAMAccountName=userl
memberOf=cn=ROLE ADMIN,cn=users,dc=company ,dc=com
userPrincipalName=userl@mail.com
cn=User Name 1

sAMAccountName=userZ2
memberOf=cn=ROLE USER,cn=users,dc=company,dc=com
userPrincipalName=user2@mail.com
cn=User Name 3

<security:authentication-manager alias="authenticationManager'>
<security:authentication-provider ref="ldapAuthProvider" />
</security:authentication-manager>

E <beans:bean id="contextSource" class:"org.springframework.security.ldap.DefaultSpriﬁg
! <beans:constructor-arg value="ldap://192.168.0.6:389/dc=company,dc=local"/> i
i <beans:property name="userDn" value="CN=Administrator,cn=users,dc=company,dc=local"
E <beans:property name="password" value="password"/> E
' </beans:bean> '
| <beans:bean id="ldapAuthProvider" class="org.springframework.security.ldap.authentica
E <beans:constructor-arg> E
! <beans:bean class="org.springframework.security.ldap.authentication.BindAuthentilc
i <beans:constructor-arg ref="contextSource"/> ]
E <beans:property name="userSearch" ref="userSearch"/>

! </beans:bean>

P </beans:constructor-arg>

i <beans:constructor-arg>

E <beans:bean class="org.springframework.security.ldap.userdetails.DefaultLdapAuth
! <beans:constructor-arg ref="contextSource"/>

i <beans:constructor-arg value=""/>

: <beans:property name="groupSearchFilter" value="memberOf={1}"/>

E <beans:property name="groupRoleAttribute" value="cn"/>

! <beans:property name="searchSubtree" value="true" />

i <beans:property name="convertToUpperCase" value="false" />

E <beans:property name="rolePrefix" value="" />

' </beans:bean>

! </beans:constructor-arg>

o
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</beans :bean>

<beans:bean id="userSearch" class="org.springframework.security.ldap.search.FilterBas
<beans:constructor-arg index="0" value="" />
<beans:constructor-arg index="1" value="sAMAccountName={0}" /> '
<beans:constructor-arg index="2" ref="contextSource" /> J
<beans:property name="searchSubtree" value="true" /> i
</beans:bean>
Configuration parameters
o User members of ROLE_ADMIN or ROLE_USER are created into users node ( these should be the distinguished names
CN=ROLE_ADMIN,cn=users,DC=company,DC=com and CN=ROLE_USER,cn=users,DC=company,DC=com).
e Groups can be created on any Active Directory node, because DC=company,DC=com is set as base filter,
principal.ldap.role.search.base=DC=company,DC=com.
o All Active Directory groups will be listed because has not applied any filter restriction principal.ldap.role.search.filter=
(objectclass=group).
Go to Administration > Configuration parameters:
Field / Property Type Description
principal.adapter String com.openkm.principal.LdapPrincipalAdapter
system.login.lowercase String true
principal.ldap.server String ldap://192.168.0.6:389
principal.ldap.security.principal String CN=Administrator,cn=users,dc=company,dc=local
principal.ldap.security.credentials String password
principal.ldap.referral String
principal.ldap.users.from.roles Boolean false
principal.ldap.user.attribute String sAMAccountName
principal.ldap.user.search.base List dc=company,dc=local
principal.ldap.user.search.filter String (objectclass=person)
principal.ldap.username.attribute String e
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principal.ldap.username.search.base

principal.ldap.username.search.filter

principal.ldap.mail.attribute

principal.ldap.mail.search.base

principal.ldap.mail.search.filter

principal.ldap.role.attribute

principal.ldap.role.search.base

principal.ldap.role.search.filter

principal.ldap.roles.by.user.attribute

principal.ldap.roles.by.user.search.base

principal.ldap.roles.by.user.search.filter

principal.ldap.users.by.role.attribute

principal.ldap.users.by.role.search.base

principal.ldap.users.by.role.search.filter

String

String

String

String

String

String

List

String

String

String

String

String

String

String

dc=company,dc=1ocal

(& (objectClass=person) (sAMAccountName={0}))

mail

dc=company,dc=1ocal

(& (objectClass=person) (sAMAccountName={0}))

cn

dc=company,dc=1ocal

(objectclass=group)

memberOf

DC=company , DC=com

(& (objectClass=person) (sAMAccountName={0}))

member

dc=company,dc=1ocal

(& (objectClass=group) (cn={0}))

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE

Page 243 of 1191

LDAP best practices for filtering users and roles

Usually you only want to retrieve a subset of users and roles present in your LDAP, to be shown in user interface lists or be

able to login into.

Example based on single LDAP group

e Create a group named OpenKM (CN=OpenKM,CN=users,DC=company,DC=com). It will be used for filtering users

and roles purpose.

e Assign roles and users are members of OpenKM group.

¢ Goal, only users and roles which are members of OpenKM group will be displayed in user interface lists.

For filtering user interface:

Field / Property

principal.ldap.user.search.filter

principal.ldap.role.search.filter

principal.ldap.users.by.role.search.filter

principal.ldap.roles.by.user.search.filter

For login restriction:

Modify OpenKM.xml with:

Type

String

String

String

String

Description

(& (objectclass=person)

(memberOf=CN=OpenKM, CN=users,dc=company,dc=com,

(& (objectclass=group)

(memberOf=CN=OpenKM, CN=users,dc=company,dc=com,

(& (objectclass=group) (cn={0})

(memberOf=CN=OpenKM, CN=users,dc=company,dc=com,

(& (objectClass=person) (sAMAccountName={0})

(memberOf=CN=OpenKM, CN=users,dc=company,dc=com,

Example based on ROLE_USER and ROLE_ADMIN group

e Create group name OpenKM (CN=OpenKM,CN=users,DC=company,DC=com). It will be used for filtering roles

purpose.

« Assign roles are members of OpenKM group.

¢ Goal, only roles with OpenKM role will be displayed in user interface lists.
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 Goal, only users what are members of ROLE_USER or ROLE_ADMIN group will be displayed in user interface lists.

For filtering user interface:

Field / Property

principal.ldap.user.search.filter

principal.ldap.role.search.filter

principal.ldap.users.by.role.search.filter

principal.ldap.roles.by.user.search.filter

For login restriction:

Modify OpenKM.xml with:

Type

String

String

String

String

Description

(& (objectclass=person) (|
(memberOf=cn=ROLE USER,cn=users,dc=company ,dc=c

(memberOf=cn=ROLE ADMIN,cn=users,dc=company,dc:

(& (objectclass=group)

(memberOf=cn=0OpenKM,dc=company ,dc=com) )

(& (objectClass=group) (cn={0})

(memberOf=cn=0OpenKM,cn=users,DC=company,DC=com,

(& (objectClass=person) (sAMAccountName={0})

(memberOf=cn=0OpenKM,cn=users,DC=company,DC=com,

.
1
| There are some characters restricted in XML, one of these is &. Should be used &amp; in place you usually
1
i should use &, otherwise you will get an error on starting the application.
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ClearOS LDAP configuration

Need to install the Certificate Manager and Directory Server modules.

e Create an okmAdmin user in ClearOS.

e Create ROLE_ADMIN, ROLE_USER groups in ClearOS, populate.

LDAP Structure

dc=local
dc=mydomain
ou=Accounts
ou=Groups
cn=ROLE ADMIN
member=okmAdmin
member=userl
member=user2
objectClass=posixGroup
cn=ROLE USER
member=user3
member=user4
objectClass=posixGroup
cn=ROLE XXXX
objectClass=posixGroup
cn=ROLE YYYY
objectClass=posixGroup

ou=Users
uid=okmAdmin
memberOf=CN=ROLE ADMIN,ou=Groups,ou=Accounts,dc=mydomain,dc=local
mail=okmAdmin@mail.com
cn=0OpenKM Administrator
objectClass=inetOrgPerson
uid=userl
memberOf=CN=ROLE ADMIN,ou=Groups,ou=Accounts,dc=mydomain,dc=local
mail=userl@mail.com
cn=User Name 1
objectClass=inetOrgPerson
uid=user?2
memberOf=CN=ROLE ADMIN, ou=Groups,ou=Accounts,dc=mydomain,dc=Ilocal
mail=userZ@mail.com
cn=User Name 3
objectClass=inetOrgPerson

1 <?xml version="1.0" encoding="UTF-8"?>

' <beans:beans xmlns:beans="http://www.springframework.org/schema/beans" i
i xmlns:security="http://www.springframework.org/schema/security" ]
: xmlns:task="http://www.springframework.org/schema/task" ‘
E xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance" E
! xsi:schemaLocation="http://www.springframework.orqg/schema/beans ]
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</beans :bean>

</beans :bean>

<beans:property
<beans:property
<beans:property
<beans:property
<beans:property
</beans:bean>

</beans :bean>

</beans :bean>

</beans:beans>

http://www.springframework.
http://www.springframework.
http://www.springframework.
http://www.springframework.
http://www.springframework

<!-- Security configuration -->
<security:authentication-manager alias="authenticationManager'">
<security:authentication-provider ref="ldapAuthProvider" />

</security:authentication-manager>

</beans:constructor-arg>
<beans:constructor-arg>

<beans:constructor-arg ref="contextSource"/>
<beans:constructor-arg value="ou=groups,ou=Accounts"/>
name="groupSearchFilter" value="member={0}"/>

name="groupRoleAttribute" value="cn"/>
name="searchSubtree" value="true" />

name="convertToUpperCase" value="true" />

name="rolePrefix" value="" />

</beans:constructor-arg>

<beans:constructor-arg index="0" value="ou=Users,ou=Accounts" />
<beans:constructor-arg index="1" value="uid={0}" />
<beans:constructor-arg index="2" ref="contextSource" />
<beans:property name="searchSubtree" value="true" />

Configuration parameters

Go to Administration > Configuration parameters

org/schema/beans/spring-b
org/schema/security ]
org/schema/security/spri@

org/schema/task '

.org/schema/task/spring—ﬁa

<beans:bean id="contextSource" class="org.springframework.security.ldap.DefaultSpri.
<beans:constructor-arg value="ldaps://ldap.mydomain.local:636/dc=mydomain,dc=1loc
<beans:property name="userDn" Value:"cn:Manager,ou:Internal,dc=mydomain,dc:locaﬁ"
<beans:property name="password" value="passl234"/>

<beans:bean id="ldapAuthProvider" class:”org.springframework.security.ldap.authenﬁi
<beans:constructor-arg>
<beans:bean class="org.springframework.security.ldap.authentication.BindAuthenticat
<beans:constructor-arg ref="contextSource"/> i
<beans:property name="userSearch" ref="userSearch'"></beans:property>

Field / Property Type Description
principal.adapter String com.openkm.principal.LdapPrincipalAdapter
principal.database.filter.inactive.users Boolean true
principal.hide.connection.roles Boolean false
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system.login.lowercase

principal.ldap.server

principal.ldap.security.principal

principal.ldap.security.credentials

principal.ldap.referral

principal.ldap.users.from.roles

principal.ldap.user.attribute

principal.ldap.user.search.base

principal.ldap.user.search.filter

principal.ldap.username.attribute

principal.ldap.username.search.base

principal.ldap.username.search.filter

principal.ldap.mail.attribute

principal.ldap.mail.search.base

principal.ldap.mail.search.filter

principal.ldap.role.attribute

principal.ldap.role.search.base

principal.ldap.role.search.filter

String

String

String

String

String

Boolean

String

List

String

String

String

String

String

String

String

String

List

String

true

ldaps://ldap.mydomain.local: 636

cn=Manager,ou=Internal,dc=mydomain,dc=local

passl234

false

uid

ou=Users,ou=Accounts,dc=mydomain,dc=local

(objectClass=inetOrgPerson)

cn

ou=Users,ou=Accounts,dc=mydomain,dc=local

(& (objectclass=inetOrgPerson) (uid={0}))

mail

dc=company,dc=1ocal

(& (objectclass=inetOrgPerson) (uid={0}))

cn

ou=Groups,ou=Accounts,dc=mydomain,dc=local

objectClass=posixGroup
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principal.ldap.roles.by.user.attribute

principal.ldap.roles.by.user.search.base

principal.ldap.roles.by.user.search.filter

principal.ldap.users.by.role.attribute

principal.ldap.users.by.role.search.base

principal.ldap.users.by.role.search.filter

Create a Certificate

ClearOS by default only allows LDAPS.

String

String

String

String

String

String

memberOf

ou=Users,ou=Accounts,dc=mydomain,dc=local

(& (objectClass=person) (uid={0}))

member

ou=Groups,ou=Accounts,dc=mydomain,dc=local

(& (objectClass=posixGroup) (cn={0}))

P

that is permissive.

You should create a certificate on ClearOS with the leftmost RDN of the Subject being the common name

(FQDN) of your ClearOS server. Easy way is to only specify the common name, and when signing use a policy

You can create an alias (CNAME) called Idap if you wish.

$ openssl req -out Idap.csr -key private/sys-0-key.pem -new

$ openssl ca -policy policy_anything -days 3650 -out /etc/pki/CA/certs/ldap.mydomain.local.crt -infiles Idap.csr

Add the CA cert to the nssdb:

$ certutil -A -d /etc/pki/nssdb/ -n "CA certificate" -t "CT,," -a -i /etc/pki/CA/ca-cert.pem

The LDAP server certificate needs to be saved in the nssdb with the name of Server-Cert.

$ openssl pkcs12 -export -inkey /etc/pki/CA/private/sys-0-key.pem -in /etc/pki/CA/certs/ldap.mydomain.local.crt -out

/root/Server-Cert.p12 -nodes -name 'Server-Cert'

$ pki2util -i /root/Server-Cert.p12 -d /etc/pki/nssdb/

Edit the file/etc/openldap/slapd.conf:

$ vim /etc/openldap/slapd.conf

' TLSCACertificatePath /etc/pki/nssdb
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' TLSCertificateFile Server-Cert
' TLSVerifyClient never d

access to *
by self write
by peername.ip=127.0.0.1 read

by peername.ip=<OpenKM's IP address> read

Copy ClearOS' public CA certificate to the OpenKM server and add it to OpenKM's keystore:

$ keytool -import -trustcacerts -keystore /opt/openkm-6.2.3-community/java/jre/lib/security/cacerts -alias myca -file

/etc/pki/tls/certs/myca.pem
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LDAP troubleshooting

javax.naming.PartialResultException error

If you see an exception like this "javax.naming.PartialResultException" probably you can not use Active Directory basic
configuration.

javax.naming.PartialResultException: Unprocessed Continuation Reference(s); remaining name
'cn=users,dc=company,dc=com’

(TTTTTTTTY

Solution:

Enable Idap referral property.

Go to Administration > Configuration parameters:
Field / Property Type Description

principal.ldap.referral  String follow

Read these articles:

e Referrals in the JNDI
e JNDI Implementor Guidelines for LDAP Service Providers

Can't connect to LDAP server
If your LDAP server is configured under SSL then you should use ldaps://
Solution:
Go to Administration > Configuration parameters:
Change server connection URL to ldaps.
Field / Property Type Description

principal.ldap.server  String ldaps://192.168.0.6:389

Slow login or not able to login
It may be a problem with LDAP DNS names resolution.
Solution:

To prevent this issue - specially on Windows OS Family - it's a good practice to add all subdomains in application server's
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hosts file (/etc/hosts for linux or C:/Windows/system32/driver/etc/host for windows ).

Example based with active directory ( LDAP ) with distinguished base name dc=company,dc=com and server at SBSSERVER

domain server name.

1 10.10.1.2 company.com

' 10.10.1.2 SBSSERVER SBSSERVER.company.com

v 10.10.1.2 Schema.Configuration.company.com
i 10.10.1.2 Configuration.company.com

E 10.10.1.2 DomainDnsZones.company.com

' 10.10.1.2 ForestDnsZones.company.com

More information at OpenKM forum.

Force all users to be members of ROLE_USER

In a huge user AD repositories, can not be practice for the AD administrator to adding a new group to all the users, in this case

we can force across xml login configuration that any logged user be member of ROLE_USER. Must be added the xml tag

<beans:property name="defaultRole" value="ROLE_USER" />.

For example:

<?xml version="1.0" encoding="UTF-8"?>

xmlns:xsi="http://www.w3.
xsi:schemaLocation="http
http:
http:
http:
http:
http

</security:authentication-manager>

<beans :map>
<beans:entry>
<beans:key>

</beans:key>
</beans:entry>
</beans :map>

</beans:property>
</beans:bean>

<beans:constructor-arg>

<beans:beans xmlns:beans="http://www.springframework.org/schema/beans"

xmlns:task="http://www.springframework.org/schema/task"

org/2001/XMLSchema-instance"

2/ www.
//wWwWw .
/S www .
/S www .
/S www .
2/ www.

<beans:value>follow</beans:value>

springframework.
springframework.
springframework.
springframework.
springframework.
springframework.

<security:authentication-manager alias="authenticationManager'>
<security:authentication-provider ref="ldapAuthProvider" />

<beans:bean id="contextSource" class="org.springframework.security.ldap.DefaultSprin
<beans:constructor-arg value="ldap://192.168.xxx.xxx"/>
<beans:property name="userDn'" value="CN=connect,OU=OpenKM,DC=company,DC=com" />
<beans:property name="password" value="****"/>
<beans:property name="baseEnvironmentProperties'>

<beans:value>java.naming.referral</beans:value>

xmlns:security="http://www.springframework.org/schema/security" ]

org/schema/beans
org/schema/beans/spring-
org/schema/security
org/schema/securlty/sprlm
org/schema/task
org/schema/task/spring- ta

<beans:bean id="ldapAuthProvider" class:"org.springframework.security.ldap.authentiqa
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</beans:bean>
</beans:constructor-arg>
<beans:constructor-arg>

</beans :bean>
</beans:constructor-arg>
</beans:bean>

</beans:bean>

</beans:beans>

<beans:bean class="org.springframework.security.ldap.userdetails.DefaultLdapAuth
<beans:constructor-arg ref="contextSource"/>
<beans:constructor-arg value="DC=company,DC=com" />
<beans:property name="groupSearchFilter" value="member={0}"/>
<beans:property name="groupRoleAttribute" value="cn"/>
<beans:property name="searchSubtree" value="true" />
<beans:property name="convertToUpperCase" value="false" />
<beans:property name="rolePrefix" value="" />
<beans:property name="defaultRole" value="ROLE USER" />

<beans:bean class="org.springframework.security.ldap.authentication.BindAuthentic
<beans:constructor-arg ref="contextSource"/>
<beans:property name="userSearch" ref="userSearch"/>

[¢)

<beans:bean id="userSearch" class="org.springframework.security. ldap.search.FilterBa:s
<beans:constructor-arg index="0" value="DC=company,DC=com" /> '
<beans:constructor-arg index="1" value="(&amp; (sAMAccountName={0}) (| (memberOf=CN= RO
<beans:constructor-arg index="2" ref="contextSource" />
<beans:property name="searchSubtree" value="true" />

org.springframework.beans.factory.parsing. BeanDefinitionParsingException

If you see an error like this "org.springframework.beans.factory.parsing. BeanDefinitionParsingException" probably you have

some spring wrong version set in the OpenKM.xml:

at

n org.springframework.beans.factory.parsing.BeanDefinitionParsingException: Configuration problem: You
cannot use a spring-security-2.0.xsd or spring-security-3.0.xsd or spring-security-3.1.xsd schema with Spring
Security 3.2. Please update your schema declarations to the 3.2 schema.

Offending resource: URL [file:/desarrollo/tomcat/tomcat-7.0.61-openkm-6.4/OpenKM.xml]

org.springframework.beans.factory.parsing.FailFastProblemReporter.fatal(FailFastProblemReporter.java:59)

Solution:

Edit the OpenKM.xml file and remove the version numbers:

<?xml version="1.0" encoding="UTF-8"?>
<beans:beans xmlns:beans="http://www.springframework.orqg/schema/beans"
xmlns:security="http://www.springframework.org/schema/security"
xmlns:task="http://www.springframework.org/schema/task"
xmlns:xsi="http://www.w3.
://www.springframework.org/schema/beans
http:
http:
http:
http:
http:

! xsi:schemaLocation="http

org/2001/XMLSchema-instance"

//www.springframework.org/schema/beans/spring-b
//www.springframework.org/schema/security i
//www.springframework.orqg/schema/securi ty/sprlrn
//www.springframework.org/schema/task
//www.springframework.org/schema/task/spring- t-a
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<?xml version="1.0" encoding="UTF-8"?>

<beans:beans xmlns:beans="http://www.springframework.org/schema/beans"

xmlns:task="http://www.springframework.org/schema/task"

xmlns:xsi="http://www.w3.

org/2001/XMLSchema-instance"

J//www .

springframework.

org/schema/beans

xmlns:security="http://www.springframework.org/schema/security" ]

http:
http:
http:
http

xsi:schemaLocation="http:
i http:

/S www .
J//wwWw .
/S www .
2/ www.
/S www .

springframework.
springframework.
springframework.
springframework.
springframework.

org/schema/security .
org/schema/security/sprin
org/schema/task 1
org/schema/task/spring—ti

LDAP: error code 8 - BindSimple: Transport encryption required

The transport encryption required error usually happens when you are trying to connect with ldaps ( with SSL encryption ) and

you have not configured the trust certificate into the JAVA certs storage.

First, check you are using "ldaps://" - ends with s - in your OpenKM.xml file for the connection, when you get this error you

sould use it.

The first step is to get the certificate from the server for it follow the steps below:

$ openssl s_client -showcerts -connect your.ldap.server.com:636

The output will contain a number of entries delimited with:

Copy the last certificate entry into a file (Idapca.crt)

Then, add it to the java keystore in $JRE_HOME/lib/securi

$ cd $JRE_HOME/lib/security

ty

$ keytool -import -alias Idapca_self_sign -keystore cacerts -storepass changeit -file Idapca.crt

Finally enable trust store into the file STOMCAT_HOME/bin/setenv.sh

1 Additional information:

e https://docs.spring.io/spring-ldap/docs/1.2.0/reference/#dir-context-url
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Ldap error: Caused by java.security.cert.CertificateException: No subject alternative DNS
name matching

In the log maybe show some stack trace error like:

1 Caused by:
! at
i at
i at
E at
| at
i at
E at

java.security.cert.CertificateException: No subject alternative DNS name
util.HostnameChecker.matchDNS (HostnameChecker. java:214)
util.HostnameChecker.match (HostnameChecker. java:96)

ssl.
ssl.
SSL
ssl.
ssl.

sun.

sun

sun.
sun.
sun.
sun.

sun
72

security.
.security.
security.
security.
security.
security.
.security.

more

X509TrustManagerImpl.checkIdentity (X509TrustManagerImpl ..j
X509TrustManagerImpl.checkIdentity (X509TrustManagerImpl. ﬁ
X509TrustManagerImpl.checkTrusted (X509TrustManagerImpl. ja
X509TrustManagerImpl.checkServerTrusted (X509TrustManagenl.
ClientHandshaker.serverCertificate(ClientHandshaker.javé:

Caused by:
at
at
at
at
at
at
at
at
at

.springframework.ldap.CommunicationException: simple bind failed: ldap.

springframework.ldap.support.LdapUtils.convertLdapException (LdapUtils.

.springframework.ldap.core.support.AbstractContextSource.createContext(.
.springframework.ldap.core.support.AbstractContextSource.doGetContext (A
.springframework.ldap.core.support.AbstractContextSource.getReadOnlyCdn
.Sspringframework.ldap.core.LdapTemplate.executeReadOnly (LdapTemplate. ja
.springframework.security.ldap.SpringSecurityLdapTemplate.searchForSing
.springframework.security.ldap.search.FilterBasedeapUserSearch.searcﬁF
.springframework.security.ldap.authentication.BindAuthenticator.authent
.springframework.security.ldap.authentication.LdapAuthenticationProvide

Modify JVM configuration parameters in setenv.sh or setenv.bat adding the JVM configuration parameter:

-Dcom.sun.jndi.ldap.object.disableEndpointldentification=true
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Log Configuration

Log4j based Log Configuration

OpenKM uses log4j which is a Java-based loggin utility. This is useful, for example when you need to get more information
about something that is not working properly in OpenKM, for example third-party application configuration or Spring
authentication. By default only log messages with INFO level are shown, but you can increase this log information by raising
the log level to WARN or DEBUG. The log configuration file is STOMCAT_HOME/conf/log4j.properties here you can change

the error level message generated by a give class or package.

When OpenKM detect a modification in the log4j.properties file, it will reload it so you don't need to stop and

TTTTTTTTY

start OpenKM to make these changes effectives.

Third-party application execution

This is useful when something like a document preview fails, because this way OpenKM will log every external program

execution:

Enable log authentication

If you need to debug the security configuration, edit the log4j.properties file and add this line:
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OpenOffice and LibreOffice configuration

A After changing system.openoffice.path parameter is required to restart application.

TTTT T TN

Linux

Debian & Ubuntu

OpenKM has been roughly tested with recent build of OpenOffice and LibreOffice, but in recent Linux distros
only LibreOffice is available to install. Anyway it works pretty well.

TTTTTTTTY

———

Install application:

Go to Administration > Configuration parameters:

Field / Property Type Description

The path may change depending your OS version. To verify that your

path is correct, take a look into your chosen path and it should be a
system.openoffice.path  String

B ————

folder named program, otherwise the path is not correct.

.

/usr/bin/libreoffice

CentOS

Install the application:

| |
I
i By default, OpenOffice or LibreOffice is not present on Red Hat repository. If you're using this OS then you i
I
i should try to install manually. !

I
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Download and install one of them from:

e LibreOffice: http://www.libreoffice.org
e OpenOffice: http://www.openoffice.org

E——

Check if you've installed all needed packages:

These packages are mandatory:

 openoffice.org-ure-3.1.1-19.5.el5_5.6 (ure )
 openoffice.org-headless-3.1.1-19.5.el5_5.6 ( headless )

 openoffice.org-pyuno-3.1.1-19.5.el5_5.6 ( pyuno )

The name of the packages can change depending your OpenOffice version. Take these as reference for your
check.

TTTT T T T

Go to Administration > Configuration parameters:

Field / Property Type Description

The path can change depending your OS version. To verify your path

is correct, into your chosen path should be a folder named program,
system.openoffice.path  String

B ————
.

otherwise the path is not correct.

/usr/bin/libreoffice

Windows

Download and install one of them:

e LibreOffice: http://www.libreoffice.org
e OpenOffice: http://www.openaoffice.org

i Our suggestion is to use OpenOffice in Windows OS. In some Windows OS we've found unexpected problems that

are automatically solved changing LibreOffice to OpenOffice. Take it only as a suggestion.

TTTTTTTTY

Go to Administration > Configuration parameters:

Field / Property Type Description

=TT

The path can change depending your OS version. To verify your path
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Check configuration

system.openoffice.path

String

otherwise the path is not correct.

A is correct, into your chosen path should be a folder named program,

.|

c:\Program files\OpenOffice 4

« Go to Administration > Configuration parameters and click on check icon 'L:‘:' If all is right you should see under

system.openoffice.path parameter an OK status.

After application starts you should see a process called soffice.bin.

Upload a MS Office or OpenOffice file. Select the document and from toolbar choose the option Download as PDF @

e Take a look at sSTOMCAT_HOME/logs/catalina.log file. At the end of the startup process you should see something like

this:

2015-03-17
2015-03-17
2015-03-17
2015-03-17
2015-03-17
2015-03-17
2015-03-17
2015-03-17
2015-03-17
2015-03-17
2015-03-17
2015-03-17

[pool-2-thread-1]
[pool-2-thread-1]
[pool-2-thread-1]
[pool-2-thread-1]
[pool-2-thread-1]
[pool-2-thread-1]

[OfficeProcessThread-0]
[OfficeProcessThread-0]
[OfficeProcessThread-0]
[OfficeProcessThread-0]
[OfficeProcessThread-0]
[OfficeProcessThread-0]

INFO

com.
com.
com.
com.
com.
org.
WARN
INFO
INFO
WARN
INFO
INFO

org.
org.
org.
org.
org.
org.

.servlet.RepositoryStartupS

.util.DocConverter -

* kK Bu
(

.util.DocConverter - system
.util.DocConverter - sSystem
.util.DocConverter - systeim
artofsolving. jodconverter.office.

artofsolving
artofsolving
artofsolving
artofsolving
artofsolving
artofsolving

. jodconverter..o
.jodconverter.o
. jodconverter.'o
. jodconverter.o
. jodconverter.o
. jodconverter.o

Read

Libr

& LibreOffice configuration parameters.

I's to get more information about all available OpenOffice
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Security configuration

OpenKM can work with several security managers, depending on the selected value, the manner in which the result is evaluated
is different. This application has separated managers, one for the search engine and other for the rest of the application.

Search engine managers:

e lucene.

e am_more, am_window or am_limited.

i The fastest one is lucene, because it is the Lucene search engine which restricts the search results based on the
node security. The others are am_more, am_window and am_limited, which make use of the AccessManager -
security.access.manager value - to restrict the search results, these will reduce OpenKM performance (at least in

search) but will match customer requirements. The performance can be improved customizing

com.openkm.cache.parentNodePermissions cache.

Rest of application manager:

e simple.
e recursive.

e read_recursive.

The simple option only evaluates the selected node. With recursive, the security is evaluated starting with the
selected node until the repository root (so, evaluating form bottom to top). The read_recursive is used to prevent
showing documents in search results when any folder in the path doesn't have read access for the user who ran

the query. Should be used in combination with am_more.

e
DE—

Application by default is configured with:

Field / Property Type Description
security.access.manager String simple
security.search.evaluation ~ String lucene

Diferences betweem simple and recursive

o I okm:root
o I ]evel-1a
o I ]evel-2a

o I level-3a
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o U alpha.doc
o D beta.doc
o D gamma.doc
. level-3b
. level-1b

. level-1c

When using simple if you revoke permission from the level-2a folder and the user tries to view the level-3a folder, OpenKM will
still show the documents to this user. When the user performs a search, OpenKM will return these documents as search results.
However, the user can't access the documents because when OpenKM tries to access the document, it will open every path
location and will fail to open level-2a because the user has no rights. But these document can be accessed using the API. You

need to apply revoke recursively to prevent the user from seeing these documents, so they won't be shown in the search results.

When using recursive if you revoke permission from the level-2a folder and the user tries to view the level-3a folder, OpenKM
will report an error because Access Manager also evaluates the permission of the level-2a ancestor node. When the user
performs a search, OpenKM won't show these documents in the search results. Keep in mind that this Access Manager
implementation is slower because it needs to evaluate more nodes: the more depth node the more parent nodes need to be

evaluated.

Extending security

You can use the extend security to download files, start workflows, add, remove or modify property groups ( metadata ) or

compact history. To enable extended security evaluation you must change the value of security.extended.mask parameter.

i After the value is changed, refresh the browser to take effect in user view.

TTTTTTTY

Values:

o DOWNLOAD = 1024;
o START WORKFLOW = 2048,
o COMPACT _HISTORY = 4096;

e PROPERTY GROUP = 8192;

For example, to enable download and property groups you should put the mask 9216 ( 1024 + 8192 )

Field / Property Type Description

security.extended.mask  Integer 9216

Configuration for security changes which take a long time
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By default when you change the security of a node in standard view, every time you click to grant or revoke a permission the
action is performed by OpenKM. This means that if you want to change the security of 10 users, 10 commands are sent to the
server. This became a problem when every change affects several hundred (or even thousands) of nodes. There's an alternative

security configuration parameter named security.mode.multiple which enables multiple changes at a time, so it's so faster.

Field / Property Type Description

security.mode.multiple ~ Boolean true
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Cache configuration

OpenKM uses several caches to enhance performance. Some of these caches are directly used by OpenKM and others
indirectly, for example those used by Hibernate. All these caches have default values which make them useful but these default
values are not always good for every installation. The cache engine used is the very popular EHCache, which is widely used
and very configurable. You can see the default values at $TOMCAT_HOME/webapps/OpenKM/WEB-

INF/classes/ehcache.xml.

A Don't modify this file because all changes will be lost when OpenKM is restarted or updated.

TTTT T TN

If you want to tweak this default configuration you have to duplicate the provided configuration file

into STOMCAT_HOME/ehcache.xml and make the proper changes to match your requirements. This is a sample definition:

<cache name="com.openkm.cache.ldapPrincipalAdapter.general”
maxElementsInMemory="1000"
timeToIdleSeconds="300"
timeToLiveSeconds="0"
overflowToDisk="true"
eternal="false" />

The most important values are:

o timeToLive: The maximum number of seconds an element can exist in the cache regardless of use. The element expires
at this limit and will no longer be returned from the cache. The default value is 0, which means no TTL eviction takes
place (infinite lifetime).

o timeToldle: The maximum number of seconds an element can exist in the cache without being accessed. The element
expires at this limit and will no longer be returned from the cache. The default value is 0, which means no TTI eviction

takes place (infinite lifetime).

Be careful with eternal, because it sets whether elements are eternal. In case of true, timeouts are ignored and

TTTT T T T

the element never expires.

So, in this case the cache called "com.openkm.cache.ldapPrincipalAdapter.general” will have a maximum of 1000 elements in
memory and in case of overflow will be written to disk. These elements will be removed from this cache if are unused for 5
minutes. Otherwise, will remain forever. If you want to force a refresh, you have to change the timeToLiveSeconds to 3600 and

will be refreshed every hour.

You can check these caches status by going to Administration > Utilities > Cache stats. In this part you can enable and see the

cache usage stats and even reset a give one. More info at Cache stats.
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Throubleshooting

Here you can find some common problems and how to solve them. The context is grouped into several sections:

e Server configuration
e Client configuration
e Browser configuration

In special, take a look to Java and Chrome problem section into Browser configuration which will help you to get Java applets

working in Google Chrome.
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Server configuration

Packet for query is too large (MySQL)
If you get an error like this:

Packet for query is too large (1708726 > 1048576).

You can change this value on the server by setting the 'max_allowed_packet' variable.

You need to modify your MySQL server configuration file and increase the value of the max_allowed_packet property. Don't
forget to restart the MySQL after any change in this file. In Debian based distros like Ubuntu, this configuration file is located

at /etc/mysql/my.cnf.

Not able to connect from other computer in the network

~

V Ensure you have access from the other computers to the server.

.

Ensure your server firewall allows remote connection to the destination port.

If you expose the tomcat port 8080, ensure is binding your ip, the "address" parameter value should be "0.0.0.0" at

$TOMCAT_HOME/conf/server.xml:

<Connector port="8080" address="0.0.0.0" protocol="HTTP/1.1"
! connectionTimeout="20000" J
! redirectPort="8443" /> 1

Error downloading document as PDF

This error usually is caused by OpenOffice or LibreOffice service configuration.

.
|
i V Check if the OpenOffice or LIbreOffice service is started by OpenKM. You should get a program named
i "soffice.bin" running after application finished the startup.

IMAP SSL certificate error

First obtain the certificate with the openssl command and after this import the certificate with:

$ keytool -import -alias mail.yourcompany.com -keystore /etc/java-6-sun/security/cacerts -file imapd.pem

The application must be restarted to refresh the SSL certificates. More information at

TTTTTTTTY

nnecting+to+SSL+services.
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OpenKM server has no direct Internet connection

If you need a proxy to access the Internet, edit your " /etc/bash.bashrc" file as root and put these lines at the end of your

"/etc/bash.bashrc" file:

export http proxy=http://username:password@proxyserver.net:port/
export ftp proxy=http://username:password@proxyserver.net:port/

You can omit the username:password, if your proxy server has no password.

Access denied installing OpenKM as service on Windows 7

The command shell works slightly differently in Vista. By default when you run cmd.exe, it does not give administrator rights.

To get around it, create a shortcut to cmd.exe on desktop, open Properties > Compatibility tab and check box for

Administrator rights. Then you can do admin stuff on cmd line.

Problems with character encodings
If your language has non-ASCII characters and they are displayed as garbage you have a problem with encodings.

Check the STOMCAT/bin/setenv.sh or $TOMCAT/bin/setenv.bat file. You should have set the JVM parameter "-

Dfile.encoding=utf-8".

i The application must be restarted.

TTTTTTTY

PermGen errors

i Since Java 8 there is no such PermSize and MaxPermSize options.

TTTTTTTY

If you see this error:

java.lang.OutOfMemoryError: PermGen space

Edit your "$TOMCAT_HOME/bin/setenv.sh" (or "$TOMCAT_HOME/bin/setenv.bat" if using Windows) and increase the

value of the JVM parameter "-XX:MaxPermSize":

See also Presenting the Permanent Generation.
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LDAP Sizelimit exceeded

Caused because bindDN has size limit for each Idap query.

In Openldap The solution is to increase the limit of bindDN, for example ( to change size limit to user used by openkm Idap

connection )

See also OpenLDAP Limits.
Behind IIS proxy you get error 404 or 404.15

Using IIS as a web server by default it has a limit for the query string sent to the server if limit is passed then you get some

error screen on the client side:

X iEeAd8MdEEBC

Server Error

404 - File or directory not found.
The resource you are locking for might have been removed, had its name changed, oris temporarily unavailable.

In the server side we get a more detailed error:

RriEeaGNlidBOYRIED

Server Error in Application “DEFAULT WEB SITE/OPENKM®

Errar Surmmary
HTTP Error 404.15 - Mot Found
Thee regueest fitering module s condigured to deny a request where the query string bs o kang.

Eetaidpd b Sal s

Hok i BrgarsllibeeiagHerkiie v ¥ ke
e W L8 BT [ b= g = ke 2
[T e — !..:;hnq,l-lu alima s Npr eB M am ol melog g s Pralie

Lagrsat peb deteransd
Metunl

Legartiit pat detiraniesd

To solve this issue we need to increase the maximum size of the query string on the web server:

e Open Internet Information Services (IIS) Manager.
 In the Connections pane, go to the connection > site > application, or directory for which you want to modify your
request filtering settings.

o In the Home pane, double-click Request Filtering.
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Change the maximum query string length:

Edit Request Filtering Settings

Genaral

M allow unlisted file name extensions
¥ allow unlisted verbs

W Allow high-bit characters

™ Allow double escaping

(2] %]

— Request Limits
Maxirnuen allowed content lenath (Bykes):
30000000

Maximum URL length (Bytes):
1096

Maximum query string (Bytes):

|204s «

More information at OpenKM forum.

e Filee Wt Extivesaan .

-]

e
Carficsim

Darey M Harw Extarmen ..
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ol Hol
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IIS gets IOException: Internal Server Error while uploading file

Solution one

Change the "Maximum allowed content lenght (Bytes)" from your IIS configuration parameters:

Gomections L o o
@ L2 8 ﬂ Request Filtering
o L 5 Start Page

485 OKM-WIN (OKM-WIN\kis-admin)

Use this feature to configure filtering rules,

L;:j‘ App“cation Poo|5 [g:l FllE NEFI"IE E:ctensions ﬁ RUIE | O::o Hidden Segmenis | @ U
b-[@] Sites File Extefsion Allowed

f> 231 Server Farms

General

[v] Allow unlisted file name extensions
[+] Allow unlisted verbs
[+ Allow high-bit characters

[ ] Allow double escaping

Request Limnits

aximum allowed content length (Bytes):

300000000 |

Maximum URL length (Bytes):
|4096 |

Maxirmum query string (Bytes):
|4006 |

oK Ca

Solution two

e Go to webapps folder

o Edit the web.config file and add the following under <configuration> where "2097151" is the maximum allowed in

1IS:
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| <system.web>
' <httpRuntime maxRequestLength="2097151" /> ]
\ </system.web> :

<configuration>
! <system.web> ]
i <httpRuntime maxRequestLength="2097151" /> 1
i </system.web> i
</configuration>

Zoho fails with SSL connection

To use Zoho integration you have to configure your server to deliver the whole certificate chain by itself, because the Zoho
client does not looks for the chain. Our solution is reconfigure APR in Tomcat to deliver the CA chain separatly to the server

certificate.

The configuration file at "$TOMCAT_HOME/conf/server.xml" it looks like this:

<!-- Define a SSL HTTP/1.1 Connector on port 8443
This connector uses the JSSE configuration, when using APR, the
connector should be using the OpenSSL style configuration
described in the APR documentation -->

<Connector port="8443" address="0.0.0.0" protocol="HTTP/1.1" SSLEnabled="true"
maxThreads="150" scheme="https" secure="true" acceptCount="100"
enableLookups="false" clientAuth="true" sslProtocol="SSLv3"
SSLCipherSuite="ALL:!ADH:RC4+RSA:+HIGH:+MEDIUM: !LOW: !SSLv2: !EXPORT"
SSLCertificateFile="/home/openkm/tomcat-7.0.27/cert/serverpublic.pem"
SSLCertificateKeyFile="/home/openkm/tomcat-7.0.27/cert/serverprivate.pe
SSLCertificateChainFile="/home/openkm/tomcat—7.0.27/cert/serverpublicdh
allowUnsafeLegacyRenegotiation="false"

Sigar java.lang.UnsatisfiedLinkError Known issue in Windows

If you have OpenOffice or LibreOffice configured and you get the error "sigar java.lang.UnsatisfiedLinkError"probably you

have missing the "sigar path" in "PATH" environment variable.

Caused by: java.lang.UnsatisfiedLinkError: org.hyperic.sigar.sigar.getSigNum(Ljava/lEa.
! at org.hyperic.sigar.Sigar.getSigNum (Native Method) J
\  at org.hyperic.sigar.Sigar.kill (Sigar.java:275) i

Edit your general environment variable "PATH" and add your "$TOMCAT_HOME\lib\sigar\" folder, for example like

PATH-=...;C:\tomcat-7.0.27\lib\sigar
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i The application must be restarted.

TTTTTTTY

WARN net.sf.ehcache.hibernate.strategy.AbstractReadWriteEhcacheAccessStrategy

If you see this message:

A soft-locked cache entry was expired by the underlying Ehcache.
If this happens regularly you should consider increasing the cache timeouts and/or c

Do you experiencing any performance or usability problems as a result of this warning? If not then it seems like you should

treat this warning as just that: a warning.

Otherwise, it looks like the solution is to increase the size of maxElementsInMemory to account for the difference in what is

cached versus what is realistically being used.

OpenOffice is not starting on Windows

Sometimes is not easy to get OpenKM with soffice service started for several and strange reason which depends on your OS

Windows version and other specific configuration done in server.

First of all ensure your OpenOffice path is correctly configured at Administration > Configuration parameters >

"system.openoffice.path" parameter.

Ensure there's no other soffice.bin instance running. If there're another soffice.bin instance on execution openkm will not be

able to start their own soffice service. Take a look at the process running on Widnows or use a tool like Process Explorer.
Stop firewall and other possible tools which be able to do not allow start soffice service. For example the antivirus.
Try starting application from command line at "%TOMCAT_HOME/bin":

$ catalina.bat run

A Another option is open a command line with administrator grants. In some Windows OS appears a checkbox to
execute with some restrictions, we suggest try both options.

We've observated in some cases the execution with some restrictions goes right and not the case without any
restriction.

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.

a,


http://technet.microsoft.com/es-es/sysinternals/bb896653.aspx
https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE Page 271 of 1191

Client configuration

ZIP filenames with wrong charset

When you download an OpenKM as ZIP maybe the included files have a wrong charset. This only happens with non-latin
languages like Greek, Chinese or Arabic. This issue is corrected since OpenKM 4.1 and exported ZIP archives should be
opened without problems from WinZip 14 or higher. But UNICODE support in ZIP is a little tricky and may cause problems. To

ensure you won't have problems, try using 7-Zip which seems to handle these UNICODE filenames.

The other problem you may have is when you want to import a ZIP into OpenKM. In this case you can also get wrong filenames.

Filenames should be encoded in UNICODE, and to ensure it you can force 7-Zip to use this encoding when creating a ZIP:

| 4
Add to Archive ==
Archive:
mare zip -
Archive format: [zip - ] Update mode:
[Add and replace files v]
Compression level: [Hnrrnal ']
Options
Compression method: [DEﬂE'tE T] Create SFX archive
Diictionany size: [32 KE - ] [] Compress shared files
Word size: [32 '] Encryption
Solid Block size: Enter password:
Number of CPU threads: /2
Reenter password:
Memory usage for Compressing: &7 MB
Memony usage for Decompressing: 2 MB ["] Show Password
Split to volumes, bytes: Encryption method: ZipCrypto -
Parameters:
CL+
OK | | cancel | | Heb

If you are on Windows you can download 7-Zip from http://www.7-zip.org/. You can also install the port of the 7-Zip

compression tool for Linux:
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$ sudo aptitude install p7zip-full p7zip

Microsoft Office Addin disappears after Office restart
Could be a problem with default template ( normal.dot ). To solve try it:

¢ Open normal.dot
e Go to menu tools / personalize / Tool bars
e Open OpenKM toolbar

e Save normal.dot

Error in Uploader / Scanner applet

To provide more complete information in order to determine the issue, please activate the Java Console. Read How do I enable

and view the Java Console? for more info.
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Browser configuration

On latest browsers versions the steps described below could not be exactly the same. Take it as a reference of

TTTT T T T

what you should be looking for.

Firefox cause error when click on "Copy to clipboard”

To enable JavaScript "Copy to clipboard" buttons on Firefox and Mozilla, enter the following line into browser address bar:

"about:config".

The list of preferences should open in browser window. Right-click somewhere in the active part of preference list window and
choose New > Boolean option from context menu. Paste the following Preference name into the New boolean value window

input box: "signed.applets.codebase_principal_support".

Unable to run Scanner applet under Linux

If you enable the Java Console and see this error:

java.lang.UnsatisfiedLinkError: uk.co.mmscomputing.util.JarLib.loadX: Could not find

You have to install the libsane-dev package:

$ sudo aptitude install libsane-dev

Internet Explorer error "Document name is different”

This is a known error in Internet Explorer family. To disable name mismatch check, change the value of configuration

parameter named "system.document.name.mismatch.check" to false.

L} . . . .
1 More information at Other configuration parameters

TTTTTTTY

Internet Explorer error downloading files in HTTPS / SSL connections

There's a very old bug from version 5.5 until now that seems like Microsoft has not decided to fix , that causes a problem

downloading files with IE behind SSL protocol ( the force may be with you, hope some day they will decide to fix it).

The problem is caused by "Cache-control: no-cache HTTP header to the response message ", obviously that's valid for any

browser except IE family ... other Microsoft IE hidden feature ?

Can see some supporting and forum information about it:

e |E SSL download problem
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e http://support.microsoft.com/kb/815313
e http://support.microsoft.com/kb/323308

o http://support.microsoft.com/kb/316431
The solution is to change a couple of entries in the Windows Registry:

e Create a file called ss_download_patch.reg

o Copy the contents

REGEDIT4

[HKEY LOCAL MACHINE\Software\Microsoft\Windows\CurrentVersion\Internet Settings]
"DisableCachingOfSSLPages'"=dword: 00000000

"BypassSSLNoCacheCheck"=dword: 00000001

"BypassHTTPNoCacheCheck"=dword: 00000001

"SSLPragmaNoCache'"=dword: 00000001

o Execute it (will be imported into Windows Registry)

o Then you need to restart Windows for this to take effect.

Google Chrome and Java applets

As you can read at Java and Google Chrome Browser, Chrome v45 no longer supports NPAPI which is required for Java
applets. So you won't be able of using some interesting features in OpenKM like Live Edit o Bulk Uploader (both applets).

There are a couple of workarounds:

« Use another browser like Firefox, which still has NPAPI support.

» Go back to Chrome v44 and enable NPAPI support.
If you prefer keep using Chrome (option 2), follow these steps:

e Uninstall Google Chrome from your computer (Control Panel > Uninstall a program)
* Download Google Chrome v44 portable and install it.

 Once installed, use this URL to access browser configuration: chrome://flags

¢ Look for Enable NPAPI, press Enable link and restart Chrome.

* Now you would be able to use Java applets again.
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Best practices reporting issues

To quickly help you in error identification and resolution, please try to follow the guideline below:

¢ Do a detailed description of the issue, that will help us understanding the problem do you have.

o When possible make screenshots of all the steps you followed . The idea is being able to reproduce the error or at least
understanding better the context where has occured.

e Videos are also welcome.

o Share the stack trace error from openkm.log file

Because support website have restriction in document size, share with us the downlaod link with online file

sharing tools like:

e https://transfer.sh/
o https://filepush.co/
e https://filetransfer.io/

o https://justbeamit.com/

Getting the stack trace

Linux

The openkm.log file is into the STOMCAT/logs folder. For example, in Linux a common location might be

"/home/openkm/tomcat-8.5.34/logs".
To wacth how openkm.log changes in real time you can use the command line:

/home/openkm/tomcat-8.5.34/logs:$ tail -f openkm.log

To show the last 500 lines of the openkm.log file you can use the command line:

/home/openkm/tomcat-8.5.34/logs:$ tail -n 500 openkm.log

Windows

The openkm.log file is into the $STOMCAT/logs folder. For example, in Linux a common location might be " c:\tomcat-

8.5.34\logs".

To wacth how openkm.log changes in real time you can a windows tools like mtail.

i You have a copy of mtail tools into c:\tomcat-8.5.34\extras\

TTTTTTTY
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Sample of stack trace capture

When you capture the stack trace error it is a good practice include some extra lines before and after the error

happens.

2019-08-04
2019-08-04
2019-08-04
2019-08-04
2019-08-04

12

:09:36,612

[Task Scheduler
[Task Scheduler

[http-nio-0.0.0.
[http-nio-0.0.0.
[http-nio-0.0.0.

18] [] INFO c.
19] [] INFO c.

0-8080-exec-6]
0-8080-exec-6]
0-8080-exec-6]

openkm.plugin.cron.BaseCronPﬁu
openkm.plugin.cron.BaseCronPlu
[okmAdmin] INFO com.openkm.ut
[okmAdmin] ERROR com.openkm.ut

com.
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at
at

openkm.

org.
org.
org.
org.
org.
com.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.
org.

apache.
apache.
apache.
apache.
apache.
openkm.
apache.
apache.

catalina.
catalina.

core.ParseException:
com.openkm.util.FormUtils.parsePropertyGroupsDefinition (FormUtils. java:308)
com.openkm.module.db.DbRepositoryModule.registerPropertyGroups(DbRepositoryModuﬁe
com.openkm.module.db.DbRepositoryModule.registerPropertyGroups (DbRepositoryModule
com.openkm.servlet.admin.PropertyGroupsServlet.doPost (PropertyGroupsServliet. java):
javax.servlet.http.HttpServlet.service (HttpServlet. java:661)
javax.servlet.http.HttpServlet.service (HttpServlet. java:742)
catalina.
catalina.
tomcat.websocket.server.WsFilter.doFilter (WsFilter.java:52) I

[okmAdmin] ERROR c.o.s.admin.P
type "hpanel" must be declared. ]

Element

core.ApplicationFilterChain.internalDoFilter (ApplicationFilt
core.ApplicationFilterChain.doFilter (ApplicationFilterChain.

[0)

J

core.ApplicationFilterChain. internalDoFilter(ApplicationFilE
core.ApplicationFilterChain.doFilter (ApplicationFilterChain. J

servlet.UserLoggingFilter.doFilter (UserLoggingFilter. java:33) I
catalina.
catalina.
springframework.
springframework.
apache.catalina.
apache.catalina.
springframework.
springframework.
apache.catalina.
apache.catalina.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.
springframework.

core.ApplicationFilterChain. 1nternalDoFllter(AppllcationFEIQe
core.ApplicationFilterChain.doFilter (ApplicationFilterChain.!j
boot.web.filter.ApplicationContextHeaderFilter.doFilterInternn
web.filter.OncePerRequestFilter.doFilter (OncePerRequestFilter
core.ApplicationFﬁlterChain.internalDoFilter(ApplicationFilﬁe
core.ApplicationFilterChain.doFilter (ApplicationFilterChain.\j
boot.actuate. trace.WebRequestTraceFilter.doFilterInternal (Web.
web.filter.OncePerRequestFﬁlter.doFilter(OncePerRequestFﬁltér
core.ApplicationFilterChain.internalDoFilter (ApplicationFilte
core.ApplicationFilterChain.doFilter (ApplicationFilterChain.j
security.web.FilterChainProxySVirtualFilterChain.doFilter (Fil
security.web.access.intercept.FilterSecurityInterceptor.invdk
security.web.access.intercept.FilterSecurityInterceptor.doFill
security.web.FilterChainProxySVirtualFilterChain.doFilter (Fil
security.web.access.ExceptionTranslationFilter.doFilter(Excép
security.web.FilterChainProxysVirtualFilterChain.doFilter (Fil
security.web.session.SessionManagementFilter.doFilter (Session.
security.web.FilterChainProxySVirtualFilterChain. doFilter(FL

security.web.authentication.AnonymousAuthenticationFilter. doF
security.web.FilterChainProxySVirtualFilterChain. doFﬁlter(Fll
security.web.servletapi.SecurityContextHolderAwareRequestFilt
security.web.FilterChainProxySVirtualFilterChain.doFilter (Fil
security.web.savedrequest.RequestCacheAwareFilter.doFilter(ée
security.web.FilterChainProxySVirtualFilterChain.doFilter (Fill
security.web.authentication.AbstractAuthenticationProcessingF
security.web.FilterChainProxySVirtualFilterChain.doFilter(Fﬁl
security.web.authentication.logout.LogoutFilter.doFilter (Logo
security.web.FilterChainProxySVirtualFilterChain.doFilter (Fill
web.filter.CorsFilter.doFilterInternal (CorsFilter.java:96) .

web.filter.OncePerRequestFilter.doFilter(OncePerRequestFiltér
security.web.FilterChainProxySVirtualFilterChain.doFilter (Fil
security.web.header.HeaderWriterFilter.doFilterInternal (Heade
web.filter.OncePerRequestFilter.doFilter (OncePerRequestFilter
security.web.FilterChainProxySVirtualFilterChain.doFilter(Fﬁl
security.web.context.SecurityContextPersistenceFilter.doFilte
security.web.FilterChainProxy$VirtualFilterChain. doFilter(FL

security.web.context.request.async. WebAsyncManagerIntegratlon
web.filter.OncePerRequestFilter. doFllter(OncePerRequestFﬁlter
security.web.FilterChainProxy$VirtualFilterChain.doFilter (Fil
security.web.FilterChainProxy.doFilterInternal(FilterChainPﬁo
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E at org.springframework.security.web.FilterChainProxy.doFilter(FilterChainProxy.javé:
! at org.springframework.web.filter.DelegatingFilterProxy.invokeDelegate (DelegatingFil
: at org.springframework.web.filter.DelegatingFilterProxy.doFilter (DelegatingFilterPro
E at org.apache.catalina.core.ApplicationFilterChain.internalDoFilter (ApplicationFilte
i at org.apache.catalina.core.ApplicationFilterChain.doFilter(ApplicationFilterChain.b
i at org.springframework.web.filter.RequestContextFilter.doFilterInternal (RequestConte.
| at org.springframework.web.filter.OncePerRequestFilter.doFilter (OncePerRequestFilter
E at org.apache.catalina.core.ApplicationFilterChain.internalDoFilter(ApplicationFilﬁe
! at org.apache.catalina.core.ApplicationFilterChain.doFilter (ApplicationFilterChain.!j
i at org.springframework.web.filter.HiddenHttpMethodFilter.doFilterInternal (HiddenHttp.
: at org.springframework.web.filter.OncePerRequestFilter.doFilter (OncePerRequestFilter
E at org.apache.catalina.core.ApplicationFilterChain.internalDoFilter(ApplicationFilﬁe
! at org.apache.catalina.core.ApplicationFilterChain.doFilter (ApplicationFilterChain.j
i at org.springframework.web.filter.CharacterEncodingFilter.doFilterInternal (Character.
E at org.springframework.web.filter.OncePerRequestFilter.doFilter(OncePerRequestFﬁltér
P at org.apache.catalina.core.ApplicationFilterChain.internalDoFilter (ApplicationFilte
i at org.apache.catalina.core.ApplicationFilterChain.doFilter (ApplicationFilterChain.j
| at org.springframework.boot.actuate.autoconfigure.MetricsFilter.doFilterInternal (Met
E at org.springframework.web.filter.OncePerRequestFilter.doFilter(OncePerRequestFﬁltér
! at org.apache.catalina.core.ApplicationFilterChain.internalDoFilter (ApplicationFilte
\  at org.apache.catalina.core.ApplicationFilterChain.doFilter (ApplicationFilterChain.j
E at org.apache.catalina.core.StandardWrapperValve.invoke (StandardiWrapperValve. java:19
i at org.apache.catalina.core.StandardContextvalve.invoke(StandardContextValve.java:Q6
i at org.apache.catalina.authenticator.AuthenticatorBase.invoke (AuthenticatorBase. javia
: at org.apache.catalina.core.StandardHostValve.invoke (StandardHostValve. java:140) '

E at org.apache.catalina.valves.ErrorReportValve.invoke (ErrorReportValve. java:80) E

! at org.apache.catalina.valves.AbstractAccessLogValve.invoke (AbstractAccessLogValve.!j
i at org.apache.catalina.core.StandardEngineValve.invoke (StandardEngineValve. java:87),

: at org.apache.catalina.connector.CoyoteAdapter.service (CoyoteAdapter.java:342) ‘

E at org.apache.coyote.httpll.HttpllProcessor.service (HttpllProcessor.java:799) E

! at org.apache.coyote.AbstractProcessorLight.process (AbstractProcessorLight. java:66)!

i at org.apache.coyote.AbstractProtocolSConnectionHandler.process (AbstractProtocol. jav
E at org.apache.tomcat.util.net.NioEndpoint$SocketProcessor.doRun(NioEndpoint.java:145
! at org.apache.tomcat.util.net.SocketProcessorBase.run (SocketProcessorBase.java:49)

\at java.util.concurrent.ThreadPoolExecutor.runWorker (ThreadPoolExecutor.java:1149) ,

i at java.util.concurrent.ThreadPoolExecutorSWorker.run (ThreadPoolExecutor.java:624) .

E at org.apache.tomcat.util.threads.TaskThreadSWrappingRunnable.run (TaskThread. java: 61
! at java.lang.Thread.run (Thread. java:748) J

\ 2019-08-04 12:10:00,000 [Task Scheduler 18] [] INFO c.openkm.plugin.cron.BaseCronPlu
1 2019-08-04 12:10:00,000 [Task Scheduler 6] [] INFO c.openkm.plugin.cron.BaseCronPlug
v 2019-08-04 12:10:00,000 [Task Scheduler 25] [] INFO c.openkm.plugin.cron.BaseCronPﬁu
v 2019-08-04 12:10:00,014 [Task Scheduler 6] [] INFO c.openkm.plugin.cron.BaseCronPlug
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Administration guide

OpenKM provides easy access to the application configuration by means of the "Administration Tab" located on the
administration system area. Relevant and useful information can be accessed to assist the administrator in controlling and

configuring the OpenKM repository.

Only users with ROLE_ADMIN can access the administration area. A new tab Administration will appear to
these users at the right top corner of system toolbar.

TTTTTTTTY

Administration layout:

Toolbar

Featured horizontal menu

Featured area

OpenKM administration provides access to:

Icon Name Description

Administration landing page. Here is shown:

@ Home « Application version.

e Installation UUID.

Almost all configuration parameters are set here.

(é}: Configuration With multi-tenant module enabled is possible to set different properties

depending on the tenant.

[TTTTTTTTY

| S —

parameters
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A Changes done here affect all the application.

TTTTTTTY

3 All registered document MIME types which OpenKM understands. You can modify,
Mime types
remove or add a new one.

Statistics . .
queue and Pending extraction queue.

-ﬂ A Shows information about repository size. Also can check the evolution of the Pending task

Scripting Execute JAVA scripts.

A
. Metadata Creates, modifies or removes metadata definitions.

Creates, modifies or removes users and roles.

&

( \
1 |
Users i When the application is configured to connect LDAP, these values can only i
i be changed on LDAP server because OpenKM connect to LDAP only in !
i read only mode. i
\ J
i‘ Profile A profile is a specific set of configurations for the user interface.

Database query  Execute queries to the database.

5 (ol

Reports Adds, removes or executes application reports.

User actions are registered in the OpenKM activity log.

()

L Activity log { . |
| 1 All activity log data is stored in OKM_ACTIVITY table. |
| )

{*é §:| Wofkflow Adds, removes or view status of registered workflows.

=] Sets automatic tasks based on application events like DOCUMENT _CREATION, among

|_‘?:'. Automation

others.
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.

&

Crontab

OMR ( Object
Mark

Recognition )

Thesaurus

Import

Export

Languages

Utilities

Adds or removes scheduled crontab tasks. The application uses these tasks to perform

actions like indexing documents, antivirus analyse among others.

Sets Object Mark Recognition parameters.

Execute thesaurus build action.

Repository import.

Repository export

Add, modifies or remove languages and manage translations.

A collection of advanced utilities:

e Cache Stats.

e Check e-mail.

o Check text extraction.
e Hibernate stats.

o List indexes.

e LogCat

« Profile stats.

e Purge permissions.
* Rebuild indexes.

» Repository checker.
* Repository view.

o System properties.

o Css.
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Configuration parameters

OpenKM is preconfigured with a number of parameters. However, if you plan to use it in production you should take a look at
Recommended configuration parameters. To access Configuration parameters go to Administration > Configuration

parameters.

Configuration parameters are shown in a table with three columns:

_________________________________________________________________________________________________________

Property key is the unique identifier for each configuration property.
There are several configuration types:

o String.

« Integer (‘only numeric values are allowed ).

 Boolean ( only true or false values allowed ).

o List (each break line is considered as new list element ).

o Text.

e File.
To create your own parameters read Creating your own parameters.

Edit a parameter

e Click edit icon Cv)
o View and modify the value.

e Click Edit button to confirm the change.

Delete a parameter

A You should not delete parameters if you're not totally sure about the implications of this action.

TTTT T TN

e Click remove icon @

¢ In Delete confirmation view click Delete button.

Backup configuration parameters

e Click at top right the Configuration parameters export icon '=*.
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¢ Browser will download an SQL file with the configuration.

Restore configuration parameters

A Restoring configuration parameters will remove actual parameters and will be replaced by newers.

TTTT T TN

¢ Go to bottom page.
e Select configuration parameter SQL file.

e Click @ Import button.

Check configuration

This action will check if some conflictive parameters are well configured ( pdf2swf, convert tool, OCR engine, OpenOffice or

LibreOffice path ).

Although a parameter may pass this check, it that not means it is 100% correct. Take it as a light check which

cannot covers all cases but is good approximation to discard most problems.

TTTT T T T

e Click at top right the Check icon @

o It will show the Configuration check view. If some parameters are misconfigured or wrong, it will be shown in red.

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE

Page 283 of 1191

Recommended configuration parameters

There are some recommended changes in the configuration:

Field / Property Type
application.url String
notification.message.body HTML
notification.message.subject Text
subscription.message.body HTML
subscription.message.subject Text

Description

This parameter is used in mail notifications and the copy-to-

clipboard feature among others.

By default OpenKM sets the access URL to
http://localhost:8080/0OpenKM/index.jsp, but obviously you don't

want to access your OpenKM installation only from localhost.

This parameter is used in mail notifications body.

<b>Message: </b>S{notificationMessage}<br/>
<b>User: </b>${userId}<br/>

<#list documentList as doc><b>Document:
</b><a href="S{doc.url}">S{doc.path}</a>

<br/></#list>

This parameter is used in mail notifications subject. Help users

identify that these emails are coming from OpenKM.

OpenKM - NOTIFICATION

This parameter is used in mail user subscription notification body.

<b>Document: </b>

<a href="${documentUrl}">S{documentPath}
</a><br/>

<b>User: </b>S{userId}<br/><b>Event:
</b>S{eventType}<br/>

<b>Comment: </b>S${subscriptionComment }<br/>

This parameter is used in mail subscription notification subject.

Help users identify that these emails are coming from OpenKM.

OpenKM - S{eventType} - S${documentPath}
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max.file.size String It indicates the maximum allowed file size which can be uploaded to
OpenKM. Default value is 0 indicates unlimited. Use size units with

KB, MB, GB or TB, otherwise value will be considered as bytes.

200MB
managed.text.extraction Boolean Enable or disable.
managed.text.extraction.batch Integer It indicates the number of documents being processed on each

indexing cycle.

i When parameter
"managed.text.extraction.concurrent” is enabled, is
a good practice to set multiple of

p—_————
DR—

"managed.text.extraction.pool.threads" value.

managed.text.extraction.concurrent Boolean  Enable or disable concurrent text extraction concurrent threads.

managed.text.extraction.pool.size Integer How many threads are launched concurrently every time. This
number should be smaller or equal to the number of CPUs in the

server.

managed.text.extraction.pool.threads  Integer Number of concurrent threads that will be used for text extraction.

p

A If "managed.text.extraction.pool.size" is 8 and
"managed.text.extraction.pool.threads" is set to 16
then all these 16 threads will be launched using this
pool. If every task take the same time to complete, in
theory every pool thread will execute two tasks. Of
course this is not true in the real world.

i It's a good practice to set this number to be less or
equal than CPU cores you want to use for text
extraction.

managed.text.extraction.pool.timeout  Integer How many minutes should the worker wait for the text extraction

pool to complete the tasks. After these minutes, the remaining pool

threads are interrupted.
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system.imagemagick.convert String Path to ImageMagick convert tool.

system.ocr String Path to OCR text extractor engine.
system.swftools.pdf2swf String Path to pd2swf conversion tool.
system.openoffice.path String Path to OpenOffice or LibreOffice installation.
logo.login File Login page logo.

It automatically tries to resize image to 316px * 74px
(suggested background #F1F3F5).

)

logo.mobile File Mobile login page logo.

{
i i It automatically tries to resize image to 161px x 38px
i (suggested background #F1F3F5).

logo.report File Default logo used in Jasper Reports.

{
i i It automatically tries to resize image to 150px * 35px
i (suggested background #FFF000).

logo.tiny File Small logo at top right corner in frontend UL

It automatically tries to resize image to 51px x 13px
( suggested background transparent).

)

logo.favicon File Small icon in left side of browser url.

i
i A The uploaded file must be a valid icon ( 16px x 16px
S

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE Page 286 of 1191

Preview parameters

In this section you can find the most common configuration parameters related to preview. Some of these commands are
included in OpenKM by default, like pdf2swf or ffmpeg (binaries compiles for Linux and Windows) but others need to be

installed by the system administrator.
Linux

Field / Property Type Description

system.imagemagick.convert  String )
Path to ImageMagick convert tool.

/usr/bin/convert

system.ocr String
Path to OCR text extractor engine.
/usr/bin/tesseract ${fileIn} ${fileOut}
system.swftools.pdf2sw, Strin
Y f pdf2swf 9 Path to pd2swf conversion tool.
/home/openkm/tomcat-7.0.27/bin/pdf2swf -f -T 9 -t
-s storeallcharacters ${fileIn} -o ${fileOut}
system.pdfimages String
Path to pdfimages extractor tool.
/usr/bin/pdfimages -j -f S${firstPage} -1
S{lastPage} S${fileIn} S{imageRoot}
. String
system.openoffice.path Path to OpenOffice or LibreOffice installation path.
/usr/lib/libreoffice
system.ghostscript String Path tot the ghosscript conversion tool.
/usr/bin/gs
Windows
Field / Property Type Description

system.imagemagick.convert = String  Path to image magick convert tool.
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system.ocr

system.swftools.pdf2swf

system.pdfimages

system.openoffice.path

system.ghostscript

String

String

String

String

String

C:\openkm\bin\convert.exe

Path to ocr text extractor engine.

C:\openkm\tools\Tesseract-OCR\tesseractexe

S${fileIn} ${fileOut}

Path to pd2swf conversion tool.

C:\openkm\bin\pdf2swf.exe -f -T 9 -t -s

storeallcharacters S{fileIn} -o S{fileOut}

Path to pdfimages extractor tool.

C:\openkm\tools\pdfimages -j -f S{firstPage} -1

S{lastPage} S${fileIn} S{imageRoot}

Path to Open Office or Libre Office installation path.

C:\Program Files (x86) \OpenOffice 4

Path tot the ghosscript conversion tool.

C:\openkm\bin\gswin32c.exe

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE Page 288 of 1191

LDAP configuration parameters

The OpenKM LDAP integration is based on a couple of LDAP searches to retrieve data.

LDAP queries are composed by tree elements:

1. Attribute or object to retrieve.
2. Node base to scope the request.

3. Filtering options.
Sample query

The query to retrieve mail attribute from an object of type person with sAMAccountName attribute value with {0} - this

parameter indicate the userld - from node cn=users,dc=company,dc=Ilocal and descendants.

principal.ldap.mail.attribute mail
principal.ldap.mail.search.base | cn=users,dc=company,dc=local

principal.ldap.mail.search.filter = (& (objectclass=person) (sAMAccountName={0}))

LDAP queries

e principal.ldap.user.* are used to retrieve user list.

e principal.ldap.username.* are used to retrieve user name.

e principal.ldap.mail.* are used to retrieve user mail adress.

e principal.ldap.role.* are used to retrieve role list.

e principal.ldap.roles.by.user.* are used to retrieve the roles of a user.

e principal.ldap.users.by.role.* are used to retrieve users of a role.

For retrieving data, are injected arguments into option filters. For example, for getting the user mail, the application use

parameter {0} to set argument value - userld - into filtering options.

Queries that use parameters to filtering:

o principal.ldap.mail.search.filter=(sAMAccountName={0}). Where {0} is attribute value retrieved from
principal.ldap.user.attribute.

e principal.ldap.roles.by.user.search.filter=(&(objectclass=user)(sAMAccountName={0})). Where {0} is attribute value
retrieved from principal.ldap.user.attribute.

o principal.ldap.username.search.filter=(sAMAccountName={0}). Where {0} is attribute value retrieved from

principal.ldap.user.attribute.
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« principal.ldap.users.by.role.search.filter=(&(objectClass=group)(cn={0})). Where {0} is attribute value retrieved from

principal.ldap.role.attribute.

Parameters
Field / Property Type Description

principal.adapter String Class used to connect with LDAP.
By default is empty. In case connecting to AD ( Microsoft Active
Directory ) must be set to "true", that force all users to be logged

system.login.lowercase String
with lowercase user Id. The reason is OpenKM is case sensitive
and Microsoft Active Directory not.

principal.ldap.server String LDAP server.

principal.ldap.security.principal String LDAP user distinguished name ( dn ).

principal.ldap.security.credentials String LDAP user password.

This property specifies how the referrals sent by AD in the
search results are handled by OpenKM. In almost most cases this

value is empty.

A Note for Active Directory (AD) users: AD servers
are apparently unable to handle referrals
automatically, which causes a
PartialResultException to be thrown
whenever a referral is encountered in a search. To
avoid this, set the
ignorePartialResultException
property to true. There is currently no way of
manually handling these referrals in the form of
ReferralException, i.e. either you get the
exception (and your results are lost) or all
referrals are ignored (if the server is unable to
handle them properly. Neither is there any simple
way to get notified that a
PartialResultException has been ignored
(other than in the log).

More information at Spring LdapTemplate.

Values might be:
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"ignore"

principal.ldap.referral String
If principal.ldap . referral=ignore, the following exception

will be thrown when a referral is encountered:

javax.naming.PartialResultException: Unprocessed
Continuation Reference(s); remaining name

'dc=company,dc=com’

"follow"

Ifprincipal.ldap.referral=follow, OpenKM will
automatically follow the referral. To be successful, make sure
OpenKM can access the referred server. The errors about

ReferralExceptions should not be shown.

"throw"

If principal. 1dap . re ferral=throw, the following exception

will be thrown:

com.sun.jndi.ldap.LdapReferralException: Continuation

Reference; remaining name 'dc=company,dc=com’

i More information at Referrals in the JNDI.

.

principal.ldap.users.from.roles Boolean When "true" tries to retrieve all users from roles list.

principal.ldap.user.attribute String User attribute.

principal.ldap.user.search.base List List of nodes base.

principal.ldap.user.search.filter String Filter options.

principal.ldap.username.attribute String Username attribute

principal.ldap.username.search.base String Node base.
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principal.ldap.username.search.filter

principal.ldap.mail.attribute

principal.ldap.mail.search.base

principal.ldap.mail.search.filter

principal.ldap.role.attribute

principal.ldap.role.search.base

principal.ldap.role.search.filter

principal.ldap.roles.by.user.attribute

principal.ldap.roles.by.user.search.base

principal.ldap.roles.by.user.search.filter

principal.ldap.users.by.role.attribute

principal.ldap.users.by.role.search.base

principal.ldap.users.by.role.search.filter

Sample configuration

Field / Property

principal.adapter
system.login.lowercase

principal.ldap.server

String

String

String

String

String

List

String

String

String

String

String

String

String

Type

String

String

String

Filter options.

Mail attribute.

Node base.

Filter options.

Role attribute.

List of nodes base.

Filter options.

User attribute.

Node Base.

Filter options.

Role attribute.

Node base.

Filter options.

Description

com.openkm.principal.LdapPrincipalAdapter

true

ldap://192.168.1.20:389
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principal.ldap.security.principal

principal.ldap.security.credentials

principal.ldap.referral

principal.ldap.users.from.roles

principal.ldap.user.attribute

principal.ldap.user.search.base

principal.ldap.user.search.filter

principal.ldap.username.attribute

principal.ldap.username.search.base

principal.ldap.username.search.filter

principal.ldap.mail.attribute

principal.ldap.mail.search.base

principal.ldap.mail.search.filter

principal.ldap.role.attribute

principal.ldap.role.search.base

principal.ldap.role.search.filter

principal.ldap.roles.by.user.attribute

principal.ldap.roles.by.user.search.base

String

String

String

Boolean

String

List

String

String

String

String

String

String

String

String

List

String

String

String

CN=Administrator,OU=OpenKM, DC=company , DC=com

password

false

SAMAccountName

DC=company, DC=com

objectclass=person

cn

DC=company, DC=com

(sAMAccountName={0}

mail

DC=company , DC=com

(sAMAccountName={0}

cn

DC=company,DC=com

objectclass=group

memberOf

DC=company,DC=com
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principal.ldap.roles.by.user.search.filter

principal.ldap.users.by.role.attribute

principal.ldap.users.by.role.search.base

principal.ldap.users.by.role.search.filter

String

String

String

String

(& (objectclass=person) (sAMAccountName={0}))

member

DC=company,DC=com

(& (objectClass=group) (cn={0}))
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User interface configuration parameters

The uploaded images - except in case of the favicon - are automatically resized to match the right size. Most image formats like

jpg, png, etc are allowed .

Field / Property Type Description

default.lang String Forces user interface language to a specific language. By default this

parameter is empty. The value is based on international language code.

en-GB

security.mode.multiple Boolean  Enabled alternative security mode that allows to apply several changes at

same time. Only one change is applied each time. By default the value is

"false".
:’ |
! After the parameter is changed, refresh the browser to take i
| ]
i effect. i
false
logo.favicon String Website icon.
logo.login String Login page logo.

i Automatically it tries to resize image to 316px x 74px (

suggested background #F1F3F5 ).

TTTTTTTTY

logo.mobile String Mobile logo.

i Automatically it tries to resize image to 161px x 38px (
suggested background #F1F3F5 ).

TTTTTTTTY

logo.report String Reports logo.

i Automatically it tries to resize image to 150px x 35px (
suggested background #FFF000 ).

TTTTTTTTY
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logo.tiny String A small logo is used at the top right in OpenKM user interface.

text.banner String Text shown at top of the logo in the landing page.

i Automatically it tries to resize image to 51px x 13px (

suggested background #E5ES5E] ).

TTTTTTTTY

text.title String Browser title. This text is set between

S{text.title}

html tags.

text.welcome String Text shown in the login table at the landing page.

Welcome to OpenKM !
Use a valid username and password to access to

OpenKM user Desktop.

keep.session.alive.interval Integer Some administration tasks take a long time, like repository checker and
rebuild Lucene indexes, these can cause the user session to be lost. For this
reason these type of operations are forced to maintain the session alive. By

default is set to 5 minutes.

5

schedule.session.keepalive Integer It is used by the user interface to maintain the browser connected to OpenKM
even when a user stays for some time without performing any operation. For
this reason, it should never be lower than server session timeout ( by default

set to 15 minutes ). By default is set to 5 minutes.

5

schedule.dashboard.refresh  Integer The application periodically does some operations like refreshing the
dashboard panel to get new imported mails, getting repository news or
showing latest documents created by other users among others. The time set

the period between dashboard panel will be refresh.

15
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schedule.ui.notification Integer User receives notification with a popup. The time - in minutes - indicate the

period used by application looking for new messages in server.

system.previewer Select The application can use "flexpaper" or "zviewer" tool to preview documents.

By default flexpaper previewer is enabled.

flexpaper

min.search.characters Integer Sets the minimum characters required to execute a search. With less

characters the search button will not be enabled.

3
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Workflow configuration parameters

Explain for what these parameteres are:
Field / Property Type Description

workflow.run.config.form String )
The form name in case the workflow needs parameters at the start. By default

this form is called "run_config".

run config

workflow.start.task.auto.run  String
If OpenKM should run the task defined in the start node. This start dummy task

is usually used to assign the "initiator" swimlane. By default the value is set to

"true". You don't need to modify this value.

true
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Notification configuration parameters

When a user is subscribed to a document, any change in the document will be notified to by email. These email messages are

created using some defined templates. These default templates to create messages can be adapted to your own style.

Field / Property Type Description

send.mail.from.user Boolean By default the application sends mail notifications setting the from
mail field value as the user mail address. When this parameter is
disabled it will use the default from mail address for all the mails
sent by the application ( all mails sent by the application will have

the same from mail address ).

i When mail server have restricted to change the
default from mail field ( for example when is not
allowed to use general@mail.com account to send
a mail with from mail field value user@mail.com ,
usually this kind of mail server configuration is set
to prevent spam) then this parameter must be set as
"false".

true

notification.message.subject Text Subject of the message sent when a user has chosen notify

something to other.

OpenKM - NOTIFICATION

notification.message.body HTML Body of the message sent when a user has chosen notify something

to other.

<b>Message: </b>S{notificationMessage}
<br/>

<b>User: </b>${userId}<br/>

<#list documentList as doc><b>Document:
</b><a href="S{doc.url}">S{doc.path}</a>

<br/></#list>

subscription.message.subject Text Subject of the message sent automatically caused by some event.

That happens because the user is subscribed to some node.
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OpenKM - S{eventType} - S{documentPath}

subscription.message.body HTML Body of the message sent automatically caused by some event.

That happens because user is subscribed to some node.

<b>Document: </b><a
href="${documentUrl}">S${documentPath}</a>
<br/>

<b>User: </b>S{userId}<br/><b>Event:
</b>S{eventType}<br/>

<b>Comment: </b>S${subscriptionComment }

<br/>

proposed.subscription.message.subject ~ Text Subject of the message sent when a user propose some node

subscription to other.

OpenKM - PROPOSED SUBSCRIPTION

proposed.subscription.message.body HTML Body of the message sent when a user propose some node

subscription to other.

<b>Comment:
</b>${proposedSubscriptionComment }<br/>
<b>User: </b>${userId}<br/>

<#list documentList as doc><b>Document:
</b><a href="S{doc.url}">S{doc.path}</a>

<br/></#list>

notify.twitter.status Text This is the text used in the notification twitter message.

OpenKM - S{documentUrl} - S${documentPath}

- S{userId} - S{eventType} Edit
Delete

notify.twitter.user String Twitter account username.

notify.twitter.password String Twitter account password.
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Substitutions

For notification.message.body property:

o ${documentUrl} or ${docUrl} shows the node URL..

o ${documentPath} or ${docPath} shows the node path.

o ${documentName} or ${docName} show the node name.
o ${userId} show the user id who caused the action.

« ${notificationMessage} show the notification message.

For subscription.message.body, proposed.subscription.message.body and notify.twitter.status properties:

o ${documentUrl} or ${docUrl} show the node URL.

o ${documentPath} or ${docPath} show the node path.

o ${documentName} or ${docName} show the node name.
o ${userId} show the user id who caused the event.

« ${eventType} show the event type.

o ${subscriptionComment}show the subscription comment.

A FreeMarker does not allow you to render null values (will throw an exception). If you expect a value to be null
you can also use the ! operator: ${content.title!}. This is the equivalent to ${content.title!}.

i More information at:

°j xt. M Form
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Document version numeration configuration

We support different numeration schemas. By default OpenKM uses

com.openkm.vernum.MajorMinorVersionNumerationAdapter which is similar to Jackrabbit implementation.

i More information about how to Creating your own Version Number Adapter.

TTTTTTTY

Field / Property Type Description

Numeration schema.

Available schemas :

e com.openkm.vernum.PlainVersionNumerationAdapter
version.numeration.adapter ~ String e com.openkm.vernum.MajorMinorVersionNumerationAdapter

e com.openkm.vernum.BranchVersionNumerationAdapter

» com.openkm.vernum.LetterVersionAdapter

» com.openkm.vernum.MajorMinorReleaseVersionNumerationAdapter

com.openkm.vernum.MajorMinorVersionNumerationAdapter

Numeration number format. Used in PlainVersionNumerationAdapter.
version.numeration.format String

oo

d

Some Numeration Adapters like PlainVersionNumerationAdapter may have additional configuration parameters like
version.numeration.format which is used to define the numeration number format. By default this is "%d" but you can change

to "%02d" to create versions like "01", "02", etc.

A Restarting application is needed after changing the value of version.numeration.adapter.

Also note that if already there are documents in the repository, changing the Numeration Adapter may cause
problems because they are not compatible between them.

—————— e —

—

Version numeration schemas

Numeration adapter First version Next versions
com.openkm.vernum.PlainVersionNumerationAdapter 1 2, 3, 4, etc.
com.openkm.vernum.MajorMinorVersionNumerationAdapter 1.0 1.1,1.2, 1.3, etc.
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com.openkm.vernum.BranchVersionNumerationAdapter 1 2,3,2.1,2.2, etc.
com.openkm.vernum.LetterVersionAdapter A A,B,C, etc.
com.openkm.vernum.MajorMinorReleaseVersionNumerationAdapter ~ 1.0.0 1.1.0,1.2.0, 1.2.1, etc.

Migration between versions

.
1
| We recommend you set the correct numeration at the beginning of using the application . Otherwise will be
1
i needed a migration of existing numeration and this operation is not always easy.

You can change the default Numeration Adapter using the "version.numeration.adapter" configuration parameter. You need
to restart OpenKM every time you change this parameter. Also note that if already there are documents in the repository,

changing the Numeration Adapter may cause problems when they are not compatible between them.

If you change the version numeration adapter you also need to update the existing numeration, for example the migration from

PlainVersionNumerationAdapter to MajorMinorVersionNumerationAdapter.

-—- HQL queries

UPDATE NodeDocumentVersion ndv SET ndv.name = '0Ol' WHERE ndv.name='1.0"';
UPDATE NodeDocumentVersion ndv SET ndv.name = '02' WHERE ndv.name='1l.1';
UPDATE NodeDocumentVersion ndv SET ndv.name = '03' WHERE ndv.name='1l.2"';
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Password validation configuration

Validation password enables the application to set a couple of rules that should be accomplished by passwords. By default,

application makes no password checking ( validator.password property is set by default to

com.openkm.validator.password.NoPasswordValidator ).

To enable validator password must change to com.openkm.validator.password.CompletePasswordValidator or Creating your

own password validator.

Field / Property

validator.password

validator.password.min.length

validator.password.max.length

validator.password.min.lowercase

validator.password.min.uppercase

validator.password.min.digits

validator.password.mini.special

Type

String

String

String

String

String

String

String

Description

Description

Available:

» com.openkm.validator.password.NoPasswordValidator

e com.openkm.validator.password.CompletePasswordValidator

com.openkm.validator.password.NoPasswordValidator

Minimum length allowed.

Numeric value greater than 0.

Maximum length allowed.

Numeric value greater than 0.

Minimum number of lower-case characters.

Numeric value greater than 0.

Minimum number of upper-case characters.

Numeric value greater than 0.

Minimum number of digits.

Numeric value greater than 0.

Minimum number of special characters.
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Sample configuration

e Must have at least 8 characters.

o At least must have 1 upper-case character.

o At least must have 1 digit.

Field / Property

validator.password

validator.password.min.length

validator.password.max.length

validator.password.min.lowercase

validator.password.min.uppercase

validator.password.min.digits

validator.password.mini.special

Type

String

String

String

String

String

String

String

Numeric value greater than 0.

Description

com.openkm.validator.password.CompletePasswordValia
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Switch application to read-only mode

It can force the whole repository to be in read-only mode. This is useful when doing maintenance tasks, or while migrating and

you wish to get the system alive for your users but want to ensure nobody can change anything.

Field / Property Type Description

Switch whole repository to be read-only. By default is set to false.

system.readonly ~ Boolean
false

A If you restart the application, this parameter will be automatically set to true.

i For security and performance reasons, when you execute Lucene rebuild indexes, the system will switch
automatically to read-only mode until the process is finished. Do not change manually, wait until be completed
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Security configuration parameters

Field / Property Type Description

default.user.role String
Sets the default general connection role.

Any user to successfully login in the screen needs to have
default.user.role or default.admin.role, otherwise will get
403 error.

,___________
SEe—

ROLE USER

default.admin.role String o ) ) ) )
Sets the default administration connection role. This role will get users

access to Administration tools.

| i
1

i - Any user to successfully login in the screen need to have i

. . . |

i default.user.role or default.admin.role, otherwise will get |

|

i 403 error. |

\. J

ROLE ADMIN

user.assign.document.creation =~ Boolean ) )
By default when a user creates a node, he is added to the node with full

permissions. You can disable this behavior by setting this parameter to

false. By default the parameters is set to true.

true

user.password.reset Boolean ) ) ) o
Sometimes the user loses or forgets their password. When this option is
enabled, used in landing page have got the option to restart their

password and be notified with a newer one by mail. By default this option

is set to false.

false

system.antivir String Path to antivirus.

A An antivirus can decrease perfomance, taking several
seconds to analyze each document and consuming a lot of
CPU resources.
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security.access.manager String Sets security access manager determinate the way on how the security is

evaluated. Default value is "simple".

Values:

e simple.
e recursive.

e read_recursive.

simple

Takes a look at Security configuration

security.search.evaluation String Sets the security search manager and determinates the way how the

security is evaluated by search engine.

Values:

o lucene.

e am_more, am_window or am_limited.

Take a look at Security configuration

security.extended.mask Integer Security evaluation can be extended to downloaded files, starts workflows,
adds, removes or modifies property groups ( metadata ) or compact

history. Default value is empty.

Values:

DOWNLOAD = 1024,
e START WORKFLOW = 2048,
e COMPACT _HISTORY = 4096;

e PROPERTY GROUP = 8192;

For example to enable download and property groups you should put the

mask 9216 ( 1024+8192 )

9216

Take a look at Security configuration
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security.live.change.node.limit  Integer When security changes affect more than the values set in this property the

security changes are applied as a background task.

100

Take a look at Security configuration

system.login.lowercase Boolean By default is empty. In case connecting to AD ( Microsoft Active Directory
) must be set to "true", that force all users to be logged with lowercase
user Id. The reason is OpenKM is case sensitive and Microsoft Active

Directory not.

principal.adapter String You must restart OpenKM service after you change this

TN

parameter

R—

OpenKM can handle user access using the Spring Security framework.
OpenKM needs an available method for reading users and roles, so when
users are stored in a database (as is the default), the class

DatabasePrincipalAdapter does this job.

com.openkm.core.DatabasePrincipalAdapter

If you configure OpenKM to authenticate against an LDAP server, you

need to configure another principal adapter like LdapPrincipalAdapter.

i More information at:

o LDAP configuration.

e Creatin r own login module.

principal.identifier.validation String Sets a regular expression to validate on the creation of user names and

roles names.

~[a-zA-Z0-9 _]+§

A This parameter only can be used in combination with
"principal.adapter" parameter value

"com.openkm.core.DatabasePrincipalAdapter".
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Extensions configuration parameters

HTML Editor 3

The application comes with integrated WYSIWYG editor based on tinyMCE v3.

The components of the editor can be parametrized with these parameters:

Field / Property

tinymce.plugins

Type

String

Description

Set enabled tinyMCE plugins.

Values:

codehighlighting
autolink

lists

e pagebreak

style

layer

table

save

advhr
advimage
advlink
emotions
iespell
inlinepopups

insertdatetime

® preview

media

searchreplace

e print

contextmenu

e paste

directionality
fullscreen

noneditable
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e visualchars
* nonbreaking
o xhtmlixtras
o template

e advlist

codehighlighting, autolink, lists, pagebreak,
layer, table, save, advhr, advimage,
emotions, iespell, inlinepopups,
preview, media, searchreplace, print,
paste, directionality, fullscreen,

visualchars, nonbreaking, xhtmlxtras,

advlist

Set the tinyMCE skin
Values:

tinymce.skin String

e 02k7

o02k7

Set the tinyMCE skin variant
Values:

tinymce.skin.variant String

e silver

silver

Set the tinyMCE theme
Values:
tinymce.theme String -
e simple

e advanced

advanced

Set elements present in first toolbar.

style,

insertdatetime,
contextmenu,
noneditable,

template,
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Values:

tinymce.theme.buttons1 String

okm
okm
codehighlighting,
strikethrough,
justifyright, justifyfull,

fontselect,

okm_checkin
okm_cancelcheckout
okm_searchDocument
okm_searchFolder
okm_searchImage
newdocument
codehighlighting
bold

italic

underline
strikethrough
justifyleft
justifycenter
justifyright
justifyfull

styleselect
formatselect
fontselect

fontsizeselect

checkin, okm cancelcheckout, okm searchDocument,

searchFolder, okm searchImage, newdocument,

|, bold, italic, underline,

|, justifyleft, justifycenter,
styleselect, formatselect,

fontsizeselect

Set elements present in second toolbar.

Values:

cutcopy
paste
pastetext

pasteword
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e search
e replace
o bullist
o numlist
e outdent

e indent

blockquote

¢ undo

¢ redo
tinymce.theme.buttons2 String e link

e unlink

e anchor

e image

e cleanup

e help

¢ code

insertdate

inserttime
® preview
e forecolor

e backcolor

cut, copy, paste, pastetext, pasteword, |, search,
replace, |, bullist, numlist, |, outdent, indent,
blockquote, |, undo, redo, |, link, unlink, anchor,
image, cleanup, help, code, |, insertdate, inserttime,

preview, |, forecolor, backcolor

Set elements present in third toolbar.

Values:

e tablecontrols
e hr

e removeformat
e visualaid

e sub
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e sup

e charmap

tinymce.theme.buttons3  String .
emotions

o iespell
* media
e advhr
e print
o ltr

o rtl

tablecontrols, |, hr, removeformat, visualaid, |, sub,
sup, |, charmap, emotions, iespell, media, advhr, |,

print, |, ltr, rtl

Set elements present in fourth toolbar.

Values:

insertlayer

moveforward

movebackward

absolute

styleprops
o cite
e abbr
tinymce.theme.buttons4  String ¢ acronym
o del
* ins
o attribs

visualchars

nonbreaking

template

e pagebreak

insertlayer, moveforward, movebackward, absolute, |,
styleprops, |, cite, abbr, acronym, del, ins, attribs,

| , visualchars, nonbreaking, template, pagebreak
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DXF applet viewer

Application comes with DXF applet viewer. If you observe problems on previewer text, you should configure the URL to
indicate an extra fonts repository used in AutoCAD files. Simply copy the files to some public URL that can be resolved by

desktop computer.

A The font file names should be in lower case ( rename if you have upper-case font file names).

TTTT T TN

Field / Property Type Description

Enable debug in java console view. By default is disabled.
dxf.applet.debug.window Boolean

false

Font might be used by big text. By default is empty.
dxf.applet.default.bigfont  String

arial

Set the default font. By default is empty.

dxf.applet.default.font String
arial
Public URL with extra font repository. By default is empty.
dxf.applet.fontdir String
http://fonts.openkm.com
Zoho

The Zoho Docs is a Web-based online office suite containing word processing, spreadsheets, etc. Integration make possible

online edition on documents stored into OpenKM repository.

You can obtain the user and password registering at http://zapi.zoho.com. Once registered and logged, you can request the API

Key and the Secret Key. In the Zoho Dashboard you can also check how many edition requests you have performed.

Field / Property Type Description

zoho.api.key String  The api key.

zoho.secret.key String  The secret key.

zoho.user String  Zoho username.
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zoho.password String  Zoho password.

OpenMeetings

OpenMeetings is a free browser-based software that allows you to set up instantly a conference in the Web. You can use your
microphone or webcam, share documents on a white board, share your screen or record meetings. It is available as hosted

service or you download and install a package on your server with no limitations in usage or users.

Field / Property Type Description

The url of the OpenMeetings server.

openmeetings.url String
localhost
Default port is 5080.
openmeetings.port String
5080
openmeetings.user String  OpenMeetings user with administration grants.

openmeetings.credentials  String  OpenMeetings password.

DICOM preview

With DICOM preview can be shown medical images. DICOM preview allows manipulate images from anywhere as easy as

surfing the Internet with zero training.

Field / Property Type Description

dicom.url String  URL of the DICOM service.

Extratab extension

The ExtraTab allows to easily add a new tab with a name and specific URL.

Field / Property Type Description

extra.tab.workspace.label ~ String  Label of the tab.

Some text
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extra.tab.workspace.url String  The URL of the tab.

http://www.openkm. com

If URL does not start with http it's considered as OpenKM
relative path and will be merged with your OpenKM server URL
like YOUR_OPENKM_URL/url

f————————
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Performance configuration parameters

Text extractor queue

There are several configuration parameters to adapt the document text extraction to your needs. Text extraction is one of the

processes that can use a lot of hardware resources ( memory and CPU's ). Aggressive text extraction policy can decrease the

performance of the application and affect the end user feeling with user interface.

When documents are uploaded are automatically added into Text extraction queue. Can see Text extraction queue at

Administration > Statistics > Text extraction queue.

There's a crontab task named "Text extractor worker" at Administration > Cron tab what control the indexing cycle

p

A When a document is uploaded, it will not be able to search by content until is processed by Text extraction queue.

aggressive ).

A In case the application need indexing a lot of files per day, or you imported a considerable amount of files,
consider create two crontab task to change these parameters between day ( less aggressive ) and night ( more

A Some mime-types like pdf or images ( what needs OCR engine ) can use a lot of CPU ( top 100% ).

Field / Property Type

managed.text.extraction.batch Boolean

managed.text.extraction.concurrent ~ Boolean

managed.text.extraction.threads Integer

Description

Indicate the number of documents to be processed on each indexing

cycle.

| |

i When parameter "text.extraction.concurrent” is |
I

i enabled, is a good practice to be multiple of i

i "text.extraction.threads" value. i

A J

20

Enable or disable concurrent text extraction concurrent threads

feature.

True

Number of concurrent threads will be used for text extraction feature.

i This number should be less or equal the number of

TTTTTTY
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1
hardware cores. |
J

———

OpenOffice LibreOffice conversion service

As part of application startup, OpenKM executes an OpenOffice or LibreQOffice service. That's used internally for conversion

purposes, for example to converting doc files to pdf.

OpenOffice or LibreOffice service can use a lot of hardware resources ( CPU top 100% ), that can decrease the performance of

the application. A good practice is move OpenOffice or LibreOffice conversion service to another server.

Field / Property Type Description

URL to OpenOffice or LibreOffice service.
system.openoffice.server  String

http://192.168.1.34:8080/converter/convert

Restart service after x conversions to prevent memory leaks.
system.openoffice.tasks String

5

For more information read:

e OpenOffice LibreOffice configuration parameters
e OpenOffice and LibreOffice configuration

Antivirus checker

There are several configuration parameters to adapt the antivirus checker to your needs. Antivirus checker is one of the process
that can use a lot of hardware resources ( memory and CPU's ). Aggressive antivirus checker policy can decrease the
performance of the application and dffect the end user feeling with user interface. The Antivirus checker works in live mode ( as
uploading process antivirus check the document and if a virus is detected a warning error is immediately raised and the

document is not incorporated to the repository ).

Antivirus checker in live mode can dramatically decrease the user interface and the end user feeling. Take in
consideration that to analyse some documents the antivirus can check it in 3 seconds or more that will be added

to the uploading time process.

———————————\

Field / Property Type Description

system.antivir String  Set the antivirus path.
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Re-indexing the whole Lucene repository

Application can use two different ways of rebuilding Lucene indexes: sequential or parallel. By default sequential re-indexing is

enabled, but you can select the mode using the "hibernate.indexer.mass.indexer" configuration parameter.

Field / Property Type Description

When is enabled the rebuild Lucene indexes process goes into " Parallel
hibernate.indexer.mass.indexer = Boolean
mode".

Mode Description

Sequential ~ You can use the "hibernate.indexer.batch.size.load.objects" configuration parameter to indicate to
mode Hibernate how many object should handle every time. To avoid OutOfMemory problems, the repository
needs to be re-indexed in batch. If the value of this property is too low, the performance will be bad but if is

too high you can have OutOfMemory problems.
o hibernate.indexer.batch.size.load.objects: batch size used to load the root entities.

30

Parallel You have several configuration properties to tune its performance:

mode
 hibernate.indexer.batch.size.load.objects: batch size used to load the root entities.

30

¢ hibernate.indexer.threads.subsequent.fetching: number of threads used to load the lazy collections

related to the indexed entities.

8
o hibernate.indexer.threads.load.objects: number of threads used to load the root entities.
4
o hibernate.indexer.threads.index.writer: number of threads used to analyse the documents and
write to the index.
3

Execution timeout
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The Application executes external applications to process documents, for example extracts the text with an OCR engine, analyse

with an Antivirus software, transforms documents to other formats among other actions. Sometimes these processes can take a
lot of time or for some reason is not finished correctly and the process keep on the OS consuming resources. To prevent it, the

parameter "system.execution.timeout" set the maximum allowed time of execution on external applications.

Field / Property Type Description

system.execution.timeout  Integer  Set the maximum allowed time of execution on external applications.

The units are minutes. By default the configuration is set to 5 minutes.

5

Uploading bandwidth

Sometimes you want to restrict the total bandwidth used by each user while uploading files.

Field / Property Type Description

upload.throttle.filter =~ Boolean  Limit the total uploading bandwidth to 10kb/sec per user.

Remote conversion service

On huge repository with a lot of concurrent users is a good idea to configure a server only for document transformation.

g
1
i i To enable this feature is needed installing a specific OpenKM service application. Contact with OpenKM
i technical staff for more information.

Field / Property Type Description

remote.conversion.server  String  Set the URL of the conversion service.

http://192.168.2.1:8080/converter/convert

Activity log actions

OpenKM can log a lot of information related to the activity of the users , but sometimes these actions don't need to be logged

and fill your activity log table.

A The table where activity log is stored - OKM_ACTIVITY - may grow quickly storing millions of records.

TTTT T TN

There is a configuration property name "activity.log.actions" where you can set which actions to log. By default this is set to the
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most common or interesting actions. You can use regular expressions to define these actions. Read Java Regex Tutorial for

more info about Java regular expressions.
Field / Property Type Description

activity.log.actions  List LOLOGIN
LOGOUT
CREATE . *
DELETE .*
PURGE . *
MOVE . *
OB %
CHECKOUT DOCUMENT

CHECKIN DOCUMENT

GET DOCUMENT CONTENT.*

i For a complete list of action see Activity log.

TTTTTTTY
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OpenOffice & LibreOffice configuration parameters

As part of the application startup, OpenKM executes an OpenOffice or LibreOffice service. That's used internally for

conversion purposes, for example to converting doc files to pdf.

p

The OpenOffice or LibreOffice process started before OpenKM startup, can cause the failure of the service that
OpenKM internally executes during startup.

A The OpenOffice or LibreOffice service can use a lot of hardware resources ( CPU top 100% ).

Field / Property Type Description

system.openoffice.path String  Path to OpenOffice or LibreOffice.

system.openoffice.dictionary =~ String  Dictionary used by search engine tokenizer.

URL to OpenOffice or LibreOffice service.

i \
[ . . |
system.openoffice.server String i i This parameter replaces the use of system.openoffice.path i
| parameter. |
l )
http://192.168.1.34:8080/converter/convert
. Restart service dfter x conversions to prevent memory leaks.
system.openoffice.tasks String
5
. Default port is 2002.
system.openoffice.port String
2002
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WebDAYV configuration parameters

Field / Property Type Description

system.webdav.server  Boolean = Enable WebDAV service. By default is disabled.

false

mon

system.webdav.fix Boolean Character ":" can cause problems with some WebDAYV client with this parameter

mon

enabled replaces in all URL the character ":" to "_". By default is disabled.

false
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CSV configuration parameters

The CSV ("Comma Separated Value") file format is often used to exchange data between disparate applications. The file format,

as it is used in Microsoft Excel, has become a pseudo standard throughout the industry, even among non-Microsoft platforms.

Some application features import or export data in CSV ( Comma Separated Value ) like results in search view users in

administration among others. The format of the output CSV file can be configured with several parameters to your needs.

Field / Property Type Description

"en

csv.format.delimiter String Set the delimiter used between columns. By default is used character ";".

csv.format.ignore.empty.lines Boolean  Set if empty lines must be processed or not. By default the value is false.

Set the quote character used to enclose column values. By default is set to

csv.format.quote.character String
character.

Set if first row contains column names and must not be processed as values

csv.format.skip_header Boolean
or not. By default is set to true.

Set character used to indicate the beginning of a comment. By default is set

csv.format.comment.indicator ~ String
to #.
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Other configuration parameters

Property Type

system.ocr.rotate String

system.document.name.mismatch.check  Boolean

max.search.results Integer
system.demo Boolean
system.keyword.lowercase Boolean

Description

This parameter forces OCR to process on the document rotated.

V The feature is useful for example in upside down scanned
standard OCR direction will fails.

————————\

mon

The parameter is a collection of degrees separated by character ";

90,180,270,

More information at Configuring OCR engine.

This parameter is used to enable or disable the name check when a ne

document is uploaded.

This parameter sets the limits of the search results. For example a val

will never get more than 500 results of any query.

500

V The reason why the number of results is limited is that so
retrieve a huge number of results, specially when the que
across api methods.

This parameter is used to switch openkm to demo mode.

A On production environment should never be enabled.

———————\

This parameter is used to force all keyword to lowercase.

A The application is case sensitive, that means a user can s
like "keyone" and "KeyOne" and for the application these
are distinct. To prevent this problem is always good idea

keyword to lowercase.

e
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tomcat.connector.uri.encoding

mobile.theme

plugin.debug

principal.hide.connection.roles

principal.database.filter.inactive.users

restrict.file.name

restrict.file.mime

native.sql.optimizations

String

String

Boolean

Boolean

Boolean

String

Boolean

Boolean

By default Tomcat Connector encoding is set to "ISO-8859-1" but yoi

with this parameter.

A When you set the "URIEncoding" parameter in Tomcat
also need to set this parmeter to "UTF-8".

I50-8859-1

There're five mobile themes ( "a", "b", "c", "d", "e" ).

More information about themes at jQuery mobile themes.

———————\

When enabled show debug information about application plugin feat

Hide "ROLE_USER" and "ROLE_ADMIN" roles from available ro.

i By default the hidden roles are set by "default.user.role"
"default.admin.role" parameters value. Usually "ROLE_
"ROLE_ADMIN".

Hide inactive users for available users list.

Restrict file name extension that are not allowed.

i Each file name extension is separated by character ";".

———————\

*~;*.bak

Restrict file name extension based on existing ones at Administration

For best performance, some database operations are done with SQL 1
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repository.stats.optimization

repository.content.checksum

system.pdf.force.ocr

store.node.path

shCoreEclipse.css

shThemeEclipse.css

system.catdoc.xIs2csv

system.maintenance

system.profiling

Boolean

Boolean

Boolean

Boolean

String

String

String

Boolean

Boolean

When is enabled the Administration > Statistics results need less time

be calculated.

When is enabled is calculated the document checksum for each uploai

Force to processing all PDF files with the OCR engine.

When enabled is stored in database the path of each node.

For performance reason on move, delete and rename ope
suggest to do not enable this parameter. We only recomn

on repositories with less 100K nodes.

CSS style used by syntax highlighter.

i More information at http://alexgorbatchev.com/SyntaxHi

———————\

CSS style used by syntax highlighter.

i More information at http://alexgorbatchev.com/SyntaxHi

———————\

Native XLS to CSV converter tool. Used in NativeMsExcelTextExtra

and other Ubuntu based distros is included in the catdoc package.

/usr/bin/x1ls2csv S${fileln}

When is enabled the application goes to "maintence mode", that mear

the okmAdmin user will be able to login.

The Profiling stats feature gives low level value information to the ad.

out application performance problems.

i You also can enable profiling from Administration > Uti
stats .

————————\
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user.keywords.cache

user.item.cache

max.search.results

html.syntaxhighlighter.core

html.syntaxhighlighter.theme

kea.thesaurus.skos.file

kea.thesaurus.vocabulary.serql

Boolean

Boolean

Integer

String

String

String

String

When enabled the keyword of the nodes are cached.

I's
|
1
i i The feature provide best perfomance with less database ¢
1
{

When enabled the application cached the number of nodes owned by

i The feature provide best perfomances with less database

calculating the nodes owned by each user.

————————\

Set the limit of the results returned by a search to the repository.

Set the syntax highlight css core.

i More information at SyntaxHighlighter.

———————\

Set the syntax highlight css theme.

i More information at SyntaxHighlighter.

———————\

The SKOS file.

/vocabulary/ag skos 20070219.rdf

i When enabled restricts the number of keywords available
with nodes. The SKOS file must be based on the ontolog)
ontology file ) set at kea.thesaurus.owl.file property ( Th

configuration ).
More information about SKOS ( Simple Knowledge Orga
).

Query to retrieve SKOS terms.

SELECT X,UID FROM (X} skos:prefLabel {UID} WHI

lang (UID) ="en" USING NAMESPACE rdf=
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registered.text.extractors

version.append.download

rss.news

rss.news.box.width

List

Boolean

Boolean

Integer

<http
<http
<http
<http
<http

<http

List of enabled text extractor

org.

org.

org.

org.

org.

org.

org.

org.

org.

com.

com.

com.

com.

com.

com.

apache

apache.

apache.

apache

apache.
apache.
apache.
apache.
apache.
openkm.
openkm.
openkm.
openkm.
openkm.

openkm.

jackrabbit.
jackrabbit.
jackrabbit.
.jackrabbit.
jackrabbit.
jackrabbit.
jackrabbit.

jackrabbit.

jackrabbit

://xmlns.com/foaf/0.1/>

extractor.

extractor.

extractor.

extractor

extractor.

extractor.

extractor.

extractor.

.extractor.

2/ /www.w3.0rg/1999/02/22-rdf-syntax-ns#>,
://www.w3.0rg/2004/02/skos/core#>,rdfs=
2/ /www.w3.0rg/2000/01/rdf-schema#>,dc=
://purl.org/dc/elements/1.1/>, dcterms=

://purl.org/dc/terms/>, foaf=

PlainTextExXtr:

MsWordTextEXt:

MsExcelTextExi

.MsPowerPointTe

OpenOfficeTexi
RTFTextExtrac
HTMLTextExtrac
XMLTextExtrac

MsOutlookTextl

extractor.PdfTextExtractor

extractor.AudioTextExtractor

extractor.ExifTextExtractor

extractor.Tesseract3TextExtractor

extractor.SourceCodeTextExtractor

extractor.MsOffice2007TextExtracto.

———————\

Take a look at Creating your own Text extractor.

Append the document version in the document file name when downlc

from OpenKM.

Enable or disable new in the login page.

Width of the news box in the login page.

300
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rss.news.max.size Integer Maximum number of news retrieved from the news server.

10

News are cached from OpenKM server and refreshed one
That means any change on this parameter will take effect
restarting OpenKM service.

rss.news.visible Integer Number of visible news at the same time.
1
webservices.visible.properties List List of configuration properties what are granted to view by users wit

grants from webservices.
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Experimental configuration parameters

Property Type Description

unit.testing.folder String Folder used by testing process.

/okm:root/okmTesting

unit.testing.user String User used for unit testing.

okmAdmin

unit.testing.password String Password of the user used for unit testing.

admin

unit.testing.url.base String The unit test URL.

http://localhost:8080/0penKM/

String The Amazon s3 access key.
amazon.access.key

(. 1
! 1 Must be configured to export repository content to Amazon S3. |
; |
\ J

amazon.secret.key String The Amazon s3 secret key.
(2 )
! 1 Must be configured to export repository content to Amazon S3. |
|
| I
| J
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AutoCAD configuration parameters

These parameters are used in AutoCAD integration.
Property Type Description

DWG to DXF converter tool. Used in old AutoCAD preview.
system.dwg2dxf String

wine /home/openkm/.wine/ACC/AcmeCADConverter.exe
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Thesaurus configuration

A thesaurus is a book that lists words grouped together according to similarity of meaning (containing synonyms and

sometimes antonyms), in contrast to a dictionary, which contains definitions and pronunciations.

In Information Science, Library Science, and Information Technology, specialized thesauri are designed for information

retrieval. They are a type of controlled vocabulary, for indexing or tagging purposes. If you want more information about the

term you can take a look at http://en.wikipedia.org/wiki/Thesaurus.

V OpenKM can work with thesaurus defined in .owl and .rdfs formats.

TTTT T T

There's a great utility http://protege.stanford.edu/ for creating and maintaining your own thesaurus. Specific thesauri can be

found on the Internet. For example, Agrovoc ( FAO ), NASA Thesaurus, UNESCO Thesaurus, Public administration Thesaurus

among others. Some of them are free and some have usage restrictions.

In order to correctly configure OpenKM to use a thesaurus the following configuration properties must be set:

Property Description

kea.thesaurus.owl.file The ontology file ( Web ontology file )

vocabulary/file.owl

kea.thesaurus.base.url The base URL.

http://www.someweb.org

kea.thesaurus.tree.root Query to get the first node.

SELECT DISTINCT UID, TEXT FROM {UID} Y {OBJECT}, {UID}
rdfs:label {TEXT} ; [rdfs:subClassOf {CLAZZ}] where not
bound (CLAZZ)

and lang (TEXT)="en" USING NAMESPACE foaf=
<http://xmlns.com/foaf/0.1/>, dcterms=
<http://purl.org/dc/terms/>,

rdf=<http://www.w3.0rg/1999/02/22-rdf-syntax-ns#>, owl=
<http://www.w3.0rg/2002/07/owl#>, rdfs=
<http://www.w3.0rg/2000/01/rdf-schema#>,

skos=<http://www.w3.o0rg/2004/02/skos/core#>, dc=

<http://purl.org/dc/elements/1.1/>
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kea.thesaurus.tree.children = Query to get children node.

SELECT DISTINCT UID, TEXT FROM {UID} rdfs:subClassOf
{CLAZZ}, {UID} rdfs:label {TEXT} where xsd:string(CLAZZ) =
"RDFparentID" and lang(TEXT)="en" USING NAMESPACE foaf=

<http://xmlns.com/foaf/0.1/>, dcterms=
<http://purl.org/dc/terms/>,

rdf=<http://www.w3.org /1999/02/22-rdf-syntax-ns#>, owl=
<http://www.w3.0rg/2002/07/owl#>, rdfs=
<http://www.w3.0rg/2000/01/rdf-schema#>,
skos=<http://www.w3.org/2004/02/skos/core#>, dc=

<http://purl.org/dc/elements/1.1/>

Take a look a full configuration example at Creating your own thesaurus.

Some interesting URL:

e A Method for Converting Thesauri to RDF/OWL
e OWL to SKOS online conversor

e SKOS to OWL online conversor

e SKOS Simple Knowledge Organization System
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Datastore

By default OpenKM store the binary information of the documents in the file system.

V Usually you will get the best perfomance storing document in the file system. Basically with this configuration,
when you upload or download a document it's open a file system stream directly from the server.

TTTT T T T Y

The parameter repository.datastore.backend help you to indicate what datastore will be used by OpenKM. You must change

the configuration properties to be set at STOMCAT_HOME/OpenKM.cfg file and restart OpenKM to take effect.

A You can not change datastore after you have uploaded documents into OpenKM .

You can only change it only at the first start up of the application or if you still have not uploaded documents.

T Y
| S

File system datastore

The file system datastore is the default datastore and what we suggest for almost OpenKM installations.

Database datastore

When database datastore is enabled, the binary information of the documents are stored into the database.

I |
i A Usually with this configuration you should get less performance. Basically when you upload or download a i
! document, it's created a temporary file in the OpenKM server what is uploaded in the database, that means more |
1 |
| steps and extra delay for setting and retrieving binary data from database. |
| )
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MIME types

The application supports several documents MIME type. Every MIME type has one or several file extensions which are used to

match the uploaded document MIME type.

P

A Based on the MIME type associated to the uploaded document, the application chooses the associated text
extractor. Text extractor works only for a few MIME types that can easilly be extended.

For example, if you upload a "sample.doc", it's detected MIME type is "application/msword" because its
extension is ".doc". In this case, the text extractor class is "com.openkm.extractor.MsWordTextExtractor".

The detected document MIME type is also used to display an icon which represents the type of document. You can change this

icon if you like.

There is list of common documents MIME types already registered in OpenKM.

A If you upload a document which MIME type is not in the list, it will be detected as "application/octet-stream".

TTTT T TN

Add new MIME type

e Click new MIME Type icon +]

e In Create mime type view fill the required fields:

Field Value

The MIME type name
Name

application/epub+zip

General purpose description.

Description
EPUB
Associated document extensions.
:’ |
Extensions I i In case multiple extensions, each one should be separated by character "," |
| |
| :
epub
Image file.
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Image i Image size should be 16x16 pixels.

mTTTTTTY

Search When is checked it means it will be shown in the application user interface at search view MIME type list.

e Click Create button.

Edit MIME Type

e Click Editicon & .
¢ In Edit MIME type view make changes in fields.

e Click Edit button.

Delete MIME type

e Click Delete icon @ .

¢ In Delete MIME type view click Delete button.

Backup MIME types

¢ Click at top right the Export Mime type icon '=.

o After a few seconds the application will download an SQL file.

Restore MIME types

A Restoring MIME types will remove actual values and will be replaced by the original ones.

TTTT T TN

¢ Go to bottom page.
e Select MIME type sql file.

e Click & Import MIME types button.
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Statistics

In the statictics view, a graphical information about repository size and it's distribution on the distinct root nodes ( taxonomy,

personal, trash, etc. ) is shown. Also is shown the basic server information like memory and disk usage.
To understand how your repository is growing and making hard disk estimations, these pie charts are interesting:

e Documents by context.
* Documents size by context.

o Folders by context.
Some pie charts describe the distribution by context. These contexts are:

e Taxonomy (the /okm:root context)
o Template (the /okm:template context, where you can place your document templates)
e Personal (the /okm:personal context, where each OpenKM user can stores their personal - not shared - documents)

o Trash (the /okm:trash context, which stores the deleted document, folders, etc.)

If the trash context is too large the trash bin should be emptied. Once you are sure these documents and folders

can be really deleted, you should empty your trash or individually purge the documents. Remember that each

———————————\

user has its own trash and every user is responsible of purging their own one.

Check the status of the Pending task queue
Pending tasks are only used in some application sections where an user action can takes longer than usual.

o Click at top right the menu option Pending task queue.

¢ In Pending task queue view is shown the status of the tasks. This is a list of the task to be processed or in progress.

i For example, if you want to change the permissions in a folder with lots of documents and / or a very depth
structure this actions will be promoted to pending task. Meanwhile the user can do more thinks while this one is
executed in background. If the number of document to process is huge, this task may take hours to complete.

———————————\

Check the status of the Text extraction queue
When upload a document to the application, its content is not extracted inmediatelly but enqueued for this.

e Click at top right the menu option Pending text extractor queue.
« In Pending text extractor queue view is shown the status of the text extractor process. This is a list of the documents to

be processed or in progress.

More information at Performance configuration parameters.
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Sometimes you might be interested on process all the documents again into the text extraction queue ( you have
introduced new text extractor, etc ... ), you can find more information at Database description about how doing
it.

———————————\
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Scripting

Scripting was an advanced feature that enables administrators to execute some BeanShell scripts in folders, triggered on every

notified event ( for example uploading documents ).

This feature has been enhanced by Automation ( see ExecuteScripting at Built in Automation Action plugins ), which helps you
to do the same things with a few mouse clicks. For compatibility reasons there is also an Automation task where you can put a

BeanShell code.

~

V OpenKM uses BeanShell. For more information check http://www.beanshell.org/intro.html.

BeanShell is a small, free, embeddable Java source interpreter with object scripting language features, written in
Java. BeanShell dynamically executes standard Java syntax and extends it with common scripting conveniences

such as loose types, commands, and method closures like those in Perl and JavaScript.

See some examples at Scripting samples.

Execute script as part of application starting process

Can be executed as an script as a part of application starting process. To do so, just create a start.bsh file in

$TOMCAT_HOME.

i
1
| V For example, we use this feature to create a complete environment (create custom users, register property
1
i groups, register workflow) each time the OpenKM demo is restarted.

Execute script as part of application stopping process

Can be executed a an script as part of the application stopping process. To do so, just create a stop.bsh file in

$TOMCAT_HOME.

Scripting in Automation

In the Automation Scripting execution, there're several variables that are directly injected in scripting environment that can be

used.

List of variables what can be used directly:

Variable Description

systemToken The system token.
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node Involved node (NodeDocument, NodeFolder, etc. )
uuid Node unique identifier.
file Only available when converting a document to PDF or to SWF.
userld The user id.
Example:

import com.openkm.api.*;

// Variable uuid is injected by automation to the scripting environment
OKMProperty.getInstance () .addKeyword (null, uuid, "test");
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Metadata

In the Metadata view are shown the registered metadata groups. In this view, it can create, modify or remove metadata

definitions.

Property groups are shown in a table structure. First row ( three columns ) corresponds to the general Property group

definition. The next rows are fields definition in Property group.

E Group label Group name Group info E
i Label Name Width Height Element Other i
Description:
Property Description
Group
Group label is shown in the user interface at Property group tab.
label
Unique group name identifier.
Group . ‘
| I
name i A Two property groups cannot have the same name. i
| )
Shows information about:
Group info « Visibility ( property group is hidden from user interface ).

¢ Read only ( property group can not be modified from user interface ).

Field label Field label is shown in the user interface in the Property group tab,

Unique property group field identifier.

Field name {’
i A Two property group fields can't have the same name.
1
|

Field width This parameter is used for rendering the width of the field in the user interface view.
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Field
This parameter is used for rendering the height of the field in the user interface view.
height
This parameter sets the element type. It's used for rendering several values in the field in the user interface
view.
Values:
o CheckBox
o Input
Element « Iframe
o Select
e Separator
o SuggestBox
o Text
o TextArea
Others Shows field extra information.
Edit metadata

To add, modify or delete metadata there's only one operation for all, edit the metadata xml definition.

« Click top right % Edit metadata.
« In Edit view, modify the XML.
» At bottom right, click Edit button.

» At top right click, click Register metadata groups to apply the changes.
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Metadata XML definition

The application metada is based on a formal XML definition. The DTD ( Document Type Definition ) defines the structure and

the legal elements and attributes of an XML document.

i You can see latest DTD in our website http://ww nkm.com/dtd/property-gr -{major}.{minor}.dtd where
{major} and {minor} values are two numbers ( major release and minor release ). For example the location for

version 2.3 of the DTD is http://www.openkm.com/dtd/property-groups-2.3.dtd

Each application version supports only a couple of DTD definitions, read Application version compatibility table
to see which are supported by your application.

Basic XML skeleton

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE property-groups PUBLIC "-//OpenKM//DTD Property Groups 2.3//EN" '

<property-groups>

</property-groups>

o The DOCTYPE is a formal definition of some DTD. In the previous example the property-groups-2.3.dtd.
e The XML begins with <property-groups> tag and ends with </property-groups>. Into this hicheracy are defined the

metada groups.

Metadata group definition

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE property-groups PUBLIC "-//OpenKM//DTD Property Groups 2.3//EN" '

<property-groups>
<property-group label="Consulting" name="okg:consulting">

</property-group>
</property-groups>

e Each <property-group>...</property-group block identify the begining and end of new metadata group definition.
o Each metadata group has a label - used by user interface - Consulting.

o Each metadata group has a unique name, okg:consulting.

o The metadata group name always must starts with "okg:" ( OpenKM Group ).

o Must not use special characters for name.

Attribute Description Required

true
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label The text shown as a label in the user interface.

name Unique field identifier. true

A Two metadata groups can't have the same name. Name must be unique.

The name must start with "okg:".

Please, use only letters, numbers and underscore: "0-9a-zA-Z_".

visiable Show or hide the metadata. false

Allowed values are:

e frue.

o false.

i By default the metadata are visible.

mTTTTTTY

readonly = Metadata values can not be modified from user interface only from APL false

Allowed values are:

e frue.

* false.

By default the metadata are modificable.

mTTTTTTY

Basic example
Available field types:

o Checkbox
o Input

o Iframe

o Select

e Separator
» Suggestbox

o Text
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o TextArea

More information about field type elements at Metadata fields

It's a good practice to use the metadata group name as the basis to create metadata field name. For example

I I
| ]
I |
i okp:consulting.code use okg:consulting as base ( changing okg to okp ). That helps to find out which is the i
| ]
i metada group asociated to each metadata field. i

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE property-groups PUBLIC "-//OpenKM//DTD Property Groups 2.3//EN" '
"http://www.openkm.com/dtd/property-groups-2.3.dtd">
<property-groups> ‘
<property-group label="Consulting'" name="okg:consulting">
<input label="Input label" name="okp:consulting.inputl" />
<separator label="Separator label" name="okp:consulting.separator" />
<input label="Input label" name="okp:consulting.input2" />
</property-group>
</property-groups>

Using file system DTD

If the server has no access to the Internet, then the DTD file must be accessible in some way, for example can store a copy in

your application server.

The XML definition must be changed to refer to the new DTD location, otherwise you will get an application

| ‘|
| i
! |
| error while processing DTD file. I
| i
| i
i Can be a file system ( example below ) or a valid intranet URL. i
! )

<!DOCTYPE property-groups PUBLIC '"-//OpenKM//DTD Property Groups 2.3//EN"
"file:///home/openkm/property-groups—-2.3.dtd">

o In the example, /home/openkm/property-groups-2.3.dtd is the file system path to the file.
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Metadata fields

These are the available field types:

Field type

Checkbox

Input

Select

Separator

Suggestbox

Text

TextArea

Some field types can have children elements, validator or option elements. This hierarchy is permitted:

Metadata Checkbox field

Metadata Input field

Metadata Select field

Metadata Separator field

Metadata Suggestbox field

Metadata Text field

Metadata TextArea field

Description

¢ metadata group

e Checkbox

Input

e Validator

e Validator

e Iframe

Select

e Option

e Validator

Separator

Suggestbox

Text

o Validator

Visible in the Metadata Stack Panel

Yes.

No.

Yes.

No.

Yes.

No.

No.
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o TextArea

e Validator
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Metadata Checkbox field

Checkbox

Best used to represent boolean data:

Attribute Description Required

label The text shown as a label in the user interface. true

Unique field identifier

A Two metadata can't have the same name. Name must be unique.

The name must start with "okp:".

name . ; :
It's a good practice to use a metadata group name as basis for a metadata field true

name. For example use "okg:consulting” has been used for field name
"okp:consulting.checkbox", changing "okg" to "okp". That helps to find out
the metada group based on metadata field name.

Please, use only letters, numbers and underscore: "0-9a-zA-Z_".

width The width of the HTML element. false
height The height of the HTML element. false
description  General description. false
visible Set field will be shown or not in the user interface. By default the value is " true". false
readonly Set field will not be able to be modified in user interface. By default the value is " false". false
Child elements:

« Validator. For more information see Metadata Validator element.

1 <?xml version="1.0" encoding="UTF-8"?>
' <!DOCTYPE property-groups PUBLIC "-//OpenKM//DTD Property Groups 2.3//EN" '
i "http://www.openkm.com/dtd/property-groups-2.3.dtd">
<property-groups> ‘
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<property-group label="Consulting'" name="okg:consulting">
<checkbox label="Checkbox label'" name="okp:consulting.checkbox" />
</property-group>
</property-groups>
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Metadata Select field

Attribute

label

name

type

table

width

height

optionsQuery

className

Description

The text shown as label in the user interface.

Unique field identifier.

a

A Two metadatas can't have the same name. Name must be unique.
The name must start with "okp:".

It's a good practice to use metadata group name as basis for metadata field
name. For example use "okg:consulting” has been used for field name
"okp:consulting.select", changin "okg" to "okp". That helps to find out the
metada group based on metadata field name.

Please, use only letters, numbers and underscore: "0-9a-zA-Z_".

Type value. Allowed types:

» simple (' single choice allowed ).

o multiple ( multiple choices allowed ).

Metadata table name.

The application can store values into a metadata table, that can be used in

)

this query.

The width of the HTML element.

The height of the HTML element.

A metadata query used to get the selected options.

A class used to get the selected options.

When adding metadata to documents, the application can suggest automatically some

values based on document content analysis. By default the application has some

Required

true

true

true
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implementations that can easilly be extended.

« com.openkm.form.suggestion. DocumentContentContainsSuggestion: Gets

suggestion suggestions based on document's content (use String.contains) false

« com.openkm.form.suggestion.DocumentContentTokenizerSuggestion: Gets
suggestions based on document's content (Use StringTokenizer).
« com.openkm.form.suggestion.DocumentTermsSuggestion: Gets suggestions

based on document's term vectors.

For more information read Creating your own Suggestion Analyzer.

visible Set field will be shown or not in the user interface. By default the value is " true". false

readonly Set field will not be able to be modified in the user interface. By default the value is " false".  false

Child elements:

 Option. Couples of XML <option label="label text" value="unique identifier value"/>.

« Validator. For more information see Metadata Validator element.

* There're two options to get option values:

e Directly defined in XML.

e Metadata table ( table + optionsQuery ).

One of these options must be defined, otherwise you will get an error. It can not done as a combination of

several of them, only one can be choosen.

Basic select example

o Type is equal to simple.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE property-groups PUBLIC "-//OpenKM//DTD Property Groups 2.3//EN" '

<property-groups>
<property-group label="Consulting'" name="okg:consulting">
<select label="select label" name="okp:consulting.select" type='"simple'>
<option label="one" value="001" />
<option label="two" value="002" />
<option label="three" value="003" />
</select>
</property-group>
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</property-groups>

Allow multiple choices

o Type is equal to multiple.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE property-groups PUBLIC "-//OpenKM//DTD Property Groups 2.5//EN" '

. <property-groups> :
<property-group label="Consulting" name="okg:consulting">
! <select label="select label" name="okp:consulting.select" type="multiple"> J
i <option label="one" value="001" /> ‘
<option label="two" value="002" />
' <option label="three" value="003" /> i
! </select> 1
i </property-group> i
' </property-groups>

Options based on a metadata table

o The application uses two tables named OKM_DB_METADATA_TYPE AND OKM_DB_METADATA_VALUE that helps
storing the options values used in select. That's very useful when you have a large number of values.

e In the table OKM_DB_METADATA_TYPE are stored metadata table definition ( table name, column name and column

type ).
e In the table OKM_DB_METADATA_VALUE are stored record values.

Create metadata table definition.

V The table will be called country, with two columns, country_id and country_name.
The country_id column is an integer type and country_name is text type.
The country_id is set as column 0 with col00 value.

The country_name is set as column 1 with col01 value.

¢ Go to Administration > Database query.
e At bottom right select JDBC from list.

e Paste the SQL in the box

E DELETE FROM OKM DB METADATA TYPE WHERE DMT TABLE='country';
. INSERT INTO OKM DB METADATA TYPE (DMT TABLE, DMT REAL COLUMN, DMT TYPE, DMT VIRTUAL C
. INSERT INTO OKM DB METADATA TYPE (DMT TABLE, DMT REAL COLUMN, DMT TYPE, DMT VIRTUAL ,C

» Click Execute button at the bottom right the .

Insert metadata table values:
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¢ Go to Administration > Database query.
o At the bottom right select JDBC from list.

e Paste the SQL in the box

E DELETE FROM OKM DB METADATA VALUE WHERE DMV TABLE='country'; '
. INSERT INTO OKM DB METADATA VALUE (DMV TABLE, DMV COL00O, DMV COL01) VALUES ('country
. INSERT INTO OKM DB METADATA VALUE (DMV_TABLE, DMV COL0O0, DMV COL01) VALUES ('country

o Click the Execute button at the bottom right .

A The insert queries depending on your database can not be a match, for example in Oracle:

INSERT INTO OKM_DB_METADATA_TYPE (DMT_ID, DMT_TABLE, DMT_REAL_COLUMN, DMT_TYPE,
DMT _VIRTUAL_COLUMN) VALUES (HIBERNATE_SEQUENCE.NEXTVAL, 'country', 'col00', 'integer’,
'country_id'");

More information at Creating your own database tables.

Finally the XML definition:

o In optionsQuery the values that begin with the character $ are identified as column names. See $country_id and
$country_name below.

e Can use normal SQL clausules like "order by", etc.

1 <?xml version="1.0" encoding="UTF-8"?>

' <!DOCTYPE property-groups PUBLIC "-//OpenKM//DTD Property Groups 2.5//EN" '
i "http://www.openkm.com/dtd/property-groups-2.5.dtd"
i\ <property-groups>

E <property-group label="Consulting'" name="okg:consulting">

! <select label="country" name="okp:consulting.country" type="simple'" table="coun
i optionsQuery="select $country id, $country name from DatabaseMetadataVa
E </property-group>

' </property-groups>

Suggested options

Based on the content analyzer the application can suggest some options values. At the user interface the suggested options will

be shown in green.

The application has some implementations that can easily be extended.

« com.openkm.form.suggestion.DocumentContentContainsSuggestion: Get suggestions based on document content
(use String.contains)

« com.openkm.form.suggestion.DocumentContentTokenizerSuggestion: Get suggestions based on document content
(Use StringTokenizer).

« com.openkm.form.suggestion.DocumentTermsSuggestion: Get suggestions based on document term vectors.
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For more information read Creating your own Suggestion Analyzer.

1 <?xml version="1.0" encoding="UTF-8"?>

' <!DOCTYPE property-groups PUBLIC "-//OpenKM//DTD Property Groups 2.3//EN" '
i "http://www.openkm.com/dtd/property-groups-2.3.dtd">
| <property-groups> ‘
E <property-group label="Consulting'" name="okg:consulting"> E
! <select label="select label" name="okp:consulting.select" type="multiple" ]
i suggestion="com.openkm. form.suggestion.DocumentContentContainsSuggestion"
E <option label="one" value="001" /> E
P <option label="two" value="002" /> '
! <option label="three" value="003" />

i </select> 1
E </property-group> E
' </property-groups> J
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Metadata Separator field

Draw a separator between fields.

Attribute Description Required

label The text shown as a label in the user interface. true

Unique field identifier

A Two metadatas can't have the same name. Name must be unique.

The name must start with "okp:".

name . ; ]
It's a good practice to use a metadata group name as basis for metadata field true

name. For example use "okg:consulting” has been used for field name
"okp:consulting.separator", changin "okg" to "okp". That helps to find out the
metada group based on metadata field name.

Please, use only letters, numbers and underscore: "0-9a-zA-Z_".

width The width of the HTML element. false
visible The set field will be shown or not in user the interface. By default the value is " true". false

readonly  The set field will not be able to be modified in the user interface. By default the value is " false". false

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE property-groups PUBLIC "-//OpenKM//DTD Property Groups 2.3//EN" '

<property-groups> ‘
<property-group label="Consulting" name="okg:consulting">
<input label="Input label" name="okp:consulting.inputl" /> J
<separator label="Separator label" name="okp:consulting.separator" /> '
<input label="Input label" name="okp:consulting.input2" />
</property-group> '
</property-groups> I
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Metadata Suggestbox field

This is an implementation of the typical AJAX suggest box component:

Attribute

label

name

table

width

height

filterQuery

valueQuery

filterMinLen

visible

Description

The text shown as a label in the user interface.

Unique field identifier.

~

A Two metadatas can't have the same name. Name must be unique.
The name must start with "okp:".

It's a good practice to use a metadata group name as basis for metadata field
name. For example use "okg:consulting" has been used for field name
"okp:consulting.suggestbox", changin "okg" to "okp". That helps to find out
the metada group based on metadata field name.

Please, use only letters, numbers and underscore: "0-9a-zA-Z_".

Metadata table name.

g
1
| The application can store values into a metadata table, that can be used in
I
1
|

this query.

Se————

The width of the HTML element.

The height of the HTML element.

A hibernate query to filter the data. Use {0} to place the user input.

A Hibernate query to obtain the value of a identifier. Use {0} to place the identifier.

The minimum chars in input to begin to filter results.

The set field will be shown or not in the user interface. By default the value is " true".

Required

true

true

true

false

false

true

true

true

false
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The set field will not be able to be modified in the user interface. By default the value is

readonly false

"false".

Child elements:

« Validator. For more information see Metadata Validator element.

Suggest box values are defined in metadata tables.

o Application use two tables named OKM_DB_METADATA_TYPE AND OKM_DB_METADATA_VALUE that helps
storing options values used in selects. That's very useful when you have?a large number of values.

e In table OKM_DB_METADATA_TYPE are stored metadata table definition ( table name, column name and column

type ).
e In table OKM_DB_METADATA_VALUE are stored record values.

Create metadata table definition.

V The table will be called country, with two columns, country_id and country_name.
The country_id column is integer type and country_name is text type.
The country_id is set as column 0 with col00 value.

The country_name is set as column 1 with col01 value.

¢ Go to Administration > Database query.
o At the bottom right select JDBC from list.

e Paste the SQL in the box

E DELETE FROM OKM DB METADATA TYPE WHERE DMT TABLE='country';
. INSERT INTO OKM DB METADATA TYPE (DMT TABLE, DMT REAL COLUMN, DMT TYPE, DMT VIRTUAL C
. INSERT INTO OKM DB METADATA TYPE (DMT TABLE, DMT REAL COLUMN, DMT TYPE, DMT VIRTUAL ,C

e Click at bottom right the Execute button.
Insert metadata table values:

¢ Go to Administration > Database query.
e At bottom right select JDBC from list.

e Paste the SQL in the box

E DELETE FROM OKM DB METADATA VALUE WHERE DMV TABLE='country'; '
! INSERT INTO OKM DB METADATA VALUE (DMV TABLE, DMV COL0O0, DMV COL01) VALUES ('country'
. INSERT INTO OKM DB METADATA VALUE (DMV TABLE, DMV COL0O0, DMV COL01) VALUES ('country'
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« Click at bottom right the Execute button.

A The insert queries depending your database can not be match, for example in Oracle:

INSERT INTO OKM_DB_METADATA_TYPE (DMT_ID, DMT_TABLE, DMT_REAL_COLUMN, DMT_TYPE,
DMT_VIRTUAL_COLUMN) VALUES (HIBERNATE_SEQUENCE.NEXTVAL, 'country', 'col00', 'integer”,
'country_id'");

Finally the XML definition:

o In the optionsQuery the values that begins with character $ are identified as column names. See $country_id and
$country_name below.

e Can use normal SQL clausules like "lower", "like", "order by", etc.

1 <?xml version="1.0" encoding="UTF-8"?>

' <!DOCTYPE property-groups PUBLIC "-//OpenKM//DTD Property Groups 2.3//EN" '
i "http://www.openkm.com/dtd/property-groups-2.3.dtd">
i\ <property-groups>

E <property-group label="Consulting" name="okg:consulting'"> E
! <suggestbox label="country" name="okp:consulting.suggestbox" width="200px" d
i table="country" dialogTitle="Choose country" filterMinLen="3" i
E filterQuery="select $country id, $country name from DatabaseMetadataValue dmv wﬁe
! valueQuery="select $country id, $country name from DatabaseMetadataValue dmv wher
! </property-group> d
E </property-groups> E
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Metadata Text field

Prints a text that can contain HTML tags.

Attribute Description Required

label The text shown as a label in user interface. true

Unique field identifier

A Two metadatas can't have the same name. Name must be unique.

The name must start with "okp:".
name It's a good practice to use metadata group name as basis for metadata field true

name. For example use "okg:consulting" has been used for field name

"okp:consulting.text", changin "okg" to "okp". That helps to find out the metada

group based on metadata field name.

Please, use only letters, numbers and underscore: "0-9a-zA-Z_".
width The width of the HTML element. false
height The height of the HTML element. false
visible The set field will be shown or not in the user interface. By default the value is " true". false
readonly  The set field will not be able to be modified in the user interface. By default the value is " false".  fglse

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE property-groups PUBLIC "-//OpenKM//DTD Property Groups 2.3//EN" '

<property-group label="Consulting'" name="okg:consulting">
<text label="text label" name="okp:consulting.text" width="200px" /> J
</property-group> 1

<property-groups>
1 </property-groups>
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Metadata TextArea field

Prints a text that can contain HTML tags.

Attribute Description Required

label The text shown as a label in theuser interface. true

Unique field identifier

A Two metadatas can't have the same name. Name must be unique.

The name must start with "okp:".

name . . ;
It's a good practice to use metadata group name as basis for metadata field true

name. For example use "okg:consulting” has been used for field name
"okp:consulting.textarea", changin "okg" to "okp". That helps to find out the
metada group based on metadata field name.

Please, use only letters, numbers and underscore: "0-9a-zA-Z_".

value Default value for the component. false
width The width of the HTML element. false
height The height of the HTML element. false
visible The set field will be shown or not in the user interface. By default the value is " true". false
readonly  The set field will not be able to be modified in the user interface. By default the value is " false". false
Child elements:

« Validator. For more information see Metadata Validator element.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE property-groups PUBLIC "-//OpenKM//DTD Property Groups 2.3//EN" '

<property-groups>
<property-group label="Consulting" name="okg:consulting">
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</property-group>

<textarea label="textarea label" name="okp:consulting.textarea" width="200px" />
</property-groups> E
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Metadata Validator element

The goal of the Validatior element is to ensure that the user provides necessary and properly formatted information needed to

successfully complete an operation.

The validator can only be used in combination with other fields:

o Metadata Checkbox field
o Metadata Input field

o Metadata Select field

o Metadata Suggestbox field
o Metadata TextArea field

Available validators:

name

req

alpha

dec

num

email

url

maxlen

minlen

It

gt

Description

Required value.

Alphanumeric value.

Decimal value.

Numeric value.

E-mail value.

URL value.

Set the maximum length allowed.

Set the minimum length required.

Less than.

Greater than.
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min Minimum value.
max Maximum value.
regexp Regular expression.
Parent:

o Metadata Checkbox field
o Metadata Input field

o Metadata Select field

o Metadata Suggestbox field
o Metadata TextArea field

Basic example

o Value required "req".
e Value must be decimal "dec".

o The maximum lenght of the decimal value is 6 digits "maxlen".

<input label="Decimal value" name="okp:consulting.decimal'>
<validator type="dec" />
<validator type="req" />
<validator type="maxlen" parameter="6" />

</input>

Regular expression

If you want a validation which is not included in these prefefined, you can use a regular expression. For example, imagine you

want to restrict an input to lowecase ASCII values:

<input label="Lowercase value" name="regExp'">
! <validator type="regexp" parameter="[a-z]+" /> ]
V. </input> :
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Metadata Option element

The option element is only used in combination with Metadata Select field. The option value represents a list of distinct values

to select.
Attribute Description Required
label The text shown as label in the user interface. true
value Unique value identifier. true
[ i
. |
| A Two options can't have the same value. Value must be unique. !
| |
l j
. - , . false
selected When present, it specifies that an option should be pre-selected when the form is redered.
Parent :

e Select. For more information, Please see: Metadata Select field.

Basic select with selected option

« attribute selected=true, when present, it specifies that an option should be pre-selected when the page loads.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE property-groups PUBLIC "-//OpenKM//DTD Property Groups 2.3//EN" '

| <property-groups> ‘
<property-group label="Consulting'" name="okg:consulting">
! <select label="select label" name="okp:consulting.select" type="simple"> J
i <option label="one" value="001" /> i
<option label="two" value="002" selected="true" />
' <option label="three" value="003" /> i
! </select> ]
: </property-group> '
' </property-groups>
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Metadata Input field

In most cases this field is used to enter free form text, althought it can be used to save http links, date, data or refer to

application folder ( as internal link to this folder ).

Attribute

label

name

type

value

width

height

visible

Description

The text shown as a label in user interface.

Unique field identifier.

A Two metadata can't have the same name. Name must be unique.
The name must start with "okp:".

It's a good practice to use metadata group name as basis for metadata field
name. For example use "okg:consulting” has been used for field name
"okp:consulting.input", changin "okg" to "okp". That helps to find out the
metada group based on metadata field name.

Please, use only letters, numbers and underscore: "0-9a-zA-Z_".

Type value. Allowed types:

e text.
* date.
o link.
o folder.

Specifies a default value for this component.

There's a special case for date types. Data is stored in format
"yyyyMMddHHmmss", be aware of this format when using OpenKM API.

———————\

The width of the HTML element.

The height of the HTML element.

The set field will be shown or not in the user interface. By default the value is " true".

Required

true

true

true

false

false

false

false
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readonly  The set field will not be able to be modified in the user interface. By default the value is " false". false

Child elements:

« Validator. For more information please see Metadata Validator element.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE property-groups PUBLIC "-//OpenKM//DTD Property Groups 2.3//EN" '

<property-groups> ‘
<property-group label="Consulting'" name="okg:consulting">
<input label="Input label" name="okp:consulting.input" /> J
</property-group> ]
</property-groups>
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Manage users and roles

In the Manage users and roles view you can do:

e Manage users.

e Manage roles.

e Manage user mail accounts.
e Logged users.

e Message queue.

i By default the application manages users and roles in its own database.
It is also possible to connect the application to an external directory (LDAP directory for instance).

Also the login module can be extended and create your own login adapter. More information about it Creating

your own login module.

A When the application is connected to LDAP the manage users and roles view is automatically set to readonly

mode.
In this scenario the LDAP takes full control of users and roles.
The restricted actions are:

o Create, delete or modify a user.

e Create or delete a role.
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Manage users

To manage users on the top right click on ' User list button.

i By default the application manages users and roles in its own database.
It is also possible to connect the application to an external directory (LDAP directory for instance).

The login module can be extended and create your own login adapter. More information about it Creating your

own login module.

A When the application is connected to LDAP the manage users view is automatically set to readonly mode. Almost

all actions are restricted.

Users are shown in a table structure.

Filtering options

Id Name Mail Roles Profile Active Chat Actions
User parameters:
Field Description Required

The id the user will use to log in.

Id

{ I true
! A Two users can't have the same id. i
|
l J
Name User name. true
Mail User email address. true
Roles - groups - from which the user is a member.
Roles { | true
! A User must be at least in 'ROLE_ADMIN' or 'ROLE_USER' role. |
|
l J
Profile ~ Each profile is a set of options available on the user interface. true
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Active Sets user enabled or not.

Indicates if user is connected to the chat.

Chat 4
i Althought a user can have the application opened on several browser tabs. Only
I
I
I
|

one of them will be logged on chat.

T—

Available actions:

e & Edits a user.

. @ Deletes a user.

Action

&7 Sets the profile.

b Configures mail accounts. More information here Manage user mail accounts.

C . .
* Configures twitter account.

o %% Shows the activity log of the user.

* Mail account and twitter account are optional.

Create a user

» On bottom right, click on the ) New user icon.
o Fill all the fields. Remember all users must be at least in 'ROLE_ADMIN' or 'ROLE_USER' roles.

e Click on the Create button.
Edit a user

e Click on the & Edit user icon.
* Modify the fields.

e Click on the Edit button.
Delete a user

e Click on the '@ Delete user icon.

e Click on the Delete button.
Change the user profile

e Click on the & User config icon.

» Choose the profile.

true

false
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e Click on the Edit button.

A By default the profile named "default" is automatically assigned to any new user.

TTTT T TN

Export the users

o On the top right click on the = export users.

e The application will download a .csv file.
Enable twitter account

. &= s .
e Click on the = Configure twitter account.
o Set twitter user.
o Enable active checkbox.

e Click on the Create button.
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Manage user mail accounts

In the user acounts view, are shown the mail user accounts. These mail accounts are used by application to periodically import

mail to application repository.
To manage user mail account, from Users view click on ) Email account icon.

Mail account hicheracy

e Mail account
e Filter

e Rules

V o The mail account sets the data connection to the mail server to retrieve mails.
e Filters are optional and sets the appliation location - folder - where to store mails.

* Rules are optional and sets a couple of rules that controls what are the valid mails to import.

A When a filter is not set, by default the application will store mail into /okm:mail/userid folder.

When rules are not set, by default any incoming mail is accepted.

Mail accounts are shown in a table structure.

=
=
g
8
=]
P—
=
=
o
2
=
I~
@
)
S
=
B
&
S
>
3
8

Mail account parameters:

Field Description Required

The protocol used to connect to the mail server.

Available options:

Mail

o IMAP true
protocol « IMAPS

e POP3

e POP3S
Mail host The mail server host. true

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.



https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE Page 373 of 1191

Mail user The user name to access the mail account. true
Mail
The password to access the mail account. true
password
The IMAP folder.
Mail p \
i ; ; ; I false
folder | Only applicable when mail protocol value is IMAP or IMAPS. In case of POP3 |
! you can leave empty otherwise need to be set to INBOX. i
! J
Sets to mail server the seen status.
Available options:
Mail
. true
mark seen » Keep (‘keep as is ).
o Yes ( mark as seen )
e No ( mark as not seen ).
Mail Set mail to be deleted.
mark |’ \I true
! A When checked the mail will be marked to be deleted from the mail server. |
deleted i |
J
Active Sets mail account enabled or not. true
Available actions:
« & Edits a mail account.
Actions .8 Deletes a mail account.

e U Sets mail account configuration filters.

o = Browsers emails in the mail server.

Create a new mail account

o At the top right click on the @ Create new account icon.

o Fill in all the fields.
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e Click on the Create button.

TTTTTTTTY

Check that will check the mail configuration. If all is right application will get OK status.

It is a good practice before clicking on Create button, to check the mail configuration. There's a button named

Edit a mail account

e Click on the 6/) Edit mail account icon.
* Modify the fields.

e Click on the Edit button.

Delete a mail account

e Click on the @ Delete mail account icon.

e Click on the Delete button.

Browser emails in the mail server

e Click on the n_] Server list icon.

i In this view mail can be directly imported.

TTTTTTTY

Manage mail account filters

In the mail account configuration, rules can be set to automatically store mails on different application folders.

others.

TTTTTTTTY

For example, filters can help to automatically catalog mails, based on a "subject" value or "from" value among

Mail accounts filter are shown in a table structure.

_________________________________________________________________________________________________________

Mail account filter parameters:

Field Description

Folder Sets the destination folder.

Sets automatic catalog by year/month/day enabled.

{
I

Required

true.
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To prevent having too many mails in the same folder, we recommend enabling

i I

Grouping | i false.
i mail grouping. i
|
| ]
i The folders year/month/years are automatically created by application. !

Active Sets filter enabled or not. true.
Available actions:

. . & Edita filter.
Actions

. @ Delete a filter.
. ’ Show rules.

At least a filter sets a destination folder it also can have additional rules.

A A rule can only be set into a filter.

TTTTTTTY

Mail accounts rules are shown in a table structure.

e
g
U
S
8
Q
=%
(=)
=i
S
P—
S
(4
>
[}
=
8

Mail account rule parameters:

Field Description Required

Sets the mail field that will be evaluated by the rule.

Auvadilable options are:

Field * From true.

e To
o Subject

e Content

Set the operation that will be done for the evalution process.

Auvadilable options are:
Operation true.

e Contains
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e Equal
Value Sets the value that will be used for evaluation process. true.
Active Sets rule enabled or not. true.

Create a mail account filter

e Clickonthe U Show filters icon.
e On top right click on < New filter icon.
e Fill in all the fields.

e Click on the Create button.

Edit a mail account filter

e Clickonthe U Show filters icon.

« On top right click on & Edit filter icon.

Modify the fields fields.

e Click on the Edit button.

Delete a mail account filter

e Clickonthe I Show filters icon.
e On top right click on =] Delete filter icon.

e Click on the Delete button.

Create a mail account rule

e Clickonthe I Show filters icon.

e Click on the fﬁ} Show rules icon.

e On top right click on < New rule icon.
o Fill in the fields.

e Click on the Create button.

Edit a mail account rule

e Clickonthe U Show filters icon.
e Click on the fﬁ} Show rules icon.

e On top right click on & Edit rule icon.
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* Modify the fields.

e Click on the Edit button.

Delete a mail account rule

e Clickonthe U Show filters icon.
e Click on the fﬁ} Show rules icon.
e On top right click on =] Delete rule icon.

e Click on the Delete button.
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Manage roles

To manage roles at the top right click on 47 Role list button.

i By default the application manages users and roles in its own database.
It is also possible to connect the application to an external directory (LDAP directory for instance).

Also the login module can be extended and create your own login adapter. More information about it Creating

your own login module.

A When the application is connected to LDAP the manage roles view is automatically set to readonly mode. Almost

all actions are disabled.

Roles are shown in a table structure.

I~y
QU
>
aQ
=
§
>
Q
=
S
S
©

Role parameters:

Field Description Required

The id of the role.

Id { I true
| A Two roles can't have the same id. |
I |
| J

Active  Sets if role is enabled or not. true
Avadilable actions:

Action « & Edits a role.

. @ Deletes a role.

Create a role

o At the bottom right, click on the e New role icon.
o Fill all the fields.

e Click on the Create button.

Edit a role
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e Click on the 6/) Edit role icon.
* Modify the fields.

e Click on the Edit button.

ROLE id can't be modified to prevent repository security inconsistences. This operation can be done only at
database level.

TTTT T T T

Delete a role

e Click on the @ Delete role icon.

e Click on the Delete button.
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Logged users

To manage logged users on top right click on & Logged users list button.

Logged users are shown in a table structure :

_________________________________________________________________________________________________________

Real time user activity log

e Click on on I“_=| Activity log icon.
o Will be shown as a table with all actions performed by the user today.

e Click on the —* Filter button to refresh values.
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Message queue

Message queue helps administrators to send messages across the user interface.

~

V Helps administrators to send a message to all logged users to indicate the system will be halt and automatically
logout the users 5 minutes after they received the message.

The application sends messages to a user when a background process has been completed.
The application sends warnings to a user about an action that is not allowed.

Among others messages.

Queue of messages shown in a table structure:

=)
2
]
>
=3
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3

Message parameters:
Field Description Required

Date of the message.

Date f . | true.
i 1 Automatically set by the application. i
l j
Avadilable values:

Action false.

e Logout ( force users who receives it to logout )

Message The text of the message. true.

To All When present, the message is sent to all the users. *

To Users = When present, indicate a set of users to sent the message. *

To Roles When present, indicate a set of users which are members of some of these roles. *

* At least one of the options.
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Send a message

« Click on the ' New message icon.
o Fill the fields.

e Click on the Create button.

Edit a message

e Click on the & Edit message icon.
* Modify the fields.

e Click on the Edit button.

Delete a message

e Click on the =] Delete message icon.

e Click on the Delete button.

Delete all messages queue

e On top right click on @ Clear button.

.
1
i A This operation can not be reverted. All the message queue will be deleted.
1
|

Refresh message queue

=
o On the top right click on = Refresh button.
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Profiles

Profiles are a set of user interface configuration parameters. They help the administrators to set the available interface features

for each user.

7 ™

i For example:

e Restricts the user interface hidding search and dashboard tabs and almost toolbar buttons.

e Restricts the user interface showing only search view.

A The application and specially the user interface comes by default with a several features and extensions.

Not all users need access to everything, specially at the begining when a lot of features can cause confusion to
end user.

Our suggestion is going from less to more features as a natural process of the application knowledge.

Profiles are shown in a table structure.

_________________________________________________________________________________________________________

Profiles are divided in four tabs:

o Profile General tab
Create a new profile

e Click on the e New profile icon.
o Fill in the fields.
e Click on the Create button.

Edit a profile

e Click on the Cm/; Edit profile icon.
o Modify the fields.

e Click on the Edit button.

Delete a profile

e Click on the @ Delete profile icon.

e Click on the Delete button.
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Clone a profile

« Click on the '_ Clone profile icon.
* Modify the fields.

e Click on the Edit button.
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Profile General tab

General section

Field Description

Name The name of the profile.

A Two profiles cannot share the same name.

TTTT T TN
S —

Active  Sets profile enabled or not.

Misc section

Field Description

Quota limit (MB) Sets the total maximum size of documents that a user can upload.

~

i Value 0 indicate unlimited.

Helps the administrator to take control of the repository growth, and detect user's

abuse.
Advanced filters Enables search filtering on users and roles popup view.
{ ;
i i Helps to find roles or user in a large list. i
i j
Web skin Sets the default skin ( css styles applied ).
s i
I — Info message |
1 ’ |
[ )

. . Enables or disables printing funtion.
Print preview

Enables or disables keywords shortcuts.
Keywords enabled

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE

Page 386 of 1191

Upload notify users

Notify external users

Browser plugin

preview

Increase version

Extensions

Reports

Workflows

Chat section

Field

Shows or hides user notification on upload popup.

Enables or disables send notifications to external users.

~

A By default the application is restricted to mail user's addresses.

i For example, sending documents to an external mail address.

When enabled, preview is based on browser pdf render capability.

When enabled, users can choose between document upload as minor version or major version.

Sets the enabled extensions for the profile.

Sets the enabled reports for the profile.

Sets the available workflows for the profile.

Description

Enabled Enables or disables chat.

Auto login When enabled the user is automatically logged in chat as part of login process.

Wizard section

The Wizard only takes effect when uploading a new document, not when updating and existing.

~

A In case an automation definition is present, these parameters has no effect.

The automation feature covers all these cases and more.

.
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Field Description

Metadata Sets a metadata that will be required to be filled as part of uploading a new document.

Workflow Sets a workflows that will be executed as part of uploading a new document.

A Some workflows require initial fields filled at the begining, but not all.

mTTTTTTN
—

Keywords When enabled the application will ask user to add keywords as part of uploading a new document.

A User can skip this step without adding any keyword.

mTTTTTTN
—

Categories When enabled the application will ask user to add categories as part of uploading a new document.

A User can skip this step without adding any category.

mTTTTTTN
—

Pagination section

Pagination control

Field Description
Enabled Enables or disable pagination on file explorer view.
Page list Sets the distinct values in what will be shown in number of elements per page.
i For example the value "10;25;50;100" set that maximum number of element per

page can be 10, 25, 50 or 100.

On the user view, the user can choose one of these options.

A When pagination is enabled at least one value must be set

o

To separate the distinct values must be used the caracter ";

Type filter When enabled a filter by type is shown, this helps the user to show only documents, folders,

records or mails at the same time. *
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Misc filter Advanced filter helps on filtering by some fields:

e name

o title

e range of sizes
e range of dates
» author

e version

When extra metadata columns are show in file explorer, they are also available
here.

————————\
|

Show folders by By default shows or hides folders. *
default

By default shows or hides document. *
Show documents by

default

By default shows or hides mails. *
Show mails by
default

By default shows or hides records. *
Show records by
default

* When type filter is enabled the options show folders by default etc... they must be active, otherwise they are not taken in

consideration and all types are shown.
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Profile Components tab

Stacks section

Field Description
Taxonomy  Shows or hides taxonomy in the stack panel.
Categories ~ Shows or hides categories in the stack panel.
Thesaurus  Shows or hides the thesarus in the stack panel.
Templates Shows or hidesthe templates in the stack panel.
Personal Shows or hides personal in the stack panel.
Mail Shows or hides mail in the stack panel.
Metadata Shows or hides metadata in the stack panel.
Trash Shows or hides trash bin in the stack panel.

Dashboard section

Field Description
User Shows or hides the user panel on dashboard view.
Mail Shows or hides the new mail panel in the dashboard view.
News Shows or hides the news panel in the dashboard view.
General Shows or hides the general panel in the dashboard view.
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Workflow Shows or hides the workflow panel in the dashboard view.

Keywords  Shows or hides the tag cloud panel in the dashboard view.

Tab section

Field Description

Sets the default tab visible when user login the application.

,

i Available options:

e Desktop

e Search
Default tab

e Dashboard

o Administration

A Must set an enabled view.
Desktop Shows or hides the desktop view.
Search Shows or hides the search view.
Dashboard Shows or hides the dashboard view.
Shows or hides the administration view.

Administration

I
I
i A Administration view is only visible to users with "ROLE_ADMIN".
I
I
|

Tab document section

The tab document is visible when a document is selected in the desktop view.

Field Description

Properties Shows or hides the document properties tab.
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Security Shows or hides the security tab.
Notes Shows or hides the notes tab.
Versions Shows or hides the versions tab.

Version download  Enables or disables the download document version.

Preview Shows or hides the preview tab.

Metadata Shows or hides the metadata tabs.

Tab folder section

The tab folder is visible when a folder is selected in desktop view.

Field Description

Properties ~ Shows or hides the folder properties tab.

Security Shows or hides the folder tab.

Notes Shows or hides the notes tab.

Tab mail section

Tab mail is visible when a mail is selected in desktop view.

Field Description

Properties  Shows or hides the mail properties tab.

Security Shows or hides the mail tab.

Notes Shows or hides the notes tab.

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE Page 392 of 1191

Preview Shows or hides the preview tab.
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Profile Menu tab

These menu options have preference among toolbar options or contextual menu options.
Hierarchy:

e Menu

e Toolbar

A Preference hierarchy. Upper hierarchy takes control over the lower. If the upper option is disabled then it will be
also disabled at the lower one.

For example, when download menu option is disabled then it will not be shown at the toolbar althought there will
be enabled.

Menu section

These are the main menu options.

Field Description
File Shows or hides the file menu.
Edit Shows or hides the edit menu.
Tools Shows or hides the tools menu.

Bookmarks  Shows or hides the bookmark menu.

Templates Shows or hides the templates menu.

Help Shows or hides the help menu.

Menu bookmark section

Field Description

Manage bookmarks Shows or hides manage the bookmarks menu option.
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Add bookmark Show or hide add the bookmark menu option.

Set home Shows or hides the set home menu option.

Shows or hides the go to home menu option.

Go home i On loading, the application always try to open the default home.

TTT T T T T T T Y

The default home is /okm:root that can be changed by end user.

Menu tool section

Field Description
Languages Shows or hides the change language menu option.
Skin Shows or hides the change skin menu option.

Shows or hides the debug menu option.

Debug i - )
i 1 When enabled is shown, it helps the administrator to find out possible UI bugs. |
: |
\. )
Shows or hides the administration menu option.

Administration | 1
1 - P . . .
| 1 Open administration is on a new window. }
: |
\. )

Preferences Shows or hides the user preferences menu option.
Shows or hides the convert menu option.

Convert

i This option is used to convert documents to different formats.

For example .doc to PDF.

FTTTT T
TER——

Menu help section
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Field Description

Documentation = Shows or hides the go to documentation website menu option.

Bug tracking Shows or hides the go to bug tracking website menu option.
Support Shows or hides the support menu option.

Forum Shows or hides the go to public forum website menu option.
Changelog Shows or hides the go to changelog menu option.

Web site Shows or hides the go to openkm website menu option.
About Shows or hides the application information menu option.

Menu file section

Field Description
Create folder Shows or hides the create folder menu option.
Find folders Shows or hides the find folders menu option.
Find documents Shows or hides the find documents menu option.
Similar documents Shows or hides the find similar documents menu option.

Shows or hides the go to folder menu option.

{ \
Go folder } - ) . . ) |
| 1 This option for example is shown in the contextual menu at the search !
]
i results. |
A )

Download Shows or hides the download menu option.
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Download PDF Shows or hides the download as pdf menu option.
Add document Shows or hides the add document menu option.
Purge Shows or hides the purge menu option.

Purge trash Shows or hides the purge all user trash menu option.
Restore Shows or hides the restore from trash menu option.
Start workflow Shows or hides the start workflow menu option.
Refresh Shows or hides the refresh user interface menu option.
Scanner Shows or hides the scanner tool menu option.
Uploader Shows or hides the bulk upload menu option.

Export Shows or hides the export to ZIP menu option.
Create from template Shows or hides the create from template menu option.
Send document link Shows or hides the send document link menu option.

Send document
Shows or hides the send document attachment menu option.
attachment

Forward e-mail Shows or hides the forward email menu option.

Menu edit section

Field Description
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Lock

Unlock

Update

Edit

Cancel Edit

Delete

Rename

Copy

Move

Add subscription

Remove subscription

Add metadata group

Update metadata group

Remove metadata group

Add note

Remove note

Add category

Shows or hides the lock menu option.

Shows or hides the unlock menu option.

Shows or hides the update a document menu option.

Shows or hides the edit a document menu option.

Shows or hides the cancel edit a document menu option.

Shows or hides the delete menu option.

Shows or hides the rename menu option.

Shows or hides the copy menu option.

Shows or hides the move menu option.

Shows or hides the add subscription menu option.

Shows or hides the remvoe subscription menu option.

Shows or hides the add metadata group menu option.

Shows or hides the update metadata group menu option.

Shows or hides the remove metadata group menu option.

Shows or hides the add note menu option.

Shows or hides the remove note menu option.

Shows or hides the add category menu option.
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Remove category Shows or hides the remove category menu option.
Add keyword Shows or hides the add keyword menu option.
Remove keyword Shows or hides the remove keyword menu option.
Merge PDF Shows or hides the merge pdf documents menu option.
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Profile Other tab

Toolbar section

Set the toolbar buttons that are shown.

TTTT T T T

To enable the toolbar option it must also be enabled in the menu tab, otherwise it will not be visible in the

toolbar.

Field Description
Create folder Shows or hides the create folder menu option.
Find folders Shows or hides the find folders menu option.

Find documents

Similar documents

Download

Download PDF

Print

Lock

Unlock

Add document

Edit

Update

Shows or hides the find documents menu option.

Shows or hides the find similar documents menu option.

Shows or hides the download document menu option.

Shows or hides the download document as pdf menu option.

Shows or hides the print document menu option.

Shows or hides the lock menu option.

Shows or hides the unlock menu option.

Shows or hides the add document menu option.

Shows or hides the edit a document menu option.

Shows or hides the update a document menu option.
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Cancel Edit

Delete

Add metadata group

Remove metadata group

Start workflow

Add subscription

Remove subscription

Refresh

Home

Scanner

Uploader

Splitter resize

File browser section

Shows or hides the cancel edit a document menu option.

Shows or hides the delete menu option.

Shows or hides the add metadata group menu option.

Shows or hides the remove metadata group menu option.

Shows or hides the start workflow menu option.

Shows or hides the add subscription menu option.

Shows or hides the remove subscription menu option.

Shows or hides the refresh user interface menu option.

Shows or hides the go to home menu option.

Shows or hides the scanner tool menu option.

Shows or hides the bulk upload menu option.

Shows or hides the splitter resize menu option.

Sets the file browser columns that are shown.

Field Description
Status Shows or hides the status column.
Massive Shows or hides the checkbox column.
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Icon

Name

Size

Last modified

Author

Version

Column 1

to

Colum 10

Shows or hides the icon column.

Shows or hides the name column.

Shows or hides the size column.

Shows or hides the last mofied date column.

Shows or hides the author column.

Shows or hides the version column.

Shows or hides the column based on metadata value.
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Database query

This feature helps administrator accessing database data, easily and quickly without thirdparty database software client.
Allowed types:

Type Description List Export

When choosen is shown a list of
JDBC SQL queries supported by the configured database. Yes.
available tables.

Neutral database queries based on hibernate queries

Hibernate No.
format.

Metadata Application specific format only for doing queries over When choosen is shown a list of Yes.
OKM_DB_METADATA_VALUE. available metadata tables.

For more information see Creating your

————————\

own database tables.

.

o Is allowed writing more than one query.

e Each query must be written on a single line, break lines are not allowed.

o Execute will process all written queries in same order has been written, top to bottom. Queries are executed as a
FIFO ( first in first out ).

o In case some query fails, that will not stop the execution of the others.

Execute JDBC query

» On bottom right choose type JDBC.

e Write some valid SQL.

e Click on Execute button.

» Optionaly the results can be exported to SQL or CSV
e Click on 'B* Export to sql icon.

« Click on & Export to csv icon.

Example:
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SELECT
SELECT
SELECT
SELECT

SELECT
SELECT
SELECT
SELECT
SELECT

*

%k % %

// nodeBase =

from
from
from
from
from

documents + folders + mails + records
count (*) from OKM NODE BASE;
count (*) from OKM NODE DOCUMENT;
count (*) from OKM NODE FOLDER;
count (*) from OKM NODE MAIL;

// select first 10 records

OKM NODE BASE LIMIT 10;

OKM NODE DOCUMENT LIMIT 10;

OKM NODE DOCUMENT VERSION LIMIT 10;
OKM NODE FOLDER LIMIT 10;

OKM NODE MAIL LIMIT 10;

Execute Hibernate query

» On bottom right choose type Hibernate.

e Write some valid HQL.

» Optionally you can check the "Show SQL" option.

e Click on Execute button.

TTTTTTTY

When "Show SQL" option is checked is shown in results the real sql executed.

Example:

select count (*) from NodeBase;
select count (*) from NodeFolder;,

Execute Metadata query

» On bottom right choose type Hibernate.

o Write some valid metadata query.

e Click on Execute button.

» Optionaly the results can be exported to SQL or CSV

Example:

e Click on 'E¥ Export to sql icon.

e Click on | Export to csv icon.

Allowed sentences
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Type

SELECT

UPDATE

DELETE

SENTENCE

Format

SELECT|TABLE

SELECT|TABLE|FILTER

UPDATE|TABLE|COLUMN

UPDATE|TABLE|COLUMNIFILTER

DELETE|TABLE

DELETE|TABLE|FILTER

SENTENCE|TABLEL1,..,TABLEn|QUERY

Example

SELECT|country
SELECT|country|$country_name='Canada’

SELECT]|country|col01="Canada’

UPDATE |country|$country_name='France'

UPDATE |country|$country_name='France' | $country_id

='001'

DELETE|country

DELETE)|country|$country_id ='001'

SENTENCE |country|select $country_id, $country_name
from DatabaseMetadataValue dmv where

dmv.table="country' order by $country_name

e Character $ is used to indicate that the word is a column name.

Execute queries from sql file

« On bottom right choose a valid sql file.

o Click on Import SQL script button.
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Reports

The application comes with Jasper reports engine. That helps administrator to create own reports.

V The JasperReports Library is one of the world's most popular reporting engine. It is able to use data coming from
any type of data source and produce pixel-perfect documents that can be viewed, printed or exported in a variety
of document formats including HTML, PDF, Excel, OpenOffice and Word.

More information about how to build your own reports at Creating your own reports.

More information about jasper report engine version that comes into application at Application version
mpatibili le .

A Keep on mind that any font used in the reports should be installed in the OpenKM server. For example, if you are
using Arial (sample provided reports use this font) you should ensure Arial font is installed. For example, if you
are using Ubuntu the package to install is ttf-mscorefonts-installer.

In RedHat or CentOS the package is msttcore-fonts. You need to restart the server after this package is
installed.

Reports are shown in a table structure.

_________________________________________________________________________________________________________

Create a new report

 On the top right click on e New report icon.
o Fill in the fields.
¢ Choose a report file ( *.rep or *.jrxml )

e Click on Create button.

Edit a report

e Click on Cv’; Edit a report icon.
* Modify the fields.
« Optionally choose a report file ( *.rep or *.jrxml )

e Click on Edit button.

Delete a report
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e Click on @ Delete a report icon.

e Click on Delete button.

Show report report parameters

i Optionally, reports can require parameters for execution.

For example a range of dates. These parameters will be shown as a form in the user interface when report will be
executed.

—_————— e —

——

e Click on ] Report params icon.

EXxecute a report

e Click on Execute report icon.
o Fill in the fields ( when report comes with parameters ).
« Choose report output format

e #= PDF format.

. RTF format.

. = CSV format.
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Reports pack

For more information Activity log.

V Most of these reports are based on Activity log events audit trail.

.

Template reports

Name Use Activity log

JavaReportPattern.jrxml No.

SQLReportPattern.jrxml No.

Authentication
Name Use Activity
log
_ Yes.
UsersLogout.rep Yes.

UsersSessionExpiration.rep Yes.

Documents

Name

DocumentCanceledCheckout.rep

DocumentCheckin.rep

DocumentCheckout.rep

Requ

ire parameters

Require
parameters

Yes.

Yes.

Yes.

Use
Activity
log

Yes.

Yes.

Yes.

Require
parameters

Yes.

Yes.

Yes.

Description

Template pattern that use Java to retrieve data.

Template pattern that use SQL to retrieve data.

Description

Users login, filtered by date range.

Users logout, filtered by date range.

Users that session expired, filtered by date

range.

Description

Lists documents that cancelled the edition,

filtered by date range.

List documents updated, filtered by date range.

List documents on edition, filtered by date
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DocumentCreate.rep Yes.
DocumentDelete.rep Yes.
DocumentGetChildren.rep Yes.
DocumentContent.rep Yes.
DocumentContentByVersion.rep Yes.
DocumentGetProperties.rep Yes.
DocumentGetVersionHistory.rep Yes.

Yes.

Yes.

Yes.

Yes.

Yes.

Yes.

Yes.

range.

List documents created, filtered by date range.

List documents deleted, filtered by date range.

Show when the users listed the documents into
some folder or record. Results are filtered by

date range.

~

i To list documents into a folder is
called internally method named
"getChildren".

De—

Show when the users retrieved the content of a

document. Results are filtered by date range.

i For example, when a user
download or preview a document
( among other actions ) is
retrieving the content of the
document.

Show when the users retrieved a specific
version of the content of a document. Results

are filtered by date range.

Show when user retrieved the properties of a

document. Results are filtered by date range.

i For example, when document is
selected, is called internally a
method named "getProperties" to
fill the contents of properties tab
in user interface.

Shown when the users retrieved the list of all
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versions of a document. Results are filtered by

date range.

DocumentGetPropertyGroupProperties.rep  Yes. Yes. List when has been retrieved the fields of a

metadata group.

i For example, when a metadata
group is shown in users
interface, is called internally a
method named
"getPropertyGroupProperties"
to fill the metadata group values.

DocumentLock.rep Yes. Yes. List documents updated, filtered by date range.
DocumentMove.rep Yes. Yes. List documents moved, filtered by date range.
DocumentPurge.rep Yes. Yes. List documents purged, filtered by date range.

A When a document is purged it
will definitively disappear from

application repository.

DocumentRenamed.rep Yes. Yes. List documents renamed, filtered by date range.
DocumentUnlock.rep Yes. Yes. List documents unlocked, filtered by date range.
DocumentsAccessibleByUserOrdered.jrxml ~ No. No. Retrieve a list of available documents - security

filtered - ordered by folder name.

A Optimized for csv format.

Not recommended for large
repositories, can take a lot of

—_—————— e

time.

DuplicatedFiles.jrxml No. No. List of duplicated files into application
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repository, based on document checksum.

ListDocumentsWithChecksum.rep No. Si. List of all documents into some folders and

subfolders with checksum value.

Folders
Use Require
Name Activity qu Description
parameters
log
FolderCopy.rep Yes. Yes. List folders copyed, filtered by date range.
FolderCreate.rep Yes. Yes. List folders created, filtered by date range.
FolderDelete.rep Yes. Yes. List folders deleted, filtered by date range.
FolderGetChilden.rep Yes. Yes. Show when the users listed the folders into some folder or record.
Results are filtered by date range.
{ )
i To list folders into a folder is called internally i
i method named "qgetChildren". i
\. )
FolderGetContentInfo.rep ~ Yes. Yes. Shown when the internal method named "getContentInfo" has
been executed.
i To do some operations is needed to calculate
folder deep, for example before starting folder
ZIP download.
There's an internal method named "getCotentInfo"
that does it.
FolderGetProperties.rep Yes. Yes. Show when user retrieved the properties of a folder. Results are
filtered by date range.

For example, when folder is selected, is called
internally a method named "getProperties" to fill

TTTTTTTTTT Y
S ——

the contents of properties tab in user interface.
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FolderMove.rep Yes. Yes. List folders moved, filtered by date range.
FolderPurge.rep Yes. Yes. List folders purged, filtered by date range.

When a folder is purged it will definitively
disappear from application repository.

FolderRename.rep Yes. Yes. List folders renamed, filtered by date range.
Mails
Use Require
Name Activity qu Description
parameters
log
MailCreate.rep Yes. Yes. List mails created, filtered by date range.

MailGetProperties.rep ) ) .
Yes. Yes. Shown when a user retrieved the properties of a mail. Results are

filtered by date range.

i For example, when mail is selected, is called
internally a method named "getProperties" to fill the
contents of properties tab in user interface.

,___________
SEe—

MailPurge.rep Yes. Yes. List mails purged, filtered by date range.

i
i When a mail is purged it will definitively disappear
i from application repository.

.

MailRename.rep Yes. Yes. List mails renamed, filtered by date range.
MailMove.rep Yes. Yes. List mails moved, filtered by date range.
MailCopy.rep Yes. Yes. List mails copyed, filtered by date range.
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MailGetChilden.rep Yes. Yes. Show when the users listed the mails into some folder or record.
Results are filtered by date range.
{ )
| - To list mails into a folder is called internally method i
|
| named "getChildren". i
[ J
Others
Name Use Activity log  Require parameters Description
WorkflowWorkload.jrxml ~ No. No. Each workflow task with the time spent on it.
RegisteredUsers.jrxml No. No. Registered users.
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Activity log

This application performs a complete audit trail. Audit trail is mainly a datastore service. It defines a

data record structure that will be used for storing audit information.

The activity log is shown in a table structure.

Date User Action Item Path Parameteres

Filter options:

Field Description Required

Fromdate  Start of date range. true.

To date End of date range. true.
User Specific user. false.
Action Any action. false.

Auth actions

Field / Property Description
LOGIN User log in.
LOGOUT User log out.

SESSION_EXPIRATION User session expiration date

GRANT_USER Adds user grant on a node.

REVOKE_USER Removes user grant on a node.
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GRANT_ROLE Add role grant on a node.
REVOKE_ROLE Removes user grant on a node.

Document actions

Field / Property Description

CANCEL_DOCUMENT_CHECKOUT Cancels document edition.
CHECKIN_DOCUMENT Updates document.
CHECKOUT_DOCUMENT Edits document.
CREATE_DOCUMENT Creates a new document.
DELETE_DOCUMENT Deletes a document.

Retrieves a document list in a node.

GET_CHILDREN_DOCUMENTS -
1 List of documents in a folder or record.

TTTTTTTY
————

GET_DOCUMENT_CONTENT Retrieves binary data.

GET _DOCUMENT_CONTENT_BY_VERSION Retrieves binary data by document version.

Retrieves all document properties.

P

GET_DOCUMENT_PROPERTIES It does not include metadata. It has a direct
relationship with the panel properties when a

document is selected.

GET _DOCUMENT_VERSION_HISTORY Retrieves a list of all versions of a document.
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GET_PROPERTY_GROUP_PROPERTIES Retrieves all metadata properties of a document.
LOCK_DOCUMENT Locks a document.
MOVE_DOCUMENT Moves a document.

Purges a document.

PURGE_DOCUMENT | ) . \I
! A purged document is definitively removed from the I
|
i application. i

J

RENAME_DOCUMENT Renames a document.

Sets document properties.

SET_DOCUMENT_PROPERTIES | . . \I
| For example when a user is subscribed to a |
|
i document. !
! J

UNLOCK_DOCUMENT Unlocks a document

Folder actions
Field / Property Description

COPY_FOLDER Copies a folder.

CREATE_FOLDER Creates a folder.

DELETE_FOLDER Deletes a folder.

Retrieves a folder list in a node.

GET_CHILDREN_FOLDERS -
1 List of folders in a folder or record.

TTTTTTTY
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GET_FOLDER_CONTENT_INFO  Counts nodes into a folder ( documents, folders, records and mails that are into ).

Retrieves all folder properties.

GET_FOLDER_PROPERTIES | . . . . .

! Does not include metadata. it has a direct relationship with panel
1

1

1

|

properties when a folder is selected.

MOVE_FOLDER Moves a folder.

Purges a folder.

PURGE_FOLDER
A A purged folder is definitively removed from application.

TTTTTTTY

RENAME_FOLDER Renames a folder.

Mail actions

Field / Property Description

CREATE_MAIL Creates a mail.

Retrieves all mail properties.

GET_MAIL_PROPERTIES

e
I
1
! A Does not include metadata. It has a direct relationship with panel
1
| properties when a mail is selected.

|

.

DELETE_MAIL Deletes a mail.

Purges a mail.

PURGE_MAIL
A A purged mail is definitively removed from application.

TTTTTTTY
.

RENAME_MAIL Renames a mail.
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MOVE_MAIL Moves a mail.

COPY_MAIL Copies a mail.

Retrieves mail list in some node.

GET_CHILDREN_MAILS

{ |
i i List of mail in a folder or record. i
|
| J
DOWNLOAD_MAIL Downloads a mail
Repository actions
Field / Property Description

Trash is purged.

PURGE_TRASH |
i All related nodes are definitively removed from application.
|
|

.

Admin actions

g

|

i i These actions are only done by users with Administration grants.

I

Field / Property Description

ADMIN_ACTIVITY_LOG The administrator uses "activity log".
ADMIN_ACTIVE_SESSIONS The administrator uses Logged users.
ADMIN_USER_CREATE Creates a user.
ADMIN_USER_EDIT Edits a user.
ADMIN_USER_DELETE Deletes a user.
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ADMIN_USER_ACTIVE Enables or disables a user.

ADMIN_ROLE_CREATE Creates a role.

ADMIN_ROLE_EDIT Edits a role.

ADMIN_ROLE_DELETE Deletes a role.

ADMIN_ROLE_ACTIVE Enables or disables a role.
Checks email poll.

ADMIN_CHECK_EMAIL | - o ) |
| 1 The application reads email accounts to |
| I
| !

ADMIN_CONFIG_CREATE

ADMIN_CONFIG_EDIT

ADMIN_CONFIG_DELETE

ADMIN_CRONTAB_CREATE

ADMIN_CRONTAB_EDIT

ADMIN_CRONTAB DELETE

ADMIN_CRONTAB_EXECUTE

ADMIN_DATABASE_QUERY

ADMIN_DATABASE_UPDATE

import emails.

Creates a configuration parameters.

Edits a configuration parameter.

Deletes a configuration parameter.

Creates a crontab task.

Edits a contab task.

Deletes a crontab task.

Executes a crontab task.

Executes a database query.

Executes an update database query.
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ADMIN_LANGUAGE_CREATE Creates a new laguage.
ADMIN_LANGUAGE_EDIT Edits a language.
ADMIN_LANGUAGE_DELETE Deletes a language.
ADMIN_LANGUAGE_IMPORT Imports a language.
ADMIN_LOGCAT_LIST The administrator user logcat tool.
ADMIN_LOGCAT_VIEW The administrator user logcat tool.
ADMIN_LOGGED_USERS The administrator uses Logged users.
ADMIN_MAIL_ACCOUNT_CREATE Creates a mail account.
ADMIN_MAIL_ACCOUNT_EDIT Edits a mail account.
ADMIN_MAIL_ACCOUNT_DELETE Deletes a mail account.
ADMIN_MAIL_ACCOUNT_CHECK Checks a mail account.
ADMIN_MAIL _FILTER CREATE Creates a mail account filter.
ADMIN_MAIL_FILTER _EDIT Edits a mail account filter.
ADMIN_MAIL _FILTER DELETE Deletes a mail account filter.
ADMIN_MAIL_FILTER_RULE_CREATE Creates a mail account rule.
ADMIN_MAIL _FILTER RULE_EDIT Edits a mail account rule.
ADMIN_MAIL_FILTER RULE_DELETE Delete a mail account rule.
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ADMIN_MIME_TYPE_CREATE

ADMIN_MIME_TYPE_EDIT

ADMIN_MIME_TYPE_DELETE

ADMIN_USER PROFILE_CREATE

ADMIN_USER PROFILE_EDIT

ADMIN_USER _PROFILE_DELETE

ADMIN_PROPERTY_GROUP_REGISTER

ADMIN_PROPERTY_GROUP_LIST

ADMIN_REPORT_CREATE

ADMIN_REPORT_EDIT

ADMIN_REPORT _DELETE

ADMIN_REPORT_EXECUTE

ADMIN_REPOSITORY_SEARCH

ADMIN_REPOSITORY_REINDEX

ADMIN_REPOSITORY_UNLOCK

ADMIN_REPOSITORY_CHECKIN

Creates a new MIME type

Edits MIME type.

Deletes MIME type.

Creates a profile.

Edits a profile.

Deletes a profile.

Registers a metadata group.

Lists metadata groups.

Creates a report.

Edits a report.

Deletes a report.

Executes a report.

Performes a Lucene search.

Reindexes Lucene repository.

Unlocks a node from a repository view.

Updates a node from a repository view.
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ADMIN_REPOSITORY_EDIT

ADMIN_REPOSITORY_SAVE

ADMIN_REPOSITORY_LIST

ADMIN_REPOSITORY_REMOVE_CONTENT

ADMIN_REPOSITORY_REMOVE_CURRENT

ADMIN_WORKFLOW_REGISTER

ADMIN_PROCESS_DEFINITION_DELETE

ADMIN_PROCESS_INSTANCE_DELETE

ADMIN_PROCESS_INSTANCE_END

ADMIN_PROCESS_INSTANCE_RESUME

ADMIN_PROCESS_INSTANCE_SUSPEND

ADMIN_PROCESS_INSTANCE_ADD_COMMENT

ADMIN_PROCESS_INSTANCE_VARIABLE DELETE

ADMIN_PROCESS_INSTANCE_VARIABLE_ADD

ADMIN_TASK INSTANCE_SET ACTOR

ADMIN_TASK INSTANCE_START

Edits a node from a repository view.

Modify a node from a repository view.

Refreshes folder contents from repository view.

Purges folder lo dentro

Deletes all folder todo

Registers a workflow.

Deletes a workflow process definition.

Deletes a workflow process instance.

Workflow process instance finished.

Workflow process instance resumed.

Workflow process instance suspended.

Adds comment on a workflow process instance.

Deletes variable on a workflow process instance.

Adds variable on a workflow process instance.

Sets actor on a a workflow task instance.

Workflow task instance started.
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ADMIN_TASK _INSTANCE_END Workflow task instance ended.
ADMIN_TASK INSTANCE_SUSPEND Workflow task instance suspeded.
ADMIN_TASK INSTANCE_ADD COMMENT Adds comment on a workflow task instance.
ADMIN_TASK INSTANCE_VARIABLE_DELETE Deletes variable on a workflow task instance.
ADMIN_TASK INSTANCE_VARIABLE_ADD Adds variable on a workflow task instance.
ADMIN_TASK INSTANCE_RESUME Resumes a workflow task instance.
ADMIN_TOKEN_SIGNAL Workflow task signal sent from administration view.
ADMIN_TWITTER_ACCOUNT_CREATE Creates a twitter account.
ADMIN_TWITTER_ACCOUNT_EDIT Edits a twitter account.

ADMIN_TWITTER _ACCOUNT_DELETE Deletes a twitter account.
ADMIN_USER_CONFIG_EDIT Changes a user profile.
ADMIN_SCRIPTING Executes scripting.

Misc actions

Field / Property Description
MISC_OPENKM_START Starts application.
MISC_OPENKM_STOP Stops application.

Application check.
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i Several internal checks to ensure application is alive:
MISC_STATUS

e Database connection.

* Repository connection.

MISC_TEXT _EXTRACTION_FAILURE Text extraction failure.
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Workflow

In Workflow view are shown the registered workflows. In this view the user can register new workflows and view or modify

existing workflow process instances.

Workflow are shown in a table structure.

3
a
2
@
~
=)
3
3
©
@
g
3
[
5
=l
(=)
=
>
(o]
=%
(=)
=

Description:

Property Description

Process Each workflow has an unique Process ID.

ID
Process The workflow Process Name is set into the workflow process definition.
Name (

A The workflow process definition is an XML. In the first tag is set the Process Name.

<?xml version="1.0" encoding="UTF-8"?>
<process-definition xmlns="urn:jbpm.org:jpdl-3.2" name="purchase">

</process-definition>

Version Workflow version.

When is a new workflow is registered, if exists a previous workflow with the same Process Name, then

the version will be increased in one unit.

TTTTTTTTY

Actions Available actions:

o 5 View ( manage process intances, form definition, process image ).

. @ Delete

Register workflow

e On the right bottom, select the .par file ( workflow file type ).
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e Click ! Register process definition button.
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Workflow forms definition

Workflow forms are based on formal XML definition. The DTD ( Document Type Definition ) defines the structure and the legal

elements and attributes of an XML document.

i You can see the latest DTD in our website http://www.openkm.com/dtd/workflow-forms-{major}.{minor}.dtd

where {major} and {minor} values are two numbers ( major release and minor release ). For example the

location for version 2.6 of the dtd is http://www.openkm.com/dtd/workflow-forms-2.4.dtd

A Each application version supports only a couple of DTD definitions, read: Application version compatibility
table to see which are supported by your application.

Basic XML skeleton

<?xml version="1.0" encoding="UTF-8"?>

<!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN"
"http://www.openkm.com/dtd/workflow-forms-2.4.dtd">

<workflow-forms>

</workflow-forms>

o The DOCTYPE is a formal definition of some DTD. In the previous example the workflow-forms-2.4.dtd.
o The XML begins with <workflow-forms> tag and ends with </workflow-forms>. Into this hicheracy are defined the

metada groups.

Workflow task form definition

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN"
"http://www.openkm.com/dtd/workflow-forms-2.4.dtd">
<workflow-forms>
<workflow-form task="evaluate price">

</workflow-form>
</workflow-forms>

e Each <workflow-form> ... </workflow-form> block identify the beginning and end of new workflow form task
definition.
e Each task has a unique name, "evaluate price".

o Must not use special characters for name.

Attribute Description Required

name Unique field identifier. true

i |
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g Two metadata groups can't have the same name. Name must be unique.
The name must start with "okg:".

Must not use special character for task name. We suggest (0-9a-zA-Z_).

Basic example
Available field types:

o Checkbox

¢ Button

e Download
o Input

o Select

e Separator

* Suggestbox
o Text

o TextArea

e Upload

More information about field type elements at Workflow fields

1 <?xml version="1.0" encoding="UTF-8"?>

' <!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN" i
i "http://www.openkm.com/dtd/workflow-forms-2.4.dtd"> |
i\ <workflow-forms> '
E <workflow-form task="evaluate price"> E
! <input label="Purchase price" name="price" data="price" readonly="true" /> J

<button name="approve" label="Approve'" transition="approve'/>
<button name="deny" label="Deny" transition="deny'"/>
</workflow-form>
</workflow-forms>

Using file system DTD

If the server has no access to the Internet, then the DTD file must be accessible in some way, for example can store a copy in

your application server.

The XML definition must be changed to refer to the new DTD location, otherwise you will get and application

, ‘=
1 |
| |
i error while trying to process a DTD file. !
]
| |
i‘ It can be a file system ( example below ) or a valid intranet URL. j

<!DOCTYPE property-groups PUBLIC "-//OpenKM//DTD Property Groups 2.4//EN"
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"file:///home/openkm/workflow-forms-2.4.dtd">

o In the example, /home/openkm/workflow-forms-2.4.dtd is the file system path to the file.
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Workflow fields

These are the available field types:

Field type Description

Checkbox orkflow Checkbox field
Button orkflow Button field

Download orkflow Download field

Input orkflow Input field
Print orkflow Print field
Select orkflow Select field

Separator orkflow Separator field

Suggestbox ~ WWorkflow Suggestbox field

Text orkflow Text field

TextArea orkflow TextArea field

Upload orkflow Upload field

Some field types can have children elements, validator or option elements. This hierarchy is permitted:

o workflow form
o Checkbox
e Validator
e Button

e Download
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¢ Node

e Validator
o Input

¢ Validator
e Print

¢ Node

¢ Validator
o Select

e Option

« Validator
e Separator
e Suggestbox

¢ Validator
o Text
o TextArea

¢ Validator
e Upload

e Validator
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Workflow Button field

Buttons are typically used by users - in user interface - for decision making.

TTTTTTTY

i For example two buttons, accept and deny. One for accept something and the other one to deny.

Attribute

label

name

transition

confirmation

validate

style

Description

The text shown as label in user interface.

A unique field identifier

Two fields can't have the same name into the same task definion. The Name

must be unique.

W——,

If present, a process instance token will follow the indicated transition.

The button will show as a popup with an operation confirmation message. The message text

used is confirmation value.

Default value is "true".

Icon style applied to the button. Possible values:

o yes
* no
e add

delete

download

downloadZip
e home

* view

change

compact
e clean

search

e save

Required

true

true

false

false

false

false
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¢ comment
width The width of the HTML element. false
height The height of the HTML element. false

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN"
"http://www.openkm.com/dtd/workflow-forms-2.4.dtd">

<workflow-forms>

<workflow-form task="evaluate price">

<button name="deny" label="Deny" transition="deny'"/>

</workflow-form>

</workflow-forms>
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Workflow Download field

This workflow is used to download a document.

Attribute Description Required

label

The text shown as a label in user interface. true

Unique name identifier

name |’ } i o L true
! Two fields can't have the same name in the same task definion. Name must be 1
I I
i unique. i
width The width of the HTML element. false
height The height of the HTML element. false
When present,it is an identifier used to load data.
data I’ | false
| i For example to dynamically load the uuid or path of the node to download. |
| ]
l ]
Child elements:

e Node. For more information see Workflow Node element.
e Validator. For more information see Workflow Validator element.

Basic download example

e Download button with node element.

uuid is a valid document uuid.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN"
"http://www.openkm.com/dtd/workflow-forms-2.4.
<workflow-forms>
<workflow—-form task="download test">
<download name="download" label="Download document'>
<node label="download" uuid="afb8ac33-912d-4515-e29b-1c01b693809%a" />
</download>
</workflow-form>
</workflow-forms>

B e >
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Dynamic download example

e Download button with node element.
e uuid is a valid document uuid.

e data is a valid mapping variable. This variable is used to dynamically set uuid attribute into node element.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN"
"http://www.openkm.com/dtd/workflow-forms-2.4.dtd">
<workflow-forms>
<workflow—-form task="download test'">
<download name="download" label="Download document'" data='"dynamic'">
<node label="download" />
</download>
</workflow-form>
</workflow-forms>
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Workflow Validator element

The goal of the Validatior element is to ensure that the user provides necessary and properly formatted information needed to

successfully complete an operation.

Validator can only be used in combination with other fields:

o Workflow Input field

» Workflow Suggestbox field
¢ Workflow Upload field

¢ Workflow Download field
¢ Workflow Print field

» Workflow Checkbox field
o Workflow Text field

¢ Workflow TextArea field

o Workflow Select field

Available validators:

name Description
req Required value.
alpha Alphanumeric value.
dec Decimal value.

num Numeric value.

email E-mail value.

url URL value.

maxlen  Sets the maximum length allowed.

minlen Sets the minimum length required.
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It

gt

min

max

regexp

Parent:

Less than.

Greater than.

Minimum value.

Maximum value.

Regular expression.

o Workflow Input field

o Workflow Suggestbox field

o Workflow Upload field

» Workflow Download field
o Workflow Print field

o Workflow Checkbox field
o Workflow Text field

o Workflow TextArea field
» Workflow Select field

Basic example

o Value required "req".

e Value must be decimal "dec".

o The maximum length of the decimal value is 6 digits "maxlen".

<input label="Decimal value" name="decimal'">
<validator type="dec"/>
<validator type="req"/>
<validator type="maxlen" parameter="6"/>
</input>

Regular expression

If you want a validation which is not included in these prefefined, you can use a regular expression. For example, imagine you
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want to restrict an input to lowecase ASCII values:

<input label="Lowercase value" name="regExp'>
! <validator type="regexp" parameter="[a-z]+" /> J
| </input> :
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Workflow Node element

This option element is only used in combination with:

e Workflow Download field
e Workflow Print field

The option value represents a list of distinct values in a Selected field.

Attribute Description Required
label The text shown as a label in the user interface. true
path Node path. Usually a document path. false
uuid Node uuid. Usually a document valid uuid. false

Parent :

* Workflow Download field
e Workflow Print field

Basic download example

e Download button with node element.

e yuid is a valid document uuid.

1 <workflow-form task="download test">
! <download name="download'" label="Download document'"> J
i <node label="download" uuid="afb8ac33-912d-4515-e29b-1c01b693809a" /> i
i </download> ‘
' </workflow-form>

Take it as an example. Normally it wants to assign dynamically a uuid, for it is used data attribute.
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Workflow Upload field

Upload is used to upload a document.

Attribute

label

name

width

height

data

type

folderPath

folderUuid

documentName

documentUuid

Description

The text shown as a label in user interface.

Unique name identifier

must be unique.

)

Two fields can't have the same name in the same task definion. Name

The width of the HTML element.

The height of the HTML element.

When present, is an identifier used to load data.

TTTTTTTY

i For example dynamically set the folderPath or folderUuid.

Values:

e create ( the operation will be create new document )

e update ( the operation will be update existing document )

i When it is not present, the default value is set to create.

TTTTTTTY

The folder path where the document will be stored.

The folder uuid where the document will be stored.

Forced name of the uploaded document.

The uuid of the document to be updated.

Required

true

true

false

false

false

false

false

false

false

false
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To upload a new document, you should set the folderPath or folderUuid, optionally documentName if we
want to force the document name.

To update an existing document, you should set documentUuid and put type to update.

Ea———

Child elements:

e Validator. For more information see Workflow Validator element .

Basic upload example

e Upload a new document to a folder.

folderUuid is a valid folder uuid. You can also use folderPath and set a path, which is more human readable.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN"

</workflow-form>
</workflow-forms>

i "http://www.openkm.com/dtd/workflow-forms-2.4.dt

1 <workflow-forms>

i <workflow-form task="upload test"> ]

i <upload name="upload" label="Upload document" folderUuid="fca2d85e-0e01-418c

: </workflow-form> '

1 </workflow-forms>
Document update

e Create a new version of a given document.

e documentUuid is the UUID of the document to be replaced.

e Note the type parameter which is set to update.
e 1
<?xml version="1.0" encoding="UTF-8"?>
' <!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN" ]

] "http://www.openkm.com/dtd/workflow-forms-2.4.dtd"> |
1 <workflow-forms>
i <workflow-form task="upload test"> ]
i <upload name="upload" label="Upload document" type="update" documentUuid="e6a0630

Upload example with dynamic parameters

¢ Upload a document into a non-predefined folder.

¢ data is a valid mapping variable. This variable is used to dynamically set folderPath attribute.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN" i
"http://www.openkm.com/dtd/workflow-forms-2.4.dtd"> |

<workflow-forms> '
<workflow-form task="upload test'">
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<upload name="upload" label="Upload document" data="updData" />
</workflow-form>
</workflow-forms>

import org.jbpm.graph.def.ActionHandler;,
import org.jbpm.graph.exe.ExecutionContext;

import com.openkm.bean.form.Upload;

public class UploadAction implements ActionHandler {
private static final long serialVersionUID = 1L;

@O0verride

public void execute (ExecutionContext ctx) throws Exception {
Upload upd = new Upload() ;
upd.setFolderPath ("/okm:root/dstF1d") ;
ctx.setVariable ("updData", upd),

// Go to next node
ctx.getToken().signal () ;
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Workflow Print field

Used to print a document.

Attribute Description Required

label

The text shown as label in user interface. true

Unique name identifier

name |’ } i o L true
! Two fields can't have the same name in the same task definion. Name must be 1
I I
i unique. i
width The width of the HTML element. false
height The height of the HTML element. false
When present, is an identifier used to load data.
data I’ | false
| i For example dynamically set the uuid or path of the document to download. |
| ]
l ]
Child elements:

¢ Node. For more information Workflow Node element.
e Validator. For more information Workflow Validator element.

Basic print example

e Print a document

uuid is a valid document uuid.

<?xml version="1.0" encoding="UTF-8"2?>
<!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN"
"http://www.openkm.com/dtd/workflow-forms-2.4.
<workflow—-forms>
<workflow-form task="print test'">
<print name="print" label="Print document">
<node label="print" uuid="arfb8ac33-912d-4515-e29b-1c01b693809a" />
</print>
</workflow-form>
</workflow-forms>

B e >

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE Page 443 of 1191

Dynamic print example

e Print an existing document

e data is a mapping valid variable. This variable is used to dynamically set uuid attribute into the node.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN"
"http://www.openkm.com/dtd/workflow-forms-2.4.dtd">
<workflow-forms>
<workflow-form task="print test'">
<print name="print" label="Print document" data="dynamic">
<node label="print" />
</print>
</workflow-form>
</workflow-forms>
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Workflow Checkbox field

Checkbox

Best used to represent boolean data:

Attribute Description
label The text shown as label in user interface.
Unique field identifier
I's
name i
! Two fields can't have the same name in the same task definion. Name must be
I
i unique.
width The width of the HTML element.
height The height of the HTML element.
readonly  Set field, it will not be able to be modified in user interface. By default the value is " false".
When present, is an identifier used to load data.
data I’
i i For example to dynamically load the true or false value of the checkbox.
l
Child elements:

e Validator. For more information see Workflow Validator element.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN"

Required

true

true

false

false

false

"http://www.openkm.com/dtd/workflow-forms-2.4.dtd">

<workflow-forms>
<workflow—-form task="checkbox test">
<checkbox label="Checkbox label'" name="checkbox" />
</workflow-form>
</workflow-forms>
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Workflow Input field

In mosts cases is used to enter free form text, although can be used to save http links, date data or refer to application folder (

as internal link to this folder ).

Attribute Description Required
label ) )

The text shown as a label in the user interface. true
"ame . . . Yy

Unique field identifier. true

Two fields can't have the same name in the same task definion. Name must be

———————\

unique.

e true
op Type value. Allowed types:

o text.
e date.
o link.
e folder.

value false
Can specify a default value for this component.

There's a special case for date types. Data is stored in format
"yyyyMMddHHmmss", take care of it when you're using OpenKM APL

———————\

width false
The width of the HTML element.

height The height of the HTML element. false

data
When present, is an identifier used to load data.

i For example to dynamically load the Input value.

———————\

readonly  Set field will not be able to be modified in user interface. By default the value is " false". false

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE Page 446 of 1191

Child elements:

« Validator. For more information see Workflow Validator element.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN"
"http://www.openkm.com/dtd/workflow-forms-2.4.dtd">

<workflow-forms>

<workflow-form task="input test'>

<input label="Input label" name="input" />

</workflow-form>

</workflow-forms>
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Workflow Select field

Attribute Description Required

label The text shown as label in user interface. true

Unique field identifier.

name i’ | true

! Two fields can't have the same name in the same task definion. Name must |

I I

i be unique. 1

J

Type value. Allowed types:

type o simple ( single choice allowed ). true
o multiple ( multiple choice allowed ).

Metadata table name.
table { . I

| 1 Application can store values into metadata table, that can be used in this |

| ]

i query. i
width The width of the HTML element. false
height The height of the HTML element. false
optionsQuery A metadata query or SQL query used to get the select options. *
data When present, is an identifier used to load data. false
optionsData When present, is an identifier used to load options. false
readonly Set field will not be able to be modified in user interface. By default the value is " false". false
Child elements:
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¢ Option. Couples of XML <option label="Iabel text" value="unique identifier value"/> values or <option
label="label text" value="unique identifier value" parentValue="parent unique identifier value"/> in case is

set some hierarchical relationship.

e Validator. For more information see Workflow Validator element.

* There're two options to get option values:

e Directly defined in XML.

e Metadata table ( table + optionsQuery ).

One of these options must be defined, otherwise you will get an error. A combination of several of these
cannot be done, only one can be choosen.

Basic select example

o Type is equal to simple.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN"
"http://www.openkm.com/dtd/workflow-forms-2.4.dtd">
<workflow-forms>
<workflow-form task="select test'">
<select label="select label" name="select" type="simple'>
<option label="one" value="001" />
<option label="two" value="002" />
<option label="three" value="003" />
</select>
</workflow-form>
</workflow-forms>

Allow multiple choice

¢ Type is equal to multiple.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN"
"http://www.openkm.com/dtd/workflow-forms-2.4.dtd">
<workflow-forms>
<workflow—-form task="select test'">
<select label="select label" name="select" type="multiple'>
<option label="one" value="001" />
<option label="two" value="002" />
<option label="three" value="003" />
</select>
</workflow-form>
</workflow-forms>

Options based on metadata table
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e Application use two tables named OKM_DB_METADATA_TYPE AND OKM_DB_METADATA_VALUE that helps
storing used options values. That's very useful when you have a large number of values.

e In the table OKM_DB_METADATA_TYPE are stored metadata table definition ( table name, column name and column

type ).
o In the table OKM_DB_METADATA_VALUE are stored record values.

Create metadata table definition.

V The table will be called country, with two columns, country_id and country_name.
The country_id column is integer type and country_name is text type.

The country_id is set as column 0 with col00 value.

The country_name is set as column 1 with col01 value.

¢ Go to Administration > Database query.
e At the right bottom select JDBC from list.

e Paste the SQL in the box

E DELETE FROM OKM DB METADATA TYPE WHERE DMT TABLE='country'; ]
1 INSERT INTO OKM DB METADATA TYPE (DMT TABLE, DMT REAL COLUMN, DMT TYPE, DMT VIRTUAL (C
. INSERT INTO OKM DB METADATA TYPE (DMT TABLE, DMT REAL COLUMN, DMT TYPE, DMT VIRTUAL .C

e Click at bottom right the Execute button.
Insert metadata table values:

¢ Go to Administration > Database query.
e At the right bottom select JDBC from list.

o Paste the SQL in the box

E DELETE FROM OKM DB METADATA VALUE WHERE DMV TABLE='country';
' INSERT INTO OKM DB METADATA VALUE (DMV TABLE, DMV COL0O0O, DMV COL01) VALUES ('country

INSERT INTO OKM DB METADATA VALUE (DMV TABLE, DMV COL00, DMV COLO1) VALUES ('country'

e Click the Execute button at the right bottom.

A The insert queries depending on your database can not be matched, for example in Oracle:

INSERT INTO OKM_DB_METADATA _TYPE (DMT_ID, DMT TABLE, DMT REAL_COLUMN, DMT TYPE,
DMT VIRTUAL_COLUMN) VALUES (HIBERNATE_SEQUENCE.NEXTVAL, 'country', 'col00', 'integer’,

'country_id'");

More information at: Creating your own database tables.
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Finally the XML definition:

o In optionsQuery the values that begins with character $ are identified as column names. See $country_id and
$country_name below.

e Can use normal sql clauses like "order by" etc.

E <?xml version="1.0" encoding="UTF-8"?>

i\ <!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.6//EN" i
] "http://www.openkm.com/dtd/workflow-forms-2.6.dtd"> |
i\ <workflow-forms>

E <workflow-form task="select test">

i <select label="country" name="country" type="simple" table="country" ]
i optionsQuery="select $country id, $country name from DatabaseMetadataValu
E </workflow-form> i
' </workflow-forms>

Based on SQL query

We can also get these option values using a SQL query. This SQL sentence should be put on the optionsQuery attribute, but the
table attribute should be empty (otherwise this query is used as a metadata query). Note that the first element returned in every

row is the option value and the second one is the option label.

E <?xml version="1.0" encoding="UTF-8"?>

i\ <!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN" i
] "http://www.openkm.com/dtd/workflow-forms-2.4.dtd"> |
i\ <workflow-forms>

E <workflow-form task="select test">

i <select label="country" name="country" type="simple" ]
i optionsQuery="select CT ID, CT NAME from COUNTRY order by CT NAME" /> |
E </workflow-form> E
' </workflow-forms> '

create table COUNTRY (
CT _ID varchar(2),
CT NAME varchar (32),
primary key (CT _ID)

L) :

insert into COUNTRY (CT _ID, CT NAME) values ('es', 'Spain');
insert into COUNTRY (CT _ID, CT NAME) values ('pt', 'Portugal');
insert into COUNTRY (CT _ID, CT NAME) values ('it', 'Italy');
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Workflow Separator field

Draw a separator between fields.

Attribute Description Required

label The text shown as a label in user interface. true

Unique field identifier

name If . ) o | true
! Two fields can't have the same name in the same task definion. Name must be 1
I
i unique. i
[}
width The width of the HTML element. false
readonly  Set field, it will not be able to be modified in user interface. By default the value is " false". false

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN"
"http://www.openkm.com/dtd/workflow-forms-2.4.dtd">
<workflow-forms>
<workflow-form task="separator test'">
<input label="Input label" name="inputl" />
<separator label="Separator label" name="separator" />
<input label="Input label" name="input2" />
</workflow-form>
</workflow-forms>
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Workflow Suggestbox field

This is an implementation of the typical AJAX suggest box component:

Attribute Description Required

label The text shown as a label in user interface. true

Unique field identifier.

name H’ ‘I true
i Two fields can't have the same name in the same task definion. Name must i
i be unique. i
A J
Metadata table name.
table {r ) true
i Application can store values in a metadata table, that can be used in this i
| query. |
{ J
width The width of the HTML element. false
height The height of the HTML element. false
filterQuery A Hibernate query to filter the data. Use {0} to place the user input. true
valueQuery A Hibernate query to obtain the value of an identifier. Use {0} to place the identifier. true
filterMinLen The minimum chars in input to begin to filter results. true
dialogTitle The title of the HTML dialog. true
readonly Set field, it will not be able to be modified in user interface. By default the value is " false". false
Child elements:

e Validator. For more information see Workflow Validator element.
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Suggestbox values are defined in metadata tables.

o The application use two tables named OKM_DB_METADATA_TYPE AND OKM_DB_METADATA_VALUE that helps
storing selected options values used. That's very useful when you get a large number of values.

e In the table OKM_DB_METADATA_TYPE are stored metadata table definition ( table name, column name and column

type ).
o In the table OKM_DB_METADATA_VALUE are stored record values.

Create metadata table definition.

V The table will be called country, with two columns, country_id and country_name.
The country_id column is integer type and country_name is text type.
The country_id is set as column 0 with col00 value.

The country_name is set as column 1 with col01 value.

¢ Go to Administration > Database query.
e At the right bottom select jdbc from list.

o Paste the SQL in the box

E DELETE FROM OKM DB METADATA TYPE WHERE DMT TABLE='country'; ]
1 INSERT INTO OKM DB METADATA TYPE (DMT TABLE, DMT REAL COLUMN, DMT TYPE, DMT VIRTUAL (C
. INSERT INTO OKM DB METADATA TYPE (DMT TABLE, DMT REAL COLUMN, DMT TYPE, DMT VIRTUAL .C

e Click at the right bottom of the Execute button.
Insert metadata table values:

¢ Go to Administration > Database query.
o At the right bottom select jdbc from list.

o Paste the SQL in the box

E DELETE FROM OKM DB METADATA VALUE WHERE DMV TABLE='country';
1 INSERT INTO OKM DB METADATA VALUE (DMV_TABLE, DMV COL00O, DMV COL01) VALUES ('country,
. INSERT INTO OKM DB METADATA VALUE (DMV_TABLE, DMV COL00, DMV COL0O1) VALUES ('country'

e Click at the right bottom on the Execute button.

A The insert queries, depending on your database can not be matched, for example in Oracle:

INSERT INTO OKM_DB_METADATA TYPE (DMT_ID, DMT TABLE, DMT REAL _COLUMN, DMT TYPE,
DMT VIRTUAL_COLUMN) VALUES (HIBERNATE_SEQUENCE.NEXTVAL, 'country', 'col00", 'integer’,

s
I
1
1
1
1
1
1
1
1
1
1
1
1
1
1
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i ‘country_id"); i

Finally the XML definition:

o In optionsQuery the values that begins with character $ are identified as column names. See $country_id and
$country_name below.

e Can use normal SQL clausules like "lower", "like", "order by", etc.

1 <?xml version="1.0" encoding="UTF-8"?>

' <!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN"

] "http://www.openkm.com/dtd/workflow-forms-2.4.dtd">
i\ <workflow-forms>

E <workflow—-form task="suggestbox test">

i <suggestbox label="country" name="suggestbox" width="200px"

: table="country" dialogTitle="Choose country" filterMinLen="3"

E filterQuery="select $country id, $country name from DatabaseMetadataValue dmv wﬁe
! valueQuery="select gcountry id, $country name from DatabaseMetadataValue dmv wher

</workflow-form> i
</workflow-forms> i
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Workflow Text field

Print a text that can contain HTML tags.

Attribute Description Required

label The text shown as a label in user interface. true

Unique field identifier

name

i, Two fields can't have the same name in the same task definion. Name must be i frue
i unique. i
width The width of the HTML element. false
height The height of the HTML element. false
data When present, is an identifier used to load data. false
readonly  Set field, it will not be able to be modified in user interface. By default the value is " false". false

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN"
"http://www.openkm.com/dtd/workflow-forms-2.4.dtd">
<workflow-forms>
<workflow-form task="text test'>
<text label="text label" name="consulting text" width="200px" />
</workflow-form>
</workflow-forms>
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Workflow TextArea field

Print a text that can contain HTML tags.

Attribute Description Required

label The text shown as a label in user interface. true

Unique field identifier

name

i, Two fields can't have the same name in the same task definion. Name must be i frue

i unique. i
value Default value for the component. false
width The width of the HTML element. false
height The height of the HTML element. false
data When present, is an identifier used to load data. false
readonly  Set field, it will not be able to be modified in user interface. By default the value is " false". false
Child elements:

« Validator. For more information see: Workflow Validator element.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN"
"http://www.openkm.com/dtd/workflow-forms-2.4.dtd">
<workflow-forms>
<workflow—-form task="textarea test'">
<textarea label="textarea label" name="textarea" width="200px" />
</workflow-form>
</workflow-forms>
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Workflow Option element

The option element is only used in combination with Workflow Select field. The option value represents a list of distinct values

to select.
Attribute Description Required
label The text shown as label in the user interface. true
value Unique value identifier. true
( i
| A Two options can't have the same value. Value must be unique. !
| |
| )
selected ) - ) ) false
When present, it specifies that an option should be pre-selected when the form is rendered.
Parent :

e Select. For more information, Please see: Workflow Select field .

Basic select with selected option

o attribute selected=true, when present, it specifies that an option should be pre-selected when the page loads.

<?xml version="1.0" encoding="UTF-8"?>
<!DOCTYPE workflow-forms PUBLIC "-//OpenKM//DTD Workflow Forms 2.4//EN"
"http://www.openkm.com/dtd/workflow-forms-2.4.dtd">
<workflow-forms>
<workflow—-form task="textarea test'">
<select label="select label" name="test" type="simple'>
<option label="one" value="001" />
<option label="two" value="002" selected="true" />
<option label="three" value="003" />
</select>
</workflow-form>
</workflow-forms>
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Automation

Automation is a set of controls that perform actions based on a set of rules.

Preliminar concepts.

Each rule is composed of:

Field Description

Order Indicates the order of the evaluation.

P

A The rules with less

Name Rule description.

Events Available events:

e Document creation.
e Document update.

e Document move.

e Folder creation.

e Mail creation.

¢ Adds metadata group.
e Sets metadata group.
o Text extraction.

e Converts to PDF.

e Converts to SWF.

e User login.

¢ User logout.

At The evaluation time.

Available values:

e Pre.

e Post.
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Understanding stages on automation execution:

o
o
~
=)
(<)
=
=
=
~
o
x
a
s
=
(=]
=
N
2
a

V Pre indicate rule execution before an internal event is executed.

Post indicate rule execution after the internal event is executed.

i For example a rules based on "Document creation" event.
e On "pre" stage the rule is triggered when the document has not yet been created.
e On "post" stage the rules is triggered after the document has been created
Exclusive When enabled, indicates no order rules should be executed.
Active Enables or disables the rule.

Validators  List of validators. Each validator is a condition that must be complied.

i Validations are also ordered. It's a good practice to first set positions that will have more possibilitii

to comply.

A When empty, always comply.

Actions List of actions. An action is something that will be done with the node that caused the execution of the rule.

P

L4 .
1 Nodes types:

e Document
e Folder

e Mail

Example of an action, can be renaming a document immediately after creation.

Understanding Validators and Actions
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By default application comes with built in validators and actions:

e Built in Automation Validator plugins

¢ Built in Automation Action plugins

Also you can create your own plugins:

e Creating your own Automation Action

e Creating your own Automation Validation

Creating a rule

-

i Rules are composed of:

e General fields.

e Actions and validators definions.

A rule creation has two steps. First define the general fields, then the actions and validations definitions.

¢ On top right click on ) Create new rule.

Fill in the fields.

e Click on Create button. ( the application will return to the initial screen ).
e Clickon Definition icon.

¢ Add actions and validations according to convenience.

« Click on ) Add validation icon.

« Click on ) Add action icon.

o When finished, at the top left click on Automation rules button. ( the application will return to the initial screen ).

Editing a rule

Edit general parameters

e Click on & Edit rule.
¢ Modify the fields.

e Click on Edit button.
Edit action and validation definitions

e Clickon Definition icon.
e Modifiy actions and validations according to convenience.
¢ Validations

e Click on & Add validation icon.
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e Click on & Edit validation icon.

e Click on 'a:' Delete validation icon.
o Actions

« Click on ' Add action icon.

e Click on & Edit action icon.

e Click on 'a:' Delete action icon.

Deleting a rule

e Click on @ Delete rule.

e Click on Delete button.
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Built in Automation Validator plugins

Name

ContainsFolder

HasCategory

HasKeyword

HasPropertyGroup

HasPropertyGroupValue

NameContains

Apply

at

Post

Post

Post

Post

Post

Post

Parameters

Folder

name

Keyword

name

Metadata

group

name

Metadata

field name

Metadata

field value

Name

Description

Valid when the node path contains a folder name.

V The value of the parameter folder name is test.

Node with path /okm:root/folder1 triggered the

event..

the folder /okm:root/folder1/test exists ,then
the validation return is valid.

n The value of the parameter folder name is test.

Node with path /okm:root/folder1 triggered the
event..

A folder /okm:root/folder1/test
doesn't exist, then the validation return is not
valid.

Valid when the node path has a keyword with the same name

assigned.

Valid when the node path has a metadata group with the same

name assigned.

Valid when the node path has a metadata group field with the

same value assigned.

Valid when the node name contains the name value into.

-

Rest

Only

appl

to fo

App

to al

type

App

to al

type

App

to al

type

App

to al
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PathContains

Post

Path

The value of the parameter name is test.

Node with path
/okm:root/folder/sometest triggered the event.

Folder sometest contains the value test ,then the

validation return is valid.

The value of the parameter name is test.

Node with path /okm:root/folder/somefolder

triggered the event.

Folder somefolder does not contains the value
test ,then the validation return is not valid.

Valid when the node path starts with a path.

v

The value of the parameter path is
/okm:root/folder1.

Node with
path /okm:root/folder1/test/temporary triggered
the event.

/okm:root/folder1/test/temporary starts with
path /okm:root/folder1 ,then the validation
return is valid.

The value of the parameter path is
/okm:root/folder1.

Node with
path /okm:root/test/temporary triggered the
event.

/okm:root/test/temporary does not start with
path /okm:root/folder1 ,then the validation
return is not valid.

type.

App

to al

type
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Built in Automation Action plugins

Name AI; [;Iy Parameter
AddCategory Post Category
AddCategoryToWizard Post
AddDigitalSignatureToWizard  Post

Keyword
AddKeyword Post
name
Post
AddKeywordToWizard

AddPropertyGroupToWizard Post Metadata

group

name

Description

Adds a category to the node that triggered

the event.

Shows a category popup as part of the

process of uploading a new document.

A Only takes effect when an user
uploads a new document from

the user interface.

p——
TE———

Shows a digital signature popup as part of the

process of uploading a new document.

Adds a keyword to the node that triggered an

event.

Shows a keyword popup as part of the

process of uploading a new document.

A Only takes effect when an user
uploads a new document from

p——
TE———

user interface.

Shows a Metadata group popup as part of the

process of uploading a new document.

A Only takes effect when an user
uploads a new document from

TTTTTTTTTT Y

the user interface.

Restriction

Applicable

to all node

types.

Applicable
to

documents.

Applicable
to

documents.

Applicable

to all node

types.

Applicable
to

documents.

Applicable
to

documents.
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AddWorkflowToWizard

ExecuteScripting

GrantRole

GrantUser

OMRDataCapture

PurgeNode

RevokeAllRoles

Post

Pre

Post

Post

Post

Post

Post

Post

Workflow

name

Code

Role name

Permission

User name

Permission

Starts a workflow as part of the process of

uploading a new document.

A A popup will be shown if a
workflow requires an user to
sets parameters for starting the
workflow. Otherwise, it will be
transparent to the end user.

Only takes effect when an user
uploads a new document from

user interface.

Executes an script.

Grants a role permission the node that

triggered the event.

Grants a user permission the node that

triggered the event.

Captures data from document.

Purge a node. The node is removed from

repository.

Revokes all roles granted to the node that

triggered the event.

Applicable
to

documents.

Applicable

to all node

types.

Applicable

to all node

types.

Applicable

to all node

types.

Applicable
to OMR

valid files.

Applicable

to all node

types.

Applicable

to all node
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RevokeAllUsers

RemoveCategory

RemoveKeyword

RevokeRole

RevokeUser

Post

Post

Post

Post

Post

Category

Keyword

name

Role name

User name

Revoke all user granted to the node that

triggered the event.

Removes the category from the node that

triggered the event.

Remove the keyword from the node that

triggered the event.

Revokes the role granted to the node that

triggered the event.

Revokes the user granted to the node that

triggered the event.

types.

Applicable

to all node

types.

Applicable

to all node

types.

Applicable

to all node

types.

Applicable

to all node

types.

Applicable

to all node

types.
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Enable Automation validations

Almost databases

¢ Go to Administration > Database query

e Choose type JDBC.

e Paste the SQL

INSERT INTO
INSERT INTO
INSERT INTO
INSERT INTO
INSERT INTO
INSERT INTO
INSERT INTO
INSERT INTO
INSERT INTO
INSERT INTO

OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA

AMD CLASS NAME, AMD NAME, AMD GROUP, AMD TYPEO
AMD CLASS NAME, AMD NAME, AMD GROUP, AMD TYPEO
AMD CLASS NAME, AMD NAME, AMD GROUP, AMD TYPEQ
AMD CLASS NAME, AMD NAME, AMD GROUP, AMD TYPEQ
AMD CLASS NAME, AMD NAME, AMD GROUP, AMD TYPEO
AMD CLASS NAME, AMD NAME, AMD GROUP, AMD TYPEQ
AMD CLASS NAME, AMD NAME, AMD GROUP, AMD TYPEQ
AMD CLASS NAME, AMD NAME, AMD GROUP, AMD TYPEO
AMD CLASS NAME, AMD NAME, AMD GROUP, AMD TYPEO
AMD CLASS NAME, AMD NAME, AMD GROUP, AMD TYPE(

e Click on

Oracle

Execute button.

¢ Go to Administration > Database query

e Choose type JDBC.

e Paste the SQL

i INSERT INTO
! INSERT INTO
\ INSERT INTO
i INSERT INTO
' INSERT INTO
! INSERT INTO
i INSERT INTO
i INSERT INTO
! INSERT INTO

OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA

AMD CLASS NAME, AMD NAME,
AMD CLASS NAME, AMD NAME,
AMD CLASS NAME, AMD NAME,
AMD CLASS NAME, AMD NAME,
AMD CLASS NAME, AMD NAME,
AMD CLASS NAME, AMD NAME,
AMD CLASS NAME, AMD NAME,
AMD CLASS NAME, AMD NAME,
AMD CLASS NAME, AMD NAME,

AMD GROUP, ‘A
AMD GROUP, ‘A
AMD GROUP, ‘A
AMD GROUP, ‘A
AMD GROUP, ‘A
AMD GROUP, A
AMD GROUP, ‘A
AMD GROUP, 1A
AMD GROUP, ‘A

e Click on

PostrgreSQL

Execute button.

¢ Go to Administration > Database query

¢ Choose type JDBC.

e Paste the SQL

INSERT INTO
INSERT INTO
INSERT INTO

OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA

AMD AT,
AMD AT,
AMD AT,

AMD CLASS NAME, AMD NAME,
AMD CLASS NAME, AMD NAME,
AMD CLASS NAME, AMD NAME,

AMD GROUP, ‘A
AMD GROUP, A
AMD_GROUP, A
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\ INSERT INTO
i INSERT INTO
' INSERT INTO
! INSERT INTO
| INSERT INTO
i INSERT INTO

e Click on

OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA
OKM AUTO METADATA

Execute button.

AMD CLASS NAME,
AMD CLASS NAME,
AMD CLASS NAME,
AMD CLASS NAME,
AMD CLASS NAME,
AMD CLASS NAME,

AMD GROUP,
AMD_GROUP,
AMD_GROUP,
AMD_GROUP,
AMD_GROUP,
AMD_GROUP,
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Enable Automation actions

Almost databases

¢ Go to Administration > Database query
e Choose type JDBC.

e Paste the SQL

INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM AUTO METADATA (AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,

e Click on Execute button.

Oracle

¢ Go to Administration > Database query
e Choose type JDBC.

e Paste the SQL

INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, ‘A
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A,
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, ‘A
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, 'A
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A,
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, 'A
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A

AMD TYPHO
AMD TYPEQ
AMD TYPEQ
AMD TYPEO
AMD_TYPEO
AMD TYPEQ
AMD TYPEQ
AMD _TYPHO
AMD TYPEQ
AMD TYPEQ
AMD TYPEO
AMD TYPEO
AMD TYPEQ
AMD TYPEQ
AMD_TYPEO
AMD TYPEQ
AMD TYPEQ
AMD TYPEQ
AMD TYPEO
AMD TYPEQ

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE Page 470 of 1191

INSERT INTO OKM _AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, 'A
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A

e Click on Execute button.

PostgreSQL

¢ Go to Administration > Database query
e Choose type JDBC.

e Paste the SQL

INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM_AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, ‘A
INSERT INTO OKM_AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM_AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, ‘A
INSERT INTO OKM_AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, ‘A
INSERT INTO OKM_AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM_AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM_AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, ‘A
INSERT INTO OKM_AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP,
INSERT INTO OKM_AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM_AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM_AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, ‘A
INSERT INTO OKM_AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, ‘A
INSERT INTO OKM_AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM_AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, ‘A
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM_AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM_AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, A
INSERT INTO OKM AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, ‘A
INSERT INTO OKM_AUTO METADATA (AMD ID, AMD AT, AMD CLASS NAME, AMD NAME, AMD GROUP, ‘A

e Click on Execute button.
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Crontab

The application implements a time-based job scheduler named Crontab. In crontab view there are a set a jobs that are

executed periodically at fixed times or intervals.

V Typically automated application maintenance or administration are crontab jobs.

TTTTTTTY

Crontab is shown in a table structure.

g
S
(4
=
$
g
=,
(=)
~
5
(4
=l
P—
(1)
~
Q
S
(4
S
g,
B~
g8
3
S
S
h
Q
a
(1)
-
{=%
>
o
=%
3

Crontab parameters
Field Description Required
Name Job name. true

Sets when the job is executed.

. |
I
| A Takes in consideration the status of the application when the task will be i

Expression i executed. i true
I I
I I
I
i For example, if you stop the application at 00:00 to perform a backup, it i

I
i delays the task until you consider the backup process will be completed. 1
\ ]
Supported MIME types:
e application/x-bsh ( BeanShell ).
e application/x-java-archive ( JAR file ).

Mime ¢ \ true
i i The application supports tasks written in beanshell or classes into JAR file. i
| ]
| ]
i We recommend using JAR files instead of beanshell. i
| ]
| ]
i More information at: Creating your own Crontab job. i
u 7

When present, a mail is sent as part of the task once the execution has been completed. You
Mail false

can use several mail addresses using a comma "," as separator.
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Last begin Shows the last time a process started. -
Last end Shows the last time a process was completed. -
Active Enables or disables the process execution. true

Understanading expresion syntax

The commands are executed by cron when the minute, hour, and month fields match the current time, and when at least one of
the two day fields (day of month, or day of week) match the current time. The scheduler examines crontab entries once every

minute. The time and date fields are:

* * command to execute
77 377 é‘// é‘ll

7 7

*
a a
é a\//, é”, é”,
v, a~, av, av, avvareid €ad”€4a”€ day of week (0 - 6) (0 to 6 are Sunday to Saturday,
a a7, avv7arearearearearede€ad7€ad”€a”€ month (1 - 12)

a a7VATEGTELTELTELELTELTELTELEA"ELE€47€47€47€ day of month (1 - 31)

, Q77ATEATEGTELTEGTEATELTELVESTELELTELVELTELAELELEL"E€L7E4A”€E€ hour (0 - 23) .

NN IO AN R e TEENES ELNEAESTCENESELNELESNCEESNELSNEZESNEAELATE min (0 i—

Field Values
minute 0-59
hour 0-23

day of month  1-31

month 1-12

Other expressions:

Expression  Equivalent Description

@yearly oo11* Runs once a year at midnight of January 1.

@annually 0011* Same as @yearly.

@monthly 001** Runs once a month at midnight of the first day of the month.
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@weekly 00%%*0 Runs once a week at midnight on Sunday morning.
@daily 00*** Runs once a day at midnight.

@midnight 00 *** Same as daily.

@hourly 0 & Runs once an hour at the beginning of the hour.

A field may be an asterisk (*), which always stands for first-last.

Ranges of numbers are allowed. Ranges are two numbers separated with a hyphen. The specified range is inclusive. For

example, "8-11" for an hours entry specifies execution at hours 8, 9, 10 and 11.
Lists are allowed. A list is a set of numbers (or ranges) separated by commas. Examples: "1,2,5,9", "0-4,8-12".

Step values can be used in conjunction with ranges. Following a range with "/<number>" specifies skips of the number's value
through the range. For example, "0-23/2" can be used in the hours field to specify command execution every other hour. Steps

are also permitted after an asterisk, so if you want to say "every two hours", just use "*/2".

Names can also be used for the month and day of week fields. Use the first three letters of the particular day or month (case

doesn't matter). Ranges or lists of names are not allowed.

Create a new crontab job

¢ On top right click 2 New crontab job icon.
o Fill the fields.

e Click on Create button.

Edit a crontab job

¢ Click on & Edit crontab job icon.
¢ Modify the fields.

e Click on Edit button.

Execute a crontab job

e Click on Execute crontab job icon.

Download a crontab job
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« Click on * Download crontab job icon.

o After some second will be retrieved the file.

Delete a crontab job

e Click on @ Delete crontab job icon.

e Click on Delete button.
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Built in crontab tasks

Task De.f ault Execution Description
time

Dashboard Activity )

@daily At 00:00. Clean older than one month activity log entries.

Purge

User Items Serialize @hourly Each hour.

Refresh the total repository size assigned to a single
user.

Refresh User Items @weekly Each sunday. r i
1
i i Each user is owner of some repository i
| size. !
| J

Each 30
User Mail Importer */30 * *k ok *x Import mails from registered user mail accounts.
minutes.
Process text extraction queue.

Text Extractor Worker R Each 5 minutes. [ |
| i For more information Statistics. |
| )

Session Watchdog H/G Kk ok k Each 5 minutes. Kill orphan sessions.

Execute pending task.

Process Pending Tasks RE Each 5 minutes. { - ; ; o
| 1 For more information Statistics.
1
1
|
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OMR templates

Application integrates OMR - Optical Mark Recognition - that has been written by Aaditeshwar Seth from the Udai Waterloo

chapter, at the University of Waterloo. Udai is a volunteer student organization at the University of Waterloo in Canada and

the University of California at San Diego. For more information about it see OMRProj website.

OMR ( Optical Mark Recognition ) engines is especially suited for extracting data from forms that have been photo-copied and

then scanned; hence, the resultant images are likely to suffer from rotations, smudge marks, and random lines here and there.

Examples of a few forms that the tool is able to handle with 100% accuracy are shown here.
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Yes - ;
| Mo Q000
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L L1 o®00 } O O 08 doop
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Add a new OMR template
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Get a full example Omr_example.zip

Preliminars

e First make a form in PowerPoint using the template Omr_patterns.zip. Make sure that you do not move the two
concentric circles in the top-left and bottom-right corners of the template. These are used by the software to determine
the angle of rotation of the form.

e Take a printout and make as many photocopies of the form as you want.

e On the original printout, color all the marks with a black pen, and scan this marked up printout. Please be as careful as
you can to align the printout so that there is no rotation. Some amount of error is fine, but not too much! This scanned

image will be the template.

o

Sabationg Propety S Al gl Dx Salectisne Tips da Documenio
@ Alarmas Calle Larga ®zoi2 @ Actas
@ Alarmas Rinconada @iy @ Boleta de Compra
@ Alcantarillados Rinconada | W2o04 @ Boleta de Hongrario
@ Mina Caracoles @5 @ Boleta de Venta
@ Colegio Metodista Pomb @ Comprobante de Compra
B Obras Adiclonales MO -EL'H'.'.' .Cmnpm]mrlt:dc\fmh
BVilla Las Rosas @ Contratos de Trabajo

@ Contratos de Venta

& Documentaciin de Contabilidad
@ Documentaciin de Propuesta

@ Documentacitn Legal

@ Factura de Compra

@ Factura de Venta

@ Manuales

@ Oicios

W Oros Documentos
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Create a new template

On top right click on @ Create new template icon.

Choose the template image produced in preliminar step.

Choose the metadata fields.

i More information about register Metadata.

TTTTTTTY

e Click on Send button.

Ll
it
T
(=]
it
T
it

Omr template

Template name Test template
Template /homefjllort/Escritorio/OMF| Examinar...
Property Select properties -
okp:data.year
ckp: data.type
okp: data.project
Active (=)

Cancel

Sel

V The application will generate two training files ( .asc and .config ) based on template file name:

e template_file_name.asc

o template_file_name.config

Name Template Asc Config
Test template template.png template.png.asc template.png.config

Fields = Active
ndl

Update asc training files

Download the tranining .asc file and openkm with a standard text editor. This is actually an ascii representation of the template

with all the marks marked with a '0', as shown below.
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Some of the marks may not be exactly aligned, but don't worry. Now, very carefully, label the marks with single characters, by
setting all the marks in the same group with the same character. This is shown below. In case you run out of alphabets, you can
use numerals or any other character such as - + ? . etc. Make sure that you do not alter the position of any mark! This is

agreably hard to do, but we chose this method to avoid the need for making a graphical frontend.

e 1
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T G L e e i—
o e e e e o e e e e e e o o o o o e o e o o e o o e o o e o o o e o o e e o o S e o e e e e e e —
T e e Brmmmemmmmmmmmmm] i~
) Se—@oosesmrrssssrorsssmmesssmmesssmes L e e e e G e —
- e e C————————————— -
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e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e e D e e e e D D D e D G s BB L Lt i—
O D O O D 3 I G e S LB L -
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: —————————————————————————————————————————————————————————————————— (CEEE S tSS e —:—
I e e e e e e e e e e e e e e o —— —— —— —— — — —— e —— —— —— —— —— —— —— —— — —— —— —— —— —— —— —————————————————— ——— R
e e e e e e e e e e e e e e e e e e e e e e e e e o e e e e e e e e e e e e e o D e e e e D D D e e D e e e e B e i—
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e Click on & Edit template icon.
e Click on & Edit ".asc" training file icon.
¢ Chose the training .asc file.

e Click on Send button.

Omr template Edit omr template
Template name Test template
Template template.png
| | Examinar...
Property Select properties - |
okp:data.year IE:)
ockp:data.type IE:!I
okp: data. project (%}
Asc template. png.asc éﬁ’
Config template. png.config
Fields Upload new file &
Active (1
Cancel Send

Update .fields training files

You now need to make a [template-filename].fields file, which contains the details of the various form-fields, as follows.
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The format of each line is: character type subtype name valuel value?2....

Field Description

Character  Thjs is the same as the character you used in the .asc file

The types of fields supported are single and multiple choice lists, aligned row-wise (horizontally) or column-

wise (vertically). And grids aligned horizontally or vertically. Each field is denoted by (i) row single or row

Type and
Sub multiple for a single or multiple selection field aligned row-wise, (ii) column single or column multiple for a
ubtype

single or mutiple selection field aligned column-wise, or (iii) grid row or grid column for a grid field aligned
row-wise or column-wise respectively.

Field
This can be any name you want to associate with the field.

name
These are the field values, in order.

Values {’ )
i The values has a direct corresponde with metadata field values, first indicate the field name i
i and others the values into i

Example:

a column single okp:data.project alarmasCalleLarga alarmasRinconada alcantarilladosR:i.
' b column single okp:data.year 2012 2013 2014 2015 2016 2017 d
\ ¢ column single okp:data.type actas boletaCompra boletaHonorario boletaVenta comprob.a.

e Click on & Edit template icon.
e Click on & Edit fields training file icon.
¢ Chose the training .fields file.

e Click on Send button.
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Omr template Edit omr template

Template name

Template

Property

Asc

Config
Fields

Active

|Test template

template.png

| Select properties |
okp:data.year

okp:data.type
okp: data.project

template.png.asc (v)
template. png.config

Upload new file ﬁ

Examinar...

000

Cancel || Send |

Check the template

e Click on @ Check icon.

¢ Choose some file to upload ( will be used to capture data).

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE

Page 484 of 1191

@ Alormas Calle Larga

@ Alarmas Rinconada

@ Alcantarillados Rinconada
@ Mina Caracoles

® Colegio Metodista

@ Obras Adiclonales MC
@Villa Las Rosas

@ Actas

@ Boleta de Compra

@ Boleta de Hongrario

@ Boleta de Venta

@ Comprobante de Compra

@ Comprobante de Venta

@ Contratos de Trabajo

@ Contratos de Venta

& Documentaciin de Contabilidad
@ Documentaciin de Propuesta
@ Documentacitn Legal

@ Factura de Compra

@ Factura de Venta

@ Manuales

@ Oicios

@ 0tros Documentos

And you'll get the results:

O

Omr template

Process Template Check

UﬂlDﬂd FDHTI | Ea:,al-nil-l,arl_L
| Cancel || Send |
RESULTS
Key Value
okp:data.year 2014
okp:data.type documentacionPropuesta
okp:data.project minaCaracoles
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Thesaurus

The thesaurus feature helps the administrator to create the thesaurus folder structure. By default the thesaurus folder structure

is not created.

i The application needs a configured parameter to create thesaurus folders, check Thesaurus configuration.

T T T Y

Take a look a the full configuration example at Creating your own thesaurus.

.4

Build thesaurus

e Choose the level ( the level indicates the tree depth that will be shown during creation process ).

e On top right click on Generate button.

A log will be displayed on the screen to monitor thesaurus folder creation. This process could take some hours

depending on your thesaurus size.

TTTT T T T Y
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Languages

The application can work with several languages, here are set the languages terms definitions.

Languages are shown in a table structure.

_________________________________________________________________________________________________________

The "en-GB" translation is used by application as default translation.

,

i Sometimes translations are not fully completed and some terms are missing. The "en-GB" is used to identify
which are the missing terms and how many are.

When a term is missing in other language the "en-GB" term is used in its place.

n en-GB translation can not be removed.

Create a new language

e Click on '*'3' new language icon.

o Fill the fields
e The id must be compliant with ISO 639 ( 2 levels ).
o Language name
e The icon should be 16x11 px

e Click on Create button.

i More information about ISO 639.

TTTTTTTY

Edit a language

e Click on 6/) Edit language icon.
* Change the fields.

e Click on Edit button.

Delete a language

e Click on @ Delete language icon.
o Change the fields.

e Click on Delete button.
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Edit language translations

V On the right top the translation can be filtered by key.

TTTTTTTY

-l.
e Click on \i1 Edit language translation icon.

Languages translations are shown in a table structure.

3
<9
S
P—
&
8
3
<
8
3
<
&=
=
Q
=
1%
=
g
=
17
P—
S
=
S
=

e frontend ('used on frontend )
e mobile ('used on mobile view )

e extension (used on frontend by extension modules )

Two key property can not be equals.

V By default are tree modules that indicate where translations are used:

¢ Change the fields.

e Click on Edit button.

Export a language translations

¢ Click on 'E* Export language translations icon.

¢ The application retrieve a SQL file with language translation into.

Import a language translations

V Download your language package from Language translations.

TTTTTTTY

¢ On right bottom choose a Language package file.

e Click on Add new translation button.
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Language translations

Language

Arabic

Azeri

Belgian/Flemish

Bosnian

Bulgarian

Catala

Chinese simple

Chinese traditional

Czech

Danish

Deutsch

Deutsch - Austria

Dutch

English

English - USA

File

OpenKM_6.3_ar-SD.sql

OpenKM_6.3_az-AZ.sql

OpenKM_6.3_nl-BE.sql

OpenKM_6.3_bs-BS.sql

OpenKM_6.3_bg-BG.sql

OpenKM_6.3_ca-ES.sql

OpenKM_6.3_zh-CN.sql

OpenKM_6.3_zh-TW.sql

OpenKM_6.3_cs-CZ.sql

OpenKM_6.3_dk-DK.sql

OpenKM_6.3_de-DE.sql

OpenKM_6.3_de-AT.sql

OpenKM_6.3_nl-NL.sql

OpenKM_6.3_en-GB.sql

OpenKM_6.3_en-US.sql

Number of terms

653

1563

824

505

830

1169

1181

1184

1107

802

1536

823

1227

1605

506
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Espaiiol

Espaiiol Colombia

Euskera

Farsi

French

Gallego

Greece

Hungarian

Indonesian

Italian

Japanese

Korean

Latvian

Lithuanian

Macedonian

Norwegian

OpenKM_6.3_es-ES.sql

OpenKM_6.3_co-ES.sql

OpenKM_6.3_eu-ES.sql

OpenKM_6.3_fa-FA.sql

OpenKM_6.3_fr-FR.sql

OpenKM_6.3_gl-ES.sql

OpenKM_6.3_el-GR.sql

OpenKM_6.3_hu-HU.sql

OpenKM_6.3_id-ID.sql

OpenKM_6.3_it-IT.sql

OpenKM_6.3_jp-JP.sql

OpenKM_6.3_ko-KR.sql

OpenKM_6.3_Iv-LV.sql

OpenKM_6.3_It-LT.sql

OpenKM_6.3_mk-MK.sql

OpenKM_6.3_nb-NO.sql

1605

505

1563

505

1535

505

1172

506

506

1184

802

1675

506

506

506

1175
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Polish

Portugueés do Brasil

Romanian

Russian

Serbian

Slovak

Suomi

Swedish

Thai

Turkish

Vietnamese

OpenKM_6.3_pl-PL.sql

OpenKM_6.3_pt-BR.sql

OpenKM_6.3_ro-RO.sql

OpenKM_6.3_ru-RU.sql

OpenKM_6.3_sr-SR.sql

OpenKM_6.3_sk-SK.sql

OpenKM_6.3_fi-FLsql

OpenKM_6.3_sv-SE.sql

OpenKM_6.3_th-TH.sql

OpenKM_6.3_tr-TR.sql

OpenKM_6.3_zh-VN.sql

1229

1328

506

1250

853

1184

1060

506

506

1213

1135
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How to create a new translation

A Before starting with a new translation, please check if is available in Language translations section.

TTTT T TN

A sample of new language base on Oromo from Ethiopia

The first step is identifying what is your language code based on ISO 639 ( 2 level ). Looking at the table of language
identifiers, the code might be "om-ET".

The second step will get the country flag, in this case, Ethiopia. Go to famfamfam.com website and download the flags icons.

The flags icon name are based ISO 369 ( one level ), that means we are looking for a file named "et.gif".

The third step will be to create the new language. Go to Administration > Languages and create a new language with these

values:

« Click on @ new language icon.
o Fill the fields
o The "id" might be "om-ET".
e The "name" might be "Oromo".
o The "icon" might be the file named "et.gif".

e Click on Create button.
Once the new language has been created must set the translations:

e Click on & Edit language icon.
¢ Change the fields.

e Clic,k on Edit button.
Finally, think on sharing with the community your translation.

e Click on 'E* Export language translations icon.
 The application retrieves a SQL file with language translation into.

 Contact us at the contact website form and we will tell you the way for sharing with us the translation.
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Repository import

The repository importer helps administrator to import data from the file system.

V Initial import ( import standard folders and documents from your openkm server ).

Import from previous openkm export.

Field Description

Filesystem
Server import path.
path

Repository  The repository destination path.

path
Common values:
e /okm:root
o /okm:templates
o /okm:personal
o /okm:mail
Metadata When enabled, the importer assumes the metadata information ( .okm files ) are present.
History When enabled, the importer assumes all document versions of the document are present.
More information about document versions format at Repository export.
Restore When enabled, the importer will keep the same node UUID.
UUIDs

1 When applicationis integrated with thirdparty software, usually the thirdparty software
stores in their own database UUID of the node as main reference. This references should not

———————————\

be lost, that's why on these scenarios are needed to keep out the UUID's.

Specially when importing from previous openkm, export must take in consideration that you must use the

same import options that had been chosen while exporting, otherwise the import will fails.

.
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Import

e Set the file system path.
e Set the repository path.
o Check the repository import options.

e Click on Import button.
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Repository export

The repository export feature helps the administrator to export the whole or part of the OpenKM repository to the file system.

The output result will be the same folders and files structure that are set into the application.

Field Description

Repository path The repository path to export.
Common values:

e /okm:root
o /okm:templates
o /okm:personal

o /Jokm:mail

Filesystem path Server destination path.

Linux example:

/mnt/export

Windows example:

c:/export

Metadata When enabled, metadata values are exported.
History When enabled, all documents versions are exported.
EXxport

e Set the repository path.
e Check the repository export options.

e Click on Export button.

Understanding output format

Case metadata and history are not checked

The result will be a folder structure with documents and mails into. Although a document has several versions only will be
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exported the actual version.
Case only metadata is checked

The result will be a folder structure with documents and mails into. Although a document has several versions only will be

exported the actual version.

For each folder, document or mail will be created an .okm file. For example for a file named "Administration.html" will be
created in the same path a file named "Administration.html.okm". The .okm files contains into all the metadata information

associated to the node in a JSON format.

Example of .okm file:

{"uuid":"8299d059-7894-468b-ba48-3f3b59%9ebc37c",
"author":"okmAdmin",
"name":"redacted 481.pdf",
"path":"/okm:root/redacted 481.pdf",
"created":{"year'":2015,

"month":6,
"dayOfMonth":1,
"hourOfDay":17,
"minute'":18,
"second":0},
"lastModified":{"year":2015,
"month'":6,
"dayOfMonth":2,
"hourOfDay":10,
"minute":47,
"second'":39},
"language":"en",
"keywords":[],
"categories":[],
"subscriptors":[],
"notes": [{"user":"system",
"date'":{"year":2015,
"month":6,
"dayOfMonth":2,
"hourOfDay":10,
"minute":47,
"second":40},
"text":'"New version 1.1 by okmAdmin: Signed”,
"oath":"7d11d393-df46-49al-8f29-ae6d0ea4al093"}],
"oropertyGroups":[],
"version":{"author":"okmAdmin",
"name": "l . l "/
"created":{"year'":2015,

"month":6,

"dayOfMonth":2,

"hourOfDay":10,

"minute":47,

"second":39},
"size'":139215,
"mimeType":"application/pdf",
"comment":"Signed"},

"grantedUsers":{"okmAdmin":15},
"grantedRoles":{"ROLE USER":15}
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Take in consideration that the JSON output format can change if the main objects ( folder, document, mail or
record ) are added, removed or modified fields.

TTTT T T T

Case only history is checked

The result will be a folder structure with documents and mails. All document versions will be saved.

Example of output for a document with version 1.0 and 1.1:

o Administration.html ( size = 0 bytes )
o Administration.html#v1.0# ( contents of version 1.0 )

o Administration.html#v1.1# ( contents of version 1.1 )

Case metadata and history are checked

The result will be a folder structure with documents and mails. All document versions will be saved.

For each folder, document or mail will be created a .okm file. For example for a file named "Administration.html" will be
created in the same path a file named "Administration.html.okm". The .okm file contains all the metadata

information associated to the node in a JSON format.

Example of output for a document with version 1.0 and 1.1:

o Administration.html ( size = 0 bytes )

o Administration.html.okm ( metadata associated to the document )

o Administration.html#v1.0# ( contents of version 1.0 )

o Administration.html#v1.0#.okm ( metadata associated to version 1.0 )
o Administration.html#v1.1# ( contents of version 1.1 )

o Administration.html#v1.1#.0okm ( metadata associated to version 1.1 )
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The utilities section at Administration is a collection of useful features designed to be used by IT staff.

To take advantage of most of these feature some technical skills are needed .

These features can be categorized as:

Category

Security

Performace

Low level access

Check specific configuration

Search engine

Others

Experimental features

Description

e Purge permissions

e Cache stats

e Hibernate stats

¢ Profiling stats

* Repository view

e Check email

o Check text extraction

o System properties

o List indexes

e Rebuild indexes

® Repository checker
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Cache stats

OpenKM takes advantage of cached objects for fast retrieving data.

o

For example the users and roles list, when application is configured to working with LDAP, are cached to reduce
the traffic between application and LDAP server.

The associated cached name for LDAP are:

e com.openkm.cache.ldapPrincipalAdapter.general

e com.openkm.cache.ldapPrincipalAdapter.name

Also cache can be used to collect data useful to find out configuration parameters changes needed for better application

perfomance. For this purpose the application comes with a cache audit trail.

Cache stats are shown in a table structure:

Cache name|| | Hits| | Misses|| [Objects| Memory hits| |Memory objects| | Disc hists| |Disc missed| |\Disc objects| |Action

Field Description Audit trail required
Cache name Unique class name of the cached class. Not applicable.
Hits Number of successful queries. true
Misses Number of failed queries. true
Objects Number of cached objects. false
Memory hits Number of successful queries in cache memory. true
Memory missed  Number of failed queries in cache memory. true
Memory objects  Number of objects in cache memory. false
Disc hits Number of successful queries in cache disk. true
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Disc missed Number of failed queries in cache disk. true
Disc objects Number of objects in cache disk. false
Action Clean cached objects. Not applicable.

Clean all cache

e On the right top click on @ Reset all button.

Refresh cache stats

¢ On the top right click on > Refresh icon.

Enable cache stats audit trail
e On the top right click on =" Enable cache audit trial button.
Enables the fields stats:

e Hits.

e Misses.

e Memory Hits.

e Memory missed.
e Memory objects.
e Disc hits.

e Disc missed.

Disable cache stats audit trail
e On top right click on & Disable cache audit trial button.
Disable the fields stats:

e Hits.

e Misses.

e Memory Hits.

e Memory missed.
e Memory objects.

e Disc hits.
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e Disc missed.

Clean cache stats audit trail
¢ On top right click on @ Clear cache audit trial button.
Reset to zero the value of the fields stats:

o Hits.

o Misses.

e Memory Hits.

e Memory missed.
e Memory objects.
e Disc hits.

e Disc missed.
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Check email

The check email feature helps the administrator to check the application mail configuration.

Check email

o Fill the fields
e From
e To
o Subject
o Content

e Click on Check button

If the application mail configuration application is correctly set it will return an "OK" otherwise will be shown

the cause of the error.

TTTT T T T Y
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Check text extraction

This feature helps the administrator to check the text extraction process.
It can check the extraction process based on:

e Document to be processed

¢ Document UUID ( see tab properties when document is selected on general application user interface ).

¢ Document path.

¢ Document outside application ( choose a document from file system to be uploaded).

Check text extraction

e Choose a document to be processed

e OpenKM document:
o Fill field document UUID or document path.

e External document:

¢ Choose a document from file system to be uploaded.

e Click on Check button.

V After the process is completed it will show the text extracted by the selected text extractor.

The text extraction process can take some seconds or minutes depending on the size of the document to be

processed and the file MIME type.
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Hibernate stats

With the Hibernate stats feature the administrator can take control of value information about database queries, finding out

performance problems and the possible causes.

i By default Hibernate stats feature is disabled because the log analysis consumes hardware resources.

This feature should only be enabled by administrator in order to investigate possible performance problems with
application.

A Each time the application is restarted all the previous analysis is removed. It's important that wh he or she n the

administrator enables this feature, takes in consideration that the application should not be stopped.

Information provided by Hibernate stats
Information provided by Hibernate stats are shown in several tables:

e General data.

o Query statistics.

o Entity statistics.

e Collection statistics.

e 2nd level cache statistics.

- . . e .
1 Time columns are finished with dur. name:

e Max dur ( Maximum duration ).
e Min dur ( MInimum duration ).
o Avr dur (Average duration ).

e Total dur ( Accumulated total time ).

Columns with time values are in miliseconds.

V When the application presents some performance problem, in most cases it will be caused by some query that
need a huge time to complete its execution.

On Query statistics are shown, all the database queries executed by application, the most important column value
is Max dur. which indicates the Maximum duration of the query.

Enable Hibernate stats

i This option is only available when Hibernate stats is stopped.

TTTTTTTY
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e Onright top click on? = Enable button.
Clear Hibernate stats

¢ On right top click on?@ Clear button.

Disable Hibernate stats

i This option is only available when Hibernate stats is running.

TTTTTTTY

e On right top click on? = Disable button.
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List indexes

The List index feature helps the administrator to take control about how the objects ( documents, folders, mails and records )

are indexed into Lucene search engine.
At the main screen is shown a table with the Lucene indexed fields of each object.

Common indexed fields:

Field Description

# Number

_hibernate_class The hibernate class name:

e com.openkm.dao.bean.NodeFolder
e com.openkm.dao.bean.NodeDocument

e com.openkm.dao.bean.NodeMail

uuid Object unique identifier.
parent Parent node.
context Context values:

e okm_root

e okm_metadata
e okm_categories

e okm_thesaurus

okm_templates
e okm_personal
e okm_mail

e okm_personal

okm_trash

tenant Tenant identifier.
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author

created

name

userPermission

rolePermission

Id of the user author.

Indicate when object was created.

Object name.

User permissions.

Role permissions.

A Depending the type of object ( _hibernate_class ) can be more indexed fields.

E——

Search indexes

e On top right click on — Search indexes button.

e In input box copy some object UUID ( from desktop view, you can get at Properties tab any object UUID, select the

UUID and press CTRL+C to copy ).

e Click on Search button.

e From the table list click on ._] List icon.

V The filtering input box use the sintaxis FIELD : value , here some examples:

e uuid:ce3338a5-b1ec-481b-9d59-f5aeb3fcf42b
e name:invoice.*

o text:telephone

Let's see an example. Imagine you have two documents called "Parana.doc" and "Parana.pdf". You can locate them by this

search:

name:paran*

But be careful because using quotation marks you won't get any result:

name: "paran*"

If you want to locate all PDF documents which name starts with "Paran", the right query is:
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name:paran*pdf

This query would also work (note the dot before que extension):

name:paran*.pdf

But this query will failt because you cannot use a * or ? symbol as the first character of a search. This is a Lucene limitation.

name:*pdf

If you want to lookup documents with a given extension, I would recommend using the MIME Type property this way:

mimeType:application/pdf

In this query we are looking for all documents which name starts with "parana"” and has a keyword called "dog":

name:parana* AND keyword:song

You can learn more about query syntaxt at Lucene Query Syntax.

Enable show terms

When show terms enabled, is shown and extra fields named terms on documents objects with the terms used by Lucene search

engine for indexing that document.

e On top right clickon = Show terms button.

Disable show terms

¢ On top right clickon = Show terms button.
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LogCat

The LogCat feature helps administrator to accessing Tomcat log files directly from application.

Logs are shown is a table structure:

=
P—
(3
>
Q
=7
=}
S

V The main Tomcat log file is named catalina.log.

This file rotate each day at night creating a new catalina.log file and saving older with name catalina.log.year-

—_————— e —

month-day

Purge all logs
The purge option will clean all Tomcat logs.

¢ On top right click on @ Purge button.

Download file as ZIP

¢ Choose a log file.

e Click on L‘ﬂ, download as ZIP icon.

Browser log file

e Choose a log file.
e Click on — browse icon.

e Use filter options.
Filter options:
Option Description

Begin . N
Indicate the row position.

1 By default 0 indicate the starting of the document.

,_______
—

End ) .
Indicate the row position.

; 3
| By default -1 indicate the end of the document. i

R —
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| S

String Filter by some text.
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Profiling stats

The Profiling stats feature gives low level value information to the administrator to find out application performance problems.

,

i By default the Profiling stats feature is disabled because the log analysis consumes hardware resources.

This feature should only be enabled by the administrator in order to investigate possible performance problems

with application.

A Each time the application is restarted all the previous analysis are removed. It's important when administrator

enable this feature take into consideration that the application should not be stopped.

Profiling stats are shown is a table structure:

2
a
3
s
3
2,
S
&
3
2
QU
3
&
E-
QU
3
&
5
S
g
>3
g
g
P—
Sy
£
5
>
o
2,
3
S

Cred pesapin |
Class The Java class name.
Method The Java method name into the class.
Calls Number of calls.
Max dur. Maximum duration of the calls.
Min dur. Minimum duration of the calls.
Avr dur. Average duration of the calls.

Total dur. Accumulated duration time.

Action List of all calls.

- . . P ..
1 The duration time is in miliseconds.

,_______
.
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Enable profiling stats

» On top right clickon = Enable button.
Disable profiling stats

» On top right click on = Disable button.
Clear profiling stats

e On top right click on 'L'!’} Clear button.
Refresh profiling stats

e On top right click on > Refresh button.

List of detailed calls

e Click on "I List detailed calls icon.
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Purge permissions

The purge permissions feature helps administrators to delete users and roles grants assigned to objects ( documents, folders,

mails or records ).

V Examples of usage:

e Remove grants of users or roles that no longer exists into the repository.

e Remove grants of users or roles that has been propagated along the repository accidentally.

Purge

A This operation can not be reverted, use with care.

TTTT T TN

¢ From checkbox choose users or roles option.
e Click on List Button.

e Click on @ Delete icon.
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Rebuild indexes

The Rebuild Indexes feature helps the administrator to rebuild Lucene indexes.

Indexes Description
Text extractor Extracts all document contents and rebuild the indexes.
Lucene indexes Rebuild indexes with actual contents.

Optimize indexes = Remove older contents that no longer exists in repository.

Rebuild

e Choose the index to rebuild.

e Click on Execute button.
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Repository checker

The repository checker feature helps the administrator to verify the repository integrity.

g
|
| i When the administrator thinks the system could be compromised, for example a hard disk failure or similar,he
|
i can use Repository checker feature to verify the application integrity.
Option Description
Path The path from where will be started the verification process.
Common values:
¢ /okm:root
¢ /okm:trash
e /okm:personal
¢ /okm:mail
e /okm:templates
Fast The fast verification will only check the existence of the last document version.
Versions Verify the existence of all document versions. This option has priority over fast option.

Checksum  Calculate the checksum of repository document and compares with database value.

Check repository

A The process can take several minutes or hours depending on the repository size and the repository options
checked.

The repository checker process will show a process status in %, before it is shown the application calculates the
total amount of nodes that should be checked in a huge repository this calculation process can take several
minutes, please be patient.

e Set the path.
e Choose repository checker options ( fast, versions, checksums ).

e Click on Check button.
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Repository view

The repository view feature provides a low level access to the repository that should be used with care because it allows to

apply changes into the repository directly.

Node folder selected
Sections Description
Info Get general information of the node selected.

Allowed options:

e Path helps to navigate to parent nodes.
e Remove contents action will remove all children nodes.

e Remove current action will remove selected node and descendants.

Properties Shows the node properties:

e UUID.
e Keywords.

e Categories.

Property group  Shows and modifies the assigned metadata values.

Children Shows all the children nodes ( document, folders, mail and records into ).

Node document selected

Sections Description

Info Gets general information of the node selected.

Allowed options:

e Path helps to navigate to parent nodes.
e Remove current action will remove selected node.

o Force text extraction action will execute the text extraction process.

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE

Page 516 of 1191

Properties

Property group

History

Text extracted

Shows the node properties:

e UUID.
* Keywords.

o Categories.

Shows and modifies the assigned metadata values.

Shows and downloads any version of the document.

Shows the document differences between previous document versions.

Shows the text extracted from the document.

Node mail selected

Sections

Info

Properties

Property group

Children

Description

Gets general information of the node selected.

Allowed options:

o Path helps to navigate to parent nodes.

e Remove current action will remove selected node and descendants.

Shows the node properties:

e UUID.
* Keywords.

o Categories.

Shows and modifies the assigned metadata values.

Shows all the children nodes ( documents into ).
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System properties

The system properties feature show the JVM variables.

Most common JVM variables:

java.

java.

java.

java.

java.

java.

Java.

java.

java.

java.

java.

java.

java.

java.

java.

java.

java.

java.

Key
version
vendor
vendor.url

home

vm.

vm.

vm.

vm.

vm.

vm.

specification.version

specification.vendor

specification.name

version

vendor

name

specification.version

specification.vendor

specification.name

class.version

class.path

library.path

io.

tmpdir

compiler

Description of Associated Value

Java Runtime Environment version

Java Runtime Environment vendor

Java vendor URL

Java installation directory

Java Virtual Machine specification version

Java Virtual Machine specification vendor

Java Virtual Machine specification name

Java Virtual Machine implementation version

Java Virtual Machine implementation vendor

Java Virtual Machine implementation name

Java Runtime Environment specification version

Java Runtime Environment specification vendor

Java Runtime Environment specification name

Java class format version number

Java class path

List of paths to search when loading libraries

Default temp file path

Name of JIT compiler to use
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java.

ext.dirs

OS.name

os.arch

0s.version

file.

path.

line.

user.

user.

user.

separator

separator

separator

name

home

dir

Path of extension directory or directories

Operating system name

Operating system architecture

Operating system version

File separator ("/" on UNIX)

Path separator (":" on UNIX)

Line separator ("\n" on UNIX)

User's account name

User's home directory

User's current working directory
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CSS

The application allowes to set your own CSS - Cascade Style Sheets - to be applied in user interface.

~

The CSS applied to user interface is set on Profile General tab section.

V That helps the administrator to change the look and feel of the application.

For example, change the font size for cyrillic or logographic languages.

Css are shown in a table structure.

g
s
&
S
=4
X

Create a new CSS

A Can not be two css with same name.

TTTTTTTY

e At the top right click on "&'}' New CSS icon.
o Fill in the fields.

e Name.

¢ Context available are frontend or mobile.

e Active.

e Click on Create button.

Edita CSS

e Click on & Edit CSS icon.
¢ Modify the fields.

e Click on Edit button.

Delete a CSS

e Click on @ Delete CSS icon.

e Click on Delete button.

Clone a CSS

e Click on ‘Ifl Clone CSS icon.
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¢ Modify the fields.

e Click on Clone button

Download a CSS

e Click on ¥ Download CSS icon.

¢ Elapsed some seconds, will be retrieved a CSS file.

Samples

Large font sample

body, td, a, p, div, input, input.submit , textarea, select, buttonf{
font-family: Tahoma, Arial, Helvetica, sans-serif;
font-size: 13px;

}

.gwt-MenuItem, .okm-TopMenuBar .gwt-Menultem-selected, .okm-Input, .okm-TextArea,
font-family: Tahoma, Arial, Helvetica, sans-serif;
font-size: 13px;

}

.okm—-Popup .Caption, .okm-Popup-Error .Caption, .okm-Image-Popup .Caption {
font-family: Tahoma, Arial, Helvetica, sans-serif;
font-size: 15px;

body, td, a, p, div, input, input.submit , textarea, select, buttonf{
font-family: Arial, Helvetica, sans-serif;
font-size: 12px;

}

.gwt-MenuItem, .okm-TopMenuBar .gwt-Menultem-selected, .okm-Input, .okm-TextArea,
font-family: Arial, Helvetica, sans-serif;
font-size: 12px;

}

.okm-Popup .Caption, .okm-Popup-Error .Caption, .okm-Image-Popup .Caption f{
font-family: Arial, Helvetica, sans-serif;
font-size: 14px;

body, td, a, p, div, input, input.submit , textarea, select, buttonf{
font-family: Arial, Helvetica, sans-serif;
font-size: 1lpx;

}

.gwt-MenuItem, .okm-TopMenuBar .gwt-Menultem-selected, .okm-Input, .okm-TextArea,
font-family: Arial, Helvetica, sans-serif;
font-size: 1lpx;

}
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\  .okm-Popup .Caption, .okm-Popup-Error .Caption, .okm-Image-Popup .Caption f{ i
font-family: Arial, Helvetica, sans-serif; i
' font-size: 13px; '
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User guide

.
1
i V You can use the Quick start guide to quickly learn the basics, and to find detailed info on the user sections.
1
|

OpenKM frontend is the Back office view on the content repository. The features are organized in several sections:

¢ The Menu bar at the top where are available all the features organized by type.
¢ The Quick search box at the right top.

¢ The Toolbar where are the most commonly used features.

o The Desktop tab enables to navigate the repository.

o The Search tab enables to query the repository.

¢ The Dashboard tab provides a set of dashboards.

e The Administration tab provides a set of the administration tools.

¢ The Status panel at the bottom provides general information.

A Only members with "ROLE_ADMIN" role have access to the Administration tab.

TTTT T TN

The OpenKM frontend allows you to manage any type of content: scanned images, photographs, office documents and even
large videos files or CAD files among others. The built-in workflow feature helps companies to automate businesses processes
and get a full control of the cycle of the documents, saving time and money. It also allows the social activities around the
content to be used to connect people to other people, information to information, and people to information; helping to manage,

more efficiently, the collective intelligence of the human resources of the company.
The OpenKM Profiles feature helps administrators to set what is displayed for each user of the application.

OpenKM provides the solution to:

¢ Controls the growing volume of information to be managed.

¢ Ends the diversification of information storage sources.

¢ Prevents the duplication of the information.

e Obtains valid information through the control of document versions.

¢ Reduces the time and resources used in locating information.

e Avoids knowledge leaks or wrongful access by users, therefore complying with the obligations set in the LOPD (Spanish
Data Protection Law).

e Restricts non-authorized users access to the information.

Through the OpenKM system, all relevant and useful information can be accessed and found in the less possible time to resolve

problems and make decisions.
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Menu bar
The menu bar at the top has all features organized by type:

o File.

o Edit.

e Tools.

¢ Bookmarks.
o Templates.

e Helps.

File Edit Tools Bookmarks Templates Help

Quick search box
The Quick search box is at the top right corner. It provides a fast access to Default search in Search panel.

openkm 5

A The minimal text length for doing a query is three characters.

TTTT T TN

ToolBar

The toolbar section has the most commonly used features like download documents, create new folders, edit or upload files

among others.

i Y e D = Z 8 | =@

Desktop
Most user's activity is done there. Users can work directly on folders, documents, mails or records.
The desktop is distributed in tree sections:

¢ Navigation panel at left hand side.
* Browser panel at top center.

¢ Properties panel at bottom center.
Navigation

The navigation at left hand side is an stack panel. Each stack contains into a tree ( folder and records hierarchy ) structure
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from root that enables easily access documents and mails.

Browser

The browser panel at top center shows a table of nodes ( documents, folders, mails and records ) that are on the selected node

of navigation panel.

Properties

The properties panel at bottom center shows a collection of tabs that contain the grouped properties or features like preview

associated with selected node. The selected node can be a navigator node or browser node.

Basically the selected node at navigator panel determines the content shown at the browser panel and depending
if the last selected node by the user is at navigator or browser panel the properties panel will shown the

e
|
|
|
|
|
|
I
| properties of the active node at navigator or browser.
|
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File Edit Tools Bookmarks Templates Help

1] i o G4 13 2 4= 6 | m5® |4

Path : /Jokm:root/

Mame Title Language

hosts. txt inglés

test. pdf espanol
google-web-toclkit - |

s0me subject

Navigation Browser

O0000oalf

QEPWE ® &

uuID 0Badeedd-Thif-4349-063c-3bBcd4009749 Subscribed usel
Name okmroot Mube de palabra
Style = Categorias|
Parent

Created  10-07-2015 15:52:16 by Administrator

Subscribed Mo .

Folders 3 Properties

Documents 2
Mails 2
Records Li]

Keywords | |

] Trash
© # CINTITITITETY | 5 20 | (300500000 -0

Search

The search tab enables to query the repository. This tab gives access to different searches to query the content of the

application:

e Default search is a full-text search. Default search is also available from the top right corner on the screen.

¢ Advanced search enables you to search keywords, metadata and additional criteria such as location in the application.
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Fie Edit Tools Bookmarks Templates Help

x| ] B

f#ifl Stored searches Fulltext search Wi
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Page
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- User news

Connected as Administrator | 20.0 MB 2ol o]o o ko s o0
gl

Dashboard

The dashboard panel provides a set of dashboards, each user has a set of personal dashboard that display the information

relevant for him and helps to have a global view of the application activity.

The dashboard panel :

o User view. Displays the actions that have been carried out in the system
¢ General view. Displays a global view of the application activity.

o News. Displays information based on scheduled user search queries.

e Mail. It's a virtual navigation across all mail repositories.

o Workflow. Users work in company business process tasks.

* Keyword map. Displays a tag cloud based on all repository keywords.
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¢ Messaging. Displays internal OpenKM messaging.
e Forum. Displays a forum.
¢ Wiki. Displays a wiki.

e Meeting. Manages meetings with OpenMeetings.

A Messaging is only available if you have enabled the Messaging feature.
Forum is only available if you have enabled the Forum feature.
Wiki is only available if you have enabled the Wiki feature.

Meeting is only available if you have enabled the OpenMeetings feature.

|H= Edit Tocls Bookmarks Templates Help

D"ﬂ-ii.wh]--l -:-IaL'd,;,_-,_--_- ]q-;-].;]-_n-:; - o |

’ a \‘- st | ; .'5:-
e @ & o

User Mail MNews General Workflow Keyword map

“Y Locked documents (0) & = [} Last modified docur

|| Edited documents (0) & = | Last uploaded doc

| insert.sql
|4 Last downloaded documents (1) New:1 | | % W fix calls to ext
cherokee. txt
|| Subscribed documents (0) EE
|| Subscribed folders (D) BG4

@ # ORI | e | Bo@oDodode 0 [

Administration

The administration panel is a set of tools that helps administrator to manage the application.

i More information at Administration guide.

TTTTTTTY

———

Status

Created in 2016 by OpenKM. OpenKM documentation is provided under OpenKM documentation license.


https://docs.openkm.com/kcenter/view/okmdl

OpenKM 6.3 - CE Page 528 of 1191

The status panel provides general information:

e OpenKM news alert.

e The connected user.

e User repository size.

e Chat.

o Alerts.

e HTML documents on edition.

¢ Message panel.

. IR |+ w0 | o000 G0t o .
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Quick start

V Before starting a production environment you should also read these sections:

 Essential fundamentals.
» Plan your data organization.

With OpenKM it's simply to store and share information and collaborate effectively.

This quick start guide give you an introduction to some of the features of the OpenKM:

e Logging in.

e Create a taxonomy.
e Add documents.

e Edit documents.

e Search documents.
Loggin in
You need to log in to OpenKM.

¢ Enter the following on the login page:
¢ Username: your username.
¢ Password: your password.

¢ Choose your language.

e Click on Login button.

Ask your administrator for your login URL. By default from the OpenKM server the URL is
http://127.0.0.1:8080/OpenKM

A The default administrator credentials are:

e Username: okmAdmin

e Password: admin

Do not forget to change the administrator password.

Create a taxonomy

V The dictionary says:

"Taxonomy (from Greek taxis meaning arrangement or division and nomos
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meaning law) 1is the science of classification according to a pre-
determined system, with the resulting catalog used to provide a
conceptual framework for discussion, analysis, or information retrieval.
In theory, the development of a good taxonomy takes into account the
importance of separating elements of a group (taxon) into subgroups
(taxa) that are mutually exclusive, unambiguous, and taken together,

include all possibilities."

Basically, a taxonomy is a way to group things together. Like a controlled vocabulary focuses on concepts, i n
practice, a good taxonomy should be simple, easy to remember, and easy to use.

The first step should be analyse the company organization and define a set of folder hierarchy to store the documents organized.

Take this one as a sample:

/okm:root/ 2015/  invoices/

human resources/

marketing/

2016/  invoices/

human resources/

marketing/

To create a folder:

e Select a node from taxonomy where to create the folder.
e Click on & folder icon at tool bar.
e Set the name.

e Click on Accept button.
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File Edit Toole Bookmarks Templates Help

e s lEREREL LS BL e BUls0 |28 |4

u:—'. Taxonomy |F"ath : lokmuroot/2015/
B & okmiroot N Title !
B % 2015 (] & invoices
(= invoices [l (= human rescurces
[ human resources [] [ marketing
(== marketing
= 2016 Create folder
| X cancel ||« Accept |
uuID b26cHcSe-abdf-4865-a0b5-d4fbed3TacaT Subscribed use
Name 2015 Nube de palabr:
le [~ _
Sty Categorias |_:_|;
5 Parent lokmiroot
- - Categories Created  25-08-2015 17:22:42 by Administrator
| Metadata Subscribed No
L] Thesaurus Folders O
Documents O
i~ Templates Mails 0
£ My documents Records O
E-mail Keywords | |
1l Trash : -

IR
. T | © =owe | Do oo doge o) C

[ |

1

i We suggest spending some time thinking and designing your taxonomy. For a best UI performance we suggest i
|

i less than 200 elements per folder. 1

g J

Add documents

e Select a node from taxonomy where to add the document.
e Click the Q add document icon from the toolbar.
e Select the document from your computer.

e Click Upload button.
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File Edit Toocls Bookmarks Reports Templates Help
; L ) ) :
1 e =R ] B Ni=1=00 JI=I=E-F- K
< ou Taxonomy Path : /okm:root/ 2015/
B (= okm:root 0] &4 =/ | % | B} paginate |10 7| Total: 3 14 4 1031 |
= [ 2015 Name Title Language Si
= human resources [] & human resources
= invoices | &= invoices
= marketing | = marketing
=% 2016
Add new documents
I Mo se ha seleccionado ningln an
|| Impert Documents from ZIP
|x Close | Lﬁ mﬂad_]
Properties | Notes | Security | Relations |
UUID b26cOcle-abdf-4865-a0b5-d4fbe337aca? Subscribed users
Name 2015 Keywords cloud
le (] _
Sty Categories I__,j:
5 Parent Jokm: root
ioaregorias Created  25-08-2015 17:22:42 by Administrator
- | Metadata Subscribed No
L Thesaurus Folders 3
- Templates Documents 0
£ My documents Mails 0
My —l Records 0
y o
E-mail Keywords | | B
ﬁ Trash

# T | v | 631 | BoB m 01 G0 o o |

Edit documents

The document edition is based on the "check-out / check-in" model.

v

of content - in OpenKM a document - at the same time.

user can prevent others from editing that content.

"Check-out" and "check-in" are common terms in many document management systems, including OpenKM.

Their purpose is to prevent conflicts in an environment where multiple people might want to edit the same piece

The term "check-out" describes the process of getting a version of a document. By checking out a document, a

The term "check-in" describes the process of updating a document to replace the previous version. By checking
in the item, the user can allow others to edit the document, without needing to worry about overriding changes
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that others have made.

When a document is checked out to a user, that user can work on that document, and other users cannot. Other
users must wait for the user to check in the document before they can edit. While the document is checked out,
other users usually can see only the last version that was checked in; they can't see the changes that the current
user has made on the document while it's been checked out.

First must check-out the document:

e Select a document.

e Click on Q Edit icon.

Fie Edit Toole Bookmarks Templates Help

I3RS 8 eEiE S

ER- M=l Nl lERE-X- BE R

n:—'. Taxonomy
B &F okm:root
B & 2015
[= invoices
=+ human resources

[==- marketing
= 2016

|| categories

| Metadata

m Thesaurus

o~ Templates

&. My documents
E-mail

1l Trash

Path : root' 201 Sinvoices/

GROUP RELATIONS &8

. T |+ =owe | Do oo doso o) C

Finally check-in the document to upload the changes:

e Select the edited document.
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